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3 1. Oversikt

Systemkonfigurasjon

UWP-D21 
UWP-D22 
UWP-D26 
Trådløs 
mikrofonpakke

URX-P03D 
Trådløs 
mikrofonmottaker

SMAD-P3D 
Skoadapter for 
flere grensesnitt

SMAD-P5 
Skoadapter for 
flere grensesnitt

LA-EA3 
LA-EA4 
A-festeadapter

E-festeobjektiv

ECM-VG1 
ECM-MS2 
Mikrofon

RM-30BP 
Fjernkontrollenhet

MCX-500 
Multikamera 
live-produsent

Grep, fjernkontroll 
(følger med)

ILME-FX6V/ILME-FX6VK 
ILME-FX6T/ILME-FX6TK

XLR-K2M 
XLR-K3M 
XLR-adapterpakke

HVL-LBPC 
Videolys

CFexpress Type A 
Minnekort

SDXC  
minnekort

BC-CU1 
Batterilader 
(følger med)

BP-U35, BP-U60, 
BP‑U60T, BP-U70, 
BP‑U90, BP-U100 
Batteripakke

Strømadapter 
(følger med)

CFexpress Type A kortleser/ 
SD-kortleser

BC-U1A, BC-U2A 
Batterilader

ECM-B1M  
Shotgun-mikrofon
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Delenes plassering og funksjon

Venstre side og forside
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4
5
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7
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1.	 Målebåndkrok
Målebåndkroken er på samme plan som 
bildesensoren. For å måle avstanden mellom 
videokameraet og motivet nøyaktig, bruk 
denne kroken som et referansepunkt. Du kan 
feste enden på et målebånd til kroken for å 
måle avstanden fra motivet.

2.	 Søkerkontakt (side 19)

3.	 Luftehull

[Merk]
Ikke dekk over luftehullet.

4.	 Velgerbryter TC IN/OUT (tidskode inn/ut) 
(side 34, 120)

5.	 Grep, fjernkontrollkontakt (side 20)

6.	  (N-merke) (side 60)
ˎˎ Hold en mobiltelefon med NFC-funksjonen 
mot enheten for å opprette en trådløs 
forbindelse.  
Noen mobiltelefoner som støtter trådløse 
betalingssystemer støtter kanskje ikke NFC. 
Se driftshåndboken for mobiltelefonen for 
mer informasjon.
ˎˎ NFC (Near Field Communication) er en 
internasjonal kommunikasjonsprotokoll: 
for trådløs kommunikasjon mellom enheter 
som er nær hverandre.

7.	 Grep, fjernkontrolltilbehør (side 20)

8.	 Utløserknappen for grepfjernkontrollen 
(side 20)

9.	 Wi-Fi-antenne

10.	Opptakslampe (foran) (side 34)
Blinker hvis gjenværende kapasitet på 
opptaksmediet eller batteriet er lavt.

11.	FOCUS-bryter (side 37)

12.	Bildesensor

13.	PUSH AUTO FOCUS-knapp (side 40)

14.	Kontakter for linsesignaler

[Merk]
Ikke ta på med hendene.

15.	WB SET-knapp (still inn hvitbalanse) 
(side 46)

16.	Utløserknapp for linsen (side 22)
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Høyre side (foran/topp/bunn)
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1.	 Klippflaggknapp (side 53, 70)

2.	 HOLD-bryter (side 102)

3.	 Opptak START/STOP-knapp (side 34)
Trykk knappen opptak START/STOP for å 
begynne å ta opp. Lysdioden lyser rødt mens 
det tas opp.

4.	 ND VARIABLE-hjul (side 44)

5.	 ND PRESET/VARIABLE-bryter (side 44)

6.	 ND FILTER POSITION opp/ned-brytere 
(side 44)

7.	 ND CLEAR-indikasjon (side 44)

8.	 ND VARIABLE AUTO-knapp (side 44)
Trykk på knappen ND VARIABLE AUTO for å 
begynne automatisk tetthetsjustering av ND-
filteret. Lysdioden lyser grønt når den er slått 
på.

9.	 Flerfunksjonshjul (side 49)
Trykk når du ser bildet i søkeren for å vise og 
bruke direktemenyen.
Drei hjulet når en meny vises i søkeren 
for å flytte markøren opp/ned for å velge 
menyelementer eller innstillinger. Trykk for å 
bruke det valgte elementet.
Når menyen ikke vises, kan hjulet også 
fungere som et programmerbart hjul.

10.	Funksjonsknapp for IRIS (side 43)

11.	CANCEL/BACK-knapp (side 69)

12.	THUMBNAIL-knapp (side 68)

13.	MENU-knapp (side 14, 73)
Trykk på MENU-knappen (meny) for å 
vise statusskjermen. Trykk og hold MENU-
knappen (meny) for å hovedmenyskjermen. 
Trykk på knappen når statusskjermen eller 
hovedmenyskjermen vises for å gå tilbake til 
forrige skjermbilde.

14.	Knapp for ISO/GAIN-funksjon (side 43)

15.	ISO/GAIN (forsterkningsvalg)-bryter 
(side 43)

16.	Knapp for funksjonen WHT BAL 
(hvitbalanse) (side 46)

17.	Velgerbryter for WHT BAL (velg 
hvitbalanseminne) (side 46)

18.	Knapp for SHUTTER-funksjon (side 44)

19.	Uttak til hodetelefon (side 34)

20.	POWER-bryter (side 34)

Høyre side (bak) (side 6)
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Høyre side bak og kortspor
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1.	 Wi-Fi-antenne

2.	 AUDIO LEVEL (CH1)-hjul (side 47)

3.	 CH1 (AUTO/MAN)-bryter (side 47)

4.	 ASSIGN (kan tilordnes) 1 til 3 knapper 
(side 49)

5.	 Intern mikrofon (side 47)
Lydmikrofon for opptak av lyd fra 
omgivelsene. 

[Tips]
Denne mikrofonen deaktiveres når håndtaket er festet, 
og den interne mikrofonen i håndtaket aktiveres 
(side 7).

6.	 DISPLAY-knapp (side 11)

7.	 Innebygd høyttaler (side 34)

8.	 POWER-indikatoren (Strømindikator) 
(side 34)

9.	 SLOT SELECT-knapp (valg av 
minnekortspor (A)/(B)) (side 34)

10.	CH2 (AUTO/MAN)-bryter (side 47)

11.	AUDIO LEVEL (CH2)-hjul (side 47)

12.	Tilgangsindikator A (side 26)

13.	Kortspor for CFexpress Type A/SD-kort (A) 
(side 26)

14.	Kortspor for CFexpress Type A/SD-kort (B) 
(side 26)

15.	Tilgangsindikator B (side 26)
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Håndtak, bakside og koblingsblokk
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1.	 HOLD-bryter for håndtak (side 102)
Brukt til å deaktivere bruken av kontrollene på 
håndtaket.

[Tips]
Kan også stilles inn kun for håndtakets opptak START/
STOP-knapp.

2.	 Håndtakets opptak START/STOP-knapp

3.	 Håndtakets interne mikrofon

4.	 Flergrensesnittsko

For mer informasjon om tilbehør som støttes 
av flergrensesnittskoen, kontakt din lokale 
salgsrepresentant.

5.	 Programmerbart hjul for håndtak 
(side 49)

6.	 Håndtakets zoomspake (side 102)

7.	 ASSIGN (kan tilordnes) 7 til 8 knapper 
(side 49)

8.	 Flervalg-knappen (8-veis D-plate og 
bruk-knapper)

9.	 Tilbehørssko (side 7)

10.	Festeskruehull for tilbehør (1/4 tommer)
Kompatibel med 1/4-20 UNC-skruer (lengde 
6 mm eller mindre).

[Merk]
Bruk av skruer over 6 mm kan skade de utvendige 
delene.

11.	Opptakslampe (bak) (side 34)

12.	BATT RELEASE-knapp (side 17)

13.	Luftinntak

[Merk]
Ikke dekk over luftinntaket.

14.	Feste for batteripakke (side 17)

15.	USB-C®-kontakt (side 63)

16.	Kontakt for INPUT2 (lydinngang 2) 
(side 47)

17.	Kontakt for INPUT1 (lydinngang 1) 
(side 47)

18.	INPUT2-bryter (LINE/MIC/MIC+48V) 
(side 47)

19.	INPUT1-bryter (LINE/MIC/MIC+48V) 
(side 47)

20.	Skruehull for eksternt utstyr
Kompatibel med M3-skruer (lengde 4 mm eller 
mindre).

[Merk]
Hvis du bruker skruer på over 4 mm, kan det skade den 
utvendige overflaten.

21.	HDMI OUT-kontakt (side 119)

22.	SDI OUT-kontakt (side 119)

23.	TC IN/TC OUT-kontakt (tidskodeinngang/-
utgang) (side 120)

24.	REMOTE-kontakt
Koble til generelt LANC-plugg (tilbehør).

25.	USB/multikontakt (side 121)

26.	DC-IN-kontakt (standard DC-plugg) 
(side 18)

Feste tilbehørsskoen

1	 Løft forkanten av fjæren i skoen, og trekk 
fjæren i motsatt retning av pilen som er 
gravert på fjæren.

Skofjær

Tilbehørssko

1

2	 Plasser tilbehørsskoen på festet til 
tilbehørsskoen, juster utspringene på 
skoen med de tilsvarende punktene på 
festet, og stram de fire skruene.
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3	 Sett inn skofjæren i pilens retning, slik at 
den U-formede delen passer på enden av 
tilbehørsskoen.

Skofjær

Tilbehørssko

2 32 3

Ta av tilbehørsskoen

Fjern skofjæren slik som beskrevet i trinn 1 
under "Feste tilbehørsskoen", skru ut de fire 
skruene, og ta av tilbehørsskoen.

Feste håndtaket

Plasser håndtaket slik at håndtakkontakten og 
skruhullene er rettet inn riktig, skyv inn og vri 
festeskruene for håndtaket med urviseren for 
å feste håndtaket til enheten.
Du kan også trekke til de to festeskruene for 
håndtaket ved å dreie dem med urviseren 
med en sekskantnøkkel (4 mm).

[Merk]
Kontroller at de to festeskruene til håndtaket er godt 
festet før du bruker håndtaket. Håndtaket kan falle av 
videokameraet hvis skruene ikke trekkes godt til.

Ta av håndtaket

Løsne ved å bruke motsatt prosedyre som for 
å feste.

Feste beskyttelsesdekslet på 
håndtakskontakten (følger med)

Når du bruker videokameraet med håndtaket 
fjernet, må kontakten beskyttes ved hjelp av 
det medfølgende beskyttelsesdekslet.

[Tips]
Når du fester håndtaket, sett det medfølgende 
beskyttelsesdekslet på undersiden av håndtaket.

Beskytte kontaktterminalene

Fest dekselet på ubrukte kontakter for å 
beskytte kontaktterminalene.

Overside

1

2 2

2

2

1.	 Håndtakkontakt

2.	 Festeskruehull for tilbehør (1/4 tommer)
Kompatibel med 1/4-20 UNC-skruer (lengde 
6 mm eller mindre).

[Merk]
Bruk av skruer over 6 mm kan skade de utvendige 
delene.
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Underside

1 2
1.	 Skruehull for stativ (1/4 tommer, 

3/8 tommer)
Kompatibel med 1/4-20 UNC-skruer og 3/8-
16 UNC-skruer. Festes til et stativ (tilleggsutstyr, 
skruelengde 5,5 mm eller mindre).

2.	 Luftutløp

[Merk]
Ikke dekk over luftutløpet.

Søker

For mer informasjon om hvordan feste 
søkeren (følger med), se side 19.

1
2
3

4 5

1.	 PEAKING-knapp

2.	 ZEBRA-knapp

3.	 ASSIGN (kan tilordnes) 9 knapper 
(side 49)

4.	 Berøringspanel
Berøringsoperasjoner kan deaktiveres ved 
hjelp av en tilordnet knapp eller ved hjelp av 
menyen (side 10).

5.	 MIRROR-bryter

Grep, fjernkontroll

For mer informasjon om hvordan feste 
grepfjernkontrollen (følger med), se side 20.

4

3
2

1

7
8

6
5

1.	 Zoomspake

2.	 ASSIGN (kan tilordnes) 4 knapper 
(side 49)

3.	 Programmerbart hjul for grep (side 49)

4.	 ASSIGN (kan tilordnes) 6 knapper 
(side 49)

5.	 Grep-rotasjonsspak (side 21)

6.	 Opptak START/STOP-knapp

7.	 Flervalg-knappen (8-veis D-plate og 
bruk-knapper)

8.	 ASSIGN (kan tilordnes) 5 knapper 
(side 49)
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Hvordan bruke berøringspanelet

Forsiktighetsregler ved bruk av 
berøringspanelet

Søkeren på enheten er et berøringspanel 
som du betjener direkte ved å trykke på med 
fingeren.
ˎˎ Berøringspanelet er utformet for å berøres 
lett med fingeren. Ikke bruk stor kraft eller 
skarpe kanter eller spisse gjenstander 
(spiker, kulepenn, pinne osv.) for å trykke på 
panelet.
ˎˎ Det kan hende at berøringspanelet ikke 
reagerer når det berøres i følgende 
situasjoner. Legg også merke til at dette kan 
føre til funksjonsfeil.
ˎˎ 	Betjening med spissen av neglene
ˎˎ 	Betjening mens andre gjenstander 
berører overflaten
ˎˎ 	Betjening med påsatt beskyttelsesfilm 
eller klistremerke
ˎˎ 	Betjening med vanndråper eller kondens 
på displayet
ˎˎ 	Betjening med våte eller svette fingre

Bevegelser på berøringspanelet

Tapp
Trykk lett på et element, bruk fingeren til 
å, for eksempel trykke på et ikon eller et 
menyelement og løft fingeren med en gang.

Dra
Trykk på skjermen, skyv fingeren til ønsket 
posisjon på skjermen, og løft deretter 
fingeren.

Flikke/sveipe
Trykk på skjermen, og dra raskt fingeren 
oppover, nedover, mot venstre eller mot høyre.

[Tips]
Hvis det som vises fortsetter utenfor kantene av 
skjermen, kan du dra eller sveipe bildet for å skrolle.

Konfigurering av berøringspanelet

Berøringsfunksjonen kan aktiveres/
deaktiveres ved hjelp av Touch Operation på 
(side 102) Technical-meny.
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Skjermvisning
Under opptak (opptak/standby) og avspilling vises status og innstillinger for videokameraet over 
bildet som vises i søkeren.
Du kan vise/skjule informasjonen ved hjelp av DISPLAY-knappen. Selv om den er skjult, vises den 
under direkte menyoperasjoner (side 49).
Du kan også velge å vise/skjule hvert element for seg (side 96).

Informasjon som vises på skjermen under fotografering

3 42

6
8

9 1075

11
13 12

14
15

16
17
18

19 20 21 22 23 24 25 26 27 28 29

30

31
32
33
34
35
36
37

138

1.	 Nettverksstatus, indikator (side 13)
Viser status for nettverkstilkoblingen som et 
ikon.

2.	 Indikator for opplasting / indikator for 
gjenværende filer (side 65)

3.	 Fokusområdeindikator (side 38)
Viser fokusområdet for autofokus.

4.	 Opptaksmodus, spor A/B, indikator for 
intervall på opptak (side 50)

Skjerm Betydning

Rec Opptak

Stby Pause i opptak

5.	 Indikator for feltdybde

6.	 Indikator for bildeskannermodus 
(side 25)

Et -merke vises hvis det ikke er samsvar 
mellom størrelsen på bildesirkelen i objektivet 
og innstillingen for effektiv bildestørrelse for 
bildeskannermodus.
Når bildeskannemodus er satt til FF, 
vises et C-merke i moduser med smalere 
visningsvinkel (beskåret).
Beskjæring skjer i følgende moduser:
ˎˎ Når opptaksformatet er 3840×2160 og S&Q 
Motion bildefrekvensen er 100 bilder/sek 
eller 120 bilder/sek
ˎˎ Når kodeken er satt til RAW eller RAW 
& XAVC-I og RAW utdataformatet er 
3840×2160

7.	 Driftsstatusindikator for RAW-utdata 
(side 59)

Viser ut-status for RAW-signalet.

8.	 Statusindikator for UWP-D-serien 
(side 13)

Viser RF-signalstyrken som et ikon når en 
enhet i UWP-D-serien er koblet til MI-skoen 
som er konfigurert for digital lydoverføring.

9.	 Indikator for opptakets bildefrekvens for 
sakte og rask bevegelse (side 50)

10.	Indikator for gjenværende 
batterikapasitet / DC IN-spenning 
(side 17)

11.	Fokuseringsmodus, indikator (side 41)

Betydning Skjerm

Focus Hold-modus Focus Hold

MF-modus MF

AF-modus AF

Sanntidssporing i AF-modus

AF for ansiktsgjenkjenning (AF/ /Only/ / )

Ikon for 
ansiktsgjenkjenning

AF-ikon for 
ansiktsgjenkjenning

Only

Ikon for lagret 
ansiktssporing

AF pause-ikon1)

1)	 Vises under bruk av AF når bruk av AF ikke kan 
fortsette og stoppes midlertidig. Ikonet forsvinner når 
årsaken til stopp i bruk av AF er løst, og da gjenopptas 
bruk av AF.

12.	Fokusposisjonsindikator
Viser fokusposisjonen.

13.	Indikator for zoomposisjon (side 36)
Viser zoomposisjonen i området 0 (vidvinkel) 
til 99 (telefoto) (hvis et objektiv som støtter 
zoominnstillingsvisning er satt på).
Visningen kan endres til en søyleindikator eller 
til en indikator for fokusavstand (side 103).
Følgende elementer legges til visningen når 
Clear Image Zoom er aktivert.

Skjerm Betydning

Clear Image Zoom er aktivert

Forstørrelsesverdi Ved bruk av Clear Image 
Zoom

14.	Indikator for bildestabiliseringsmodus

15.	SDI-utgang/HDMI-utgang 
opptakskontroll statusindikator 
(side 119)

Viser ut-status for REC Control-signalet.

16.	Fokusindikator (side 37)

17.	 Indikator for gjenværende 
mediekapasitet

Skjerm Betydning

Montering/monteringsstatus 
(medie A)

Montering/monteringsstatus 
(medie B)

Montering/monteringsstatus 
(medie B)1)

(blinkende)

Monteringsstatus (ikke opptakbar) 
(medie B)1) 2)

1)	 Tar opp kun proxy-data
2)	Mediefeil, medie fullt, eller annen feil inntraff ved start 

av opptak eller under opptak.

Det vises et -ikon hvis minnekortet er 
skrivebeskyttet.

18.	Indikator for hvitbalanse-modus

Skjerm Betydning

Auto-modus

 Hold Auto-modus er satt i pause

W:P Forhåndsinnstilt modus

W:A Minne A, modus

W:B Minne B, modus
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19.	Tidskode ekstern lås-indikator/
tidsdatavisning (side 34)

Viser "EXT-LK" når den er låst til tidskoden fra 
en ekstern enhet.

20.	ND-filterindikator (side 44)

Skjerm Betydning

Auto-modus

Bokeh-kontrollmodus 
(side 53)

21.	Scenefil-indikator (side 56)

22.	Irisindikator
Viser irisposisjonen (F-verdi) (hvis et objektiv 
som støtter irisinnstillingsvisning er satt på).

23.	Varselindikator for videonivå

24.	Forsterkningsindikator (side 43)
I Custom-opptaksmodus (side 24), viser 
den forsterkningsverdien eller ISO-verdien. I 
Flexible ISO-modus viser den ISO-verdien.
I Cine EI/Cine EI Quick-opptaksmodus 
(side 24), viser den EI-verdien.

Skjerm Betydning

Auto-modus

H Forhåndsinnstilt 
H-modus

M Forhåndsinnstilt 
M-modus

L Forhåndsinnstilt 
L-modus

Midlertidig 
justeringsmodus

Bokeh-kontrollmodus 
(side 53)

25.	Visning av klippnavn (side 94)
Viser navnet på klippet som tas opp eller skal 
tas opp påfølgende.

26.	Lukkerindikator (side 44)

27.	AE-modus/AE-nivåindikator (side 43)

28.	Spritlibelle
Viser det horisontale nivået i trinn på ±1° opp 
til ±15°.

29.	Lydnivåmåler
Viser lydnivået for CH1 til CH4.

30.	Videosignalskjerm (side 52)
Viser en kurve, vektorskop og et histogram.
Den oransje linjen viser innstillingsverdien for 
zebra-nivået.
I Log-opptaksmoduser (side 24), vises 
skjermmålets LUT-type over displayet.

31.	Indikator for basisfølsomhet / ISO 
basisindikator (side 43)

I Custom-opptaksmodus (side 24) viser den 
basisfølsomheten som er angitt ved hjelp av 
Base ISO/Sensitivity på Main-statusskjermen, 
eller ISO/Gain/EI >Base Sensitivity i Shooting-
menyen i hovedmenyen.
I Flexible ISO/Cine EI-opptaksmodus 
(side 24) viser den Base ISO-følsomheten 
som er angitt ved hjelp av Base ISO/Sensitivity 
fra Main-statusskjermen, eller ISO/Gain/EI > 
Base ISO i Shooting-menyen i hovedmenyen.
I Cine EI Quick-opptaksmodus (side 24), 
viser den Base ISO-følsomheten som er innstilt 
automatisk i forbindelse med  og Exposure 
Index.

32.	Gammaskjermhjelpindikator/
basisutseendeindikator

I Custom-opptaksmodus (side 24), viser 
den status for gammaskjermhjelp. Funksjonen 
gammaskjermhjelp kan slås av/på ved å 
tilordne Gamma Display Assist til en knapp 
som kan tilordnes (side 49).
I Log-opptaksmoduser (side 24), viser den 
innstillingen for basisutseende (side 91).

33.	Videoopptaksindikator (side 56)
Viser videosignalet for opptak på 
minnekortene. I Custom-opptaksmodus 
(side 24), viser den innstillingen for 
basisutseende.
I Log-opptaksmoduser (side 24), viser den 
fargeskalainnstillingen (side 85).

34.	Proksystatusindikator

Skjerm Betydning

Proxy-opptak på

Proxy-opptak

 
(blinkende)

Proxy-opptak ikke klar

Proxy-underinndelingsopptak på

Proxy-underinndelingsopptak

 
(blinkende)

Proxy-underinndelingsopptak 
ikke klar

35.	Indikator for opptaksformat (kodek) 
(side 84)

Viser navnet på formatet for opptak på 
minnekort.

36.	Indikator for opptaksformat 
(bildefrekvens og skannemetode)

37.	Indikator for opptaksformat 
(bildestørrelse) (side 84)

Viser bildestørrelsen for opptak på minnekort.

38.	Stoppknapp for sanntidssporing i  
AF-modus (side 42)
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Informasjon som vises på skjermen under avspilling

Følgende informasjon vises over avspillingsbildet.

1

9 10 11 12 13 14

2 3 4 5 6 7 8

1.	 Nettverksstatus, indikator

2.	 Indikator for opplasting / indikator for 
gjenværende filer

3.	 Klippnummer / totalt antall klipp

4.	 Avspillingsstatus, indikator

5.	 Indikator for avspillingsformat 
(bildefrekvens og skannemetode)

6.	 Indikator for avspillingsformat 
(bildestørrelse)

7.	 Indikator for gjenværende 
batterikapasitet / DC IN-spenning

8.	 Indikator for avspillingsformat (kodek)

9.	 Medieindikator
Det vises et -ikon hvis minnekortet er 
skrivebeskyttet.

10.	Visning av tidsdata

11.	Visning av klippnavn

12.	Indikator for gammaskjermhjelp
I Custom-opptaksmodus (side 24), viser den 
status for gammaskjermhjelp.
I Log-opptaksmoduser , viser den aktuell 
skjerm-LUT.

13.	Lydnivåmåler
Viser lydnivået for avspilling.

14.	Videoopptaksindikator

Ikonvisning

Visning av ikoner for nettverkstilkobling

Nettverksmodus Forbindelsesstatus Ikon

Tilgangspunktmodus Fungerer som et tilgangspunkt

Feil ved drift av tilgangspunkt

Stasjonsmodus Wi-Fi-forbindelse
Ikonet endres i henhold til signalstyrken 
(4 trinn)

   

Wi-Fi frakoblet (også mens forbindelsen 
etableres)

Feil på Wi-Fi-forbindelsen

Internett-deling via USB Internett-deling via USB er tilkoblet

Internett-deling via USB er frakoblet

Feil ved Internett-deling via USB

Visning av ikon for UWP-D-serien

Status for sender Status for mottak Ikon

Slå av Mottar ikke

Normal sendestatus Mottar
 –   

(mottaksnivå (4 trinn))

Dempestatus Mottar (dempet)

Varselstatus for gjenværende 
batterikapasitet

Mottar
 (Ikonet blinker)

Varselstatus for demping og 
gjenværende batterikapasitet

Mottar
 (Ikonet blinker)
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Statusskjerm

Du kan kontrollere innstillingene og statusen 
til videokameraet på statusskjermen. 
Innstillingene for elementer som er merket 
med en stjerne (*), kan endres.
Statusskjermen støtter betjening ved berøring.

For å vise statusskjermen
ˎˎ Trykk på MENU-knappen.

[Tips]
Du kan vise/skjule hver enkelt statusskjerm med Menu 
Page On/Off (side 103) i Technical-menyen.

For å bytte statusskjerm
ˎˎ Drei på flerfunksjonshjulet.
ˎˎ Skyv flervalg-knappen opp/ned
ˎˎ Sveip statusskjermen opp/ned.

For å skjule statusskjermen
ˎˎ Trykk på MENU-knappen.

For å endre en innstilling
Når statusskjermen vises, trykk 
flerfunksjonshjulet eller flervalg-knappen for å 
aktivere valg av et oppsettelement på en side. 
Velg et sidenummer og trykk deretter for å 
bytte side.
Du kan også velge elementer direkte ved hjelp 
av berøringsfunksjonen.

[Merk]
Du kan deaktivere endringer fra statusskjermen ved 
å sette Menu Settings >User Menu Only (side 103) i 
menyen Technical i hovedmenyen til On (på).

Main-statusskjermen

Viser hovedfunksjonene til kameraet og ledig 
lagerplass på mediene.

Visningselement Beskrivelse

S&Q Frame Rate* Opptak med Slow & Quick 
Motion og 
bildefrekvensinnstillinger

Frequency/Scan* Innstillinger for 
systemfrekvens og 
skannemetode

Imager Scan* Skannemodus på 
bildesensoren

Media Remain 
(A)

Gjenværende ledig plass på 
mediet i spor A

ND Filter ND-filterinnstilling

ISO/Gain/EI Innstilling av ISO/
forsterkning/
eksponeringsindeks

Base ISO/
Sensitivity*

Innstilling for 
grunnleggende ISO/
basisfølsomhet

Codec* Kodek-innstilling for opptak

Media Remain (B) Gjenværende ledig plass på 
mediet i spor B

Scene File* Scenefil i bruk og dens 
innstillinger for fil-ID

Base Look/LUT* Basisutseende/LUT 
Innstilling

Shutter Lukkerhastighet eller 
lukkervinkelinnstilling

Iris Irisinnstilling

Video Format* Bildestørrelse for opptak på 
minnekort

RAW Output 
Format*

Bildestørrelse for RAW-
utdata

White Balance Innstilling for hvitbalanse

Camera-statusskjermen

Viser status for forskjellige 
forhåndsinnstillinger av kameraet.

Visningselement Beskrivelse

White Switch<B> Hvitbalanse minne 
B-innstilling

White Switch<A> Hvitbalanse minne 
A-innstilling

White Switch<P> Forhåndsinnstilt hvit-
innstilling

ND<Preset> ND-filter Preset1 til 3 
innstillinger

ISO / Gain1)<L>* Innstilling for ISO/Gain1)<L>

ISO / Gain1)<M>* Innstilling for ISO/Gain1)<M>

ISO / Gain1)<H>* Innstilling for ISO/Gain1)<H>

Base ISO/
Sensitivity*

Innstilling for 
grunnleggende ISO/
basisfølsomhet

Zebra1* Zebra1 av/på-innstilling og 
-nivå

Zebra2* Zebra2 av/på-innstilling og 
-nivå

VF Gamma/
Gamma

Gammakategori og -kurve

Scene File* Scenefil i bruk og dens 
innstillinger for fil-ID

1)	 Exposure Index i Cine EI/Cine EI Quick-opptaksmodus.

Audio-statusskjermen

Viser inndatainnstillingen, lydnivåmåleren og 
volumovervåkningsinnstillingen for hver kanal.

Visningselement Beskrivelse

CH1 Level 
Control

Automatisk justering av/
på-status

Level Meter Lydnivåmåler

Source* Inngangskilde

Reference* Referansenivå for inngang

Wind 
Filter*

Innstilling for 
vindstøyreduksjonsfilter

CH2 Level 
Control

Automatisk justering av/
på-status

Level Meter Lydnivåmåler

Source* Inngangskilde

Reference* Referansenivå for inngang

Wind 
Filter*

Innstilling for 
vindstøyreduksjonsfilter

CH3 Level 
Control*

Automatisk justering av/
på-status

Level 
Meter*

Lydnivåmåler

Source* Inngangskilde

Reference* Referansenivå for inngang

Wind 
Filter*

Innstilling for 
vindstøyreduksjonsfilter

CH4 Level 
Control*

Automatisk justering av/
på-status

Level 
Meter*

Lydnivåmåler

Source* Inngangskilde

Reference* Referansenivå for inngang

Wind 
Filter*

Innstilling for 
vindstøyreduksjonsfilter

Audio Input 
Level*

Innstilling for lydnivå inn 
(hovedvolum)

HDMI Output CH* Innstilling for HDMI-
utgangens lydkanal
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Visningselement Beskrivelse

Volume* Voluminnstilling for 
hodetelefon / innebygd 
høyttaler

Monitor CH* Innstilling for skjermkanal

Project-statusskjerm

Viser de grunnleggende innstillingene for 
opptaksprosjektet.

Visningselement Beskrivelse

Frequency/Scan* Innstillinger for 
systemfrekvens og 
skannemetode

Codec* Kodek-innstilling for opptak

Rec Function* Innstilling for spesiell 
opptaksfunksjon On/Off og 
hovedinnstillinger

Simul Rec* On/Off-status og innstilling 
for 2-spors samtidig 
opptaksfunksjon

Title Prefix1) / 
Reel2)

Titteldelen av klippnavn/
Angitte verdier for Camera 
ID og Reel Number

Imager Scan* Skannemodus på 
bildesensoren

Video Format* Bildestørrelse for opptak på 
minnekort

Picture Cache 
Rec*

Opptaksfunksjon for bilde-
cache On/Off og innstilling 
for cache-størrelse

Number1) / Shot2) Numerisk suffiks for 
klippnavnet/Camera Position- 
og Shot Number-verdier

Shooting Mode* Innstillinger for 
opptaksmodus

RAW Output 
Format*

Bildestørrelse for RAW-
utdata

Proxy Rec* Proxy-opptaksfunksjon On/
Off-innstilling

1)	 Når Auto Naming er angitt til Title
2)	Når Auto Naming er angitt til Cam ID + Reel#

Monitoring-statusskjermen

Viser innstillingene for SDI- og HDMI-
utgangene.

Visningselement Beskrivelse

SDI Signal* Utdata bildestørrelse

Info. 
Disp.*

Innstilling for utdataskjerm 
av/på

Color 
Gamut*

Fargeskalainnstilling/
Monitor-LUT-status

HDMI Signal* Utdata bildestørrelse

Info. 
Disp.*

Innstilling for utdataskjerm 
av/på

Color 
Gamut*

Fargeskalainnstilling/
Monitor-LUT-status

Stream Signal Utdata bildestørrelse

Info. 
Disp.

Utdataskjerm (Off (fast))

Color 
Gamut*

Fargeskalainnstilling/
Monitor-LUT-status

VF Color 
Gamut*

Innstilling for Gamma-
skjermhjelp/
fargeskalainnstilling/
Monitor-LUT-status

Base Look/LUT* Basisutseende/LUT 
Innstilling

Gamma Display 
Assist*

Innstilling for 
gammaskjermhjelp av/på

Assignable Button-statusskjermen

Viser funksjonene som er tilordnet til hver av 
knappene som kan tilordnes.

Visningselement Beskrivelse

1 Funksjon tilordnet ASSIGN 
1-knappen

2 Funksjon tilordnet ASSIGN 
2-knappen

3 Funksjon tilordnet ASSIGN 
3-knappen

4 Funksjon tilordnet ASSIGN 
4-knappen

5 Funksjon tilordnet ASSIGN 
5-knappen

6 Funksjon tilordnet ASSIGN 
6-knappen

7 Funksjon tilordnet ASSIGN 
7-knappen

8 Funksjon tilordnet ASSIGN 
8-knappen

9 Funksjon tilordnet ASSIGN 
9-knappen

Focus Hold-
knapp

Funksjon tilordnet Focus 
Hold-knappen på objektivet

Multi Function 
Dial

Funksjon som er tilordnet til 
flerfunksjonshjulet

Grip Dial Funksjon tilordnet det 
programmerbare grephjulet

Handle Dial Funksjon tilordnet det 
programmerbare hjulet på 
håndtaket

Battery-statusskjermen

Viser informasjon om batteriet og DC IN-kilden.

Visningselement Beskrivelse

Detected Battery Batteritype

Remaining Gjenværende kapasitet (%)

Charge Count Antall oppladninger

Capacity Gjenværende kapasitet (Ah)

Voltage Batterispenning (V)

Manufacture 
Date

Batteriets produksjonsdato

Video Light 
Remaining

Viser gjenværende kapasitet 
for batteriet til videolyset.

Power Source Strømkilde

Supplied Voltage Spenning fra strømforsyning
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Media-statusskjermen

Viser gjenværende kapasitet og gjenværende 
opptakstid for opptaksmedier.

Visningselement Beskrivelse

Medie A 
informasjon

Viser medieikonet når 
opptaksmedium er satt inn i 
spor A.

Medie A måler 
for gjenværende 
kapasitet

Viser gjenværende kapasitet 
for opptaksmedier som er 
satt inn i spor A, uttrykt som 
en prosent på et 
stolpediagram.

Medie A 
gjenværende 
opptakstid

Viser et estimat over 
gjenværende opptakstid for 
opptaksmedium som er satt 
inn i spor A i minutter ved 
gjeldende opptaksforhold.

Format Media(A)* Velger formateringsmetoden 
(Full Format eller Quick 
Format) og formaterer 
medie A.

Medie B 
informasjon

Viser medieikonet når 
opptaksmedium er satt inn i 
spor B.

Medie B måler 
for gjenstående 
kapasitet

Viser gjenværende kapasitet 
for opptaksmedier som er 
satt inn i spor B, uttrykt som 
en prosent på et 
stolpediagram.

Medie B 
gjenværende 
opptakstid

Viser et estimat over 
gjenværende opptakstid for 
opptaksmedium som er satt 
inn i spor B i minutter ved 
gjeldende opptaksforhold.

Format Media(B)* Velger formateringsmetoden 
(Full Format eller Quick 
Format) og formaterer 
medie B.

Network-statusskjermen

Viser status for nettverkstilkoblingen.

Visningselement Beskrivelse

Wireless LAN* Driftsmodusinnstillinger 
(Off/AP/Station) og 
tilkoblingsstatus for trådløst 
LAN

Wired LAN* På/av- og tilkoblingsstatus 
for kablet LAN

Modem* På/av- og tilkoblingsstatus 
for Internettdeling via USB

File Transfer-statusskjermen

Viser informasjon om filoverføring.

Visningselement Beskrivelse

Auto Upload Av/på-status for automatisk 
opplasting

Auto Upload 
(Proxy)

Av/på/
underinndelingsopptak-
status for automatisk 
opplasting (proxy)

Total Transfer 
Progress

Overføringsfremdrift for alle 
jobber

Default Upload 
Server

Navn på målserver for 
automatisk opplasting 
(proxy)

Job Status 
(Remain / Total)

Gjenstående antall jobber 
og totalt antall jobber

Current File 
Transfer Progress

Fremdrift for gjeldende 
filoverføring

Current 
Transferring File 
Name

Navnet på filen som 
overføres i øyeblikket

Server Address Adressen til filoverføringens 
målserver

Destination 
Directory

Målkatalog for 
filoverføringens målserver

Hvordan bruke berøringsaktiverte innstillingsskjermer

Skjermoppsett

Element

Merk av for gjeldende innstilling

Set (bruk)-knappen

Innstillingsvalgmarkør 
(oransje ramme)

Elementnavn

Valgalternativer

Betjening

1	 Trykk på et oppsettelement.

Tapp

Valgalternativene for verdien vises.

2	 Dra eller sveip en innstilling for å velge 
verdien.

Flikk

3	 Trykk på Set-knappen eller markøren for 
valg av verdi.
Verdien tas i bruk, og visningen går tilbake 
til forrige skjermbilde.

[Tips]
ˎˎ Trykk på CANCEL/BACK-knappen for å gå til forrige 

verdi.
ˎˎ Du kan også bruke flerfunksjonshjulet eller flervalg-

knappen.
ˎˎ Bruk av berøring kan også deaktiveres (side 102).
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Strømforsyning
Du kan bruke en batteripakke eller bruke 
nettstrøm og en strømadapter.
Av sikkerhetshensyn må du bare bruke 
batteripakkene fra Sony og strømadaptere 
som er oppført nedenfor.

Litium-ion batteripakker
BP-U-serien

Batteriladere
BC-CU1 (følger med)
BC-U1A
BC-U2A

Strømadapter (følger med)
[FORSIKTIG]

Ikke oppbevar batteripakker på steder der 
de utsettes for direkte sollys, ild eller høy 
temperatur.

[Merknader]
ˎˎ Bruk strømadapteren som fulgte med når du bruker 

nettstrøm.
ˎˎ Sett alltid POWER-bryteren til av før du kobler til 

et batteri eller en strømadapter. Hvis den kobles 
til med POWER-bryteren i PÅ-stillingen, kan det 
i noen tilfeller hende at videokameraet ikke kan 
starte. Hvis videokameraet ikke kan startes, slå av 
POWER-bryteren og koble fra batteripakken eller 
strømadapteren et øyeblikk. Vent ca. 30 sekunder 
før du prøver å koble til igjen. (Hvis strømadapteren 
kobles til mens videokameraet driftes fra 
batteripakken, kan den kobles til med POWER-
bryteren i på-stilling, uten problemer.)

Slik bruker du en batteripakke

For å sette i en batteripakke, plugg 
batteripakken inn i tilbehøret (side 7) så 
langt det går, og skyv den deretter nedover for 
å låse den på plass.

For å fjerne en batteripakke, trykk og hold 
nede BATT RELEASE-knappen (side 7), 
skyv batteripakken opp og trekk den deretter 
ut av tilbehøret.

BATT RELEASE-
knapp (frigjør 
batteriet)

[Merknader]
ˎˎ Før du setter på til et batteri, må batteriet lades ved 

hjelp av den dedikerte BC‑CU1-, BC-U1A- eller BC‑U2A-
batteriladeren.
ˎˎ Hvis du lader opp en batteripakke mens den er varm 

(for eksempel rett etter bruk), blir den kanskje ikke 
fulladet.

Hvordan kontrollere gjenværende 
kapasitet

Når du tar opp / spiller av ved hjelp av 
en batteripakke, vises gjenværende 
batterikapasitet i søkeren (side 11).

Ikon Betydning

91% til 100%

71% til 90%

51% til 70%

31% til 50%

11% til 30%

0% til 10%

Videokameraet angir gjenværende 
kapasitet ved å beregne tilgjengelig tid med 
batteripakken hvis driften fortsettes med 
gjeldende strømforbruk.

Hvis ladenivået i batteripakken blir lav

Hvis den gjenværende batteriladningen 
faller under et bestemt nivå under drift (Low 
Battery-tilstand), vises en melding om lavt 
batterinivå og lampen for opptak/telling 
begynner å blinke som et varsel.
Hvis gjenværende batteriladningen faller 
under nivået der operasjonen ikke kan 
fortsette (Battery Empty-tilstand), vises en 
melding om tomt batteri.
Erstatt med en ladet batteripakke.

Endre varselnivåene

Low Battery Level er satt til 10% av fullt 
ladenivå, og Battery Empty Level er satt til 
3% som standard fra fabrikken. Du kan endre 
innstillingene for varslingsnivå ved hjelp 
av Camera Battery Alarm (side 104) på 
Technical-menyen i hovedmenyen.

Slik lader du batteripakken ved hjelp av 
den medfølgende batteriladeren 
(BC‑CU1)

1	 Koble strømadapteren (følger med) til 
batteriladeren, og koble strømledningen 
(følger med) til en strømkilde.

2	 Skyv batteriet inn og skyv det i pilens 
retning.
CHARGE-lampen lyser oransje og 
ladingen starter.

CHARGE-lampe

Strømadapter

Strømledning

CHARGE-lampen (oransje)
Tent:� Lader
Blinker: �Ladefeil, eller temperaturen er utenfor 

driftsområdet og ladingen er stoppet 
midlertidig

ˎˎ Når batteriet er fulladet, slås CHARGE-
lampen på batteriladeren av.
ˎˎ Bruk alltid originale batterier fra Sony.
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Ladetid
Omtrentlig tid (minutter) som kreves når du 
lader en helt utladet batteripakke.

Batteripakke Tid til full ladning

BP-U35 120 minutter

[Merk]
Hvis strømadapteren kobles fra batteriladeren og 
batteriet fortsatt er koblet til batteriladeren, begynner 
batteriet å utlades.

Bruk av nettstrøm

Hvis du kobler videokameraet til nettstrøm, 
kan du bruke det uten å bekymre deg for om 
batteripakken må lades opp.

DC IN-kontakt  
(strøminngang)

Strømadapter

Strømledning

Koble strømadapteren til DC IN-kontakten 
på videokameraet, og koble strømledningen 
(følger med) til nettstrømmen.

Hvis utgangsspenningen fra 
strømadapteren blir lav

Hvis utgangsspenningen fra strømadapteren 
faller under et bestemt nivå under drift (DC 
Low Voltage1-status), vises det en melding 
som forteller deg at strømadapterens 
utgangsspenning har falt og lampen for 
opptak/telling begynner å blinke.
Hvis utgangsspenningen fra strømadapteren 
faller under nivået der drift ikke kan fortsette 
(DC Low Voltage2-status), vises det en 
melding som forteller deg at strømadapterens 
utgangsspenning er for lav.
Hvis dette skjer, kan strømadapteren være 
defekt. Kontroller strømadapteren etter behov.

Endre varselspenningene

Nivået for DC Low Voltage1 er satt til 16,5 V, og 
nivået for DC Low Voltage2 er som standard 
satt til 15,5 V. Du kan endre innstillingene for 
varslingsnivå ved hjelp av Camera DC IN Alarm 
(side 104) på Technical-meny.

Strømadapter

ˎˎ Ikke koble til eller bruk en strømadapter på 
steder med begrenset plass, for eksempel 
mellom en vegg og et møbel.
ˎˎ Koble strømadapteren til nærmeste 
stikkontakt. Hvis det oppstår et problem 
under bruk, må du umiddelbart koble 
strømledningen fra nettstrømkilden.
ˎˎ Ikke kortslutt metalldelene på støpselet til 
strømadapteren. Dette fører til funksjonsfeil.
ˎˎ Batteriet kan ikke lades mens det er festet til 
videokameraet, selv om strømadapteren er 
koblet til.
ˎˎ Når strømadapteren kobles fra enheten, 
ta tak i pluggen og trekk den rett ut. 
Hvis du trekker i kabelen, kan det føre til 
funksjonsfeil.
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Koble til enheter

Koble til en mikrofon (selges 
separat)

1	 Plasser mikrofonen i mikrofonholderen.

2	 Koble mikrofonkabelen til INPUT1- eller 
INPUT2-kontakten.

INPUT

1
LINE MIC

+48VMIC

2
LINE MIC

+48VMIC

1

2

Mikrofon

Mikrofonholder

INPUT1 INPUT2

3	 Plasser mikrofonkabelen i kabelholderen 
som vist på tegningen.

Kabelholder

[Tips]
ˎˎ Hvis du ikke kan feste mikrofonen ordentlig, kan du 

bruke avstandsstykket som følger med mikrofonen.
ˎˎ Tuppen på mikrofonen kan være synlig i bildet fra 

videokameraet, avhengig av typen objektiv som er 
satt på. Juster mikrofonens stilling.

Hvordan sette på søkeren

[Merk]
Sett på / fjern søkeren mens videokameraet er slått av.

Hvordan feste søkeren foran på 
håndtaket

1	 Sett tilpasningstykket for søkerens 
monteringsklemme inn i søkerfestet på 
håndtaket (), og vri skruen (følger med) 
med urviseren for å feste den i riktig 
stilling ().
Tilpasningsstykket for 
monteringsklemmen kan festes fritt i trinn 
på 45°, men plasseringen der festepunktet 
er rett over skruen anbefales.

Skrue
Adapter for søkerens 
monteringsklemme

2	 Fest søkerklemmen på klemmeadapteren 
(), og vri låseknappen med urviseren for 
å feste den i riktig stilling ().

[Merk]
Pass på at låseknappen trekkes godt til når du bruker en 
søker. Søkeren kan falle av hvis låseknappen ikke trekkes 
godt til.

3	 Rett inn -merket på videokameraet mot 
-merket på søkerkontakten, og sett inn 
kabelen.
Kontroller at -merket er på utsiden før 
du setter inn kontakten.

4	 Plasser kabelen i kabelholderen som vist 
på tegningen.

Kabelholder
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Hvordan feste søkeren bak på håndtaket

Det er to festepunkter, ett bak på håndtaket 
() og ett bak på videokameraet () for å 
koble til en søker. Fest søkeren på samme 
måte som beskrevet under "Hvordan feste 
søkeren foran på håndtaket."

Justering av søkerposisjonen

Vipp søkeren opp/ned/fremover/bakover for 
å justere vinkelen på søkeren.
Du kan for eksempel bruke MIRROR-bryteren 
til å vende bildet når du ser på det fra forsiden 
av videokameraet.

[Tips]
Når enheten ikke brukes eller transporteres, anbefales 
det at søkeren flyttes til posisjonen på tegningen 
nedenfor for å beskytte søkeren.

Hvordan ta av søkeren

Løsne låseknappen for søkeren, og bruk 
motsatt prosedyre av når du festet søkeren.

Hvordan sette på søkerdekselet

1	 Åpne metallklipsene på søkerdekselet.

2	 Fest metallklipset på toppen av 
søkerdekselet til kroken på toppen av 
søkeren, og fest metallklipset nederst på 
søkerdekselet til kroken på bunnen av 
søkeren.

Festekroker

3	 Skyv låseplaten nederst på søkerdekselet i 
pilens retning for å låse søkerdekselet på 
plass.

Låseplate

Slik åpner du søkerdekselet

Trekk den nederste, midtre delen av 
søkerdekselet ut mot deg, og dra deretter 
oppover for å åpne dekselet.

[Merk]
Når du flytter søkeren, ta tak i selve søkeren og flytt den. 
Ikke ta tak i søkerdekselet.

Hvordan ta av søkerdekselet

Løsne låsen på søkerdekselet, og fjern 
søkerdekselet fra søkeren.

Hvordan sette på 
grepfjernkontrollen

[Merk]
Sett på / fjern grepfjernkontrollen mens videokameraet 
er slått av.

1	 Koble kabelen til grepfjernkontrollen.

2	 Rett inn festet for grepfjernkontrollen på 
videokameraet mot festemerket på 
grepet (), fest grepet på videokameraet, 
og vri det sakte mot urviseren ().
Du hører et klikk når det låses på plass.
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Festemerke

[Merk]
Hvis det ikke kan festes på riktig måte, fest det igjen 
uten å bruke stor kraft på grepfjernkontrollen eller 
videokameraet.

3	 Sett kabelen som ble koblet til i trinn 2, 
inn under utsparingen på 
grepfjernkontrollen, som vist på 
tegningen.

[Merk]
Hvis kabelen ikke plasseres under utsparingen, 
kan endringer av vinkelen på grepet legge for stor 
kraft på kabelen, eller kabelen komme i klem i 
rotasjonsmekanismen.

Hvordan justere vinkelen på 
grepfjernkontrollen

Du kan justere vinkelen på grepfjernkontrollen 
over et område som vist i tegningen nedenfor, 
slik at den passer til måten du fotograferer på.

Standardposisjon

Rotert mot objektivet (maks. 90°)

Rotert bakover (maks. 83°)

1	 Flytt grepets rotasjonsspak til den 
posisjonen som er vist på tegningen, og 
drei grepet mens du trykker på spaken.

2	 Ta fingeren av grepets rotasjonsspak når 
du er nær ønsket posisjon.

3	 Flytt grepet litt til du hører et klikk som 
indikerer at grepet er festet på plass.
Når grepet er festet, går rotasjonsspaken 
tilbake til den opprinnelige stillingen.

[Merknader]
ˎˎ Etter at du har endret posisjon, må du alltid 

kontrollere at grepet er godt festet.
ˎˎ Du kan ikke justere vinkelen ut over 

justeringsområdet. Ikke bruk for mye kraft når du vrir 
grepet.

Hvordan holde i grepet (anbefalt 
metode)

Det er ingen regler for hvordan grepet skal 
holdes, men dette eksempelet viser en måte 
for enkel betjening av grepet.

Når du bruker ASSIGN 5-knappen eller 
flervalg-knappen

A: Roter det programmerbare grephjulet med 
pekefingeren.
B: Betjen flervalg-knappen og ASSIGN 
5-knappen med tommelen.
C: Hold godt fast i grepet med langfingeren, 
ringfingeren og lillefingeren.

Når du bruker zoomen

A: Betjen zoomspaken med pekefingeren og 
langfingeren.
B: Hold godt i grepet med tommelen.
C: Hold godt i grepet med ringfingeren og 
lillefingeren.
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Hvordan ta av grepet

[Merk]
Når du fjerner grepet, må du passe på å plassere 
videokameraet på en jevn overflate, for eksempel et 
skrivebord.

1	 Koble kabelen fra kontakten til 
grepfjernkontrollen.

2	 Trykk og hold nede utløserknappen for 
grepfjernkontrollen på videokameraet, og 
drei grepet med urviseren til det løsner.

Utløserknappen for grepfjernkontrollen

[Tips]
Det kan festes en rosett til både grepfestepunktet på 
enheten og det tilsvarende festepunktet på grepet.
For informasjon om kjøp av rosetter, kontakt din Sony-
forhandler.
–– På videokamerasiden: 4-546-932- (tilleggsutstyr)
–– På grepsiden: 4-547-089- (tilleggsutstyr)
–– Festeskruer* 

Videokamerasiden: 7-627-556- (tilleggsutstyr) 
Grepsiden: 7-627-556- (tilleggsutstyr)

*	 Det kreves fire skruer for hver rosett (skruehull vises 
med sirkler på følgende tegning). Hvis du bruker 
andre skruer enn de som er spesifisert, kan det skade 
utvendige deler.

Videokamerasiden Grepsiden

Hvordan sette på et objektiv

[FORSIKTIG]

Ikke la objektivet vende mot solen. Direkte 
sollys kan komme inn gjennom objektivet 
og bli fokusert i videokameraet, slik at det 
forårsaker en brann.

[Merknader]
ˎˎ Sett på / fjern objektiver mens videokameraet er slått 

av.
ˎˎ Et objektiv er en presisjonskomponent. Ikke plasser 

objektivet på en overflate med objektivfestet vendt 
ned. Sett på det medfølgende objektivdekselet.

[Tips]
Hvis du vil ha mer informasjon om objektiver 
som støttes av videokameraet, kontakt en 
servicerepresentant for Sony.

Hvordan sette på et objektiv med 
E-feste

1	 Fjern objektivhetten og -dekselet fra 
videokameraet og objektivet.

2	 Rett inn objektivets festemerket (hvitt) 
med videokameraet, sett objektivet 
forsiktig inn, og vri deretter objektivet 
med urviseren.
Du hører et klikk når det låses på plass.

Monteringsmerker (hvite)

[Merk]
Ikke trykk på utløserknappen for objektivet når du setter 
på et objektiv.

Hvordan sette på et objektiv med 
A-feste

Hvis du vil bruke et objektiv med A-feste, 
sett på en festeadapter for objektivet 
(tilleggsutstyr) og sett deretter på et objektiv 
med A-feste.

[Merk]
Når du bruker et objektiv med A-feste, stilles iris manuelt 
inn og fokus settes på MF.

Hvordan ta av et objektiv

Fjern et objektiv ved hjelp av følgende 
prosedyre.

1	 Trykk og hold nede utløserknappen for 
objektivet, og vri objektivet mot urviseren 
mens du holder objektivet oppe.

2	 Trekk linsen ut og forover.

[Merknader]
ˎˎ Når du fjerner et objektiv, må du rette inn 

monteringsmerket på objektivets låsering med 
monteringsmerket på videokameraet.
ˎˎ Hold objektivet fast i hånden for å hindre at det faller 

ned.
ˎˎ Hvis et annet objektiv ikke settes på med én gang, må 

du alltid sette lokket på huset.

Irisjusteringer for objektiver med bryter 
for Auto Iris

ˎˎ Når objektivets Auto Iris er satt til AUTO, 
justeres iris automatisk. Den kan også 
justeres manuelt fra videokameraet.
ˎˎ Når objektivets Auto Iris er satt til MANUAL, 
kan iris bare justeres med objektivringen. 
Innstilling av iris fra videokameraet har 
ingen effekt.

Fokusjusteringer for objektiver med 
fokusbryter

ˎˎ Når objektivets fokusbryter er satt til AF/MF 
eller AF, justeres fokus automatisk. Den kan 
også justeres manuelt fra en fjernkontroll.
ˎˎ Når objektivets fokusbryter er satt til MF, 
justeres fokus med objektivringen. Den kan 
også justeres manuelt fra en fjernkontroll.

	 [Merk]
Når du bruker et objektiv med A-feste, kan det 
hende at manuell justering fra en fjernkontroll ikke er 
tilgjengelig.

ˎˎ Når objektivets fokusbryter er satt til 
Full MF, kan fokus bare justeres ved 
hjelp av objektivringen. Fokusering fra 
videokameraet har ingen effekt.

Hvordan sette på et stativ

Bruk skruehullene på videokameraet for å 
feste det til et trebensstativ. Hvis du bruker 
trebensstativfestet på objektivet, kan det føre 
til skade.
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Anamorfe objektiver

Ved opptak med anamorfe objektiver, se 
"Stille inn De-Squeeze-visning" (side 54) 
for informasjon om hvordan du oppnår De-
Squeeze av HDMI-utgangsbildet og hvordan 
du oppnår De-Squeeze i enhetens søker.
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Konfigurere grunnleggende bruk av videokameraet
Skjermen for grunninnstillinger vises i søkeren 
første gang videokameraet slås på eller etter 
at reservebatteriet er helt utladet.
Angi dato og klokkeslett for den interne 
klokken fra dette skjermbildet.

Time Zone
Time Zone (tidssone) angir tidsforskjellen 
fra UTC (Coordinated Universal Time). Endre 
innstillingen etter behov.

Hvordan angi dato og tid

Bruk flervalg-knappen (side 7) eller 
flerfunksjonshjulet (side 5) til å velge 
elementer og innstillinger, og trykk deretter på 
flervalg-knappen eller flerfunksjonshjulet for å 
bruke innstillingene og starte klokken.
Når innstillingsskjermbildet er lukket, kan du 
endre innstillingene for dato, klokkeslett og 
tidssone ved hjelp av Clock Set (side 109) på 
Maintenance-menyen (vedlikehold).

[Merknader]
ˎˎ Hvis du mister klokkeinnstillingen fordi 

reservebatteriet er helt utladet på grunn av at 
strømmen var koblet fra i en lengre periode (ingen 
batteripakke og ingen DC IN-strømkilde), vises 
skjermbildet med opprinnelige innstillinger neste 
gang du slår på videokameraet.
ˎˎ Når skjermbildet for grunninnstillinger vises, er 

det ikke mulig å gjøre noe annet, unntatt å slå av 
strømmen, før du har avsluttet innstillingene på dette 
skjermbildet.
ˎˎ Videokameraet har et innebygd oppladbart batteri for 

lagring av dato, klokkeslett og andre innstillinger, selv 
når videokameraet er slått av.

Før du tar bilder må du konfigurere 
grunnleggende bruk av videokameraet på 
statusskjermbildet for Project, slik at det 
passer til programmet.

Opptaksmodus

Du kan veksle opptaksmodus mellom 
"Custom" for å lage bilder fleksibelt på stedet, 
og "Log-opptak (Flexible ISO, Cine EI Quick, 
Cine EI)" der videokameraet brukes på samme 
måte som et filmkamera, med bilder som 
produseres i etterproduksjon.
Angi opptaksmodus med Shooting Mode 
(side 15) på skjermbildet for Project-status.

[Tips]
Du kan også angi opptaksmodusen ved hjelp av Base 
Setting >Shooting Mode (side 84) i menyen Project i 
hovedmenyen.

Custom

I Custom (egendefinert) opptaksmodus kan du 
velge videostandarden.
Du kan angi videostandarden ved hjelp av 
Base Setting >Target Display (side 84) i 
menyen Project i hovedmenyen.
ˎˎ SDR (BT.709): Opptak i henhold til 
standarden for HD-kringkasting
ˎˎ HDR (HLG): Opptak i henhold til neste 
generasjon 4K-kringkastingsstandard

Du finner mer informasjon på side 56.

Log-opptaksmoduser (Cine EI, Cine EI Quick, Flexible ISO)

I Log-opptaksmoduser, velger du basisfargeskala for opptakssignaler og utgangssignaler. Den 
fargeskalaen som velges her, er fargeskalaen for videoutgangen når MLUT er satt til Off.
Du kan angi fargeskala ved hjelp av Cine EI/Flex.ISO Set >Color Gamut (side 85) i menyen 
Project i hovedmenyen.
ˎˎ S-Gamut3.Cine/SLog3: Enkel justerbar fargeskala for digital kino (DCI-P3).
ˎˎ S-Gamut3/SLog3: Sonys brede fargeskala som dekker fargeskalaen ITU-R BT.2020.

Du finner mer informasjon på "Fotografering med utseendejustering i postproduksjon" 
(side 58).
Det finnes tre Log-opptaksmoduser: Flexible ISO, Cine EI og Cine EI Quick.
ˎˎ Flexible ISO: Tar opp S-Log3-innhold med eksponeringsinnstillinger som reflekterer ISO-
følsomheten som matcher scenene som tas opp.
ˎˎ Cine EI/Cine EI Quick: Tar opp S-Log3-innhold ved en valgt basis-sensitivitet (fast), men lar 
deg endre fordelingen mellom lyse og mørke områder ved å bruke Exposure Index. I Cine EI 
Quick-opptaksmodus velges automatisk en basis-sensitivitet som passer til Exposure Index-
innstillingen.

[Merk]
Ved opptak i Cine EI Quick eller Cine EI, anbefales det at du holder Exposure Index-innstillingen konstant. Hvis du 
endrer Exposure Index-innstillingen, kan lysstyrkekorreksjon være meget vanskelig å oppnå i etterproduksjon, og det 
kan gjøre det umulig å reprodusere tilstanden da bildet ble tatt opp.

De funksjonelle begrensingene for hver enkelt opptaksmodus er angitt nedenfor.
Ja: Støttet
Nei: Ikke støttet

Element Custom Log-opptak

Flexible ISO Cine EI Quick Cine EI

ISO/GAIN Ja Ja (Kun ISO) Nei Nei

AGC Ja Ja Nei Nei

Base Sensitivity Ja Nei Nei Nei

Base ISO Nei Ja Ja (auto) Ja

Exposure Index Nei Nei Ja Ja

Auto Shutter Ja Ja Nei Nei

ATW Ja Ja Nei Nei

LUT On/Off Nei Ja Ja Ja

Paint/Look (unntatt Base Look) Ja Nei Nei Nei

Kodeker inkluderer RAW Nei Ja Ja Ja
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Systemfrekvens

Angi systemfrekvens med Frequency/Scan 
(side 15) på statusskjermbildet Project. 
Videokameraet kan starte på nytt automatisk 
etter skifte, avhengig av verdien som velges.

[Tips]
Du kan også angi systemfrekvens ved hjelp av Rec 
Format >Frequency (side 84) i menyen Project i 
hovedmenyen.

[Merk]
Du kan ikke bytte systemfrekvens under opptak eller 
avspilling.

Bildeskannermodus

Du kan angi den effektive bildestørrelsen og 
oppløsningen for bildesensoren.
Angi skannemodus med Imager Scan 
(side 15) på statusskjermbildet Project.
ˎˎ FF: Full størrelse på rammen.
ˎˎ S35: Super 35 mm størrelse.

[Tips]
Du kan også angi skannemodus ved hjelp av Rec Format 
>Imager Scan Mode (side 84) i menyen Project i 
hovedmenyen.

[Merknader]
ˎˎ Du kan ikke bytte bildeskannermodus under opptak 

eller avspilling.
ˎˎ Når den settes til S35, blir videoformatet begrenset til 

1920×1080.

Kodek

Angi kodeken med Codec (side 15) på 
statusskjermbildet Project.

[Tips]
Du kan også angi kodeken med Rec Format >Codec 
(side 84) i menyen Project i hovedmenyen.

[Merk]
Du kan ikke bytte kodek under opptak eller avspilling.

Videoformat

Du kan angi videoformatet for opptak. Angi 
opptaksmodus med Video Format (side 15) 
på statusskjermbildet Project.

[Tips]
Du kan også angi videoformatet med Rec Format >Video 
Format (side 84) i menyen Project i hovedmenyen.

[Merknader]
ˎˎ Du kan ikke bytte videoformat under opptak eller 

avspilling.
ˎˎ Begrensninger kan gjelde for signalet fra SDI 

OUT- og HDMI OUT-kontaktene, avhengig av 
videoformatinnstillingen.
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Videokameraet tar opp lyd og video på CFexpress Type A-minnekort (tilgjengelig separat) 
eller SDXC-minnekort (tilgjengelig separat) som er satt inn i kortsporet. Minnekortene 
brukes også til proksyopptak og lagring/innlasting av innstillinger, og ved oppgradering 
(programvareoppdatering).

Om CFexpress Type A minnekort

Bruk Sony CFexpress Type A-minnekortene* som er beskrevet i "Anbefalte medier" (side 27) i 
videokameraet.
For mer informasjon om bruk av medier fra andre produsenter, se bruksanvisningen for mediet 
eller les produsentens informasjon.
* �Kalt "CFexpress-kort" i dette dokumentet.

Om SDXC minnekort

Bruk SDXC-minnekortene* som er beskrevet i "Anbefalte medier" (side 27) i videokameraet.
* �Kalt "SD-kort" i dette dokumentet.

Hvordan bruke minnekort
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Anbefalte medier

De garanterte driftsforholdene vil variere avhengig av innstillingene for Rec Format og Recording.
Ja: Drift støttes
Nei: Normal drift garanteres ikke

Opptaksformat CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

RAW Out &  
XAVC-I

4096×2160
Class300

Normal modus 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

24P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja

3840×2160
Class300

Normal modus 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja

S&Q (60fps eller lavere) 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Nei Ja

25P Ja Nei Nei Nei Nei Nei Nei Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja

S&Q (100fps, 120fps) 59.94P Ja Nei Nei Nei Nei Nei Nei Nei

50P Ja Nei Nei Nei Nei Nei Nei Nei

29.97P Ja Nei Nei Nei Nei Nei Nei Nei

25P Ja Nei Nei Nei Nei Nei Nei Nei

23.98P Ja Nei Nei Nei Nei Nei Nei Nei
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Opptaksformat CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 4096×2160
Class300 

Normal modus 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

24P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja

S&Q (60fps eller lavere) 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Nei Ja

25P Ja Nei Nei Nei Nei Nei Nei Ja

24P Ja Nei Nei Nei Nei Nei Nei Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja

3840×2160
Class300 

Normal modus 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja

S&Q (60fps eller lavere) 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Nei Ja

25P Ja Nei Nei Nei Nei Nei Nei Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja

S&Q (100fps, 120fps) 59.94P Ja Nei Nei Nei Nei Nei Nei Nei

50P Ja Nei Nei Nei Nei Nei Nei Nei

29.97P Ja Nei Nei Nei Nei Nei Nei Nei

25P Ja Nei Nei Nei Nei Nei Nei Nei

23.98P Ja Nei Nei Nei Nei Nei Nei Nei
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Opptaksformat CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-I 1920×1080
Class100

Normal modus 59.94P Ja Nei Nei Nei Nei Nei Ja Ja

50P Ja Nei Nei Nei Nei Nei Ja Ja

29.97P Ja Nei Nei Ja Nei Ja Ja Ja

25P Ja Nei Nei Ja Nei Ja Ja Ja

23.98P Ja Nei Nei Ja Nei Ja Ja Ja

S&Q (60fps eller lavere) 59.94P Ja Nei Nei Nei Nei Nei Ja Ja

50P Ja Nei Nei Nei Nei Nei Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja

S&Q (100fps, 120fps) 59.94P Ja Nei Nei Nei Nei Nei Nei Ja

50P Ja Nei Nei Nei Nei Nei Nei Ja

29.97P Ja Nei Nei Nei Nei Nei Nei Ja

25P Ja Nei Nei Nei Nei Nei Nei Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja

S&Q (150fps, 180fps) 59.94P Ja Nei Nei Nei Nei Nei Nei Nei

50P Ja Nei Nei Nei Nei Nei Nei Nei

29.97P Ja Nei Nei Nei Nei Nei Nei Nei

25P Ja Nei Nei Nei Nei Nei Nei Nei

23.98P Ja Nei Nei Nei Nei Nei Nei Nei

S&Q (200fps, 240fps) 59.94P Ja Nei Nei Nei Nei Nei Nei Nei

50P Ja Nei Nei Nei Nei Nei Nei Nei

29.97P Ja Nei Nei Nei Nei Nei Nei Nei

25P Ja Nei Nei Nei Nei Nei Nei Nei

23.98P Ja Nei Nei Nei Nei Nei Nei Nei
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Opptaksformat CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 3840×2160
420 

Normal modus 59.94P Ja Nei Nei Ja Nei Ja Ja Ja

50P Ja Nei Nei Ja Nei Ja Ja Ja

29.97P Ja Nei Nei Ja Nei Ja Ja Ja

25P Ja Nei Nei Ja Nei Ja Ja Ja

23.98P Ja Nei Nei Ja Nei Ja Ja Ja

S&Q (60fps eller lavere) 59.94P Ja Nei Nei Ja Nei Ja Ja Ja

50P Ja Nei Nei Ja Nei Ja Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja

S&Q (100fps, 120fps) 59.94P Ja Nei Nei Nei Nei Nei Ja Ja

50P Ja Nei Nei Nei Nei Nei Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Nei Ja

25P Ja Nei Nei Nei Nei Nei Nei Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Nei

1920×1080
HD50

Normal modus 59.94P Ja Nei Nei Ja Nei Ja Ja Ja

50P Ja Nei Nei Ja Nei Ja Ja Ja

29.97P Ja Nei Nei Ja Nei Ja Ja Ja

25P Ja Nei Nei Ja Nei Ja Ja Ja

23.98P Ja Nei Nei Ja Nei Ja Ja Ja

S&Q (60fps eller lavere) 59.94P Ja Ja Ja Ja Ja Ja Ja Ja

50P Ja Ja Ja Ja Ja Ja Ja Ja

29.97P Ja Nei Nei Ja Nei Ja Ja Ja

25P Ja Nei Nei Ja Nei Ja Ja Ja

23.98P Ja Nei Nei Ja Nei Ja Ja Ja

S&Q (100fps, 120fps) 59.94P Ja Nei Nei Ja Nei Ja Ja Ja

50P Ja Nei Nei Ja Nei Ja Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja
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Opptaksformat CFexpress 
Type A

SDXC

VPG400 Class10 U1 U3 VSC
V10

VSC
V30

VSC
V60

VSC
V90

XAVC-L 1920×1080
HD50

S&Q (150fps, 180fps) 59.94P Ja Nei Nei Nei Nei Nei Ja Ja

50P Ja Nei Nei Nei Nei Nei Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Nei Ja

25P Ja Nei Nei Nei Nei Nei Nei Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja

S&Q (200fps, 240fps) 59.94P Ja Nei Nei Nei Nei Nei Ja Ja

50P Ja Nei Nei Nei Nei Nei Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Nei Ja

25P Ja Nei Nei Nei Nei Nei Nei Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja

1920×1080
HD35

Normal modus 59.94P Ja Ja Ja Ja Ja Ja Ja Ja

50P Ja Ja Ja Ja Ja Ja Ja Ja

29.97P Ja Ja Ja Ja Ja Ja Ja Ja

25P Ja Ja Ja Ja Ja Ja Ja Ja

23.98P Ja Ja Ja Ja Ja Ja Ja Ja

S&Q (60fps eller lavere) 59.94P Ja Ja Ja Ja Ja Ja Ja Ja

50P Ja Ja Ja Ja Ja Ja Ja Ja

29.97P Ja Nei Nei Ja Nei Ja Ja Ja

25P Ja Nei Nei Ja Nei Ja Ja Ja

23.98P Ja Nei Nei Ja Nei Ja Ja Ja

S&Q (100fps, 120fps) 59.94P Ja Nei Nei Ja Nei Ja Ja Ja

50P Ja Nei Nei Ja Nei Ja Ja Ja

29.97P Ja Nei Nei Ja Nei Ja Ja Ja

25P Ja Nei Nei Ja Nei Ja Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja

S&Q (150fps, 180fps) 59.94P Ja Nei Nei Ja Nei Ja Ja Ja

50P Ja Nei Nei Ja Nei Ja Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Ja Ja

S&Q (200fps, 240fps) 59.94P Ja Nei Nei Ja Nei Ja Ja Ja

50P Ja Nei Nei Ja Nei Ja Ja Ja

29.97P Ja Nei Nei Nei Nei Nei Ja Ja

25P Ja Nei Nei Nei Nei Nei Ja Ja

23.98P Ja Nei Nei Nei Nei Nei Nei Ja
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Sette inn et minnekort

1	 Åpne mediedekslet i kortsporseksjonen.

2	 Sett inn et minnekort.
ˎˎ For CFexpress-kort vender etiketten mot 
venstre.

Etikett

ˎˎ På SD-kort vender etiketten mot høyre 
med det skrå hjørnet nederst.

Skrått hjørne

Tilgangsindikatoren (side 6) lyser rødt 
og skifter deretter til grønt hvis kortet kan 
brukes.

	 [Merk]
Hvis tilgangsindikatoren blinker rødt hele tiden 
og ikke endres til grønt, slå av videokameraet et 
øyeblikk og ta minnekortet ut og sett det tilbake 
igjen.

3	 Lukk mediedekslet.

[Merknader]
ˎˎ Minnekortet, minnekortsporet og bildedataene på 

minnekortet kan bli skadet hvis kortet tvinges inn i 
sporet mens det er feilorientert.
ˎˎ Når du tar opp på medier som er satt inn i både 

CFexpress Type A/SD-kortspor A og B, setter du inn 
medier i begge sporene som anbefales for bruk med 
opptaksformatet.

Løse ut et minnekort

Åpne mediedekslet i kortspordelen, og trykk 
minnekortet lett inn for å løse ut kortet.

[Merknader]
ˎˎ Hvis videokameraet slås av eller minnekortet fjernes 

mens minnekortet leses, kan det ikke garanteres 
at dataene på kortet ikke skades. Alle data som er 
registrert på kortet kan bli slettet. Kontroller alltid at 
tilgangsindikatoren er grønn eller av før du slår av 
videokameraet eller tar ut minnekortet.
ˎˎ Når du tar ut et minnekort rett etter at opptaket er 

ferdig, kan det hende at minnekortet er varmt, men 
dette betyr ikke at det er et problem.

Formatere (initialisere) minnekort

Hvis det settes inn et uformatert minnekort 
eller et minnekort som er formatert med 
en annen spesifikasjon, vises meldingen 
"Media Needs to be Formatted" (mediet må 
formatteres) i søkeren.
Formatter kortet med følgende prosedyre.

1	 Velg Format Media (side 95) i TC/
Media-menyen i hovedmenyen, eller på 
Media-statusskjermen.

2	 Velg Media(A) (spor A) eller Media(B) (spor 
B), og velg så formatteringsmetoden (Full 
Format eller Quick Format).
Det vises en bekreftelsesmelding.
ˎˎ Full Format: Initialiserer mediet 
fullstendig, inkludert dataområdet og 
informasjonen om dataadministrasjon.
ˎˎ Quick Format: Initialiserer bare 
informasjonen om dataadministrasjon 
på mediet.

	 [Merk]
Hvis det finnes filer som skal overføres på 
minnekortet som skal formateres, vises en 
tilleggsmelding (visningseksempel: "En målfil for 
overføring finnes") under bekreftelsesmeldingen. I 
dette tilfellet skal du bekrefte om du vil initialisere 
minnekortet eller ikke, og utføre eller avbryte 
initialiseringen.

3	 Velg Execute.
Det vises en melding mens formateringen 
pågår, og tilgangsindikatoren lyser rødt.
Når formateringen er fullført, vises en 
melding om at formateringen er fullført. 
Trykk på flerfunksjonshjulet for å lukke 
meldingen.

[Merknader]
ˎˎ Hvis du formaterer et minnekort, slettes alle data, 

inkludert innspilte videodata og oppsettfiler.
ˎˎ Meldinger kan vises under utførelsen avhengig av 

hvor lenge formateringsprosessen tar.

Hvis formateringen mislykkes

Minnekort som ikke støttes av videokameraet, 
kan ikke formateres.
Det vises en varselmelding. Følg 
instruksjonene for å bytte ut kortet med et 
minnekort som støttes.

Hvis du vil bruke et kort som er 
formatert med videokameraet i sporet 
på en annen enhet

Ta først en sikkerhetskopi av kortet, og 
reformater deretter kortet i enheten som skal 
brukes.

Kontrollere gjenværende 
opptakstid

Når du tar bilder (opptak/standby), kan 
du overvåke gjenværende kapasitet for 
minnekortet i hvert spor ved hjelp av 
indikatorene for gjenværende medie i spor 
A/B i søkeren (side 11).
Den gjenværende opptakstiden beregnes 
ut fra gjenværende kapasitet på mediet i 
hvert spor og det gjeldende videoformatet 
(opptaksbithastigheten), og vises i minutter.

Tidspunkt for å bytte minnekort

ˎˎ Når den totale gjenværende opptakstiden 
på de to minnekortene er mindre enn 5 
minutter, vises meldingen "Media Near Full" 
(medier nesten fulle), opptaks-/tellelampen 
begynner å blinke, og en pipelyd 
(hodetelefonutgang) høres som et varsel.  
Erstatt med medier som har ledig plass.
ˎˎ Hvis du fortsetter å ta opp til den totale 
gjenværende opptakstiden når null, endres 
meldingen til "Media Full" og opptaket 
stopper.

[Merk]
Du kan spille inn opp opptil 600 klipp på ett minnekort.
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Gjenopprette minnekort

Hvis det skulle oppstå en feil på et minnekort 
av en eller annen grunn, må kortet 
gjenopprettes før bruk.
Når du laster inn et minnekort som må 
gjenopprettes, vises det en melding på 
søkerskjermen for å spørre om du vil 
gjenopprette det.

Gjenopprette et kort

Drei multifunksjonshjulet (side 5) for å 
velge Execute (utfør), og trykk deretter på 
multifunksjonshjulet.
En melding og fremdriftsstatus (%) vises mens 
formateringen pågår, og tilgangsindikatoren 
lyser rødt.
Når gjenopprettingen er ferdig, vises en 
melding om at gjenopprettingen er fullført.

Hvis gjenopprettingen mislykkes

ˎˎ Minnekort med minnefeil kan ikke 
gjenopprettes. Det vises en varselmelding. 
Følg instruksjonene for å bytte minnekortet.
ˎˎ Minnekort der det har oppstått minnefeil 
kan bli brukbare hvis de formateres på nytt.
ˎˎ I noen tilfeller kan noen klipp gjenopprettes, 
mens andre ikke kan det. De gjenopprettede 
klippene kan spilles av på vanlig måte.

[Merknader]
ˎˎ Hvis du vil gjenopprette mediene som er tatt opp 

med dette videokameraet, må du bruke dette 
videokameraet.
ˎˎ Medier som er tatt opp med en annen enhet enn 

dette videokameraet eller med et annet videokamera 
med en annen versjon (selv om det er samme 
modell), kan ikke gjenopprettes ved hjelp av dette 
videokameraet.
ˎˎ Klipp som er kortere enn to sekunder, kan ikke 

gjenopprettes.
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Prosedyre for grunnleggende bruk
Grunnleggende opptak utføres ved hjelp av 
følgende prosedyre.

1	 Sett på de nødvendige enhetene, og 
kontroller at det er strømforsyning.

2	 Sett inn minnekort(ene).

3	 Sett POWER-bryteren til på.
POWER-indikatoren tennes, og 
kamerabildet vises i søkeren.

4	 Trykk knappen for opptak START/STOP 
(side 5).
Opptaks-/tellelampen tennes, og 
opptaket begynner.

5	 Trykk på START/STOP-knappen igjen for å 
stoppe opptaket.
Opptaket stopper, og videokameraet 
settes i STBY-modus (standby).

[Merk]
Hvis du trykker på START/STOP-knappen for opptak bare 
noen få sekunder etter at du har slått på videokameraet, 
lyser opptaks-/tellelampen for å angi at enheten er i 
opptaksmodus, men det kan hende at opptak på medier 
ikke skjer i de første sekundene, avhengig av hvilket 
opptaksformat som er valgt.

Bytte mellom minnekort

Når to minnekort er satt inn, trykker du på 
SLOT SELECT-knappen (side 6) ("sporvalg") 
for å bytte kort.
Opptaket bytter automatisk til det andre 
minnekortet rett før den gjenværende 
kapasiteten på det første kortet går ned til 
null (kontinuerlig opptak). Du kan fortsette 
å ta opp kontinuerlig ved å bytte minnekort. 
Bytt ut minnekortet som er fullt med et nytt 
minnekort.

[Merknader]
ˎˎ Du kan ikke bytte mellom minnekort i 

avspillingsmodus. Kontinuerlig avspilling av et klipp 
som ligger på media på tvers av spor A og spor B 
støttes heller ikke.
ˎˎ Når et opptakbart minnekortet er satt inn i det andre 

sporet, vil minnekortene ikke skifte over hvis kun 
proxy-data tas opp på dette minnekortet.

Klipp (innspilte data)
Når du stopper opptaket, lagres video, lyd og 
tilhørende data fra begynnelsen til slutten 
av opptaket som ett enkelt "klipp" på et 
minnekort.

Navn på klippene
Navnet på hvert klipp som tas opp med 
videokameraet tilordnes automatisk 
med formatet som er angitt i Clip Name 
Format (side 94) i TC/Media-menyen i 
hovedmenyen.

Maksimal klippvarighet
Opptil 6 timer per klipp.
Maksimal lengde på et kontinuerlig opptak 
er den samme som maksimal varighet for et 
klipp. Hvis opptakstiden overskrider maksimal 
varighet for et klipp, opprettes det automatisk 
et nytt klipp, og opptaket fortsetter. Det 
nye klippet vises som et separat klipp på 
miniatyrbildeskjermen.

Flere klipp tas opp etter hverandre under 
kontinuerlig opptak, men opptaket stopper 
automatisk etter ca. 24 timer.

[Merknader]
ˎˎ Ikke løs ut et minnekort mens det pågår opptak til 

det. Når du tar opp, må du bare bytte minnekort i 
sporene der tilgangsindikatoren er slukket.
ˎˎ Når det er mindre enn ett minutt igjen av kapasiteten 

på minnekortet som det tas opp på, og det er satt 
inn et minnekort i det andre sporet som kan brukes, 
vises meldingen "Will Switch Slots Soon" (Snart 
byttes minnespor). Meldingen forsvinner etter at 
minnekortsporet er byttet.
ˎˎ Overføring av opptak fungerer kanskje ikke hvis 

opptaket startes når gjenværende kapasitet på 
minnekortet er mindre enn ett minutt. Kontroller 
at den gjenværende minnekortkapasiteten er mer 
enn ett minutt før du starter opptaket for å få riktig 
overføring av opptaket.
ˎˎ Video som er opprettet med videokameraets overført 

opptaksfunksjon kan ikke spilles av sømløst på 
videokameraet.
ˎˎ Hvis du vil kombinere video som er opprettet ved 

hjelp av kameraets overført opptaksfunksjon, må du 
bruke programmet "Catalyst Browse" (bla katalysator).

Overvåke lydopptak

Du kan overvåke lyden som tas opp med 
hodetelefoner.
Hvis du kobler et sett med hodetelefoner 
til hodetelefonkontakten (side 5), kan 
du overvåke lyden som tas opp. Du kan 
også overvåke avspillingslyden (side 69) 
ved hjelp av den innebygde høyttaleren 
(side 6) eller hodetelefonene.
Du kan justere lydstyrken for å overvåke 
volumet ved hjelp av Volume (side 14) på 
Audio-statusskjermen eller Audio Output 
> Volume (side 100) i Audio-menyen i 
hovedmenyen.
Du kan velge kanalen du vil overvåke ved hjelp 
av Monitor CH (side 14) på skjermbildet 
Audio-statusskjermen eller Audio Output 

> Monitor CH (side 100) i Audio-menyen i 
hovedmenyen.

Angi tidsdata

Stille inn tidskode

Still inn tidskoden med Timecode (side 94) i 
TC/Media-menyen i hovedmenyen.

Stille inn bruker-bits

Du kan legge til et 8-sifret heksadesimalt tall 
i det innspilte bildet som bruker-bits. Du kan 
også sette brukerbits lik gjeldende klokkeslett. 
Still inn med Users Bit (side 94) på TC/
Media-menyen.

Vise tidsdata

Angi tidskode som skal vises ved hjelp av TC 
Display > Display Select (side 94) på TC/
Media-menyen.
Hvis du trykker på en tilordnet knapp 
(side 49) med DURATION/TC/U-BIT, skifter 
tilordningen sekvensielt mellom tidskode, 
bruker-bits og varighet.

Bytte mellom tidskodeinngang/-utgang

Du kan skifte tidskodeinngangen/-utgangen 
med velgerbryteren TC IN/OUT (side 4).
Du finner mer informasjon på side 120.



3. Opptak: Prosedyre for grunnleggende bruk35

Gå gjennom opptaket (Rec 
Review)

Du kan se gjennom det sist innspilte klippet 
på skjermen (gjennomgang av opptak).

[Merk]
Rec Review støttes ikke hvis videoformatet er endret 
etter at et klipp ble tatt opp.

Metode for gjennomgang av opptak

Tilordne Rec Review til en av knappene som 
kan tilordnes, på forhånd.
Når opptaket er stoppet, trykker du på 
knappen som kan tilordnes (side 49) som 
er tilordnet Rec Review. Avspilling av det sist 
innspilte klippet begynner.
Klippet spilles helt gjennom, gjennomgang 
av opptak avsluttes, og videokameraet går 
tilbake til STBY-modus.

For å stoppe gjennomgang av opptak

Trykk på knappen som er tilordnet Rec Review, 
eller trykk på CANCEL/BACK-knappen.

Innstillinger for gjennomgang av opptak

Du kan angi startposisjonen for avspillingen til 
ett av følgende ved hjelp av innstillingen for 
Rec Review (side 102) i menyen Technical.
ˎˎ Siste tre sekunder av klippet
ˎˎ Siste 10 sekunder av klippet
ˎˎ Starten av klippet

[Tips]
Hvis du vil se gjennom et bestemt klipp etter at du har 
tatt opp flere klipp, trykker du på THUMBNAIL-knappen 
for å vise miniatyrbildeskjermen, og velger klippet for å 
starte avspillingen.
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Du kan justere zoomen i henhold til 
opptaksforholdene.

Når et objektiv med elektrisk zoom er koblet 
til, kan du justere zoomen med zoomspaken, 
enten på grepfjernkontrollen eller håndtaket. 
Zoomhastigheten varierer med trykket på 
spaken.
Videokameraet er utstyrt med 
en zoomfunksjon som bruker 
bildesignalbehandling med betegnelsen 
Clear Image Zoom. Når Clear Image Zoom er 
aktivert, støttes zoom også for objektiver med 
fast fokusavstand (primærobjektiv). Den kan 
også brukes til å utvide rekkevidden utover 
det optiske området for et objektiv med 
elektrisk zoom.
Det maksimale zoomforholdet ved bruk 
av Clear Image Zoom varierer avhengig av 
opptaksoppløsningen.
ˎˎ For QFHD/4K-opptaksoppløsning: 1,5×
ˎˎ For HD-opptaksoppløsning: 2×

Velge typen zoom

Angi zoomtypen ved hjelp av Zoom > Zoom 
Type (side 102) på Technical-menyen i 
hovedmenyen.
Typen zoom varierer avhengig av hvilken 
objektivtype som er montert.

Montert 
objektiv

Zoom Type-innstilling

Optical Zoom 
Only

On(Clear Image 
Zoom)

Primærobjektiv 
/ manuelt 
zoomobjektiv

Zoombetjening 
ved hjelp av 
spaken støttes 
ikke.

Clear Image 
Zoom støttes.

Objektiv 
med 
elektrisk 
zoom

Bare optisk 
zoom

Optisk zoom og 
Clear Image 
Zoom støttes.

[Merknader]
ˎˎ Clear Image Zoom er ikke tilgjengelig i følgende 

tilfeller:
–– Når S&Q Motion > Frame Rate (side 82) i 

hovedmenyens Shooting-meny er høyere enn 
60fps

–– Når Rec Format > Codec (side 84) på Project-
menyen i hovedmenyen er satt til RAW, eller et 
alternativ som inkluderer RAW

ˎˎ Betjening av velgerbryteren SERVO/MANUAL på et 
objektiv tilbakestiller forstørrelsen av Clear Image 
Zoom til 1×. 
ˎˎ Når Push Auto Focus (AF-S) utføres under bruk 

av Clear Image Zoom, vil bruk av AF gi prioritet til 
området midt på skjermen.

Stille inn håndtak-zoom

Angi håndtak-zoom med Handle Zoom 
(side 102) på Technical-menyen i 
hovedmenyen.

Stille inn retningen for 
zoomringen

På noen objektiver med E-feste kan du 
reversere rotasjonsretningen for zoomringen.
Angi rotasjonsretningen med Lens > Zoom 
Ring Direction (side 103) på Technical-
menyen i hovedmenyen.

Justere zoomen
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Justere fokus
Du kan justere fokus automatisk eller manuelt 
i henhold til opptaksforholdene.

Justere fokus manuelt (manuell 
fokus)

For å justere fokus manuelt, sett FOCUS-
bryteren (side 4) til posisjonen "MAN".
Dette gjør at du kan justere fokus manuelt i 
henhold til fotograferingsforholdene.
Manuell fokusering er nyttig for følgende 
typer motiver.
ˎˎ Motiver på den andre siden av et vindu 
dekket av vanndråper
ˎˎ Motiver med lav kontrast mot bakgrunnen
ˎˎ Motiver som er lenger unna enn motiver i 
nærheten

[Tips]
Du kan også bruke autofokus i følgende tilfeller når 
manuell justering er hovedmetoden for bruk.
ˎˎ Når AF motivfølsomhet er satt til 1(Locked)
ˎˎ Når FOCUS-bryteren er satt til AF-posisjon
ˎˎ Når du bruker fokusringen (AF Assist, side 40)

Fokusere ved hjelp av touch-funksjon 
(Spot Focus)

I modus for manuell fokus kan du angi 
posisjonen der du ønsker å justere fokus med 
touch-funksjon.
For å bruke Spot Focus, sett Focus >Touch 
Function in MF (side 82) i Shooting-menyen 
til Spot Focus.
Et Spot Focus-merke vises når du trykker på 
posisjonen der du ønsker å justere fokuset.

[Tips]
ˎˎ I Spot Focus-modus kan du trykke på en 

tilordningsbar knapp (side 49) som tilordnes med 
Push AF/Push MF for å stoppe fokus midlertidig 
og aktivere autofokus mens knappen trykkes inn. 
Fokuseringen går tilbake til manuell fokus når du 
slipper knappen.
ˎˎ Spot-fokusfunksjonen virker ikke hvis objektivet er 

stilt inn for manuell fokusering.
ˎˎ Spot-fokusfunksjonen virker ikke når en annen 

innstilling enn Off(1.0×) er valgt i De-Squeeze 
(side 96) i Monitoring-menyen i hovedmenyen.
ˎˎ Spot Focus-posisjonen kan ikke angis mens fokus er 

økt eller når Touch Operation (side 102) i Technical-
menyen er satt til Off.

Bruke autofokus midlertidig (Push Auto 
Focus (AF))

Når Focus >Push AF Mode (side 82) på 
Shooting-menyen i hovedmenyen er satt 
til AF, trykker du på knappen PUSH AUTO 
FOCUS (side 4) når du er i manuell 
fokuseringsmodus for å fokusere automatisk 
mens du holder knappen inne.
Fokuseringen holder seg i fokusområdet du 
stilte inn med Focus >Focus Area (side 82) 
på Shooting-menyen i hovedmenyen.
Fokuseringen går tilbake til manuell fokus når 
du slipper knappen.
Dette er nyttig når du vil flytte fokuset 
langsomt fra ett motiv til et annet mens du 
bruker manuell fokus.

[Tips]
Den samme operasjonen støttes med en knapp som kan 
tilordnes (side 49) som er tilordnet Push AF/Push MF.

[Merknader]
ˎˎ Funksjonen Push Auto Focus virker ikke hvis objektivet 

er stilt inn for manuell fokusering.
ˎˎ Push Auto Focus-funksjonen virker ikke når en 

annen innstilling enn Off(1.0×) er valgt i De-Squeeze 
(side 96) i Monitoring-menyen i hovedmenyen.

Bruke autofokus for enkeltbilde (Push 
Auto Focus (AF-S))

Still Focus >Push AF Mode (side 82) på 
Shooting-menyen i hovedmenyen til Single-
shot AF(AF-S), og angi så fokusområdet med 
Focus >Focus Area(AF-S) (side 82) på 
Shooting-menyen i hovedmenyen.
Trykk på knappen PUSH AUTO FOCUS når du 
er i manuell fokuseringsmodus, for å fokusere 
automatisk med høy hastighet. Fokuseringen 
stopper så snart du slipper knappen.
Fokuseringsstatusen angis med 
fokuseringsindikatoren.
ˎˎ På: Fokus er fiksert i fokusposisjonen.
ˎˎ Blinker: Ute av fokus. Fordi fokusering ikke 
er automatisk, endrer du komposisjonen og 
fokusinnstillingene for å oppnå fokus.

Fokuseringen går tilbake til manuell fokus når 
du slipper knappen.
Dette er nyttig når du vil fokusere raskt på et 
motiv før du begynner å filme.

[Tips]
ˎˎ Den samme operasjonen støttes med en knapp som 

kan tilordnes (side 49) som er tilordnet Push AF/
Push MF.
ˎˎ Du kan også tilordne Push AF Mode til en knapp som 

kan tilordnes (side 49).
ˎˎ Du kan også tilordne Focus Area(AF-S) til en knapp 

som kan tilordnes (side 49).
ˎˎ Du kan vise/skjule fokusområderammen ved å bruke 

Display On/Off > Focus Area Ind.(AF-S) (side 96) i 
menyen Monitoring i hovedmenyen.
ˎˎ Ved fokusforstørrelse justeres fokuset slik at det 

passer til den forstørrede visningsposisjonen.

[Merknader]
ˎˎ Funksjonen Push Auto Focus virker ikke hvis objektivet 

er stilt inn for manuell fokusering.
ˎˎ Rammen for fokusområdet skjules ikke når du bruker 

DISPLAY-knappen.

ˎˎ 	Under bruk av Clear Image Zoom, er det ikke mulig å 
stille inn rammeposisjon for Focus Area(AF-S). Under 
bruke av Push AF-S vil bruk av AF også gi prioritet til 
den midtre delen.
ˎˎ Push Auto Focus-funksjonen virker ikke når en 

annen innstilling enn Off(1.0×) er valgt i De-Squeeze 
(side 96) i Monitoring-menyen i hovedmenyen.

Fokusering med forstørret visning (Focus 
Magnifier)

Som fabrikkinnstilling er funksjonen 
Focus Magnifier ×3/×6 tilordnet til ASSIGN 
4-knappen på grepfjernkontrollen og ASSIGN 
7-knappen på håndtaket (side 49).
Trykk på ASSIGN 4-knappen eller 
ASSIGN 7-knappen for å bytte til 
fokusforstørrelsesskjermen, med midten av 
bildet forstørret omtrent tre ganger. Trykk 
på knappen igjen for å øke forstørrelsen til 
omtrent seks ganger. Denne funksjonen er 
nyttig når du skal kontrollere fokus.
Trykk på knappen en gang til for å gå tilbake 
til det normale skjermbildet.
Du kan flytte posisjonen som skal forstørres 
under fokusforstørrelse ved hjelp av flervalg-
knappen (side 7). Hvis du trykker på 
flervalg-knappen, går du tilbake til midten av 
bildet.
Når Push Auto Focus (AF) brukes i 
fokusforstørrelse, holder fokuseringen seg i 
fokusområdet du stilte inn med Focus >Focus 
Area (side 82) på Shooting-menyen i 
hovedmenyen.
Hvis Push Auto Focus (AF-S) brukes under 
fokusforstørrelse, justeres fokus til den 
forstørrede visningsposisjonen.

[Merknader]
ˎˎ Det innspilte bildet eller SDI/HDMI-bildet blir ikke 

forstørret når fokuset forstørres.
ˎˎ Under fokusforstørrelse deaktiveres MENU-knappen 

og andre funksjoner.
ˎˎ Den forstørrede posisjonen går tilbake til midten av 

skjermen når videokameraet slås av.
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Justere fokus automatisk 
(autofokus)

Videokameraet bruker fasedeteksjon-AF for 
fokusering med høy hastighet og kontrast-AF 
for fokusering med høy nøyaktighet.
Kombinasjonen av disse to AF-metodene gir 
autofokus med både høy hastighet og høy 
nøyaktighet.
Hvis du vil justere fokus automatisk, sett 
FOCUS-bryteren (side 4) på videokameraet 
til posisjonen AUTO. Hvis objektivet er utstyrt 
med en fokusvelgerbryter, sett bryteren til 
"AF/MF-" eller "AF"-posisjon. Hvis bryteren 
er satt til stillingen "Full MF" eller "MF", kan 
ikke fokuseringen på objektivet betjenes fra 
videokameraet (side 22).

[Tips]
Når Focus > AF Assist (side 82) på Shooting-menyen 
i hovedmenyen er satt til On, kan du fremdeles bruke 
fokusringen på objektivet i autofokus for å justere fokus.

[Merknader]
ˎˎ Det kreves et objektiv som støtter autofokus.
ˎˎ Det kan hende dette ikke blir nøyaktig, avhengig av 

opptaksforholdene.
ˎˎ Fokus kan ikke justeres automatisk på et objektiv med 

A-feste.
ˎˎ Autofokus kan ikke brukes når De-Squeeze >Ratio 

(HDMI/VF) (side 96) er satt til en annen verdi enn 
Off(1.0×) i Monitoring-menyen.

Stille inn autofokusområde/-posisjon 
(fokusområde)

Du kan stille inn målområdet for autofokus 
ved hjelp av Focus > Focus Area (side 82) på 
Shooting-menyen i hovedmenyen.

Flexible Spot:
Fokuserer på en angitt posisjon i bildet.
Når dette er valgt, angi posisjonen ved hjelp 
av flervalg-knappen (side 7).
Du kan gå tilbake til midtstilling ved å trykke 
på og holde flervalg-knappen.

Zone:
Søker automatisk etter en fokusposisjon 
innenfor den angitte sonen.
Når dette er valgt, angi posisjonen ved hjelp 
av flervalg-knappen (side 7).
Du kan gå tilbake til midtstilling ved å trykke 
på og holde flervalg-knappen.

Wide:
Søker etter et motiv over en vid vinkel i bildet 
når du fokuserer. En ramme vises ikke.

[Tips]
Den samme operasjonen støttes med en knapp som kan 
tilordnes (side 49) som er tilordnet Focus Area.
Du kan vise/skjule fokusområderammen ved å bruke 
Display On/Off > Focus Area Indicator (side 96) i 
menyen Monitoring i hovedmenyen.

[Merk]
Rammen for fokusområdet skjules ikke når du bruker 
DISPLAY-knappen.

Raskt skifte av fokusområde 
(fokusinnstilling)

Du kan raskt endre plasseringen og størrelsen 
på autofokusområdet under fotografering ved 
å tilordne Focus Setting til en knapp som kan 
tilordnes (side 49).
Bruken varierer avhengig av innstillingen av 
fokusområdet.

Når Focus > Focus Area (side 82) i Shooting-
menyen i hovedmenyen er satt til Flexible 
Spot eller Zone
Du kan endre plasseringen av fokusområdet 
ved å trykke på en knapp som er tilordnet 
Focus Setting og justere med flervalg-knappen 
(side 7).
Du kan flytte fokuseringsområdet tilbake til 
midten mens du justerer plasseringen ved å 
trykke på flervalg-knappen.
Du kan endre størrelsen på fokusområdet ved 
å trykke på og holde nede en knapp som er 
tilordnet Focus Setting.
Når du har endret størrelsen, angir du 
plasseringen til fokusområdet ved å trykke på 
flervalg-knappen.
Når du er ferdig, trykker du på knappen som er 
tilordnet Focus Setting for å gå tilbake til det 
opprinnelige skjermbildet.

Når Focus > Focus Area (side 82) i Shooting-
menyen i hovedmenyen er satt til Wide
Du kan bare endre størrelsen på fokusområdet 
ved å trykke på og holde nede en knapp som 
er tilordnet Focus Setting. Plasseringen kan 
også endres ved først å endre typen til Flexible 
Spot eller Zone.

[Tips]
ˎˎ Når både Focus > Push AF Mode (side 82) i 

Shooting-menyen i hovedmenyen er satt til Single-
shot AF(AF-S) og FOCUS-bryteren (side 4) er i 
MF-posisjon, kan du endre fokusområdets plassering 
med Focus Area(AF-S) (side 82).
ˎˎ Rammen for fokusområdet vises oransje når 

fokuseringsområdet kan endres.

Flytte rammen for fokusområdet ved 
hjelp av berøringsfunksjon 
(berøringsfokusområde)

Du kan endre plasseringen av fokusområdet 
ved å trykke på en tilordnet knapp (side 49) 
som er tilordnet Focus Setting for å endre 
visningen av fokusområdet til oransje, og 
deretter flytte den ved bruk av berøring.
Trykk på skjermen for å flytte fokusområdet, 
med fokusområdet sentrert på den berørte 
posisjonen. Dra på skjermen for å flytte 
fokusområdet til plasseringen fingeren din 
markerer (side 10).

[Tips]
Du kan aktivere/deaktivere berøringsfokus på 
opptaksskjermen ved å bruke en knapp som er tilordnet 
Focus Setting.
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Trykk på en hvilken som helst posisjon

Fokusområdet beveger seg, med 
fokusområdet sentrert rundt posisjonen 
som ble trykket.

Dra for å flytte fokusområdet, det følger 
fingerens posisjon

[Merknader]
ˎˎ Hvis du trykker på en posisjon eller drar fokusområdet 

til en posisjon som overskrider innstillingsområdet, 
settes fokusområdet til toppen/bunnen/venstre/
høyre kant av innstillingsområdet.
ˎˎ Denne funksjonen er ikke tilgjengelig under følgende 

omstendigheter.
–– Når Touch Operation (side 102) i Technical-

menyen i hovedmenyen er satt til Off
–– Når fokusområdet vises i grått eller ikke vises i det 

hele tatt

Justere autofokusfunksjonen (AF-
overgangshastighet, AF-følsomhet for 
motivendring)

AF-overgangshastighet
Du kan angi hastigheten på 
fokuseringsenheten for når motivet endres 
med Focus > AF Transition Speed (side 81) i 
Shooting-menyen i hovedmenyen.
Når den er satt til lav hastighet, beveger 
fokuset seg sakte når motivet som fokuseres 
endrer seg, noe som gjør det mulig å ta 
imponerende bilder.
Når den er satt til høy hastighet, veksler 
fokuset raskt mellom motiver. Motivet 
som kommer inn i bildet, blir umiddelbart 
fokusert, noe som gjør denne innstillingen 
ideell for dokumentaropptak som krever rask 
fokusering.

Under endringen:
1(Slow): Fokuseringen reagerer 
sakte
.
.
.
7(Fast): Fokuseringen reagerer 
raskt

Fokusert på motivet lengst borte

Fokusert på motivet nærmest

AF-følsomhet for motivendring
Du kan stille inn følsomheten for endring 
av motiver med Focus > AF Subj. Shift 
Sens. (side 82) fra Shooting-menyen i 
hovedmenyen.
Når den er satt til lav følsomhet, endres ikke 
fokuset så lett selv om et annet motiv beveger 
seg foran motivet som er i fokus. Når den er 
satt til høy følsomhet, endres fokuset for å gi 
prioritet til motivet som beveger seg foran.

[Tips]
Hvis AF- Speed/Sens. er tilordnet en knapp som kan 
tilordnes, vises nivålinjene for justering av verdier 
i følgende rekkefølge hver gang du trykker på 
knappen, slik at du kan endre innstillingene for AF-
overgangshastighet og AF-motivets følsomhet.
AF-overgangshastighet  AF-motivbytte følsomhet  
Ingen visning …
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AF Subj. Shift Sens.: 1(Locked On) AF Subj. Shift Sens.: 5(Responsive)

Endrer fokus sakte til et annet motiv Endrer fokus raskt til et annet motiv

Endre fokuseringsmålet manuelt  
(AF Assist)

Når Focus > AF Assist (side 82) på Shooting-
menyen i hovedmenyen er satt til On, kan du 
fremdeles bruke fokusringen på objektivet i 
autofokus for å justere fokus på et motiv.
Når du slutter å bruke fokusringen, fortsetter 
autofokuseringen å fokusere på motivet som 
ble fokusert med fokusringen (AF Assist-
tilstand).
Etter at du har brukt fokusringen, er det litt 
vanskeligere å flytte fokus til et annet motiv, 
uansett innstillingen for Focus > AF Subj. 
Shift Sens. (side 82) på Shooting-menyen i 
hovedmenyen.
AF Assist-tilstanden avbrytes av følgende:
ˎˎ Når motivet som ble fokusert med 
fokusringen, ikke lenger er synlig
ˎˎ Når det skiftes til manuell fokusering
ˎˎ Når sanntidssporing i AF-modus er startet

[Tips]
ˎˎ AF Assist-tilstanden kan avbrytes raskt ved å bruke en 

knapp som kan tilordnes (side 49) som er tilordnet 
Push AF/Push MF.
ˎˎ Sanntidssporing i AF stopper når fokusringen 

betjenes.
ˎˎ I Face/Eye Only AF-modus fokuserer autofokus på 

ansiktet som er nærmest fokusringens fokusposisjon.

Bruke manuell fokus midlertidig (Push 
Manual Focus)

Trykk på knappen PUSH AUTO FOCUS 
(side 4) når du er i autofokusmodus, for 
å fokusere manuelt mens du holder knappen 
inne.
Fokuseringen går tilbake til autofokus når du 
slipper knappen.
Dette gjør at du kan stoppe autofokus 
midlertidig og fokusere manuelt når noe 
som ikke er motivet i opptaket, krysser foran 
motivet.

[Tips]
Den samme operasjonen støttes med en knapp som kan 
tilordnes (side 49) som er tilordnet Push AF/Push MF.
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Sporing med ansikts-/
øyedeteksjon (Face/Eye Detection 
AF)

Videokameraet kan registrere ansikter 
og øyne som mål for sporing, og deretter 
justere fokuset på ansikter og øyne innenfor 
fokusområdet.
Denne funksjonen er bare tilgjengelig når 
fokusmodus er AF-modus eller i push-
autofokus.
Når ansikter detekteres, vises grå bilderammer 
for ansikt-/øyedeteksjon. Når automatisk 
fokusering er mulig, blir rammene hvite 
og sporing starter. Når øyne detekteres og 
fokus justeres, vises rammen for ansikt-/
øyedeteksjon på øynene. Når flere personer 
oppdages, bestemmes hovedmotivet 
automatisk.

[Tips]
ˎˎ Når fokuseringsområdet er satt til Zone eller Flexible 

Spot og ansikter eller øyne overlapper innenfor det 
angitte fokusområdet, endres rammene for ansikts-/
øyedeteksjon til hvite rammer, og videokameraet 
fokuserer på disse ansiktene/øynene.
ˎˎ Når Push Auto Focus (AF-S) brukes, endres rammene 

for ansikts-/øyedeteksjon for ansikter/øyne som er i 
fokus, til grønne rammer.

Angi AF-handling for ansikts-/øyedeteksjon 
ved hjelp av Focus > Face/Eye Detection AF 
(side 82) på Shooting-menyen.

Face/Eye Only AF:
Kameraet registrerer ansikter/øyne for motiver 
(personer) og fokuserer og sporer bare på 
ansiktene/øynene deres. Når et ansikt eller et 
øye ikke registreres, stoppes AF midlertidig, 
og  (AF pause)-ikonet (side 11) blir vist. 
Denne modusen er effektiv når du bare vil 
autofokusere og spore på ansikter/øyne.

Face/Eye Priority AF:
Kameraet registrerer ansikter/øyne for motiver 
(personer) og prioriterer fokusering/sporing 
av ansikter/øyne. Når et ansikt eller et øye 
ikke detekteres, er fokusering i AF-modus 
(standardinnstilling).

Off:
AF-funksjonen for ansikts-/øyedeteksjon er 
deaktivert.

[Merknader]
ˎˎ Når du bruker Push-autofokus, aktiveres Face/Eye 

Priority AF selv om Face/Eye Only AF er valgt for 
øyeblikket.
ˎˎ Når FOCUS-bryteren er satt til MAN, deaktiveres AF 

for ansikts-/øyedeteksjon (unntatt mens du bruker 
push-autofokus).
ˎˎ Hvis du slår av videokameraet mens Face/Eye Only 

AF er valgt, skifter modusen automatisk til Face/Eye 
Priority AF neste gang videokameraet slås på.

Skjule deteksjonsrammene for ansikts-/
øyedeteksjon

Du kan vise/skjule rammene for ansikts-/
øyedeteksjon ved å bruke Display On/Off 
> Face/Eye Detection Frame (side 96) i 
menyen Monitoring i hovedmenyen.

[Merk]
Grønne rammer for ansikts-/øyedeteksjon vises for 
ansikter og øyne som er i fokus ved hjelp av autofokus 
(AF-S), og de skjules ikke med DISPLAY-knappen eller når 
Face/Eye Detection Frame settes til Off.

Bytte av AF-funksjon for ansikts-/
øyedeteksjon ved hjelp av en knapp 
som kan tilordnes
Tilordne AF for ansikts-/øyedeteksjon til en 
knapp som kan tilordnes (side 49). Deretter 
kan du bytte funksjonen til AF for ansikts-/
øyedeteksjon i sekvensen Face/Eye Priority AF, 
Face/Eye Only AF og Off hver gang du trykker 
på knappen.

Innstilling ved hjelp av hurtigmenyen
Du kan også angi AF-bruk for ansikts-/
øyedeteksjon med hurtigmenyen (side 49).

Sporing av et spesifisert motiv 
(Realtime Tracking AF)

Du kan opprettholde fokus på et motiv ved å 
spesifisere motivet med touch-funksjon eller 
ved å velge en ansiktsgjenkjenningsramme.
Når et motiv er valgt vises en hvit 
sporingsramme og sporingen starter.

[Tips]
ˎˎ Sporingen utføres over hele bildeområdet, uavhengig 

av fokusområdeinnstilling.
ˎˎ Når Focus >Touch Function in MF (side 82) i 

Shooting-menyen er satt til Tracking AF, støttes 
sanntidssporing i AF også når fokusmodus er MF-
modus.

Følgende handlinger inntreffer for målsporing, 
avhengig av AF-driftsmodus for ansikts-/
øyedeteksjon.

Face/Eye Only AF, Face/Eye Priority AF:
Brukes for fokusering og sporing av et angitt 
motiv.
Hvis sporingsmålet er en person og ansikt/
øye detekteres, fokuserer kameraet på dette 
ansiktet/øyet.
Når et sporingsmål som ansikt/øye detekteres, 
lagres ansiktet som er sporingsmål. Når 
det er lagret vises et  (ikon for lagret 
ansiktssporing) (side 11).

[Merk]
Hvis sporing i AF startes under manuell fokus, vil ansiktet 
som er sporingsmål ikke bli lagret.

Off:
Fokusering og sporing av det angitte motivet.
Detektering av ansikt/øye utføres ikke, selv 
om sporingsmålet er en person.

[Merk]
Funksjonen Realtime Tracking AF virker ikke hvis 
objektivet er stilt inn for manuell fokusering.

Starte sanntidssporing i AF

Når et bestemt motiv spesifiseres som 
sporingsmål, starter sporingen av dette målet.

Spesifisere med touch-funksjon
Trykk på målmotivet for å spore i en av 
følgende modi:
ˎˎ Når fokusmodus er MF-modus, eller under 
push-manuell fokus, og Focus >Touch 
Function in MF (side 82) i Shooting-
menyen er satt til Tracking AF
ˎˎ Når fokusmodus er AF-modus eller i push-
autofokus (AF)

[Merk]
Spesifisere et mål med touch-funksjon er ikke 
tilgjengelig når Touch Operation (side 102) i Technical-
menyen er satt til Off.
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Angi bruk av markøren for ansikts-/øyevalg
Still Focus >Multi Selector Function (side 82) 
til Face/Eye Sel. Cursor i Shooting-menyen, 
flytt markøren for valg av ansikt/øye (oransje 
understreking) til målmotivet som skal spores 
ved hjelp av flervalg-knappen (side 7), og 
trykk på flervalg-knappen.

Andre ansiktsgjenkjen-
ningsramme (grå) Sporingsramme

Markør for ansikts-/øyevalg (oransje)

[Tips]
ˎˎ Du kan også endre målet som skal spores under 

sanntidssporing i AF.
ˎˎ Hvis en tilordningsbar knapp (side 49) som er 

tilordnet Focus Magnifier-funksjonen trykkes under 
sanntidssporing i AF, opprettholdes sporingsstatusen 
og fokuset forstørres. Imidlertid kan du ikke 
spesifisere et mål for sporing under fokusforstørrelse.

[Merk]
Under manuell fokus er det ikke mulig å starte sporing 
med bruk av markøren for ansikts-/øyevalg.

Angi bruk av AF-pekeren for sporing
Du kan velge et hvilket som helst motiv på 
skjermen ved hjelp av flervalgsknappen 
istedenfor berøringsfunksjon.
Still Focus >Multi Selector Function (side 82) 
til Pointer i Shooting-menyen, flytt AF-pekeren 
for sporing til målmotivet som skal spores ved 
hjelp av flervalg-knappen (side 7), og trykk 
på flervalg-knappen.

Ansikts-/øyeramme

AF-pekeren for sporing

ˎˎ Du kan stille inn fargen på AF-pekeren 
for sporing med Focus >Pointer Color 
(side 82) i Shooting-menyen.
ˎˎ Du kan angi om det skal vises en grense for 
AF-pekeren for sporing med Focus >Pointer 
Border (side 82) i Shooting-menyen.

[Tips]
Standardstillingen til AF-pekeren for sporing er i senter 
av bildevisningen. Du kan gå tilbake til standardstilling 
ved å trykke på og holde flervalg-knappen.

[Merk]
Når flervalgsknappen betjenes med en annen funksjon 
enn sanntidssporing i AF, vil AF-pekeren for sporing 
være nedtonet, og flervalgsknappen kan ikke brukes til å 
styre AF-pekeren for sporing.

Stoppe sanntidssporing i AF

Stoppe med touch-funksjon
Trykk på  (sanntidssporing i AF stopp)-
knappen som vises øverst til venstre i 
berøringspanelet.

[Tips]
ˎˎ Sanntidssporing i AF vil stoppe i følgende tilfeller:

–– Når FOCUS-bryteren eller AUTO/MAN-kontrollen på 
objektivet betjenes

–– Når fokusmodus endres
–– Når assistert autofokus utføres
–– Når fokusområdeinnstillingen eller ansikt/øye-

gjenkjenning i AF-handling endres
–– Når en tilordningsbar knapp som er tilordnet Push 

AF/Push MF trykkes
–– Når sporingsmålet ikke er innenfor 

opptaksskjermen eller når motivet er ute av fokus i 
noen sekunder

ˎˎ Når et sporingsansikt er lagret (når " " (ikon for 
lagret ansiktssporing) vises), blir sanntidssporing i AF 
gjenopptatt når det lagrede sporingsansiktet kommer 
inn i bildeområdet. For å slette sporingsansiktet, 
stopp sanntidssporing i AF som beskrevet ovenfor.
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Justering av lysstyrken

B

C
D
E

F
H

I

A

Du kan justere lysstyrken ved å justere iris, 
forsterkning, lukkerhastighet og ved å justere 
lysnivået ved hjelp av ND-filtre. Du kan også 
gjøre justeringer automatisk.
Målnivået for automatisk justering av lysstyrke 
stilles inn ved hjelp av Auto Exposure 
(side 79) > Level på Shooting-menyen i 
hovedmenyen. Du kan også tilordne Auto 
Exposure Level til en tilordningsbar knapp eller 
hjul (side 49).

[Merknader]
ˎˎ Forsterkningen kan ikke justeres i Cine EI/Cine EI 

Quick-opptaksmodus. Basisfølsomheten er fast. 
Lysstyrken kan heller ikke justeres automatisk ved 
hjelp av lukkerhastigheten. Automatisk justering av 
lysstyrke ved hjelp av iris og ND-filter støttes.
ˎˎ Fra programvareversjon 4.0, fungerer automatisk 

justering av lysstyrke slik at bildet med bruk av LUT 
blir korrekt eksponert.

Valg av basisfølsomhet

Du kan velge mellom to typer basisfølsomhet 
på videokameraet.
I Custom-opptaksmodus kan du stille inn 
basisfølsomheten til High eller Low ved 
hjelp av Base ISO/Sensitivity på Main-
statusskjermbildet (side 14) eller Camera-
statusskjermbildet (side 14), eller ISO/Gain/
EI > Base Sensitivity (side 78) i Shooting-
menyen i hovedmenyen.
I Cine EI/Flexible ISO-opptaksmodus kan 
du stille inn basis-ISO som ISO 12800 eller 
ISO 800 ved hjelp av Base ISO/Sensitivity 
(side 14) på Main-statusskjermbildet eller 
Camera-statusskjermbildet (side 14), eller 
ISO/Gain/EI > Base ISO (side 78) i Shooting-
menyen i hovedmenyen.
I Cine EI Quick-opptaksmodus velges 
automatisk en basis-sensitivitet på ISO 12800 
eller ISO 800 som passer til Exposure Index-
innstillingen.
Det anbefales å velge Low eller ISO 800 under 
normale lysforhold og å velge High eller ISO 
12800 under dårlige lysforhold.

*	 kan også konfigureres på statusskjermen.

[Tips]
Du kan også tilordne Base ISO/Sensitivity til en knapp 
som kan tilordnes (side 49).

Justering av iris

Du kan justere irisblenderen for å justere 
lysstyrken.

Automatisk justering av iris

Denne funksjonen justerer lysstyrken i 
henhold til motivet. Det kreves et objektiv som 
støtter automatisk irisjustering.

1	 Hvis et objektiv med bryter for Auto Iris er 
montert, setter du bryteren til AUTO.

2	 Trykk og hold nede funksjonsknappen IRIS 
(E) for å vise hurtigmenyen (side 49), 
og velg Auto.

	 [Tips]
Du kan også tilordne Auto Iris til en knapp som kan 
tilordnes (side 49).

	 [Merk]
Iris kan ikke justeres automatisk på et objektiv med 
A-feste.

Manuell justering av iris

1	 Trykk og hold nede funksjonsknappen IRIS 
(E) for å vise hurtigmenyen (side 49), 
og velg Manual.

2	 Trykk på funksjonsknappen IRIS (E) slik at 
irisverdien vises på en hvit bakgrunn.

3	 Drei på flerfunksjonshjulet for å justere 
verdien.

	 [Tips]
ˎˎ Du kan også bruke flerfunksjonshjulet som 

et IRIS-hjul (side 49) ved å tilordne IRIS-
funksjonen til flerfunksjonshjulet.
ˎˎ Du kan også tilordne IRIS-funksjonen til et hjul 

som kan tilordnes (side 49).

Midlertidig automatisk justering

Trykk på knappen som kan tilordnes 
(side 49) som er tilordnet Push Auto Iris for 
å midlertidig justere iris automatisk mens du 
trykker på knappen.
Irisen går tilbake til sin tidligere innstilling når 
du slipper knappen.

[Merknader]
ˎˎ Når objektivets bryter for automatisk iris er satt 

til MANUAL, har funksjonene Auto Iris og Push 
Auto Iris på videokameraet ingen effekt. Manuelle 
irisjusteringer på videokameraet har heller ingen 
effekt.
ˎˎ Push Auto Iris kan ikke utføres når Iris > Bokeh Control 

(side 79) i Shooting-menyen er satt til On.

Justere forsterkningen

I Custom-/Flexible ISO-opptaksmodus, kan du 
justere forsterkningen for å justere lysstyrken.

Automatisk justering av forsterkningen

Trykk på og hold nede funksjonsknappen ISO/
GAIN (H) for å vise hurtigmenyen (side 49), 
og velg Auto.

[Tips]
ˎˎ Du kan også utføre den samme handlingen ved å 

sette Auto Exposure (side 79) > AGC på Shooting-
menyen til On.
ˎˎ Du kan også tilordne AGC til en knapp som kan 

tilordnes (side 49).

Manuell justering av forsterkningen

Du kan kontrollere forsterkningen når du vil 
justere eksponeringen mens du bruker en 
fast irisinnstilling, eller når du vil forhindre at 
forsterkningen øker på grunn av AGC.

1	 Trykk og hold nede funksjonsknappen 
ISO/GAIN (H) for å vise hurtigmenyen 
(side 49), og velg Manual.

2	 Sett ISO/GAIN-bryteren (I) til H, M eller L.

[Tips]
ˎˎ Du kan endre den forhåndsinnstilte verdien for hver 

bryterstilling ved hjelp av ISO/Gain<L>/<M>/<H> 
(side 14) på Camera-statusskjermen eller ISO/
Gain/EI >ISO/Gain<H>/<M>/<L> (side 77) på 
Shooting-menyen i hovedmenyen.
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ˎˎ Du kan også tilordne Push AGC til en knapp som kan 
tilordnes, og sette AGC midlertidig til On ved å trykke 
og holde knappen nede.

[Merknader]
ˎˎ Push AGC kan ikke utføres når Iris > Bokeh Control 

(side 79) i Shooting-menyen i hovedmenyen er 
satt til On.
ˎˎ Push AGC kan ikke utføres i Cine EI/Cine EI Quick-

opptaksmodus.

Kontrollere forsterkningen (finjustering)

1	 Trykk på funksjonsknappen ISO/GAIN (H) 
slik at forsterkningsverdien vises på en 
hvit bakgrunn.

2	 Drei på flerfunksjonshjulet for å justere 
verdien.

[Tips]
Endre den forhåndsinnstilte verdien for forsterkning i 
henhold til innstillingen av ISO/GAIN-bryteren (I).

Midlertidig kontroll av forsterkningen 
(finjustering)

Drei hjulet som kan tilordnes (side 49) 
som er tilordnet funksjonen ISO/Gain/EI for 
å justere forsterkningsverdien som er angitt 
med ISO/GAIN-bryteren (I).
Dette er nyttig når du vil justere 
eksponeringen med ett trinn uten å endre 
dybdeskarpheten.
Den justerte forsterkningsverdien annulleres 
ved å bruke ISO/GAIN-bryteren (I), endre 
basisfølsomheten, sett AGC til On eller slå av 
strømmen.

[Tips]
ˎˎ Du kan også tilordne denne funksjonen til 

flerfunksjonshjulet (side 49).
ˎˎ Du kan også tilordne Push AGC til en knapp som kan 

tilordnes, og sette AGC midlertidig til On ved å trykke 
og holde knappen nede.

[Merknader]
ˎˎ Push AGC kan ikke utføres når Iris > Bokeh Control 

(side 79) i Shooting-menyen i hovedmenyen er 
satt til On.
ˎˎ Push AGC kan ikke utføres i Cine EI/Cine EI Quick-

opptaksmodus.

Justere eksponeringsindeksen

I Cine EI/Cine EI Quick-opptaksmodus antas 
det at videoutgangen med MLUT er satt til 
Off tas opp som hovedsignal. Ved å endre 
lysstyrken på bildet med MLUT On (på) 
slik at det samsvarer med EI-verdien, kan 
du kontrollere resultatet av justeringen av 
eksponeringsfølsomheten som vil inntreffe i 
etterproduksjon, mens du fotograferer.
Du kan endre EI-verdien ved å sette ISO/GAIN-
bryteren (I) til H, M eller L.
I Cine EI Quick-opptaksmodus, kan du endre 
basisfølsomheten samtidig med EI-verdien.

[Tips]
Du kan endre EI-verdien for hver bryterstilling ved hjelp 
av ISO/Gain /EI (side 14) på Camera-statusskjermen 
eller ISO/Gain/EI > Exposure Index<H>/<M>/<L> 
(side 77) på Shooting-menyen i hovedmenyen.

Finjustering av eksponeringsindeksen

1	 Trykk på funksjonsknappen ISO/GAIN (H) 
slik at EI-verdien vises på en hvit 
bakgrunn.

2	 Drei på flerfunksjonshjulet for å justere 
verdien.

[Tips]
Endre den forhåndsinnstilte EI-verdien i henhold til 
innstillingen av ISO/GAIN-bryteren (I).

Justere lukkeren

Du kan justere lukkeren for å justere 
lysstyrken.

Automatisk justering av lukkeren

Trykk og hold nede funksjonsknappen 
SHUTTER (F) for å vise hurtigmenyen 
(side 49), og velg Auto for å justere 
lukkerhastigheten eller lukkervinkelen 
automatisk ut fra lysstyrken på bildet.

[Tips]
Du kan også utføre den samme handlingen ved å sette 
Auto Exposure > Auto Shutter (side 80) på Shooting-
menyen i hovedmenyen til On.

Manuell justering av lukkeren

1	 Trykk og hold nede funksjonsknappen 
SHUTTER (F) for å vise hurtigmenyen 
(side 49), og velg Speed eller Angle.

2	 Trykk på funksjonsknappen SHUTTER (F) 
slik at lukkerverdien vises på en hvit 
bakgrunn.

3	 Drei på flerfunksjonshjulet for å justere 
lukkerhastigheten.

[Tips]
ˎˎ Hvis du vil justere eksponeringstiden slik at den 

samsvarer med rammeintervallet, velger du Off (av) 
i trinn 1.
ˎˎ Du kan også stille inn vinkelen og justere frekvensen 

(side 78).

Justere lysnivået (ND-filter)

Under forhold der lyset er for skarpt, kan du 
angi riktig lysstyrke ved å endre ND-filteret.
Videokameraet har to ND-filtermoduser. Du 
kan veksle mellom de to modusene ved hjelp 
av bryteren ND PRESET/VARIABLE.

Justering i forhåndsinnstilt modus

Sett bryteren ND PRESET/VARIABLE (A) i 
PRESET posisjon, og sett opp-/nedknappene 
for ND FILTER POSITION (B) til en av følgende 
innstillinger.
Clear: Uten ND-filter
1: Transmisjonsgrad satt av ND Filter > 
Preset1 (side 78) på Shooting-menyen i 
hovedmenyen.
2: Transmisjonsgrad satt av ND Filter > 
Preset2 (side 78) på Shooting-menyen i 
hovedmenyen.
3: Transmisjonsgrad satt av ND Filter > 
Preset3 (side 78) på Shooting-menyen i 
hovedmenyen.

Justering i variabel-modus

Sett ND PRESET/VARIABLE-bryteren (A) til 
stillingen VARIABLE. Skift opp-/ned-bryterne 
for ND FILTER POSITION (B) CLEAR og On.

Justere lysnivået automatisk
Du kan sette Auto ND Filter til On for å aktivere 
automatisk eksponeringsjustering ved hjelp av 
ND-filteret.

1	 Trykk på knappen [+] for opp-/
nedknappene for ND FILTER POSITION (B) 
for å slå på bruk av ND-filter.

2	 Trykk og hold nede knappen ND VARIABLE 
AUTO (C) til Auto er valgt.
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Justere lysnivået manuelt

1	 Trykk på knappen [+] for opp-/
nedknappene for ND FILTER POSITION (B) 
for å slå på bruk av ND-filter.

2	 Trykk og hold nede ND VARIABLE AUTO-
knappen (C) til Manual er valgt.

3	 Drei ND VARIABLE-hjulet (D) for å justere 
filterets transmisjonsgrad.

[Tips]
Du kan også tilordne ND Filter-funksjonen til et hjul som 
kan tilordnes (side 49).

Midlertidig automatisk justering
Du kan tilordne Push Auto ND til en knapp 
som kan tilordnes (side 49), og sette Auto 
ND Filter midlertidig til On (på) ved å trykke og 
holde knappen nede. Når du slipper knappen, 
settes Auto ND Filter tilbake til Off.
Trykk på knappen [+] for opp-/nedknappene 
for ND FILTER POSITION (B) for å slå på bruk av 
ND-filter.

[Merknader]
ˎˎ Når ND-filteret settes til eller fra CLEAR under opptak, 

vises ND-filterrammen på bildet, og driftslyden 
inkluderes i lyden.
ˎˎ Push Auto ND kan ikke utføres når Iris >Bokeh Control 

(side 79) i Shooting-menyen er satt til On.

[Tips]
ˎˎ Du kan sette til CLEAR ved å dreie ND VARIABLE-hjulet 

(D) ned fra ND1/4. Å vri hjulet opp fra CLEAR setter 
ND1/4. Du kan deaktivere denne handlingen ved hjelp 
av ND Dial > CLEAR with Dial (side 102) i menyen 
Technical i hovedmenyen.
ˎˎ Du kan også tilordne ND Filter Position til en knapp 

som kan tilordnes (side 49), og trykke på knappen 
i stedet for å bruke knappene ND FILTER POSITION 
opp/ned til å endre innstillingen.  
Forhåndsinnstilt modus: Clear  Preset1  Preset2 
 Preset3  Clear… 
Variabel modus: Clear  On  Clear…
ˎˎ Du kan også tilordne Auto ND Filter til en knapp som 

kan tilordnes (side 49), og trykke på knappen for å 
skifte Auto ND-filter mellom On og Off.

ˎˎ Når du tar bilder av et motiv som er sterkt 
belyst, kan det at iris lukkes for mye føre til 
diffraksjonsutydelighet og gi et bilde som begynner 
å gli ut av fokus (typisk fenomen i videokameraer). 
Du kan undertrykke denne effekten for å få bedre 
opptaksresultater ved hjelp av ND-filteret.
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Du kan velge justeringsmodus i henhold til 
opptaksforholdene.

ATW (automatisk sporende 
hvitbalanse)

Denne funksjonen justerer hvitbalansen 
automatisk til et passende nivå.
Hvitbalansen justeres automatisk når 
fargetemperaturen på lyskilden endres.
Trykk og hold nede funksjonsknappen WHT 
BAL (G) for å vise hurtigmenyen (side 49) 
og velg ATW.
Du kan velge justeringshastighet (fem 
trinn) ved hjelp av White Setting > ATW 
Speed (side 81) på Shooting-menyen i 
hovedmenyen.

[Tips]
Du kan fryse den gjeldende hvitbalanseinnstillingen ved 
å tilordne ATW Hold-funksjonen til en knapp som kan 
tilordnes (side 49), og trykke på knappen som kan 
tilordnes for å sette ATW-modusen midlertidig på pause.

[Merknader]
ˎˎ ATW kan ikke brukes i Cine EI/Cine EI Quick-

opptaksmodus.
ˎˎ Det kan hende at det ikke er mulig å justere til riktig 

farge ved hjelp av ATW, avhengig av forholdene rundt 
lys og motiv.  
Eksempler:
–– Når én enkelt farge dominerer motivet, for 

eksempel himmel, hav, jord eller blomster.
–– Når fargetemperaturen er ekstremt høy eller 

ekstremt lav.
	 Hvis den riktige effekten ikke kan oppnås fordi ATW-

hastigheten for automatisk sporing er langsom eller 
av andre årsaker, kjører du automatisk hvitbalanse.

Justere hvitbalansen manuelt

1	 Når hvitbalansen er satt til ATW-modus, 
trykk og hold nede funksjonsknappen 
WHT BAL (G) for å vise hurtigmenyen 
(side 49), og velg W:P, W:A, eller W:B.

2	 Velg B, A eller PRESET med bryteren WHT 
BAL (J).
B: Minne B-modus
A: Minne A-modus
PRESET: Forhåndsinnstilt modus

[Tips]
ATW kan aktiveres for minne B ved å sette White Setting 
> White Switch<B> (side 81) på Shooting-menyen i 
hovedmenyen til ATW.

Minne A- / Minne B-modus
Denne modusen justerer hvitbalansen til 
innstillingen som er lagret i henholdsvis minne 
A eller B.

Forhåndsinnstilt modus
Denne modusen justerer fargetemperaturen til 
en forhåndsinnstilt verdi (standardinnstillingen 
er 3200K).

Endre standard forhåndsinnstilt verdi

I forhåndsinnstilt modus kan du endre en 
eksisterende forhåndsinnstilt verdi direkte.
Trykk og hold inne funksjonsknappen 
WHT BAL (G) og velg ett av følgende i 
hurtigmenyen.
Custom:  3200K,  4300K,  5600K, 

 6300K
Log-opptak:  3200K,  4300K,  5500K

[Tips]
Du kan også tilordne Preset White Select til en knapp 
som kan tilordnes (side 49), og trykke på knappen for 
å endre innstillingen.
Custom: 3200K  4300K  5600K  6300K 
 3200K…

Log-opptak: 3200K  4300K  5500K  3200K…

Endre fargetemperaturen

1	 Trykk på funksjonsknappen WHT BAL (G) 
slik at fargetemperaturverdien vises på en 
hvit bakgrunn.

2	 Drei på flerfunksjonshjulet for å justere 
verdien.

[Tips]
ˎˎ I forhåndsinnstilt modus kan du angi verdien i 

100K-enheter.
ˎˎ I minnemodus kan du angi verdien i trinn på 20K i 

området 2000K til 5600K. Verdier over 5600K kan 
stilles inn med intervaller som tilsvarer mengden 
fargeendring (mired) fra 5580K til 5600K. Du kan 
også justere fargenyanseverdien ved hjelp av 
White (side 80) > Tint på Shooting-menyen i 
hovedmenyen.

Kjøre automatisk hvitbalanse

Hvitbalansen som skal lagres i minne A-/
minne B-modus konfigureres automatisk.

1	 Velg minne A-modus eller minne 
B-modus.

2	 Legg hvitt papir (eller andre objekter) på 
et sted med samme lyskilde og under 
samme forhold som motivet, og zoom 
deretter inn på papiret for å vise hvitt på 
skjermen.

3	 Justere lysstyrken.
Justere iris med prosedyre i "Manuell 
justering av iris" (side 43).

4	 Trykk på WB SET-knappen (side 4).
ˎˎ Hvis automatisk hvitbalanse kjøres 
i minnemodus, lagres resultatet av 
automatisk justering i minnet (A eller B) 
som er valgt i trinn 1.
ˎˎ Hvis automatisk hvitbalanse kjøres i 
ATW-modus vil resultatet bli overtatt 
og ATW gjenopptas når automatisk 
justering avsluttes. Dette er nyttig når 
du vil justere hvitbalansen veldig raskt, 
uavhengig av ATW Speed-innstillingen.

[Merk]
Hvis justeringen ikke er vellykket, vises det en 
feilmelding på skjermen i ca. tre sekunder. Hvis 
feilmeldingen vedvarer etter gjentatte forsøk på å stille 
inn hvitbalanse, kontakt en servicerepresentant for Sony.

Justere for naturlige farger (hvitbalanse)
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Du kan angi lyden som skal tas opp, ved hjelp 
av inngangskontakter, brytere og hjul på 
videokameraet.

Eksterne lydinngangskontakter og 
valgbrytere

INPUT1-kontakt (side 7)
INPUT2-kontakt (side 7)
Flergrensesnittsko (side 7)
INPUT1-bryter (LINE/MIC/MIC+48V) (side 7)
INPUT2-bryter (LINE/MIC/MIC+48V) 
(side 7)

Brytere for innstilling av lydnivå

CH1 (AUTO/MAN)-bryter (side 6)
CH2 (AUTO/MAN)-bryter (side 6)
AUDIO LEVEL (CH1)-hjul (side 6)
AUDIO LEVEL (CH2)-hjul (side 6)

Audio-statusskjermen

Velge enheten for lydinngang

1	 Angi lydinngangen ved hjelp av CH1/CH2/
CH3/CH4 >Source (side 14) på Audio-
statusskjermen eller Audio Input > CH1 
Input Select til CH4 Input Select 
(side 99) på Audio-menyen i 
hovedmenyen.
Hvis du bruker mikrofon eller XLR-adapter 
koblet til flergrensesnittskoen, angi Shoe 
CH1 eller Shoe CH2. For mer informasjon 
om XLR-adapteren, se "Legge til 
lydinngangkontakter" (side 48).

	 [Merknader]
ˎˎ Lyd tas ikke opp i intervallopptaksmodus eller 

sakte og hurtig film.
ˎˎ Videokameraet har en innebygd lydmikrofon 

for opptak av omgivelseslyd. Det kan brukes til 
synkronisering av tidsberegningen med annet 
utstyr. I slike tilfeller angir du Internal MIC.
ˎˎ Bare den interne mikrofonen på håndtaket 

(side 7) aktiveres for lydopptak når håndtaket 
er tilkoblet. Når håndtaket ikke er festet, kan 
lydmikrofonen (side 6) for opptak av 
omgivelseslyd brukes.
ˎˎ Når CH1 Input Select og CH2 Input Select er satt til 

Internal MIC, justeres opptaksnivået for både CH1 
og CH2 med hjulet AUDIO LEVEL(CH1) (side 6). 
Når CH3 Input Select og CH4 Input Select er satt 
til Internal MIC, justeres lydopptaksnivået for 
både CH3 og CH4 ved hjelp av CH3 Input Level 
(side 99).

2	 Velg inngangslydkilden.
Still inn bryterne INPUT1/INPUT2 (LINE/
MIC/MIC+48V) til enhetene som er koblet 
til henholdsvis INPUT1/INPUT2-
kontaktene.

Tilkoblet enhet Bryterstilling

Ekstern lydkilde (f.eks. 
mikser)

LINE

Dynamisk mikrofon, 
batteridrevet mikrofon

MIC

+48 V fantommatet 
mikrofon

MIC+48V

ˎˎ Hvis du velger MIC+48V og kobler til en 
mikrofon som ikke er kompatibel med en 
+48V-kilde, kan den tilkoblede enheten 
bli skadet. Kontroller innstillingen før du 
kobler til enheten.
ˎˎ Hvis det er støy på kontakter uten 
tilkoblet enhet, stiller du inn den 
tilsvarende INPUT1/INPUT2 (LINE/MIC/
MIC+48V) til LINE.

Justere nivået for lydopptak 
automatisk

Angi CH1/CH2 (AUTO/MAN)-bryterne for 
kanalene som skal justeres automatisk til 
AUTO.
For CH3/CH4 stiller du lydnivåkontrollen på 
Audio-statusskjermen (side 14) eller Audio 
Input > CH3 Level Control og CH4 Level Control 
i Audio-menyen i hovedmenyen til Auto 
(side 99).

Justere nivået for lydopptak 
manuelt

Bruk følgende fremgangsmåte for å justere 
nivået for lydopptak for CH1/CH2.

1	 Sett CH1/CH2 (AUTO/MAN)-bryterne for 
kanalene som skal justeres manuelt til 
MAN.

2	 Under opptak eller i standby vrir du 
hjulene for AUDIO LEVEL (CH1)/(CH2) for 
de tilsvarende kanalene for å justere 
lydnivået.
ˎˎ For CH3/CH4 stiller du lydnivåkontrollen 
ved hjelp av CH3/CH4 (side 14) på 
Audio-statusskjermbildet eller Audio 
Input > CH3 Level Control eller CH4 Level 
Control i Audio-menyen i hovedmenyen 
til Manual, og juster deretter nivået for 
lydopptak ved hjelp av CH3 Input Level 
eller CH4 Input Level.
ˎˎ Du kan justere nivåene for CH1 til 
CH4 som en gruppe. Du kan justere 
opptaksnivået ved hjelp av et hjul 
(side 49) som er tilordnet med 
funksjonen Audio Input Level, Audio-
statusskjermen eller Audio Input > 
Audio Input Level i Audio-menyen i 
hovedmenyen.

[Tips]
Audio-statusskjermen er nyttig for å kontrollere nivået 
på lydinngangen (side 14).

[Merknader]
ˎˎ Innstillingene for Audio Input Level kan deaktiveres, 

avhengig av innstillingskombinasjonen i Audio-
menyen. Du finner mer informasjon i tegningen på 
side 138.
ˎˎ Videokameraet støtter kombinasjoner av ulike 

innstillinger. Du finner mer informasjon i tegningen 
på side 138.

Angi at lyden skal tas opp
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Legge til lydinngangkontakter

Du kan koble opptil fire kanaler med XLR-
lydenheter til videokameraet samtidig ved å 
bruke en XLR-K2M XLR-adapter (følger ikke 
med) eller XLR-K3M XLR-adapter (følger ikke 
med).
Fest XLR-adapteren til flergrensesnittskoen 
og still CH3 > Source til Shoe CH1 og CH4 
>Source til Shoe CH2 på Audio-statusskjermen 
(side 14). Eller du kan stille Audio Input 
> CH3 Input Select til Shoe CH1 og CH4 
Input Select til Shoe CH2 i Audio-menyen i 
hovedmenyen.
Videokamerafunksjoner som overlapper blir 
deaktivert for kanaler der XLR-adapteren 
velges som inngang. Bruk bryterne og hjulene 
på XLR-adapteren til å utføre justeringer.

[Merknader]
ˎˎ Videokameraet støtter digitalt 2-kanals lydgrensesnitt 

til XLR-K3M.
ˎˎ Hvis Audio Input > CH3 Level og CH4 Level i Audio-

menyen er satt til Audio Input Level, så multipliseres 
Audio Input Level på videokameraet med nivået som 
justeres på XLR-adapteren.  
Audio Input Level aktiveres også når XLR-
adapterbryteren er satt til AUTO.  
Når Through (gjennom) er angitt, tas det opp lyd med 
nivået som justeres med XLR-adapteren (side 139).
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Nyttige funksjoner

Bruk av hurtigmenyen

Du kan kontrollere statusen og innstillingene 
til videokameraet som vises på søkerskjermen, 
og velge og endre innstillingene direkte.
Følgende elementer kan konfigureres.
ˎˎ Face/Eye Detection AF
ˎˎ SteadyShot
ˎˎ White Mode
ˎˎ Color Temp
ˎˎ Scene File
ˎˎ ND Filter Position / Auto ND Filter
ˎˎ ND Filter Value
ˎˎ Auto Iris
ˎˎ Iris Value
ˎˎ AGC
ˎˎ Gain Value
ˎˎ ISO Value
ˎˎ Exposure Index Value
ˎˎ Auto Shutter / ECS
ˎˎ Shutter Value
ˎˎ Auto Exposure Mode
ˎˎ Auto Exposure Level
ˎˎ S&Q Motion Frame Rate

1	 Trykk på flerfunksjonshjulet, eller en 
tilordnet knapp med Direct Menu-
funksjonen tilordnet.
Bare elementer på skjermen som kan 
konfigureres ved hjelp av hurtigmenyen, 
kan velges med den oransje markøren.

2	 Vri på flerfunksjonshjulet for å flytte 
markøren til menyelementet som skal 
brukes, og trykk deretter på 
flerfunksjonshjulet.
Det vises en meny, eller elementet vises 
på hvit bakgrunn.

3	 Drei flerfunksjonshjulet for å velge en 
innstilling, og trykk deretter på 
flerfunksjonshjulet.
Menyen eller den hvite bakgrunnen 
forsvinner, og den nye innstillingen vises 
med en oransje markør.
Trykk på knappen som er tilordnet Direct 
Menu igjen, eller vent i 3 sekunder uten å 
utføre noen handling for å gå ut av 
hurtigmenyen.

	 [Tips]
ˎˎ Direkteinnstillinger kan også konfigureres 

ved å trykke på og holde inne hver av 
funksjonsknappene (side 5).
ˎˎ Når elementer vises på hvit bakgrunn, kan 

flerfunksjonshjulet brukes som et hjul som kan 
tilordnes.
ˎˎ Flervalg-knappen (side 9) kan også brukes til 

å velge handlinger.

Knapper/hjul som kan tilordnes

Det er ni knapper på videokameraet  
som kan tilordnes forskjellige funksjoner (side 
6, 7, 9).
Du kan også tilordne funksjoner til 
flerfunksjonshjulet på videokameraet 
(side 5), det programmerbare hjulet på 
håndtaket (side 7) og det programmerbare 
hjulet på grepfjernkontrollen (side 9).

Endre knappefunksjonen

Bruk Assignable Button (side 87) i menyen 
Project i hovedmenyen.
Du kan vise de tilordnede funksjonene på 
Assignable Button-statusskjermen (side 15).

Funksjoner som er tilordnet hver enkelt knapp 
som kan tilordnes som standard
Knapp 1	 S&Q Motion
Knapp 2	 AF Speed/Sens.
Knapp 3	 Focus Setting
Knapp 4	 Focus Magnifier x3/x6
Knapp 5	 Direct Menu
Knapp 6	 Off
Knapp 7	 Focus Magnifier x3/x6
Knapp 8	 Direct Menu
Knapp 9	 Video Signal Monitor
Focus Hold-knapp	 Focus Hold

Funksjoner som kan tilordnes
ˎˎ Off
ˎˎ Base ISO/Sensitivity
ˎˎ AGC
ˎˎ Push AGC
ˎˎ ND Filter Position
ˎˎ Auto ND Filter
ˎˎ Push Auto ND
ˎˎ Auto Iris
ˎˎ Push Auto Iris
ˎˎ Bokeh Control
ˎˎ Auto Shutter
ˎˎ Auto Exposure Level
ˎˎ Backlight
ˎˎ Spotlight
ˎˎ Preset White Select
ˎˎ ATW
ˎˎ ATW Hold
ˎˎ AF Speed/Sens.
ˎˎ Focus Setting
ˎˎ Focus Area
ˎˎ Focus Area(AF-S)
ˎˎ Face/Eye Detection AF
ˎˎ Push AF Mode
ˎˎ Push AF/Push MF
ˎˎ Focus Hold
ˎˎ Focus Magnifier x3/x6
ˎˎ Focus Magnifier x3
ˎˎ Focus Magnifier x6
ˎˎ S&Q Motion
ˎˎ SteadyShot

ˎˎ Rec
ˎˎ Picture Cache Rec
ˎˎ Rec Review
ˎˎ Clip Flag OK
ˎˎ Clip Flag NG
ˎˎ Clip Flag Keep
ˎˎ Color Bars
ˎˎ Tally [Front]
ˎˎ DURATION/TC/U-BIT
ˎˎ Display
ˎˎ Lens Info
ˎˎ Video Signal Monitor
ˎˎ Marker
ˎˎ VF Adjust
ˎˎ VF Mode
ˎˎ Gamma Display Assist
ˎˎ Peaking
ˎˎ Zebra
ˎˎ Volume
ˎˎ Thumbnail
ˎˎ Touch Operation
ˎˎ Handle Zoom
ˎˎ NFC
ˎˎ Auto Upload (Proxy)
ˎˎ Direct Menu
ˎˎ User Menu
ˎˎ Menu

Endre hjulfunksjonen

Du kan endre funksjonen til 
multifunksjonshjulet på videokameraet, det 
programmerbare hjulet på grepet og det 
programmerbare hjulet på håndtaket.

For flerfunksjonshjulet angis dette ved hjelp av 
funksjonen Multi Function Dial (side 90) > 
Default Function i menyen Project.
Standardinnstillingen er Off.
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Funksjon som kan tilordnes til 
flerfunksjonshjulet
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level

[Merk]
Innstillingen er deaktivert mens menyen vises.

For hjulet som kan tilordnes, angi funksjonen 
med Assignable Dial (side 89) på Project-
menyen i hovedmenyen.
IRIS er tilordnet til alle som fabrikkinnstilling.

[Tips]
Hjulet som kan tilordnes på RM-30BP (tilleggsutstyr) 
følger innstillingen Grip/Remote Dial.

Funksjoner som kan tilordnes det 
programmerbare hjulet på håndtaket/grepet
ˎˎ Off
ˎˎ ISO/Gain/EI
ˎˎ ND Filter
ˎˎ IRIS
ˎˎ Auto Exposure Level
ˎˎ Audio Input Level
ˎˎ Multi Function Dial

Du kan vise de tilordnede funksjonene på 
Assignable Button-statusskjermen (side 15).

Sakte og rask bevegelse

Når opptaksformatet (side 84) er satt til følgende verdier, kan du angi forskjellige verdier for 
bildefrekvensen ved opptak og bildefrekvensen for avspilling.

Opptaksformat Bildefrekvens

Systemfrekvens Bildeskannermodus Kodek Videoformat

59.94/50/29.97/ 
25/23.98

FF RAW 3840×2160P 1–60, 100, 120

RAW & XAVC-I 3840×2160P 1–60, 100, 120

XAVC-I 4096×2160P 1–60

3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

XAVC-L 3840×2160P 1–60, 100, 120

1920×1080P 1–60, 100, 120, 150, 
180, 200, 240

S35 XAVC-I 1920×1080P 1–60, 100, 120

XAVC-L 1920×1080P 1–60, 100, 120

24 FF XAVC-I 4096×2160P 1–60

Du kan slå sakte og rask bevegelse av/på 
ved å trykke på en knapp som kan tilordnes 
(side 49) som er tilordnet S&Q Motion-
funksjonen.
Du kan angi bildefrekvensen for opptak ved å 
trykke på og holde inne knappen.

[Tips]
Du kan også stille inn modusen med S&Q Frame Rate 
på Main-statusskjermen, Rec Function på Project-
statusskjermen, og S&Q Motion i Shooting-menyen i 
hovedmenyen.

[Merknader]
ˎˎ Sakte og rask bevegelse kan ikke angis under opptak, 

avspilling eller mens miniatyrbildeskjermen vises.
ˎˎ Lydopptak støttes ikke i sakte- og rask 

bevegelsesmodus.
ˎˎ Autoirisfunksjonen og den automatiske 

lukkerfunksjonen er i Slow & Quick Motion-modus.

ˎˎ Autofokusfunksjonen har følgende begrensninger i 
Slow & Quick Motion-modus.
–– Begrensninger på grunn av objektivmodell, 

systemfrekvens og opptakets bildefrekvens

Sony-
objektiv

Systemfrekvens AF-
tilgjengelighet

Annet enn 
SEL16F28

– 7 fps eller 
høyere støttes

SEL16F28 59.94/29.97/ 
23.98

30, 60, 120, 
240 fps støttes

50.00/25.00 25, 50, 100, 
200 fps støttes

24.00 Ikke støttet

–– Autofokusfunksjonen er midlertidig deaktivert hvis 
iris er satt til F18 eller høyere.

ˎˎ For mer informasjon om bruk av RAW-data, se side 
59.

Opptak av video med jevne 
mellomrom (intervallopptak)

Videokameraets funksjon for intervallopptak 
(Interval Rec) kan brukes til tidsforkortet 
opptaksvideo i videokameraets interne minne. 
Denne funksjonen er en effektiv måte å ta 
bilder av motiver i sakte film på.
Når du starter opptaket, tar videokameraet 
automatisk opp et angitt antall bilder med et 
angitt tidsintervall.

Fotograferingsintervall (Interval Time)

Antall bilder i ett opptak
(Number of Frames)

Når Interval Rec er aktivert, slås HVL-LBPC 
videolyset (tilleggsutstyr) automatisk på 
før opptaket starter. Dette gjør at du kan ta 
opp bilder under forhold med stabile lys- og 
fargetemperatur (forhåndslysfunksjon).

[Merknader]
ˎˎ Bare én spesiell opptaksfunksjon, for eksempel 

intervallopptak, kan brukes om gangen.
ˎˎ Hvis en annen spesiell opptaksmodus er aktivert 

mens Interval Rec er i bruk, frigjøres Interval Rec 
automatisk.
ˎˎ Modusen for intervallopptak frigis automatisk når 

du har endret systeminnstillinger, for eksempel 
videoformatet.
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ˎˎ Innstillinger for intervallopptak kan ikke endres under 
opptak eller avspilling, eller når miniatyrbildeskjermen 
vises.

For å angi intervallopptak

Velg Rec Function >Interval Rec på Project 
status-skjermen og konfigurer innstillingene 
for Number of Frames og Interval Time.
Hvis du bruker HVL-LBPC-videolyset 
(tilleggsutstyr), angir du tidsintervallet for å slå 
på videolyset før du begynner opptaket med 
Interval Rec >Pre-Lighting i menyen Project 
etter behov.

[Tips]
Du kan også stille inn modusen med Interval Rec 
(side 86) i menyen Project i hovedmenyen.

[Merknader]
ˎˎ Hvis du vil slå på videolyset før opptaket starter, 

setter du videolysbryteren til AUTO. Videolyset slås 
automatisk av og på i henhold til innstillingen for 
Video Light Set (side 104) i menyen Technical.
ˎˎ Hvis du slår på videolysbryteren, lyser videolyset alltid 

(videolyset slås ikke av/på automatisk).
ˎˎ Hvis videolyset er konfigurert slik at det slås av i 5 

sekunder eller mindre, slås ikke videolyset av.

Videokameraet går ut av modusen for Interval 
Rec når det slås av, men innstillingene for 
Number of Frames, Interval Time, og Pre-
lighting opprettholdes. Du trenger ikke å angi 
dem igjen nest gang du tar bilder i Interval 
Rec-modus.

For å gjøre opptak med Interval Rec

Trykk knappen opptak START/STOP for å 
begynne å ta opp. "Int Rec" og "Int Stby" 
vises vekselvis i søkeren.
Hvis du bruker funksjonen for 
forhåndsbelysning, slås videolyset på før 
opptaket starter.

For å stoppe opptaket

Avslutt opptaket.
Når opptaket er ferdig, skrives videodataene 
som er lagret i minnet så langt til mediet.

Avslutte modus for intervallopptak

Gjør ett av følgende.
ˎˎ Slå POWER-bryteren av.
ˎˎ I standby-modus for opptak, sett Rec 
Function til en annen innstilling enn Interval 
Rec på Project-statusskjerm.

Modusen for intervallopptak frigis automatisk 
når videokameraet startes på nytt.

Begrensninger under opptak

ˎˎ Lyd tas ikke opp.
ˎˎ Det er ikke mulig å gå gjennom opptaket 
(Rec Review).

Hvis videokameraet slås av under 
opptak

ˎˎ Hvis POWER-bryteren på videokameraet 
settes til av-stillingen, holdes mediene åpne 
i flere sekunder for å registrere bildene 
som lagres i minnet, til det øyeblikket, og 
deretter slås strømmen av automatisk.
ˎˎ Hvis strømmen forsvinner fordi batteriet 
ble tatt ut, likestrømledningen ble koblet 
fra, eller strømmen ble slått av ved 
strømadapteren, kan video- og lyddata som 
er tatt opp til dette tidspunktet, gå tapt 
(maksimalt 10 sekunder). Vær forsiktig når 
du bytter batteri.

Opptak av cachet-bilder (Picture 
Cache Rec)

Funksjonen Picture Cache Rec lar deg ta opp 
video retroaktivt når du starter opptak ved å 
opprettholde et internt cache-minne av en 
spesifisert varighet under opptak.
Sett Picture Cache Rec til On i Project-
statusskjermen, og angi deretter cache-
størrelsen.

Cache Size-
innstilling

Cache-tid (cirka)

Short 5 sekunder

Medium 10 sekunder

Long 20 sekunder

Maks Maksimum verdi for hvert 
opptaksformat

[Tips]
ˎˎ Cache-tiden kan være kortere, avhengig av opptakets 

bildefrekvens og opptaksformatet. Kontroller feltet 
for Picture Cache Rec på Project-statusskjermen 
eller displayet nede til høyre for oppsettskjermen for 
cache-størrelse.
ˎˎ Du kan også stille inn modusen med Picture Cache 

Rec (side 86) i menyen Project i hovedmenyen.
ˎˎ Du kan også veksle Picture Cache Rec mellom On og 

Off med en tilordningsbar knapp (side 49).

[Merknader]
ˎˎ Picture Cache Rec kan ikke brukes i kombinasjon med 

Interval Rec, 2-spors samtidig opptaksfunksjon eller 
Proxy-opptak. Når Picture Cache Rec er satt til On, 
settes disse andre opptaksfunksjonene automatisk 
til Off.
ˎˎ Picture Cache Rec-modus kan ikke velges under 

opptak eller når Rec Review er aktiv.
ˎˎ Når Picture Cache Rec er satt til On, registreres 

tidskoden i Free Run-modus selv om innstillingen er 
satt til Regen eller Rec Run (side 94).
ˎˎ Innstillingen for Output Format er kanskje ikke 

konfigurerbar i Picture Cache Rec-modus. Hvis dette 
skjer skal du midlertidig sette Picture Cache Rec til 
Off, og så endre innstillingen.

Starte Picture Cache Rec

Når Picture Cache Rec er satt til On, vises 
"Cache" ( er grønn) i søkeren.
Når du trykker på START/STOP-knappen for 
opptak, starter opptaket og video lagres på 
minnekort, med start fra video som er lagret i 
cache-minnet.

Avslutte Picture Cache Rec

Sett Picture Cache Rec til Off på Project-
statusskjermen, eller trykk på den 
tilordningsbare knappen som er tilordnet 
Picture Cache Rec-funksjonen.

[Merknader]
ˎˎ Endring av opptaksformatet eller det grunnleggende 

utseendet sletter videoen i cache-minnet som er 
lagret frem til dette tidspunktet, og starter cache-
lagring av ny video. Konsekvensen er at bildeopptak 
til cache av bilder før endring av format ikke er mulig, 
heller ikke hvis du starter opptak umiddelbart etter 
endring av format.
ˎˎ Hvis Picture Cache Rec er satt til On eller Off 

umiddelbart etter innsetting av minnekort, kan det 
hende at cache-data ikke blir tatt opp på kortet.
ˎˎ Video lagres i cache-minnet når Picture Cache Rec-

funksjonen er satt til On. Video fra før funksjonen blir 
satt til On lagres ikke i cache.
ˎˎ Video lagres ikke i cache-minnet mens et minnekort 

brukes, som f.eks. under avspilling, Rec Review eller 
visning av miniatyrbildeskjermen. Bildeopptak til 
cache av video i dette tidsintervallet er ikke er mulig.
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Ta opp på minnekort A og B 
samtidig (opptak med to spor)

Du kan ta opp på både minnekort A og 
minnekort B samtidig ved å angi samtidig 
opptak med Simul Rec (side 15) på 
skjermbildet for Project status eller ved å sette 
Simul Rec > Setting (side 86) på Project-
menyen i hovedmenyen til On.

Separat opptak til minnekort A og 
minnekort B

Du kan starte/stoppe opptak til hvert 
minnekort uavhengig ved å bruke opptak 
START/STOP-knappene på videokameraet og 
håndtaket.
Med fabrikkinnstilling er begge knappene satt 
for samtidig å starte/stoppe opptak til begge 
minnekort, A og B.
ˎˎ ”Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB]”

Når knappene er stilt inn for å styre opptak 
for forskjellige minnekort, vil SDI/HDMI Rec 
Control (side 87) følge styringen av start/
stopp opptakstilstanden for spor A.

For å endre innstillingen

Velg Simul Rec >Rec Button Set (side 86) i 
Project-menyen.

Rec Button Set Knapper og 
minnekort

"Rec Button:[SlotA 
SlotB] Handle Rec 
Button:[SlotA SlotB]"

Starter/stopper 
simultant opptak til 
minnekort A og B ved 
bruk av en av 
knappene.

"Rec Button:[SlotA] 
Handle Rec Button: 
[SlotB]"

START/STOP-knappen 
for opptak starter/
stopper opptak til 
minnekort A, og 
START/STOP-knappen 
for opptak på 
håndtaket starter/
stopper opptak til 
minnekort B.

"Rec Button:[SlotB] 
Handle Rec 
Button:[SlotA]"

START/STOP-knappen 
for opptak starter/
stopper opptak til 
minnekort B, og 
START/STOP-knappen 
for opptak på 
håndtaket starter/
stopper opptak til 
minnekort A.

[Tips]
Opptaksknappen på håndtakets fjernkontroll eller LANC-
fjernkontrollen fungerer på samme måte som enhetens 
START/STOP-knapp for opptak.

For å hindre utilsiktet betjening av 
håndtakets START/STOP-knapp for 
opptak

Sett håndtakets HOLD-bryter til HOLD-
posisjon.

[Merk]
Håndtakets HOLD-bryter fungerer ikke når HOLD Switch 
Setting (side 102) >with Rec Button er satt til Off i 
Technical-menyen i hovedmenyen. Når den er satt til On, 
sett Handle HOLD Switch-funksjonen til Rec Button Only.

For å aktivere zoom-spaken og andre knapper 
enn håndtakets START/STOP-knapp for 
opptak, sett HOLD Switch Setting >Handle 
HOLD Switch til Rec Button Only.

Om filnavnet

I 2-spors samtidig opptak vil det genererte 
klippet ha samme klippnavn på begge 
medier. Klippnavnet vil være det samme som 
klippnavnet ved opptakt til spor A under 
normalt opptak.

Videosignalskjerm

Du kan angi typen videosignal som vises 
på søkerskjermen til kurve, vektorskop eller 
histogram ved hjelp av Display On/Off > Video 
Signal Monitor (side 97) i Monitoring-
menyen.
Den oransje linjen viser innstillingsverdien for 
zebra-nivået.
Du kan også tilordne Video Signal Monitor-
funksjonen til en tilordningsbar knapp 
(side 49).

Visning av skjermmål

I Log-opptaksmodus vises informasjon om 
fargeskalainnstillingen (side 24) eller 
skjerm-LUT-innstillingen (side 82)  øverst 
til høyre i videosignalskjermen for å angi 
skjermmålet.

Gamma Display Assist-funksjon

I Custom-opptaksmodus (side 24), når 
Target Display er satt til HDR(HLG), kan du 
sette Gamma Display Assist* på Monitoring-
statusskjermen til On for å vise skjermhjelp i 
søkeren som gjøre det enklere med opptak i 
HDR.
*	 Du kan også stille inn funksjonen med Gamma 

Display Assist >Setting (side 98) i Monitoring-
menyen i hovedmenyen.

Velge søkerdisplayet når Gamma 
Display-skjermhjelpen er aktivert

Det finnes to displaymetoder som støttes for 
visning av HDR-bilder i søkeren når Gamma 
Display-skjermhjelpen er aktivert.

Visning av HDR med opprettholdt kontrast 
mellom områder med lav belysning og 
områder med høy belysning
Denne metoden benytter seg av den 
ekspressive kraften i HDR for å vise bilder 
i søkeren uten å gi "crushed blacks" eller 
"blown out highlights", selv under opptak 
med lys eller mørk eksponering. Kontrasten er 
imidlertid litt redusert.
For å bruke denne visningsmetoden, sett HDR 
Setting >VF SDR Preview (side 86) til Off i 
Project-menyen i hovedmenyen.
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Vise SDR med enkel konvertering fra HDR til 
SDR
Denne metoden lar deg betjene kameraet 
med den samme følelsen som i konvensjonell 
SDR.
Du kan justere lysstyrken i HDR-bildet ved å 
stille inn differansen i Gain mellom HDR og 
SDR med SDR Gain.
For å bruke denne visningsmetoden skal du 
konfigurere følgende prosedyre.

1	 Sett HDR Setting >VF SDR Preview 
(side 86) til On i Project-menyen i 
hovedmenyen.

2	 Juster SDR Gain-verdien i HDR-modus 
med HDR Setting >SDR Gain (side 86) i 
Project-menyen i hovedmenyen.

[Tips]
Ved konvertering fra et HDR-bilde til SDR ved hjelp 
av SR Live Metadata etter opptak, brukes SDR Gain til 
konvertering slik at SDR-bildevisningen har den samme 
eksponeringen som ble vist i søkeren på tidspunktet for 
opptak.

Klippflagg

Du kan legge til et OK klippflagg for et klipp 
ved å trykke på Clip Flag-knappen (side 5) 
og velge Add OK.
Du kan slette et OK-klippflagg ved å trykke to 
ganger på knappen og velge Delete Clip Flag.

[Tips]
ˎˎ Du kan også bruke en tilordnet knapp med klippflagg-

funksjonen for å legge til klippflagg (side 49).
ˎˎ Du kan også legge til et klippflagg ved hjelp av 

Set Clip Flag (side 101) i Thumbnail-menyen i 
hovedmenyen (side 70).
ˎˎ Miniatyrbildeskjermen kan vises som sortert på 

Klippflagg-type (miniatyrbildebildeskjerm med 
filtrerte klipp). Du finner mer informasjon på "Klipp-
handlinger" (side 70).

Pust-kompensering

Du kan stille inn om det skal utføres pust-
kompensering for objektivet med Lens 
>Breathing Compensation (side 103) i 
Technical-menyen i hovedmenyen.
Denne funksjonen korrigerer for fenomenet 
der endringer i synsvinkelen inntreffer når 
fokusposisjonen varierer.
Når pust-kompensering utføres, blir en del av 
bildet beskåret elektronisk for å opprettholde 
en konstant synsvinkel slik at pust-fenomenet 
ikke vises.

[Merknader]
ˎˎ Når pust-kompensering er aktivert kan synsvinkelen 

og bildekvaliteten endre seg litt.
ˎˎ Avhengig av objektivet vil det kanskje ikke være 

mulig å korrigere endringen i synsvinkel når pust-
kompensering er aktivert.
ˎˎ Kompensering er ikke mulig når et objektiv som ikke 

støtter pust-kompensering er montert.
ˎˎ Denne funksjonen er satt til Off (fast) i følgende 

tilfeller.
–– Når Lens >Distortion Comp. i Technical-menyen er 

satt til Off
–– Når S&Q Motion >Setting i Shooting-menyen er 

satt til On
–– Når Rec Format >Codec på Project-menyen er satt 

til RAW, eller et alternativ som inkluderer RAW

Justere Bokeh (Bokeh-
kontrollfunksjon)

Du kan enkelt justere graden av Bokeh ved å 
lenke ND-filteret og Gain til bruk av Iris.

Slå Bokeh-kontrollfunksjonen av/på

Denne funksjonen kan kun aktiveres når 
eksponering justeres manuelt. Sett ND-filteret 
til variabel modus, og sett deretter Iris-, Gain-, 
Lukker- og ND-filter til manuell justering.
Du kan slå Bokeh-kontrollfunksjonen av/
på med Iris >Bokeh Control (side 79) i 
Shooting-menyen i hovedmenyen.
Når Bokeh-kontrollfunksjonen er satt til On, 
vises et -ikon på ND-filteret og Gain-
indikatorer. 

[Tips]
Du kan også tilordne Bokeh Control-funksjonen til 
en tilordningsbar knapp (side 49) og skifte Bokeh-
kontrollfunksjonen mellom On og Off ved hjelp av 
knappen.

Justere graden av Bokeh

1	 Sett Bokeh-kontrollfunksjonen til On.

2	 Åpne iris fullstendig. 

3	 Sett ND-filteret til 1/128. 

4	 Sett forsterkningen til 0 dB og bruk 
belysning for å justere eksponeringen. 

5	 Juster fokuset.

6	 Justere Iris.
Graden av Bokeh endres.

[Tips]
ˎˎ Når Bokeh-kontrollfunksjonen er satt til On, vil ND-

filteret og Gain fungere sammen for å kompensere 
endringer i eksponering på grunn av Iris-justering, og 
gi deg mulighet til å endre graden av Bokeh.
ˎˎ Bokeh-kontrollen er først lenket til ND-filteret som 

respons til bruk av Iris. Når ND-filteret ikke lenger kan 
endres, lenkes det til Gain.
ˎˎ I MF-modus anbefales det at du først åpner Iris og så 

justerer fokuset.
ˎˎ Hvis du bruker auto ND-filteret istedenfor Bokeh-

kontrollfunksjonen, vil ND-filteret følge endringen i 
lysstyrke på motivet.

Display under bruk av Gain link

Når Bokeh-kontrollfunksjonen er satt til On, 
kan Gain endre seg når Iris justeres.
Når Gain link er aktivert og Gain endres, vises 
en melding øverst i skjermen og et -ikon 
på Gain-indikatoren blinker. 

[Merknader]
ˎˎ Denne funksjonen er kun aktivert på objektiv med 

E-fatning som kan kommunisere med enheten.
ˎˎ Den maksimale effekten av denne funksjonen kan 

oppnås ved hjelp av Iris-ringen på et objektiv med 
Sony E-fatning.
ˎˎ Utseendet kan variere avhengig av benyttet hastighet, 

objektiv, opptaksinnstillinger og motiv, og lysstyrken 
kan også endre seg. Å utføre en kameratest før 
opptak anbefales på det sterkeste.
ˎˎ Lysstyrken kan endre seg når benyttet retning for Iris 

endres, som f.eks. ved åpning av Iris etter at den er 
lukket, eller ved lukking av Iris etter at den er åpnet. I 
dette tilfellet skal man justere litt mer enn påkrevd på 
forhånd, og så justere litt tilbake, sjekke lysstyrken og 
så starte opptak.  
Hvis du f.eks. vil åpne Iris til blenderåpning F8 
og gjøre bakgrunnen uklar, skal du først lukke 
blenderåpningen forbi F8 og så gå tilbake til F8, 
sjekke lysstyrken og starte opptak.
ˎˎ Utfør bokeh-kontrollhandlinger sakte. Hvis du trenger 

å gjøre raske endringer, prøv å justere gradvis mens 
du sjekker endringer på bildet.
ˎˎ Kvaliteten på bildet med Bokeh-kontroll er ikke 

garantert under alle opptaksforhold.
ˎˎ Bokeh-kontrollfunksjonen er satt til Off når en av 

følgende operasjoner inntreffer.
–– Når videokameraet slås av
–– Når Iris-, Gain-, Lukker- eller ND-filter er satt til Auto
–– Når opptaksmodus endres
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–– Når ND-filteret er satt til Klart- eller 
Forhåndsinnstilt-modus

–– Når objektivet fjernes
–– Når enheten startes på nytt, for eksempel etter 

skifte av frekvens

Stille inn De-Squeeze-visning

Du kan gjøre opptak med anamorft objektiv 
for å skape innhold med cinemascope-format.
Når du stiller inn De-Squeeze-visningen til å 
matche forstørrelsen i ditt anamorfe objektiv, 
kan du få ut bilder via HDMI-utgangen og 
på søkerskjermen som er justert til samme 
sideforhold som når du ser motivet direkte.
Du kan stille inn De-Squeeze-visningen med 
De-Squeeze >Ratio (HDMI/VF) (side 96) i 
Monitoring-menyen.

[Merk]
HDMI-utgangens bildevisning blir ikke De-Squeezed ved 
bruk av RAW-utgang og SD-signalutgang.
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Proxy-opptak
Med denne funksjonen kan du ta opp proxy-
klipp med lav oppløsning samtidig som du tar 
opp originalt klipp med høy oppløsning ved 
opptak til et minnekort.
Et proxy-klipp kan deles opp i 
underinndelinger automatisk med korte 
intervaller, og filene kan overføres før slutten 
av opptaket.

For detaljer om hvilke minnekort som støttes, formatering 
av minnekort og hvordan kontrollere gjenværende 
kapasitet, se "Hvordan bruke minnekort" (side 26).

Konfigurering før opptak

1	 Angi Proxy Rec (side 15) på 
skjermbildet for Project status eller sett 
Proxy Rec >Setting (side 86) i Project-
menyen i hovedmenyen til On.

2	 Sett inn et minnekort i et CFexpress Type 
A/SD-kortspor (side 6).
ˎˎ For CFexpress-kort vender etiketten mot 
venstre.
ˎˎ På SD-kort vender etiketten mot høyre 
med det skrå hjørnet nederst.

[Merknader]
ˎˎ Proxy Rec kan ikke settes til On samtidig med S&Q 

Motion. Når S&Q Motion er satt til On, er Proxy Rec 
midlertidig satt til Off. Når S&Q Motion er satt til Off, 
vil Proxy Rec bli satt til On igjen.
ˎˎ Proxy Rec kan ikke slås på samtidig som Interval 

Rec. Når Proxy Rec er satt til On, settes disse andre 
opptaksmodiene automatisk til Off.

Spille inn en proxy

Trykk på START/STOP-knappen for opptak 
for å starte opptak etter at du har angitt den 
ønskede innstillingen for opptak.

[Merknader]
ˎˎ Hvis videokameraet slås av eller minnekortet fjernes 

mens minnekortet leses, kan det ikke garanteres 
at dataene på kortet ikke skades. Alle data som er 
registrert på kortet, kan bli kassert. Kontroller alltid at 
tilgangsindikatoren er av før du slår av videokameraet 
eller tar ut minnekortet.
ˎˎ Pass på at minnekortet ikke spretter ut når du setter 

det inn eller tar det ut.

Stopp opptaket for å avslutte.

Angi lydkanal for proxy-opptak

Velg Proxy Rec >Audio Channel (side 86) 
i Project-menyen i hovedmenyen, og angi 
lydkanalen for proxy-klippopptak.

Opptak og opplasting av proxy-
klipp i underinndelinger

Når den automatiske opplastingen er 
satt til Chunk og et proxy-klipp tas opp i 
underinndelinger, kan opplasting av proxy-
klipp starte før det originale klipp-opptaket 
avsluttes.
For mer informasjon om opplasting av en 
proxy-klipp som er tatt opp i underinndelinger, 
se "Laste opp klipp automatisk" (side 66) 
og "Bruke Creators' App for enterprise" 
(side 67).

1	 Velg Proxy Rec >Chunk (side 86) i 
menyen Project og velg intervall for 
underinndelingsopptaket.
30s: Ta opp proxy-klipp i 30-sekunders 
underinndelinger (standardinnstilling).
1min: Ta opp proxy-klipp i 1-minutts 
underinndelinger.
2min: Ta opp proxy-klipp i 2-minutters 
underinndelinger.

2	 Sett File Transfer >Auto Upload (Proxy) 
(side 108) i menyen Network til Chunk.
Det originale klippet tas opp til mediet i 
spor A, og proxy-klippet tas opp i 
underinndelinger til mediet i spor B.

3	 Start proxy-opptak.
En separat proxy-klippoverføringsjobb 
registreres i jobblisten ved det angitte 
opptaksintervallet for underinndelingen.

[Merknader]
ˎˎ Når Auto Upload (Proxy) ikke er satt til Chunk, blir 

proxy-opptak i underinndelinger ikke bli utført.
ˎˎ Mediet i spor B er dedikert til opptak av proxy-klipp 

i underinndelinger, og derfor er det ikke støtte for 
videresending av opptak og simultant 2-spors opptak.

Om den innspilte filen

Filtypen er ".mp4".
Tidskoden registreres også samtidig.

Lagringssted for den innspilte 
filen

Den innspilte filen lagres i følgende katalog.

Opptaksmedie Mappebane

SDXC /PRIVATE/XDROOT/
GENERAL/PXTMP

CFexpress Type A /XDROOT/GENERAL/
PXTMP

Om filnavnet

Filnavnet består av navnet på klippet 
som er registrert på minnekortet + "S03"-
suffiks. Filnavnet til et proxy-klipp som er 
tatt opp i underinndelinger for opplasting 
består av det originale klippnavnet + 
underinndelingsnummer + "S03"-suffiks.
For mer informasjon om klippnavn, se Clip 
Name Format (side 94) i TC/Media-menyen 
i hovedmenyen.
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Ta bilder med ønsket utseende
Når videokameraet er satt til Custom-
opptaksmodus (side 24), kan du legge 
til justeringer i svart, matrise og andre 
parametere for å lage et "utseende" basert på 
basisutseendet.

：

Utseende

Matrise

Svart

Basisutseende

Du kan også raskt velge et annet utseende 
ved å lagre ulike innstillingskombinasjoner i 
scenefiler.
Videokameraet leveres med totalt seks 
forhåndsinnstilte utseender.

Velge et utseende

1	 Når opptaksskjermen vises, trykker du på 
flerfunksjonshjulet.

2	 Velg  (scenefil)-ikonet.

3	 Trykk på flerfunksjonshjulet.

4	 Velg ønsket utseende fra menyen, og 
trykk på flerfunksjonshjulet.

[Tips]
ˎˎ Følgende forhåndsinnstillinger konfigureres som 

standard fra fabrikken.

Shooting Mode Custom

Target Display SDR(BT.709) HDR(HLG)

Scenefil 1 S-Cinetone HLG Live

Scenefil 2 Standard HLG Natural

Scenefil 3 Still (Ikke 

registrert)

Scenefil 4 ITU709 (Ikke 

registrert)

Scenefil 5 709tone (Ikke 

registrert)

Scenefiler 6–16 (Ikke registrert) (Ikke 

registrert)

ˎˎ Du kan også velge et utseende ved hjelp av Scene 
File (side 14) på Main-statusskjermbildet eller 
Scene File > Recall (side 91) i menyen Paint/
Look i hovedmenyen. Du kan også hente frem en 
forhåndsinnstilt fremstilling ved hjelp av Scene File > 
Preset Recall.

Importere et ønsket 
basisutseende

Du kan importere en 3D LUT-fil som er 
opprettet på en datamaskin eller en annen 
enhet, som et basisutseende fra et minnekort 
eller en skytjeneste. Opptil 16 filer kan 
importeres.
ˎˎ Filformatet: CUBE-fil (*.cube) for en 17-grid 
eller 33-grid 3D LUT opprettet ved hjelp av 
Catalyst Browse, RAW Viewer eller DaVinci 
Resolve* (fra Blackmagic Design Pty. Ltd.).
*	 Verifisert med Resolve V9.0, V10.0 og V11.0.

ˎˎ Fargeskala/Gamma for inndata: S-Gamut3.
Cine/S-Log3 eller S-Gamut3/S-Log3

Importere fra et minnekort

Du kan importere en 3D LUT-fil fra et 
minnekort.

1	 Lagre 3D LUT-filen i den angitte mappen 
eller opptaksmediet på datamaskinen 
eller en annen enhet.

Opptaksmedie Mappebane

SDXC /PRIVATE/SONY/PRO/LUT/

CFexpress 
Type A

/SONY/PRO/LUT/

2	 Sett inn opptaksmediet der 3D LUT-filer er 
lagret i CFexpress Type A/SD-kortspor (B).

3	 Velg Base Look >Import from Media(B) 
(side 91) i menyen Paint/Look i 
hovedmenyen.

4	 Velg en importdestinasjon.

5	 Velg en 3D LUT-fil som skal importeres.

Følg instruksjonene på skjermen. 
Videokameraet håndterer en 3D LUT-fil som 
et basisutseende.

6	 Velg den importerte 3D LUT-filen ved hjelp 
av Base Look > Select (side 91) i 
menyen Paint/Look i hovedmenyen.

7	 Konfigurer Base Look >Input og Output 
(side 91) på Paint/Look-menyen i 
hovedmenyen for å samsvare med 
attributtene for den importerte 3D LUT-
filen.

Importere fra en skytjeneste

Du kan importere en 3D LUT-fil fra en 
skytjeneste.

1	 Koble til enheten fra smarttelefonappen 
"Creators' App for enterprise" (side 67).

2	 Velg Base Look >Import from 
Cloud(Private) eller Import from 
Cloud(Share) (side 91) i menyen Paint/
Look i hovedmenyen.

3	 Velg en importdestinasjon.

4	 Velg en 3D LUT-fil som skal importeres.
Følg instruksjonene på skjermen. 
Videokameraet håndterer en 3D LUT-fil som 
et basisutseende.

5	 Velg den importerte 3D LUT-filen ved hjelp 
av Base Look > Select (side 91) i 
menyen Paint/Look i hovedmenyen.

6	 Konfigurer Base Look >Input og Output 
(side 91) på Paint/Look-menyen i 
hovedmenyen for å samsvare med 
attributtene for den importerte 3D LUT-
filen.
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Importere fra "Monitor & Control"-
programmet

Du kan importere en 3D LUT-fil fra "Monitor & 
Control"-programmet. For mer informasjon om 
betjening, se i Hjelpveiledning for "Monitor & 
Control"-programmet.
For mer informasjon om tilkobling til 
videokameraet fra "Monitor  Control"-
programmet, se "Koble til andre enheter via 
LAN" (side 60).

[Merk]
Når det basisutseende som brukes på videokameraet 
endres ved å importere en 3D LUT-fil fra "Monitor 
& Control"-programmet, kan bildet bli midlertidig 
forvrengt.

Justering for undereksponering

Hvis det er en tendens til undereksponering 
når automatisk eksponering er valgt når du 
bruker det importerte, basisutseendet, justerer 
du Base Look >AE Level Offset (side 91) i 
Paint/Look-menyen.

[Merknader]
ˎˎ Å bare importere en 3D LUT-fil påvirker ikke bildet. 

Last inn den importerte 3D LUT-filen ved hjelp av 
Base Look > Select (side 91) i menyen Paint/Look i 
hovedmenyen.
ˎˎ Hvis inndata ikke er riktig angitt, får du ikke riktig 

utseende.
ˎˎ Innstillingene for menyelementene Input, Output 

og AE Level Offset brukes på basisutseendet som 
velges ved hjelp av Select (Velg). Hvis flere 3D LUT-
filer importeres, velger du Select for hver 3D LUT-fil, 
og konfigurerer Input, Output og AE Level Offset 
individuelt for hver fil.
ˎˎ De konfigurerte innstillingene for Input, Output og AE 

Level Offset lagres for hver 3D-LUT-fil.
ˎˎ Alternativene for å velge basisutseende/LUT for 

importerte 3D LUT-filer er felles for SDR(BT.709)/
HDR(HLG)/Log-opptaksmoduser, men fargeskala- og 
gammakonvertering utføres ikke i henhold til disse 
modusene.
ˎˎ 3D LUT-filer slettes ikke når All Reset >Reset 

(side 109) utføres på Maintenance-menyen i 
hovedmenyen.

Tilpasse et utseende

Du kan tilpasse utseendet basert på 
basisutseendet ved hjelp av Matrix og andre 
oppsettelementer på Paint/Look-menyen fra 
hovedmenyen. For mer informasjon om hvert 
oppsettelement, se side 91.
Koble videokameraet til en TV eller skjerm, og 
juster bildekvaliteten samtidig som du ser på 
bildet på TV-en eller skjermen.

[Merk]
Når du importerer en 3D LUT-fil og bruker den på bildet, 
vil ikke det ønskede utseendet som er definert i 3D 
LUT-filen bli nådd hvis Matrix og innstillinger annet enn 
innstillingene for basisutssende i menyen Paint/Look er 
endret. Du kan tilbakestille alle tilpassede innstillinger 
ved hjelp av Reset Paint Settings > Reset without Base 
Look (side 91) på Paint/Look-menyen i hovedmenyen.

Lagre et utseende

Du kan lagre det gjeldende utseendet som 
en scenefil i det interne minnet ved hjelp av 
Scene File > Store (side 91) på Paint/Look-
menyen i hovedmenyen.
Du kan raskt lagre funksjonene via 
hurtigmenyen direkte fra opptaksskjermbildet.

[Merknader]
ˎˎ Hvis du velger et annet utseende uten å lagre 

det gjeldende utseendet, kasseres det gjeldende 
utseendet.
ˎˎ Scenefiler slettes ikke når All Reset >Reset (side 109) 

utføres på Maintenance-menyen i hovedmenyen.

[Tips]
Du kan overskrive de forhåndsinnstilte scenefilene.
Hvis du vil gjenopprette en forhåndsinnstilt scenefil, 
laster du inn utseendet som skal gjenopprettes med 
Scene File > Preset Recall (side 91) på Paint/Look-
menyen i hovedmenyen, og lagrer deretter scenefilen 
ved hjelp av Scene File > Store.

Slette et lagret utseende

Du kan slette en scenefil som er lagret 
i det interne minnet med Scene File > 
Delete (side 91) i menyen Paint/Look i 
hovedmenyen.

[Tips]
Når den er slettet, vises den ikke lenger i hurtigmenyen.

Slette et basisutseende

Du kan slette en importert 3D LUT-fil med Base 
Look > Delete (side 91) i menyen Paint/Look 
i hovedmenyen.
Du kan slette alle de importerte 3D LUT-filene 
med Base Look > Delete All (side 91) i 
menyen Paint/Look i hovedmenyen.

[Merknader]
ˎˎ Før du sletter, må du kontrollere at basisutseendet 

ikke brukes i noen scenefiler. Hvis et basisutseende 
som brukes blir slettet, vil utseendet til de tilsvarende 
scenefilene bli feil.
ˎˎ Importerte 3D LUT-filer slettes ikke når All Reset > 

Reset (side 109) velges på Maintenance-menyen i 
hovedmenyen.
ˎˎ Et slettet basisutseende kan ikke lenger brukes som 

LUT i Log-opptaksmoduser (side 58).
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Fotografering med utseendejustering i postproduksjon
Ved å velge en Log-opptaksmodus og 
gjøre opptak av jevnt fordelte graderinger 
fra mørke områder til lyse områder, kan du 
foreta finjusteringer, for eksempel lokalt 
gjenopprette graderingen av mørke områder 
og lyse områder, i postproduksjonen.
Når du ser på bildene som er tatt på en vanlig 
skjerm, vil imidlertid den generelle kontrasten 
synes lav, slik at det blir vanskelig å justere 
fokus og eksponering.
Du kan bruke en LUT på skjermmålet på 
videokameraet for å gjøre det enklere å justere 
kameraet under opptak. Du kan også bruke en 
LUT på avspillingsvideoen for å kontrollere det 
ferdige resultatet.
LUT-er brukes av følgende systemer. Du kan 
imidlertid bare bruke én LUT.
ˎˎ SDI-utgang og HDMI-utgang
ˎˎ Søker- og proxy-bilder, strømming
ˎˎ Video tatt opp på opptaksmedier

Hvordan bruke en LUT på 
søkerbildet

1	 Trykk på MENU-knappen for å vise 
Monitoring-statusskjermen.

2	 Velg kolonnen Gamut/Gamma i VF-raden.

3	 Velg On eller Off.

[Merknader]
ˎˎ Innstillingen LUT On/Off for VF brukes også på proxy-

fil og strømmet video.
ˎˎ Gammavisningshjelp er tilgjengelig ved bruk av 

fokusforstørrelse.

[Tips]
ˎˎ Du kan også stille inn ved hjelp av LUT On/Off > VF/

Proxy/Stream (side 82) på Shooting-menyen i 
hovedmenyen.
ˎˎ SDI/HDMI kan settes til VF på samme måte.
ˎˎ For video på opptaksmedier kan du angi LUT On/

Off > Internal Rec (side 82) på Shooting-menyen i 
hovedmenyen.

Bytte LUT

1	 Trykk på MENU-knappen for å vise 
Monitoring-statusskjermen.

2	 Velg feltet Base Look/LUT.

3	 Velg LUT som skal brukes, fra listen for 
basisutseende.

[Tips]
ˎˎ Enheten har s709, 709(800%), og S-Log3 som 

forhåndsinnstilte LUT-er.
ˎˎ Du kan også importere og bruke en 3D LUT-fil. For mer 

informasjon, se "Importere et ønsket basisutseende" 
(side 56) og "Slette et basisutseende" (side 57).
ˎˎ Basisutseendet kan også angis ved hjelp av Base 

Look > Select (side 91) i menyen Paint/Look i 
hovedmenyen.

Endre fordelingen av mørke og 
lyse områder i videoopptak

I Cine EI/Cine EI Quick-opptaksmodus kan 
du endre fordelingen av mørke områder 
og lyse områder, for eksempel hvis du vil 
prioritere tonen i mørke områder fremfor 
lyse områder, ved å endre Exposure Index fra 
basisfølsomheten.

1	 Hvordan bruke en LUT på søkerbildet 
(side 58).

2	 Trykk på MENU-knappen for å vise 
Camera-statusskjermen.

3	 Angi L/M/H-feltene for Exposure Index.
De enkelte innstillingene tilordnes til 
L/M/H-posisjonene for ISO/GAIN-bryteren 
(side 5).

4	 Velg Exposure Index som skal brukes, ved 
hjelp av ISO/GAIN-bryteren.

5	 Juster eksponeringen av søkerbildet etter 
behov.

[Merk]
Gammavisningshjelp er tilgjengelig ved bruk av 
fokusforstørrelse. Innstillingene for Exposure Index 
brukes ikke til gammavisningshjelp.

[Tips]
ˎˎ Eksponeringen kan også justeres ved hjelp av ISO/

Gain/EI > Exposure Index (side 77) på Shooting-
menyen i hovedmenyen.
ˎˎ Den andre tallverdien i innstillingen angir hvor 

mange trinn lysstyrkeinformasjon som er tildelt for 
lyse områder (lysstyrke som er høyere enn 18% grå). 
Områder som er lysere enn disse blir overeksponerte.  
Eksempel: I "400EI/5.0E" tilordnes 5,0 trinn til den lyse 
siden.
ˎˎ Du kan også bruke dette som en veiledning for å 

kontrollere tonen i mørke og lyse områder under 
fotograferingen. Hvis for eksempel M-posisjonen er 
basisfølsomheten, L-posisjonen er minus to trinn, 

og H-posisjonen er pluss to trinn, kan du kontrollere 
ved å trykke på ISO/GAIN-bryteren. Husk å gå 
tilbake til M-posisjonen etter at du har kontrollert 
eksponeringen.

Ta opp en 3D LUT-fil som 
Metadata

Du kan ta opp en 3D LUT-fil (CUBE-fil) som 
brukes på monitorbildet under opptak, som 
metadata for klippet.
For å aktivere denne funksjonen, sett Cine EI/
Flex.ISO Set >Embed LUT File (side 118) til On 
i Project-menyen i hovedmenyen.
3D LUT-filen (CUBE-filen) som velges når 
opptaket startes, tas opp som metadata. 
Imidlertid er opptak av metadata ikke mulig 
under følgende forhold:
ˎˎ Når en 3D LUT-fil (filen viser en "!" foran 
filnavnet når Base Look velges) som er 
importert med en tidligere versjon velges
ˎˎ Når en 3D LUT-fil som kan lagres er valgt, 
men LUT-dataene som skal brukes så blir 
endret og opptak startes umiddelbart
ˎˎ Når LUT On/Off >Internal Rec (side 82) 
er satt til MLUT On i Shooting-menyen i 
hovedmenyen

[Merk]
Kun ett metadata-element kan tas opp per klipp.

[Tips]
De 3D LUT-filene som brukes, lagres i en spesifikk 
mappe på mediet.

Opptaksmedie Mappebane

SDXC /XDROOT/GENERAL/LUT

CFexpress Type A
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Du kan spille inn RAW-videosignalet fra SDI 
OUT-kontakten eller HDMI OUT-kontakten på 
videokameraet til en støttet ekstern opptaker.

Gjøre opptak fra SDI OUT-
kontakten

1	 Koble til en ekstern RAW-opptaker til 
videokameraets SDI OUT-kontakt.

2	 Angi opptaksmodus på skjermbildet for 
Project status (side 15) eller sett Base 
Setting >Shooting Mode (side 84) i 
Project-menyen i hovedmenyen til Cine EI.

3	 Angi skannemodus (bare FF) ved hjelp av 
Imager Scan på skjermbildet for Project 
status eller Rec Format >Imager Scan 
Mode (side 84) i Project-menyen i 
hovedmenyen.

4	 Angi kodeken ved hjelp av skjermbildet 
for Project status eller Rec Format >Codec 
(side 84) i Project-menyen i 
hovedmenyen til en kodek som inkluderer 
RAW.
Hvis du velger RAW & XAVC-I, tar du 
samtidig opp video til den eksterne 
RAW-opptakeren og video til 
minnekortene i videokameraet.

5	 Still inn oppløsningen i skjermbildet for 
Project status eller bruk Rec Format >RAW 
Output Format (side 84) i Project-
menyen i hovedmenyen.

6	 Kontroller at den eksterne opptakeren er 
slått på, og trykk deretter på START/
STOP-knappen for opptak på 
videokameraet.

	 [Merk]
Når opptaket startes på en ekstern opptaker uten 
at du bruker START/STOP-knappen for opptak på 
videokameraet, er det ikke sikkert at klippene blir 
tatt opp på riktig måte.

De støttede RAW-formatene vises nedenfor.

System-
frekvens

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & XAVC-I 4096×2160

3840×2160

24 RAW 4096×2160

RAW & XAVC-I 4096×2160

Gjøre opptak fra HDMI OUT-
kontakten

1	 Koble til en ekstern RAW-opptaker til 
videokameraets HDMI OUT-kontakt.

2	 Angi opptaksmodus på skjermbildet for 
Project status (side 15) eller sett Base 
Setting >Shooting Mode (side 84) i 
Project-menyen i hovedmenyen til Cine EI.

3	 Angi skannemodus (bare FF) ved hjelp av 
Imager Scan på skjermbildet for Project 
status eller Rec Format >Imager Scan 
Mode (side 84) i Project-menyen i 
hovedmenyen.

4	 Angi kodeken ved hjelp av skjermbildet 
for Project status eller Rec Format >Codec 
(side 84) i Project-menyen i 
hovedmenyen til RAW(HDMI).
Hvis du velger RAW(HDMI) & XAVC-I, tar 
du samtidig opp video til den eksterne 
RAW-opptakeren og video til 
minnekortene i videokameraet.

5	 Kontroller at den eksterne opptakeren er 
slått på, og trykk deretter på START/
STOP-knappen for opptak på 
videokameraet.

[Merk]
Når opptaket startes på en ekstern opptaker uten 
at du bruker START/STOP-knappen for opptak på 
videokameraet, er det ikke sikkert at klippene blir tatt 
opp på riktig måte.

De støttede RAW-formatene vises nedenfor.

System-
frekvens

Codec RAW Output 
Format

59.94/
50/
29.97/
25/
23.98

RAW(HDMI) 4240×2392

RAW(HDMI) & 
XAVC-I

4240×2392

Opptaksstatusindikator

Når Display On/Off (side 96) > RAW 
Output Control Status i Monitoring-menyen 
i hovedmenyen er satt til On, vises RAW-
opptaksstatusen med et ikon som vises på 
søkerskjermen.

[Merk]
Kontrollsignalet for opptak sendes ut fra SDI OUT-
kontakten på videokameraet, men det er ikke mulig å 
få statusen til den eksterne opptakeren. Videokameraet 
kan derfor indikere at RAW-videoopptak pågår når den 
eksterne opptakeren faktisk ikke tar opp. Kontroller 
indikatoren på den eksterne opptakeren for å få riktig 
driftsstatus.

[Tips]
Den innstilte verdien for RAW Output Format vises også.

Opptak med sakte og rask 
bevegelse

Hvis S&Q Motion > Setting i Shooting-menyen 
er satt til On, blir RAW-video tatt opp i modus 
for sakte og rask bevegelse.
For informasjon om støttede bildefrekvenser 
for opptak, se side 50.

[Merk]
Slow & Quick Motion-opptak fra HDMI OUT-kontakten 
støttes ikke.

Hvordan ta opp RAW-video
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Koble til andre enheter via LAN
Videokameraet kan kobles til smarttelefoner, 
nettbrett og andre enheter via LAN-tilkobling.
Ved å opprette en LAN-tilkobling mellom 
en enhet og videokameraet kan du bruke 
programmet "Monitor & Control" (mobil 
innholdsliste).
ˎˎ Videoovervåking 
Du kan overvåke kamerabildet eller spille 
av video fra videokameraet ved å bruke 
"Monitor & Control"-programmet på en 
enhet.
ˎˎ Fjernkontroll 
Du kan styre videokameraet fra en 
smarttelefon eller et nettbrett eller en 
datamaskin som er koblet til videokameraet 
via et LAN.
ˎˎ Filoverføring 
Du kan overføre en proxy-fil (lav oppløsning) 
eller original fil (høy oppløsning) som lagres 
på et minnekort i videokameraet til serveren 
via et LAN.

	 [Merknader]
ˎˎ Du kan betjene enheten fjernstyrt ved å bruke 

appen "Content Browser Mobile", men du kan ikke 
overvåke bildet.
ˎˎ Monitorvisning av videoen er ikke støttet med 

følgende innstillinger.
–– Systemfrekvens på 24
–– Interval Rec-modus

ˎˎ Hvis det oppstår en feil i den trådløse LAN-
modulen til videokameraet, sett Wireless LAN > 
Setting (side 105) til Off i Network-menyen i 
hovedmenyen. Selv om den trådløse LAN-modulen 
svikter, vil funksjonene for fotografering/opptak/
avspilling fortsette å fungere normalt.

"Monitor & Control"-programmet

Du kan betjene videokameraet eksternt på 
skjermen på enheten mens du overvåker 
videoen fra videokameraet, og konfigurere 
innstillingene for videokameraet ved hjelp av 
programmet "Monitor & Control".

For mer informasjon om programmet "Monitor & Control", 
kan du kontakte salgs- eller servicerepresentanten fra 
Sony.

Velg brukernavn og et passord

Angi brukernavnet og passordet 
for videokameraet for å bruke 
nettverksfunksjonen.

1	 Angi Access Authentication >User Name 
(side 105) i menyen Network i 
hovedmenyen.

2	 Angi Access Authentication >Input 
Password (side 105) i menyen Network i 
hovedmenyen.

	 [Tips]
ˎˎ Du kan også generere et passord automatisk. 

Utfør Generate Password istedenfor Input 
Password.
ˎˎ Brukernavnet og passordet kan vises som tekst 

og QR-kode med Show Settings.

	 [Merk]
Sørg for at QR-koden og passordet ikke vises for 
andre.

Tilkobling ved bruk av modus for 
aksesspunkt i trådløst LAN

Videokameraet fungerer som et aksesspunkt 
og kobles til en enhet via et trådløst LAN.

Mobiltelefon/nettbrett

Koble til en NFC-kompatibel enhet med 
ettrykksbetjening

[Tips]
Appen "Monitor & Control" støtter ikke LAN-tilkobling 
med bruk av NFC-funksjonen. For LAN-tilkobling med 
bruk av NFC-funksjonen, bruk appen "Content Browser 
Mobile".

Enheter som støtter NFC kan kobles til 
(ettrykkstilkobling) via NFC.

1	 Åpne [Settings] på enheten, velg [More], 
og merk av i NFC-avmerkingsboksen.

2	 Slå på videokameraet.

3	 Aktiver NFC-funksjonen.
Trykk og hold nede (i 3 sekunder) en 
tilordningsbar knapp som er tilordnet NFC, 
eller velg Wireless LAN >NFC i Network-
menyen for å aktivere NFC-
tilkoblingsmodus.
NFC-funksjonen er bare tilgjengelig når  
vises på skjermen.

4	 Berør videokameraet med enheten.
Enheten kobles til videokameraet og 
"Content Browser Mobile" starter.

	 [Merknader]
ˎˎ Deaktiver hvilemodus og skjermlås på forhånd.
ˎˎ Trykk på og hold enheten i ro til programmet 

"Content Browser Mobile" starter (1 til 2 
sekunder).
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Koble til en WPS-kompatibel enhet

Enheter som støtter WPS, kan kobles til ved 
hjelp av WPS.

1	 Velg Wireless LAN >Setting >Access Point 
Mode i Network-menyen i hovedmenyen.

2	 Velg Wireless LAN >WPS >Execute på 
Network-menyen i hovedmenyen.

3	 Åpne enhetens nettverksinnstillinger eller 
Wi-Fi-innstillingene på enheten, og slå på 
Wi-Fi.

4	 Velg videokameraets SSID fra SSID-listen i 
Wi-Fi-nettverk på enheten, og velg 
deretter WPS Push Button på Option på 
enheten som skal kobles til.

	 [Merknader]
ˎˎ Driftsmetoden varierer avhengig av enheten.
ˎˎ For SSID og passordet til videokameraet 

kontrollerer du AP Mode Settings >Camera SSID 
& Password (side 105) i menyen Network i 
hovedmenyen.

5	 Koble til ved hjelp av programmet 
“Monitor & Control”.

	 [Tips]
Du kan sjekke den nødvendige informasjonen for 
tilkobling til kameraet via Access Authentication 
>Show Settings (side 105) i Network-menyen i 
hovedmenyen.

Koble til ved å angi en SSID og et 
passord på en enhet

Du kan koble videokameraet til en enhet ved 
å angi SSID og passord for kameraet på en 
enhet.

1	 Velg Wireless LAN >Setting >Access Point 
Mode i Network-menyen i hovedmenyen.

2	 Åpne enhetens nettverksinnstillinger eller 
Wi-Fi-innstillingene på enheten, og slå på 
Wi-Fi.

3	 Koble enheten til videokameraet ved å 
velge videokameraets SSID fra SSID-listen 
i Wi-Fi-nettverket og angi passordet.
Du finner SSID og passordet til 
videokameraet ved å kontrollere 
innstillingene for AP Mode Settings 
>Camera SSID & Password (side 105) i 
menyen Network.

	 [Merk]
Driftsmetoden varierer avhengig av enheten.

4	 Koble til ved hjelp av programmet 
"Monitor & Control".

	 [Tips]
Du kan sjekke den nødvendige informasjonen for 
tilkobling til kameraet via Access Authentication 
>Show Settings (side 105) i Network-menyen i 
hovedmenyen.

Tilkobling ved bruk av trådløst 
LAN stasjonsmodus

Videokameraet kobles til et eksisterende 
aksesspunkt i det trådløse LAN som en klient. 
Videokameraet og enheten kobles til via 
aksesspunktet.
De 10 sist tilkoblede aksesspunktene vises i 
historikken.
Tilkoblingshistorikken lagres i en ALL-fil, men 
tilgangpassordene lagres ikke. Du må angi 
passordet neste gang du kobler til etter at du 
har lastet inn ALL-filen.

Mobiltelefon/
nettbrett

Aksesspunkt

Datamaskin

Koble til et aksesspunkt med WPS

Hvis aksesspunktet er kompatibelt med WPS-
funksjonen, kan du koble til aksesspunktet 
med enkle innstillinger.

1	 Slå på aksesspunktet.

2	 Slå på videokameraet.

3	 Velg Wireless LAN >Setting >Station Mode 
i Network-menyen i hovedmenyen.

4	 Velg ST Mode Settings >Camera Remote 
Control (side 106) >Enable i Network-
menyen i hovedmenyen.

5	 Velg Wireless LAN >WPS >Execute på 
Network-menyen i hovedmenyen.

6	 Trykk på WPS-knappen på aksesspunktet.
For mer informasjon om hvordan du 
bruker WPS-knappen, se i 
bruksanvisningen for aksesspunktet.
Når forbindelsen er opprettet, viser ikonet 
for nettverksstatusindikatoren en styrke 
på 1 eller høyere på søkerskjermen.

	 [Merk]
Hvis tilkoblingen mislykkes, utfører du trinnene fra 
trinn 1 på nytt.

7	 Koble enheten til aksesspunktet.
Du finner mer informasjon om tilkobling i 
bruksanvisningen for enheten.

8	 Start "Monitor & Control"-programmet på 
en enhet og velg kameraet.

	 [Tips]
Du kan sjekke den nødvendige informasjonen for 
tilkobling til kameraet via Access Authentication 
>Show Settings (side 105) i Network-menyen i 
hovedmenyen.
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Koble til ved hjelp av aksesspunktets 
funksjon for automatisk gjenkjenning

1	 Utfør trinnene 1 til 3 "Koble til et 
aksesspunkt med WPS" (side 61).

2	 Velg ST Mode Settings >Scan Networks 
(side 106) >Execute på Network-menyen 
i hovedmenyen.
Videokameraet begynner å oppdage 
tilkoblingsmål.
Mulige mål som blir funnet, vises i en liste.

3	 Velg et mål fra listen.
Skjermbildet med nettverksdetaljer 
(aksesspunktet) vises. Den valgte 
tilkoblingen vises i SSID.

4	 Velg Password og angi passordet for 
aksesspunktet for å koble til på 
passordskjermen.
Hvis du velger en SSID i tilkoblingsloggen, 
konfigureres innstillingene automatisk, 
inkludert passordet.
Angi passordet for å gå tilbake til 
skjermbildet med detaljer om nettverket 
(aksesspunktet).

5	 Konfigurer følgende 
tilkoblingsinnstillinger.
ˎˎ DHCP 
Angi DHCP-innstillingen.  
Når den stilles til On, tilordnes IP-
adressen automatisk til videokameraet.  
Hvis du vil tilordne IP-adressen til 
videokameraet manuelt, stiller du den 
til Off.
ˎˎ IP Address 
Angi IP-adressen til enheten.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.

ˎˎ Subnet Mask 
Angi enhetens nettverksmaske.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.
ˎˎ Gateway 
Angi gatewayen for aksesspunktet.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.
ˎˎ DNS Auto 
Angir om DNS skal hentes automatisk.  
Når den er satt til On, hentes DNS-
serveradressen automatisk. Denne 
innstillingen er bare tilgjengelig når 
DHCP er satt til On.
ˎˎ Primary DNS Server 
Angi den primære DNS-serveren for 
aksesspunktet.  
Denne innstillingen er bare tilgjengelig 
når DNS Auto er satt til Off.
ˎˎ Secondary DNS Server 
Angi den sekundære DNS-serveren for 
aksesspunktet.  
Denne innstillingen er bare tilgjengelig 
når DNS Auto er satt til Off.

6	 Når du er ferdig, velger du Connect til for 
å koble til aksesspunktet.

7	 Koble enheten til aksesspunktet.
Du finner mer informasjon om tilkobling i 
bruksanvisningen for enheten.

8	 Start "Monitor & Control"-programmet på 
en enhet og velg kameraet.

	 [Tips]
Du kan sjekke den nødvendige informasjonen for 
tilkobling til kameraet via Access Authentication 
>Show Settings (side 105) i Network-menyen i 
hovedmenyen.

Koble til manuelt ved å angi 
aksesspunktinformasjon

1	 Utfør trinnene 1 til 3 "Koble til et 
aksesspunkt med WPS" (side 61).

2	 Velg ST Mode Settings >Manual Register 
(side 107) >Execute på Network-menyen 
i hovedmenyen.
Skjermbildet med nettverksdetaljer 
(aksesspunktet) vises et øyeblikk.

3	 Konfigurer følgende 
tilkoblingsinnstillinger.
ˎˎ SSID 
Angi SSID for aksesspunktet.
ˎˎ Security 
Velg krypteringsmetoden.
ˎˎ Password 
Angi gatewayen for aksesspunktet.
ˎˎ DHCP 
Angi DHCP-innstillingen.  
Når den stilles til On, tilordnes IP-
adressen automatisk til videokameraet.  
Hvis du vil tilordne IP-adressen til 
videokameraet manuelt, stiller du den 
til Off.
ˎˎ IP Address 
Angi IP-adressen til enheten.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.
ˎˎ Subnet Mask 
Angi enhetens nettverksmaske.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.
ˎˎ Gateway 
Angi adressen til gatewayen.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.

ˎˎ DNS Auto 
Angir om DNS skal hentes automatisk.  
Når den er satt til On, hentes DNS-
serveradressen automatisk. Denne 
innstillingen er bare tilgjengelig når 
DHCP er satt til On.
ˎˎ Primary DNS Server 
Skriv inn adressen til den primære DNS-
serveren.  
Denne innstillingen er bare tilgjengelig 
når DNS Auto er satt til Off.
ˎˎ Secondary DNS Server 
Skriv inn adressen til den sekundære 
DNS-serveren.  
Denne innstillingen er bare tilgjengelig 
når DNS Auto er satt til Off.

4	 Når du er ferdig, velger du Connect til for 
å koble til aksesspunktet.

5	 Koble enheten til aksesspunktet.
Du finner mer informasjon om tilkobling i 
bruksanvisningen for enheten.

6	 Start "Monitor & Control"-programmet på 
en enhet og velg kameraet.

	 [Tips]
Du kan sjekke den nødvendige informasjonen for 
tilkobling til kameraet via Access Authentication 
>Show Settings (side 105) i Network-menyen i 
hovedmenyen.
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Du kan koble videokameraet til Internett ved 
hjelp av Internett-deling via USB, kablet LAN 
eller trådløst LAN.
Angi brukernavnet og passordet for 
videokameraet på forhånd (side 60).

[Merk]
Hvis det oppstår en feil i den trådløse LAN-modulen til 
videokameraet, sett Wireless LAN >Setting (side 105) 
til Off i Network-menyen i hovedmenyen. Selv om 
den trådløse LAN-modulen svikter, vil funksjonene for 
fotografering/opptak/avspilling fortsette å fungere 
normalt.

Koble til med Internett-deling via 
USB

Du kan koble enheten til en smarttelefon via 
en USB-kabel, og deretter koble til Internett 
ved hjelp av smarttelefonen.

Koble en mobiltelefon til videokameraet

Koble USB-kabel til USB-C-kontakten 
(side 7) på videokameraet, og koble 
deretter til mobiltelefonen.

[Merknader]
ˎˎ Sett på / fjern mobiltelefonen mens videokameraet 

er slått av.
ˎˎ Internett-deling via USB kan ikke brukes hvis 

mobiltelefonen er koblet til via en USB-hub.
ˎˎ Internett-deling via USB kan ikke brukes hvis en 

datamaskin er koblet til USB-/multikontakten 
(side 7).

Aktivere funksjonen for internettdeling 
via USB på videokameraet

1	 Slå på videokameraet.

2	 Sett Modem >Setting (side 107) i 
menyen Network i hovedmenyen eller i 
Network-statusskjermen til On.

Konfigurere 
mobiltelefonkommunikasjon

Aktiver kommunikasjon med Internett-deling 
på mobiltelefonen.
Se driftshåndboken for mobiltelefonen for mer 
informasjon.

Aktivere betjening fra en mobiltelefon

Du kan kontrollere videokameraet fjernstyrt 
ved å bruke "Monitor & Control"-programmet 
på en smarttelefon som er tilkoblet med USB-
kabel.

1	 Sett Modem >Camera Remote Control 
(side 107) til Enable i Network-menyen i 
hovedmenyen.

2	 Start "Monitor & Control"-programmet på 
en smarttelefon og velg kameraet.

	 [Tips]
Du kan sjekke den nødvendige informasjonen 
for tilkobling til kameraet fra "Monitor & 
Control"-programmet via Access Authentication 
>Show Settings (side 105) i Network-menyen i 
hovedmenyen.

Tilkobling ved hjelp av trådløs 
LAN-stasjonsmodus (Wi-Fi-
stasjonsmodus)

Du kan koble videokameraet til Internett i Wi-
Fi-stasjonsmodus ved å bruke en Wi-Fi-ruter 
(tilleggsutstyr) eller ved å dele Internett via 
Wi-Fi på en smarttelefon.
Koble til den trådløse ruteren eller enheten 
som beskrevet i "Tilkobling ved bruk av 
trådløst LAN stasjonsmodus" (side 61).

Mobiltelefon/
nettbrett

Wi-Fi-ruter

Datamaskin

Internett

Mobiltelefon/
nettbrett

Internett

Koble til med en LAN-kabel

Du kan koble til Internett ved å koble til en 
kablet LAN-kontakt på en kablet LAN-adapter 
(tilleggsutstyr) som er koblet til USB-C-
kontakten (side 7) på videokameraet, til en 
Wi-Fi-ruter (tilleggsutstyr) med en LAN-kabel.

Mobiltelefon/
nettbrett

Datamaskin

Wi-Fi-ruter

Kablet LAN- 
adapter

Internett

Koble til Internett
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LAN-kabeltilkoblinger og innstillinger 
for kablet LAN

1	 Koble en kablet LAN-adapter til USB-C-
kontakten på videokameraet.

2	 Koble den kablede LAN-kontakten på den 
kablede LAN-adapteren til en Wi-Fi-ruter 
ved hjelp av en LAN-kabel.

3	 Slå på videokameraet.

4	 Sett Wired LAN >Setting (side 107)  i 
menyen Network i hovedmenyen eller i 
Network-statusskjermen til On.

5	 Konfigurer tilkoblingsinnstillinger ved 
hjelp av Wired LAN >Detail Settings 
(side 107) på Network-menyen.
ˎˎ DHCP 
Angi DHCP-innstillingen.  
Når den stilles til On, tilordnes IP-
adressen automatisk til videokameraet.  
Hvis du vil tilordne IP-adressen til 
videokameraet manuelt, stiller du den 
til Off.
ˎˎ IP Address 
Angi IP-adressen til enheten.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.
ˎˎ Subnet Mask 
Angi enhetens nettverksmaske.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.
ˎˎ Gateway 
Angi adressen til gatewayen.  
Denne innstillingen er bare tilgjengelig 
når DHCP er satt til Off.

ˎˎ DNS Auto 
Angir om DNS skal hentes automatisk.  
Når den er satt til On, hentes DNS-
serveradressen automatisk. Denne 
innstillingen er bare tilgjengelig når 
DHCP er satt til On.
ˎˎ Primary DNS Server 
Skriv inn adressen til den primære DNS-
serveren.  
Denne innstillingen er bare tilgjengelig 
når DNS Auto er satt til Off.
ˎˎ Secondary DNS Server 
Skriv inn adressen til den sekundære 
DNS-serveren.  
Denne innstillingen er bare tilgjengelig 
når DNS Auto er satt til Off.

6	 Når du er ferdig, velger du Set for å bruke 
innstillingene.

[Merknader]
ˎˎ Velg alltid Set etter at du har endret 

tilkoblingsinnstillingene. Innstillingene tas ikke i bruk 
hvis Set ikke er valgt.
ˎˎ Bruk en USB Type C kablet LAN-adapter. Det anbefales 

å bruke en Gigabit Ethernet-kompatibel adapter. Det 
er imidlertid ikke garantert at alle enheter fungerer 
med denne funksjonen.
ˎˎ En LAN-adapter koblet til USB (tilleggsutstyr) kan 

ikke brukes hvis en datamaskin er koblet til USB/
multikontakten (side 7).
ˎˎ Den innebygde trådløse kommunikasjonsfunksjonen 

kan bli påvirket, avhengig av modellen på adapteren 
for kablet LAN (tilleggsutstyr).

Aktivere betjening fra en smarttelefon 
via kablet LAN

Hvis du vil betjene videokameraet eksternt ved 
hjelp av programmet "Monitor & Control" på 
en smarttelefon via Wi-Fi ved hjelp av en Wi-
Fi-ruter koblet til med kablet LAN, sett Wired 
LAN >Camera Remote Control (side 107) i 
menyen Network i hovedmenyen til Enable.



4. Nettverksfunksjoner65

Laste opp filer
Du kan laste opp en proxy-klipp 
eller originalklipp som er tatt opp på 
videokameraet til en server på Internett 
eller en server på et lokalt nettverk via en 
mobiltelefon eller et aksesspunkt.

Forberedelser

Koble til et nettverk

Koble videokameraet til Internett eller 
det lokale nettverket i "Koble til Internett" 
(side 63) eller "Koble til andre enheter via 
LAN" (side 60).

Registrere en 
klippoverføringsdestinasjon

Registrer serveren for opplasting av klipp på 
forhånd.

1	 Velg File Transfer >Server Settings1 (eller 
Server Settings2, Server Settings3) i 
menyen Network i hovedmenyen.
Skjermbildet for oppsett av 
overføringsmål vises.

2	 Angi hvert element på skjermbildet for 
oppsett av overføringsmål.
Display Name
Angi navnet på serveren som skal vises i 
listen over overføringsmål.
Service
Viser servertypen.
FTP: FTP-server
Host Name
Angi navnet på serveren.
Port
Angi portnummeret til serveren som skal 
kobles til.

User Name
Skriv inn brukernavn.
Password
Skriv inn passordet.
Passive Mode
Slå passiv modus av/på.
Destination Directory
Skriv inn navnet på målserveren.

	 [Merknader]
ˎˎ Originalklipp lastes opp til mappen 

"Main" i katalogen som er angitt som 
overføringsdestinasjon.
ˎˎ Ved redigering angir "" tegn som ikke kan 

endres. Riktig funksjon garanteres ikke hvis du 
redigerer et katalognavn som inneholder disse 
tegnene.  
Hvis du må redigere, sletter du alle tegnene og 
skriver inn en verdi på nytt.
ˎˎ Hvis tegn som er ugyldige på målserveren, 

angis i Destination Directory, overføres filene til 
brukerens startkatalog. Ugyldige tegn vil variere 
avhengig av serveren.

Using Secure Protocol
Angi om du vil bruke sikker FTP-
opplasting.
Root Certificate
Laste inn/slett et sertifikat.
ˎˎ Load 
Velg Set i trinn 3 for å importere et CA-
sertifikat.

*	 Sertifikatet som skal lastes inn må være i PEM-
format med filnavnet "certification.pem" og må 
skrives til rotmappen på minnekortet som er satt 
inn i CFexpress Type A/SD-kortsporet (B).

ˎˎ Clear 
Velg Set i trinn 3 for å slette et CA-
sertifikat.
ˎˎ None 
Ikke last inn eller slett et sertifikat.

	 [Merknader]
ˎˎ Still klokken på videokameraet til riktig klokkeslett 

før du importerer et CA-sertifikat.
ˎˎ Når du tar opp i XAVC-I 4096×2160P/ 

3840×2160P 59.94/50P, kan ikke Load være valgt.
ˎˎ Hvis spenningen er lav kan ikke Load/Clear 

velges for et CA-sertifikat.

Root Certificate Status
Viser innlastingsstatus for sertifikatet.

Reset
Tilbakestill innstillingene i Server Settings 
til standardinnstillingene.

3	 Når du er ferdig, velger du Set for å bruke 
innstillingene.
Velg alltid Set etter at du har endret 
innstillingene. Innstillingene tas ikke i bruk 
hvis Set ikke er valgt.

Velge og laste opp klipp

Du kan laste opp proxy-klipp og originalklipp 
på minnekort i videokameraet, til en server.
Opplasting utføres fra miniatyrbildeskjermen.

[Merk]
Proxy-klipp som er tatt opp i underinndelinger er filer 
som er dedikert til automatisk opplasting. De kan ikke 
velges og lastes opp manuelt.

Laste opp en proxy-klipp på et 
minnekort fra miniatyrbildeskjermen

1	 Koble enheten til Internet (side 63).

2	 Trykk på THUMBNAIL-knappen for å vise 
miniatyrbildeskjermen.

	 [Tips]
Du kan også bruke miniatyrbildeskjermen for 
filtrerte klipp (side 70).

3	 Velg Transfer Clip (Proxy) >Select Clip i 
Thumbnail-menyen i hovedmenyen.

4	 Velg klippet du vil overføre, og trykk 
deretter på MENU-knappen.
Det vises et bekreftelsesskjermbilde for 
overføring.

5	 Velg Execute.
Proxy-klippet som svarer til det valgte 
originale klippet, registreres som en 
overføringsjobb, og overføringen starter.
Når overføringsjobben er registrert, vises 
skjermbildet for overføringsresultat.

6	 Velg OK.
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For å laste opp alle klipp
Velg All Clips i stedet for Select Clip i trinn 3 
for å overføre proxy-klippene som svarer til 
originalklippene.

[Merk]
Opptil 200 overføringsjobber kan registreres.

Laste opp et originalklipp på et 
minnekort fra miniatyrbildeskjermen

[Merk]
Originalklipp lastes opp til mappen "Main" i katalogen 
som er angitt som overføringsdestinasjon.

1	 Koble enheten til Internet (side 63).

2	 Trykk på THUMBNAIL-knappen for å vise 
miniatyrbildeskjermen.

	 [Tips]
Du kan også bruke miniatyrbildeskjermen for 
filtrerte klipp (side 70).

3	 Velg Transfer Clip >Select Clip fra 
Thumbnail-menyen i hovedmenyen.

4	 Velg klippet du vil overføre, og trykk 
deretter på MENU-knappen.
Det vises et bekreftelsesskjermbilde for 
overføring.

5	 Velg Execute.
Det valgte klippet registreres som en 
overføringsjobb, og overføringen starter.
Når overføringsjobben er registrert, vises 
skjermbildet for overføringsresultat.

6	 Velg OK.

For å laste opp alle klipp
Velg All Clips i stedet for Select Clip i trinn 3 for 
å overføre alle klipp.

[Merk]
Opptil 200 overføringsjobber kan registreres.

Kontrollere filoverføringen

Du kan kontrollere statusen til filoverføringen 
ved å velge File Transfer >View Job List 
(side 108) i menyen Network i hovedmenyen.
Du kan også sjekke statusen for filoverføring 
fra programskjermen for Monitor & Control.

[Tips]
Hvis File Transfer >Auto Upload (side 108) eller 
Auto Upload (Proxy) (side 108) i menyen Network 
i hovedmenyen er satt til On og det finnes en 
nettverkstilkobling, lastes originalklipp og proxy-
klipp automatisk opp til serveren som er spesifisert 
med Default Upload Server (side 108) når opptaket 
avsluttes. Hvis både originalklipp og proxy-klipp er 
konfigurert for automatisk opplasting, vil automatisk 
opplasting av proxy-klipp har fortrinn.

[Merknader]
ˎˎ Opptil 200 overføringsjobber kan registreres.
ˎˎ Jobblisten beholdes når videokameraet slås 

av, men opptil 10 minutter med den siste 
fremdriftsinformasjon kan gå tapt hvis batteripakken 
fjernes eller videokameraet slås av uten at POWER-
bryteren først settes til STANDBY.
ˎˎ Jobber som legges til etter at batteriet får lav 

spenning lagres ikke i jobblisten.
ˎˎ Hvis det oppstår en feil under filoverføring, kan 

overføringen av et klipp med samme navn som 
et overført klipp ikke gjenopptas, avhengig av 
innstillingene og statusen til overføringsmålserveren. 
I så tilfelle kontrollerer du innstillingene og statusen 
for målserveren for overføring.

Laste opp klipp automatisk

Lastes opp originalklipp automatisk

Originalklipp kan lastes opp til den angitte 
serveren når opptak er avsluttet. For å aktivere 
denne funksjonen, sett File Transfer >Auto 
Upload (side 108) til On i menyen Network i 
hovedmenyen.

Laste opp proxy-klipp automatisk

Proxy-klipp kan lastes opp til den angitte 
serveren når opptak er avsluttet. For å aktivere 
denne funksjonen, sett File Transfer >Auto 
Upload (Proxy) (side 108) til On i menyen 
Network i hovedmenyen.
Alternativt, når Auto Upload (Proxy) er 
satt til Chunk, kan du ta opp en proxy-
klipp i underinndelinger og så laste opp 
underinndelingene til en angitt server 
mens opptaket fortsetter. Den automatiske 
opplastingen av et proxy-klipp som er tatt 
opp i underinndelinger har fortrinn i forhold til 
andre filoverføringsjobber.
For mer informasjon om konfigurasjon, 
se "Opptak og opplasting av proxy-klipp i 
underinndelinger" (side 55).

Opplasting ved hjelp av sikker FTP

Du kan laste opp filer med kryptering ved 
hjelp av FTPS i eksplisitt modus (FTPES) for 
tilkoblingen til målfilserveren.

Angi sikker FTP-overføring

For sikker FTP-overføring setter du Using 
Secure Protocol i målfilserverens innstillinger 
til ON og importerer et sertifikat. 
For mer informasjon om konfigurasjon, se 
"Registrere en klippoverføringsdestinasjon" 
(side 65).
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Bruke Creators' App for enterprise
Du kan enkelt overføre filer til skytjenesten 
C3 Portal ved å lenke enheten til 
smarttelefonappen "Creators' App for 
enterprise".
Først oppretter du en C3 Portal-konto og 
installerer Creators' App for enterprise på en 
smarttelefon.
For mer informasjon om å opprette en 
konto i skytjenesten C3 Portal, kontakt 
administratoren i din organisasjon.

[Merknader]
ˎˎ Det kan hende at tjenesten ikke er tilgjengelig, 

avhengig av hvilken region du befinner deg i.
ˎˎ For mer informasjon om bruk av Creators' App 

for enterprise, se i Creators' App for enterprise 
Hjelpveiledning.

Laste opp klipp til C3 Portal

1	 Velg Setup for Mobile App >Setup 
(side 105) i menyen Network.
En bekreftelsesskjerm vises for elementer 
som vil bli oppdatert automatisk.
Følgende innstillinger i menyen Network 
velges automatisk.
ˎˎ Wired LAN >Setting: Off
ˎˎ Modem >Setting: On
ˎˎ Modem >Camera Remote Control: 
Enable
ˎˎ Access Authentication >Input Password: 
(Genereres automatisk hvis ikke angitt)

2	 Kontroller innstillingene og velg OK.
Konfigureringen starter. Meldingen "Now 
changing" vises mens konfigureringen er 
aktiv.
Når konfigureringen er fullført vises 
følgende skjerm i søkeren.

Følgende informasjon for 
tilgangsautentisering vises.
Brukernavn, passord, fingeravtrykk, 
videokameraets navn og serienummer

	 [Tips]
Denne skjermen vises ikke i videovisningen.

	 [Merk]
Sørg for at passordet ikke vises for andre og at QR-
kodebildet ikke kan kopieres av andre.

3	 Start Creators' App for enterprise på 
smarttelefonen og logg inn på 
skytjenesten.

4	 Koble til smarttelefonen via en USB-kabel 
til USB-C-kontakten på enheten.

5	 Aktiver internettdeling via USB på 
smarttelefonens skjerm.
For mer informasjon om konfigurasjon, se 
"Koble til med Internett-deling via USB" 
(side 63).
Fremgangsmåten vil være forskjellig, 
avhengig av din smarttelefon. Se 
brukerveiledningen for mobiltelefonen.

6	 Skanne QR-koden som vises i søkeren 
ifølge instruksjonene på skjermen i 
Creators' App for enterprise.
Oppsettinformasjon for filoverføring 
sendes fra smarttelefonen til enheten, og 
følgende melding vises.

7	 Velg OK.
Lasting av oppsettinformasjon starter.
Når oppsettet er lastet inn, vises 
meldingen "Network File loaded.".

[Merknader]
ˎˎ Creators' App for enterprise overskriver File Transfer 

(side 108)-innstillingene i menyen Network på 
enheten.
ˎˎ Root Certificate kan ikke legges inn automatisk. 

Konfigurer manuelt.

Laste opp originalklipp

Sett File Transfer >Auto Upload (side 108) i 
menyen Network til On for å gjøre det mulig å 
laste opp originalklipp til C3 Portal.
Hver gang et opptak avsluttes lastes klippet 
opp til plasseringen som er knyttet til din C3 
Portal-konto.

Laste opp proxy-klipp

Sett File Transfer >Auto Upload (Proxy) 
(side 108) i menyen Network til On for å 
gjøre det mulig å laste opp proxy-klipp til C3 
Portal.
Hver gang et opptak avsluttes lastes klippet 
opp til plasseringen som er knyttet til din C3 
Portal-konto.
Når Auto Upload (Proxy) er satt til Chunk, 
deles proxy-klipp opp i underinndelinger 
og lastes opp med regelmessige intervaller 
fra start av opptak. For mer informasjon om 
konfigurasjon, se "Opptak og opplasting av 
proxy-klipp i underinndelinger" (side 55).

Laste opp valgte klipp

Se "Velge og laste opp klipp" (side 65).

[Tips]
ˎˎ Filer som sendes av enheten blir lagret i cache i 

Creators' App for enterprise og overføres til C3 Portal. 
Visningen av filoverføringsstatus på enheten indikerer 
overføringsstatus til Creators' App for enterprise.
ˎˎ Når filoverføringen fra enheten til Creators' App for 

enterprise på smarttelefonen er fullført, kan du slå av 
enheten, men merk at filoverføring fra smarttelefonen 
kanskje ikke er fullført. Vær oppmerksom på 
gjenværende batterikapasitet i smarttelefonen.

Andre funksjoner som benytter C3 
Portal

Håndtering av 3D LUT-filer

Du kan importere 3D LUT-filer som er lagret 
i C3 Portal til enheten. Se "Importere fra en 
skytjeneste" (side 56).

Håndtering av ALL-filer

Du kan lagre en ALL-fil som er opprettet 
av enheten i C3 Portal og laste inn en ALL-
fil fra C3 Portal. Se "Lagre en ALL-fil til en 
skytjeneste" (side 117) og "Laste inn en ALL-
fil fra en skytjeneste" (side 118).
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Thumbnail-skjerm
Når du trykker på knappen THUMBNAIL (side 5), vises klipp som er tatt opp på minnekortet som miniatyrbilder på skjermen.
Du kan velge et klipp på miniatyrbildeskjermen og starte avspillingen fra klippet. Avspillingsbildet kan vises i søkeren og på en ekstern skjerm.
Når du trykker på knappen THUMBNAIL en gang til, lukkes miniatyrbildet, og bildet går tilbake til kamerabildet.

[Merk]
Bare klippene som er tatt opp i det gjeldende opptaksformatet, vises på miniatyrbildeskjermen. Hvis et forventet opptak ikke vises, kontroller opptaksformatet. Vær spesielt oppmerksom på dette før du formaterer (initialiserer) medier.

Skjermoppsett

Informasjon om klippet ved markørposisjonen vises nederst på skjermen.

4 5

6

3

1

2

Indikator for valgt minnekort
(Det vises et låseikon hvis kortet er beskyttet.)

Markør (gul)

Klippnummer / totalt antall klipp

1.	 Miniatyrbilde (indeksbilde)
Viser indeksbildet for et klipp. Når et klipp tas 
opp, angis det første bildet automatisk som 
indeksbilde.
Klipp/bilde-informasjon vises under 
miniatyrbildet. Du kan endre informasjonen 
som vises, ved å bruke Customize View 
(side 101) >Thumbnail Caption i Thumbnail-
menyen i hovedmenyen.

2.	 Navn på klipp
Viser navnet til det valgte klippet.

3.	 Videoformatet til opptakene
Viser filformatet til det valgte klippet.

4.	 Spesiell opptaksinformasjon
Viser opptaksmodusen bare hvis klippet ble 
tatt opp med en spesiell opptaksmodus.
For klipp med sakte og rask bevegelse vises 
bildehastigheten til høyre.

5.	 Klippvarighet

6.	 Opprettelsesdato
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Spille av klipp

Spille av innspilte klipp

Du kan spille av innspilte klipp når 
videokameraet er i standby-modus for opptak.

1	 Sett inn minnekortet som skal spilles av.

2	 Trykk på THUMBNAIL-knappen.

3	 Bruk flervalg-knappen (side 7) eller 
flerfunksjonshjulet (side 5) til å flytte 
markøren til miniatyrbildet for klippet du 
vil spille av.

4	 Trykk på flervalg-knappen eller på 
flerfunksjonshjulet.
Avspillingen begynner fra begynnelsen av 
det valgte klippet.

Du kan kontrollere avspillingen ved å trykke på 
følgende knapper.
Trykk på flervalg-knappen eller 

flerfunksjonshjulet: 
Setter avspillingen på pause.  
Trykk en gang til for å gå tilbake til normal 
avspilling.

Trykk på venstre/høyre flervalg-knappen: 
Hopp til starten av klippet eller forrige/
neste klipp.

Trykk på og hold nede venstre/høyre 
flervalg-knappen: 
Hurtig bak-/fremover spoling.  
Går tilbake til normal avspilling når du 
slipper knappen.

CANCEL/BACK-knapp: 
Stopper avspilling og går tilbake til 
standby-modus for opptak.

[Merknader]
ˎˎ Det kan hende at det er korte bildebrudd eller visning 

av stillbilder på overgangen mellom klippene. Du kan 
ikke bruke videokameraet i denne perioden.
ˎˎ Når du velger et klipp på miniatyrbildeskjermen og 

begynner avspillingen, kan det hende opptaket på 
begynnelsen av klippet brytes opp en kort stund. 
Hvis du vil se starten på klippet uten forstyrrelser, sett 
videokameraet i avspillingsmodus, sett på pause, bruk 
venstre flervalg-knappen for å gå tilbake til starten av 
klippet og start avspillingen igjen.

[Tips]
Når et klipp som ble tatt opp i en Log-opptaksmodus 
spilles av, brukes EI-verdien og LUT som ble brukt 
da klippet ble tatt opp. Den LUT som skal brukes 
bestemmes ut fra metadata-informasjonen i den 
lagrede 3D LUT-filen.
Hvis klippet ble tatt opp med Cine EI/Flex.ISO Set 
>Embed LUT File (side 85) i Project-menyen i 
hovedmenyen satt til On under opptak, brukes denne 
LUT for avspilling hvis 3D LUT-filen som ble brukt ved 
opptak er installert i enheten.
Hvis klippet ble tatt opp med Cine EI/Flex.ISO Set 
>Embed LUT File (side 85) i Project-menyen i 
hovedmenyen satt til Off under opptak, vil den LUT som 
er valgt med Base Look >Select (side 91) i Paint/Look-
menyen i hovedmenyen bli brukt for avspilling.
Den samme LUT brukes hvis 3D LUT-filen som ble brukt 
ved opptak ikke er installert på enheten.
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På miniatyrbildeskjermen kan du håndtere 
klippene eller kontrollere egenskaper for 
klippet ved hjelp av Thumbnail-menyen i 
hovedmenyen.
Thumbnail-menyen (side 101) vises når du 
trykker og holder nede MENU-knappen og 
velger Thumbnail.

Thumbnail-menyhandlinger

Bruk flervalg-knappen (side 7) eller 
flerfunksjonshjulet (side 5) til å velge 
en funksjon, og trykk deretter på flervalg-
knappen eller flerfunksjonshjulet.
Trykk på CANCEL/BACK-knappen (side 5) 
for å gå til forrige skjermbilde.

[Merk]
Noen elementer kan ikke velges, avhengig av statusen 
da menyen ble vist.

Menyelementer for klipp-
operasjoner

ˎˎ Display Clip Properties
ˎˎ Set Clip Flag
ˎˎ Lock/Unlock Clip
ˎˎ Delete Clip
ˎˎ Transfer Clip
ˎˎ Transfer Clip (Proxy)
ˎˎ Filter Clips
ˎˎ Customize View

For mer informasjon om menyelementer for 
klippfunksjoner, se menyen Thumbnail på 
(side 101).

Vise egenskaper for utklipp

Velg Display Clip Properties (side 101) på 
Thumbnail-menyen for å vise skjermbildet for 
klippenes egenskaper.
Trykk på venstre/høyre flervalg-knappen for å 
hoppe til forrige/neste klipp.

Legge til klippflagg

Du kan legge klippflagg (merker OK, NG eller 
KP) til klipp for å filtrere visningen av klipp 
basert på klippflaggene.
Velg miniatyrbildet for klippet du vil legge til 
et klippflagg på, og velg deretter klippflagget 
ved hjelp av Set Clip Flag (side 101) i 
Thumbnail-menyen i hovedmenyen.

Innstilling Klippflagg som legges til

Add OK OK

Add NG NG

Add KEEP KP

[Tips]
ˎˎ Du kan også bruke en tilordnet knapp med 

klippflagg-funksjonen for å legge til klippflagg 
(side 49).

ˎˎ Du kan legge et OK-klippflagg (side 53) til 
miniatyrbildet av det valgte klippet ved å trykke på 
Clip Flag-knappen (side 5).

Vise miniatyrbildebildeskjermen med 
filtrerte klipp

Velg Filter Clips (side 101) fra Thumbnail-
menyen i hovedmenyen, og velg en 
klippflaggtype for å vise bare de klippene som 
har det angitte flagget.
Hvis du vil vise alle klippene, velger du All.

[Tips]
Du kan også bytte filtre i rekkefølge ved hjelp av 
DISPLAY-knappen.

Slette klipp

Du kan slette klipp fra minnekort.
Velg Delete Clip >Select Clip eller All Clips fra 
Thumbnail-menyen i hovedmenyen.
Select Clip: 

Sletter det valgte klippet. Valget av flere 
klipp støttes.

All Clips: 
Sletter alle viste klipp.

Endre informasjonen som vises på 
miniatyrbildeskjermen

Du kan endre informasjonen om klipp/bilde 
som vises under miniatyrbildet.
Velg Customize View >Thumbnail Caption i 
Thumbnail-menyen i hovedmenyen, og velg 
informasjonen som skal vises.
Date Time: 

Viser datoen og klokkeslettet da klippet 
ble opprettet og sist endret.

Time Code: 
Viser tidskoden.

Duration: 
Viser varigheten av klippet.

Sequential Number: 
Viser et sekvensnummer for hvert 
miniatyrbilde.

Klipp-handlinger
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Full menykonfigurasjon og -hierarki
Trykk og hold nede MENU-knappen for å 
vise hovedmenyen i søkeren for å angi ulike 
punkter for fotografering, opptak og avspilling 
(menyen kan også vises på en ekstern skjerm). 
Hovedmenyen inneholder følgende menyer.

Menykonfigurasjon

User-meny
Inneholder menyelementer som er 
konfigurert av brukeren ved hjelp av Edit 
User Menu.

Edit User-meny
Inneholder menyelementer for redigering 
av brukermenyen.

Shooting-meny
Inneholder innstillinger som gjelder 
fotografering.

Project-meny
Inneholder grunnleggende 
prosjektinnstillinger.

Paint/Look-meny
Inneholder innstillinger som gjelder 
bildekvaliteten.

TC/Media-meny
Inneholder innstillinger som gjelder 
tidskoder og opptaksmedier.

Monitoring-meny
Inneholder innstillinger som gjelder 
videovisning og søkervisning.

Audio-meny
Inneholder innstillinger som gjelder lyd.

Thumbnail-meny
Inneholder innstillinger som gjelder 
miniatyrbildevisning.

Technical-meny
Inneholder innstillinger for tekniske 
punkter.

Network-meny
Inneholder innstillinger som gjelder 
nettverk.

Maintenance-meny
Inneholder enhetsinnstillinger, for 
eksempel klokke og språk.

Fullt menyhierarki

User 
(fabrikkinnstillinger)

Base Setting

Focus

S&Q Motion

LUT On/Off

Simul Rec

Proxy Rec

Interval Rec

Assignable Button

Assignable Dial

Multi Function Dial

All File

Clip Name Format

Format Media

VF Setting

Zebra

Zoom

Menu Settings

Edit User Menu Add Item

Customize Reset

Shooting ISO/Gain/EI

ND Filter

Shutter

Iris

Auto Exposure

White

White Setting

Offset White

Focus

S&Q Motion

LUT On/Off

Noise Suppression

Flicker Reduce

SteadyShot

Project Base Setting

Rec Format

Cine EI/Flex.ISO Set

HDR Setting

Simul Rec

Proxy Rec

Interval Rec

Picture Cache Rec

SDI/HDMI Rec Control

Assignable Button

Assignable Dial

Multi Function Dial

User File

All File

Paint/Look Scene File

Base Look

Reset Paint Settings

Black

Knee

Detail

Matrix

Multi Matrix

TC/Media Timecode

TC Display

Users Bit

HDMI TC Out

Clip Name Format

Update Media

Format Media

Monitoring Output On/Off

Output Format

De-Squeeze

Output Display

Display On/Off

Marker

VF Setting

Gamma Display Assist

Peaking

Zebra

Audio Audio Input

Audio Output

Thumbnail Display Clip Properties

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Transfer Clip

Transfer Clip (Proxy)

Filter Clips

Customize View

Technical Color Bars

ND Dial

Tally

HOLD Switch Setting

Touch Operation

Rec Review

Zoom

Handle Zoom

Menu Settings

Menu Page On/Off

Fan Control

Lens

Video Light Set

APR

Camera Battery Alarm

Camera DC IN Alarm
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Network Access Authentication

Wireless LAN

AP Mode Settings

ST Mode Settings

Wired LAN

Modem

File Transfer

Network Reset

Maintenance Language

Clock Set

All Reset

Hours Meter

Version
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Bruk av hovedmenyen
Trykk og hold nede MENU-knappen for å 
vise hovedmenyen i søkeren for å spesifisere 
detaljerte innstillinger (menyen kan også vises 
på en ekstern skjerm).

Menystyring

MENU-knapp (side 5)
Trykk og hold for å vise hovedmenyen. 
Trykk en gang til mens hovedmenyen 
vises for å skjule menyen.

Flervalg-knappen (8-veis D-plate og bruk-
knapper) (side 7)

Trykk på den 8-veis D-pad-ens knapper 
for å flytte markøren opp/ned/venstre/
høyre for å velge menyelementer eller 
innstillinger.
Trykk på flervalg-knappen bruksknapp for 
å bruke det valgte punktet.

Flerfunksjonshjul (side 5)
Drei flerfunksjonshjulet.for å flytte 
markøren opp/ned for å velge 
menyelementer eller innstillinger.
Trykk på flerfunksjonshjulet for å bruke 
det valgte elementet.

CANCEL/BACK-knapp (side 5)
Trykk for å gå tilbake til forrige meny. En 
ufullført endring annulleres.

[Merknader]
ˎˎ Hovedmenyen kan ikke bruke i fokusforstørrer-modus 

(side 37).
ˎˎ Noen elementer kan ikke velges, avhengig av 

statusen da menyen ble vist.

Stille inn menyelementer

Trykk på den 8-veis D-pad-ens knapper 
eller vri på flerfunksjonshjulet for å flytte 
markøren til menyelementet som skal angis, 
og trykk deretter på Bruk-knappen eller 
flerfunksjonshjulet for å velge elementet.
ˎˎ Valgområdet for menyelementet viser opptil 
åtte linjer. Hvis de tilgjengelige alternativene 
for et element ikke kan vises samtidig, blar 
du i displayet ved å flytte markøren opp/
ned.
ˎˎ For underpunkter med stort 
innstillingsområde (for eksempel –99 til 
+99) vises ikke innstillingsområdet. Den 
gjeldende innstillingen er markert for å angi 
at verdien kan endres.
ˎˎ Hvis du velger [Execute] for en funksjon, 
utføres den tilsvarende funksjonen.
ˎˎ Hvis du velger et element som må bekreftes 
før utførelsen, skjules menyen midlertidig, 
og det vises en bekreftelsesmelding. 
Kontroller meldingen, og velg deretter om 
funksjonen skal utføres eller avbrytes.

Skrive inn en tegnstreng

Når du velger et element, for eksempel et 
filnavn som krever at det skrives noe, vises 
skjermbildet for tekst.

1

2 3

1	 Trykk på den 8-veis D-pad-ens knapper 
eller drei på flerfunksjonshjulet for å velge 
en tegntype, og bruk deretter 
innstillingen.
ABC: Store bokstaver
abc: Små bokstaver
123: Tall
!#$: Spesialtegn

2	 Velg et tegn fra den valgte tegntypen, og 
bruk deretter innstillingen.
Markøren flyttes til neste felt.

Space: Setter inn et mellomrom ved 
markørposisjonen.

/: flytter posisjonen til markøren.
BS: Sletter tegnet til venstre for markøren 

(tilbake).

3	 Når du er ferdig, velger du [Done] og 
bruker innstillingen.
Tegnstrengen bekreftes, og tekstskjermen 
forsvinner.

Låse og låse opp menyen

Du kan låse hovedmenyen slik at bare bruker-
menyen vises.
I denne statusen kan ikke innstillingene 
endres ved hjelp av statusskjermbildene.

Låse menyen

1	 Trykk og hold nede flerfunksjonshjulet, og 
trykk og hold nede MENU-knappen.

2	 Velg Menu Settings >User Menu with Lock 
i menyen Technical.

	 [Merk]
Når du trykker på og holder bare MENU-knappen 
nede for å vise den vanlige hovedmenyen, vises 
User Menu Only under Menu Settings i menyen 
Technical. Trykk og hold nede flerfunksjonshjulet, og 
trykk og hold nede MENU-knappen for å vise User 
Menu with Lock.

3	 Sett til On, og trykk på knappen Bruk eller 
flerfunksjonshjulet.
Visningen på søkerskjermen bytter til 
skjermen for inntasting av passkode.

4	 Oppgi et valgfritt nummer.
Angi et 4-sifret tall mellom 0000 og 9999. 
Standardverdien er 0000.
Tast inn et tall og trykk på knappen Bruk 
eller flerfunksjonshjulet for å flytte 
markøren til neste siffer.
Når alle sifrene er lagt inn, flytter du 
markøren til SET.

5	 Trykk på knappen Bruk eller på 
flerfunksjonshjulet.
Oppføringen tas i bruk.
Det vises en bekreftelsesmelding, og 
skjermbildet skifter til å vise User-menyen.
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Låse opp menyen

1	 Trykk og hold nede flerfunksjonshjulet, og 
trykk og hold nede MENU-knappen.

2	 Velg Menu Settings >User Menu with Lock 
i menyen User.

	 [Merk]
Når du trykker på og holder bare MENU-knappen 
nede for å vise den vanlige hovedmenyen, vises 
User Menu Only under Menu Settings i menyen 
Technical. Trykk og hold nede flerfunksjonshjulet, 
og trykk og hold nede MENU-knappen for å vise 
User Menu with Lock.

3	 Sett til Off, og trykk på knappen Bruk eller 
flerfunksjonshjulet.
Visningen på søkerskjermen bytter til 
skjermen for inntasting av passkode.

4	 Angi passkoden som ble brukt til å låse 
menyen.
Tast inn et tall og trykk på knappen Bruk 
eller flerfunksjonshjulet for å flytte 
markøren til neste siffer.
Når alle sifrene er lagt inn, flytter du 
markøren til Set.

5	 Trykk på knappen Bruk eller på 
flerfunksjonshjulet.
Oppføringen tas i bruk.
Hvis den angitte passkoden samsvarer 
med kodetallet som ble brukt til å låse 
menyen, låses menyen opp, og menyen 
vises.

[Merknader]
ˎˎ Hvis den angitte passkoden ikke samsvarer med 

kodetallet som ble brukt til å låse menyen, blir ikke 
menyen låst opp.
ˎˎ Det anbefales at du skriver opp passkoden i 

nærheten, i tilfelle du glemmer det. Hvis du 
glemmer passkoden, kan du ta kontakt med en 
servicerepresentant for Sony.

ˎˎ Hvis menyen låses uten å registrere elementene i 
hovedmenyen fra følgende tabell i User-menyen, kan 
ikke disse funksjonene tilordnes knapper som kan 
tilordnes.
ˎˎ Hvis disse funksjonene allerede er tilordnet til 

knapper som kan tilordnes, deaktiveres den 
tilordnede innstillingen automatisk når menyen låses.

Element i 
hovedmenyen

Knappevalg som 
kan tilordnes

Shooting >ISO/Gain/EI 
>Base Sensitivity,  
Shooting >ISO/Gain/EI 
>Base ISO

Base ISO/Sensitivity

Shooting >Auto 
Exposure >AGC

AGC

— Auto ND Filter

Shooting >Iris >Bokeh 
Control

Bokeh Control

Shooting >Auto 
Exposure >Auto Shutter

Auto Shutter

Shooting >Auto 
Exposure >Level

Auto Exposure Level

Shooting >Auto 
Exposure >Mode

Backlight

Shooting >Auto 
Exposure >Mode

Spotlight

Shooting >White > 
Preset White

Preset White Select

Shooting >Focus > 
AF Transition Speed, 
Shooting >Focus > 
AF Subj. Shift Sens.

AF Speed/Sens.

Shooting >Focus > 
Focus Area

Focus Area

Shooting >Focus > 
Focus Area(AF-S)

Focus Area(AF-S)

Shooting >Focus > 
Face/Eye Detection AF

Face/Eye Detection 
AF

Shooting >Focus > 
Push AF Mode

Push AF Mode

Shooting >S&Q Motion 
>Setting

S&Q Motion

Shooting >SteadyShot 
>Setting

SteadyShot

Element i 
hovedmenyen

Knappevalg som 
kan tilordnes

Project >Picture Cache 
Rec >Setting

Picture Cache Rec

Technical >Rec Review 
>Setting

Rec Review

Thumbnail >Set Clip 
Flag >Add OK

Clip Flag OK

Thumbnail >Set Clip 
Flag >Add NG

Clip Flag NG

Thumbnail >Set Clip 
Flag >Add KEEP

Clip Flag Keep

Technical >Color Bars 
>Setting

Color Bars

Monitoring >Display 
On/Off >Lens Info

Lens Info

Monitoring >Display 
On/Off >Video Signal 
Monitor

Video Signal 
Monitor

Monitoring >Marker 
>Setting

Marker

Monitoring >VF Setting 
>Color Mode

VF Mode

Monitoring >Gamma 
Display Assist >Setting

Gamma Display 
Assist

Monitoring >Peaking 
>Setting

Peaking

Monitoring >Zebra 
>Setting

Zebra

Audio >Audio Output 
>Volume

Volume

Technical >Touch 
Operation >Setting

Touch Operation

Technical >Handle 
Zoom >Setting

Handle Zoom

Network >Wireless LAN 
>NFC

NFC

Network >File Transfer 
>Auto Upload (Proxy)

Auto Upload (Proxy)

User User Menu
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User-meny
Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.

User

Element Beskrivelse

Base Setting Project >Base Setting-element

Focus Shooting >Focus-element

S&Q Motion Shooting >S&Q Motion-element

LUT On/Off Shooting >LUT On/Off-element

Simul Rec Project >Simul Rec-element

Proxy Rec Project >Proxy Rec-element

Interval Rec Project >Interval Rec-element

Assignable Button Project >Assignable Button-element

Assignable Dial Project >Assignable Dial-element

Multi Function Dial Project >Multi Function Dial-element

All File Project >All File-element

Clip Name Format TC/Media >Clip Name Format-element

Format Media TC/Media >Format Media-element

VF Setting Monitoring >VF Setting-element

Zebra Monitoring >Zebra-element

Zoom Technical >Zoom-element

Menu Settings Technical >Menu Settings-element

Edit User Menu Viser skjermbildet Edit User Menu.

[Merk]
Du kan legge til og fjerne menyelementer på User-menyen ved å bruke Edit User-menyen. Opptil 20 elementer kan 
konfigureres.
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Edit User-meny
Edit User-menyen vises på øverste nivå når Edit User Menu er valgt på User-menyen.

Edit User

Element Innstilling for underelement Beskrivelse

Add Item
Legg til et element på 
brukermenyen

Legger til et element på User-
menyen.

Customize Reset
Tilbakestiller 
elementene på User-
menyen

Gjenoppretter menyelementene 
som er registrert på User-menyen til 
fabrikkinnstillingene.

Menyelement som 
velges under redigering

Delete Sletter det registrerte 
menyelementet fra User-menyen.

Move Omorganiserer de registrerte 
menyelementene på User-menyen.

Edit Sub Item Redigerer (registrerer/sletter) 
underelement registrert på User-
menyen.
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Shooting-meny
Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Shooting >ISO/Gain/EI
Angir forsterkningsinnstillinger.

Element Innstilling for underelement Beskrivelse

Mode ISO/dB Velger modus for forsterkningsinnstilling.

[Merk]
I Log-opptaksmoduser er denne satt til ISO 
(fast).

ISO/Gain<H> For mer informasjon om innstillinger, se 
"ISO/Gain-innstillinger og standardverdier" 
(side 110).

Angir den forhåndsinnstilte verdien for 
<H> forsterkning.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI/Cine EI Quick-opptaksmodus.

ISO/Gain<M> For mer informasjon om innstillinger, se 
"ISO/Gain-innstillinger og standardverdier" 
(side 110).

Angir den forhåndsinnstilte verdien for 
<M> forsterkning.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI/Cine EI Quick-opptaksmodus.

ISO/Gain<L> For mer informasjon om innstillinger, se 
"ISO/Gain-innstillinger og standardverdier" 
(side 110).

Angir den forhåndsinnstilte verdien for 
<L> forsterkning.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI/Cine EI Quick-opptaksmodus.

Shooting >ISO/Gain/EI
Angir forsterkningsinnstillinger.

Element Innstilling for underelement Beskrivelse

Exposure 
Index<H>

Cine EI
Når Base ISO er satt til ISO 800:

200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 8.0E

Når Base ISO er satt til ISO 12800:
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Angir den forhåndsinnstilte verdien for 
<H> eksponeringsindeks.
Aktivert kun i Cine EI/Cine EI Quick-
opptaksmodus.
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Shooting >ISO/Gain/EI
Angir forsterkningsinnstillinger.

Element Innstilling for underelement Beskrivelse

Exposure 
Index<H>

Cine EI Quick
200EI / 4.0E
250EI / 4.3E
320EI / 4.7E
400EI / 5.0E
500EI / 5.3E
640EI / 5.7E
800EI / 6.0E
1000EI / 6.3E
1250EI / 6.7E
1600EI / 7.0E
2000EI / 7.3E
2500EI / 7.7E
3200EI / 4.0E
4000EI / 4.3E
5000EI / 4.7E
6400EI / 5.0E
8000EI / 5.3E
10000EI / 5.7E
12800EI / 6.0E
16000EI / 6.3E
20000EI / 6.7E
25600EI / 7.0E
32000EI / 7.3E
40000EI / 7.7E
51200EI / 8.0E

Angir den forhåndsinnstilte verdien for 
<H> eksponeringsindeks.
Aktivert kun i Cine EI/Cine EI Quick-
opptaksmodus.

Exposure 
Index<M>

(Samme innstillinger som Exposure 
Index<H>)
Cine EI

Når Base ISO er satt til ISO 800:
1000EI / 6.3E

Når Base ISO er satt til ISO 12800:
16000EI / 6.3E

Cine EI Quick
800EI / 6.0E

Angir den forhåndsinnstilte verdien for 
<M> eksponeringsindeks.

Shooting >ISO/Gain/EI
Angir forsterkningsinnstillinger.

Element Innstilling for underelement Beskrivelse

Exposure 
Index<L>

(Samme innstillinger som Exposure 
Index<H>)
Cine EI

Når Base ISO er satt til ISO 800:
800EI / 6.0E

Når Base ISO er satt til ISO 12800:
12800EI / 6.0E

Cine EI Quick
800EI / 6.0E

Angir den forhåndsinnstilte verdien for 
<L> eksponeringsindeks.

Shockless 
Gain

On / Off Slår funksjonen for forsterkning uten støt 
av/på.

Base 
Sensitivity

High / Low Still inn basis-sensitiviteten for Custom-
opptaksmodus.

Base ISO ISO 12800 / ISO 800 Stiller inn basis ISO-følsomhet for Flexible 
ISO/Cine EI-opptaksmodus.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI Quick-opptaksmodus. Base ISO-følsomheten 
konfigureres automatisk i samsvar med 
Exposure Index.

Shooting >ND Filter
Angir de forhåndsinnstilte verdiene for ND-filteret.

Element Innstilling for underelement Beskrivelse

Preset1 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Angir forhåndsinnstilt verdi 1 for ND-
filteret.

Preset2 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Angir forhåndsinnstilt verdi 2 for ND-
filteret.

Preset3 1/4 / 1/8 / 1/16 / 1/32 / 1/64 / 1/128 Angir forhåndsinnstilt verdi 3 for ND-
filteret.

Shooting >Shutter
Stille inn funksjonen for elektronisk lukker.

Element Innstilling for underelement Beskrivelse

Mode Speed / Angle Velger driftsmodus for den elektroniske 
lukkeren.
Brukes til å ta klare bilder av motiver i 
rask bevegelse. Velger modus for 
innstilling av lukkerhastigheten i 
sekunder (Speed) eller som en 
lukkervinkel (Angle).
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Shooting >Shutter
Stille inn funksjonen for elektronisk lukker.

Element Innstilling for underelement Beskrivelse

Shutter 
Speed  
On/Off

On / Off Angir om eksponeringstiden når Speed-
modus er valgt, følger verdien for Shutter 
Speed eller om den er stilt inn for full 
eksponering.

Shutter 
Speed

64F til 1/8000
De tilgjengelige innstillingene varierer 
avhengig av systemfrekvensen til det 
valgte opptaksformatet.
59.94P: 

64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

50P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/50 / 1/60 / 1/100 / 1/120 / 
1/125 / 1/250 / 1/500 / 1/1000 / 
1/2000 / 1/4000 / 1/8000

29.97P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/30 / 1/40 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

25P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/25 / 1/33 / 1/50 / 1/60 / 
1/100 / 1/120 / 1/125 / 1/250 / 1/500 / 
1/1000 / 1/2000 / 1/4000 / 1/8000

24P/23.98P: 
64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 1/24 / 1/32 / 1/48 / 1/50 / 
1/60 / 1/96 / 1/100 / 1/120 / 1/125 / 
1/250 / 1/500 / 1/1000 / 1/2000 / 
1/4000 / 1/8000

Angir lukkerhastigheten når Mode er satt 
til Speed.

Shutter Angle 64F / 32F / 16F / 8F / 7F / 6F / 5F / 4F / 
3F / 2F / 360.0° / 300.0° /  
270.0° / 240.0° / 216.0° / 210.0° /  
180.0° / 172.8° / 150.0° / 144.0° /  
120.0° / 90.0° / 86.4° / 72.0° / 45.0° / 
30.0° / 22.5° / 11.25° / 5.6°

Angir lukkervinkelen når Mode er satt til 
Angle.

ECS On/Off On / Off Slår funksjonen ECS (utvidet klar 
skanning) av/på.

Shooting >Shutter
Stille inn funksjonen for elektronisk lukker.

Element Innstilling for underelement Beskrivelse

ECS 
Frequency

23.99 til 8000
De tilgjengelige innstillingene varierer 
avhengig av systemfrekvensen til det 
valgte opptaksformatet.
Standardverdiene står nedenfor.
59.94P: 60.00
50P: 50.00
29.97P: 30.00
23.98P: 23.99
25P: 25.02
24P: 24.02

Angir ECS-frekvensen når Mode er satt til 
ECS.

Shooting >Iris
Stiller inn Bokeh-kontrollfunksjonens innstillinger.

Element Innstilling for underelement Beskrivelse

Bokeh 
Control

On / Off Slår Bokeh-kontrollfunksjonen av/på.

Shooting >Auto Exposure
Angir innstillinger for justering av automatisk eksponering.

Element Innstilling for underelement Beskrivelse

Level +3.0 / +2.75 / +2.5 / +2.25 / +2.0 / +1.75 / 
+1.5 / +1.25 / +1.0 / +0.75 / +0.5 / +0.25 / 
±0 / –0.25 / –0.5 / –0.75 / –1.0 / –1.25 / 
–1.5 / –1.75 / –2.0 / –2.25 / –2.5 / –2.75 / 
–3.0

Angir lysstyrkenivået for den automatisk 
registrerte eksponeringen.

Mode Backlight / Standard / Spotlight Angir driftsmodusen for automatisk 
eksponeringsjustering.
Backlight: 

Baklysmodus (modus for redusert 
mørkfarging av skygger når motivet 
er bakgrunnsbelyst)

Standard: 
Standardmodus

Spotlight: 
Lyskastermodus (modus for redusert 
antall beskårne hvite felter når 
motivet er punktvis opplyst)

Speed –99 til +99 (±0) Angir justeringshastigheten for 
automatisk eksponeringsjustering.
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Shooting >Auto Exposure
Angir innstillinger for justering av automatisk eksponering.

Element Innstilling for underelement Beskrivelse

AGC On / Off Slår funksjonen AGC (automatisk 
forsterkningskontroll) av/på.

[Merk]
Denne er satt til Off (fast) i Cine EI/Cine EI 
Quick-opptaksmodus.

AGC Limit For mer informasjon om innstillinger, se 
"AGC Limit-innstillinger og 
standardverdier" (side 113).

Angir maksimal forsterkning for AGC-
funksjonen.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI/Cine EI Quick-opptaksmodus.

AGC Point F2.8 / F4 / F5.6 Angir F-stoppverdien for irisen der 
AGC-operasjonen starter når AGC-
funksjonen er på.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI/Cine EI Quick-opptaksmodus.

Auto Shutter On / Off Slår funksjonen automatisk lukkerkontroll 
av/på.

[Merk]
Denne er satt til Off (fast) i Cine EI/Cine EI 
Quick-opptaksmodus.

A.SHT Limit 1/100 / 1/150 / 1/200 / 1/250 / 1/2000 Angir den raskeste lukkerhastigheten for 
den automatiske lukkerfunksjonen.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI/Cine EI Quick-opptaksmodus.

A.SHT Point F5.6 / F8 / F11 / F16 Angir F-stoppverdien for irisen der den 
automatiske lukkeroperasjonen starter.

[Merk]
Denne funksjonen kan ikke konfigureres i Cine 
EI/Cine EI Quick-opptaksmodus.

Clip High 
light

On / Off Slår funksjonen som ignorerer lyseste 
områder for å gi en flatere respons ved 
høy luminans av/på.

Detect 
Window

1 / 2 / 3 / 4 / 5 / 6 / Custom Angir lysmålingsområdet for automatisk 
justering av eksponeringen i henhold til 
motivets lysstyrke. (Ikke tilgjengelig ved 
manuell justering av eksponering)

Shooting >Auto Exposure
Angir innstillinger for justering av automatisk eksponering.

Element Innstilling for underelement Beskrivelse

Detect 
Window 
Indication

On / Off Slår indikasjonen av lysmålingsområdet 
av/på.

Custom 
Width

40 til 999 (500) Angir bredden på lysmålingsområdet.

Custom 
Height

70 til 999 (500) Angir høyden på lysmålingsområdet.

Custom H 
Position

–479 til +479 (±0) Angir den horisontale posisjonen på 
lysmålingsområdet.

Custom V 
Position

–464 til +464 (±0) Angir den vertikale posisjonen på 
lysmålingsområdet.

Shooting >White
Setter innstillinger for hvitbalanse.

Element Innstilling for underelement Beskrivelse

Preset White 2000K til 15000K (3200K) Angir den forhåndsinnstilte verdien for 
hvitbalanse.

Color Temp 
<A>

2000K til 15000K (3200K) Stiller inn fargetemperaturen for 
hvitbalanse som lagres i minne A.

[Merk]
Siden Color Temp kuttes ved 2000K og 15000K 
når R/B Gain brukes, kan det hende at det ikke 
er mulig å vise riktig Color Temp-verdi for R/B 
Gain-verdien.

Tint<A> –99 til +99 (±0) Stiller inn fargetonen for hvitbalanse som 
lagres i minne A.

[Merk]
Siden Tint kuttes ved ±99 når R/B Gain brukes, 
kan det hende at det ikke er mulig å vise riktig 
Tint-verdi for R/B Gain-verdien.

R Gain <A> –99.0 til +99.0 (±0.0) Stiller inn hvitbalanse R 
forsterkningsverdi som lagres i minne A.

B Gain <A> –99.0 til +99.0 (±0.0) Stiller inn hvitbalanse B 
forsterkningsverdi som lagres i minne A.

Color Temp 
<B>

2000K til 15000K (3200K) Stiller inn fargetemperaturen for 
hvitbalanse som lagres i minne B.

[Merk]
Siden Color Temp kuttes ved 2000K og 15000K 
når R/B Gain brukes, kan det hende at det ikke 
er mulig å vise riktig Color Temp-verdi for R/B 
Gain-verdien.
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Shooting >White
Setter innstillinger for hvitbalanse.

Element Innstilling for underelement Beskrivelse

Tint<B> –99 til +99 (±0) Stiller inn fargetonen for hvitbalanse som 
lagres i minne B.

[Merk]
Siden Tint kuttes ved ±99 når R/B Gain brukes, 
kan det hende at det ikke er mulig å vise riktig 
Tint-verdi for R/B Gain-verdien.

R Gain <B> –99.0 til +99.0 (±0.0) Stiller inn hvitbalanse R 
forsterkningsverdi som lagres i minne B.

B Gain <B> –99.0 til +99.0 (±0.0) Stiller inn hvitbalanse B 
forsterkningsverdi som lagres i minne B.

Shooting >White Setting
Justerer innstillinger for hvitbalanse.

Element Innstilling for underelement Beskrivelse

Shockless 
White

Off / 1 / 2 / 3 Angir responshastigheten for hvitbalanse 
ved skifte av hvitbalansemodus.
Off: Skifter umiddelbart.
1 til 3: Skifter saktere jo høyere tall.

ATW Speed 1 / 2 / 3 / 4 / 5 Angir responshastigheten for ATW-
modus.
1: Raskeste responshastighet

White 
Switch<B>

Memory / ATW Velger modus for justering av hvitbalanse 
som er valgt når bryteren WHT BAL er 
satt til B.

[Merk]
Denne er satt til Memory (fast) i Cine EI/Cine EI 
Quick-opptaksmodus.

Filter White 
Memory

On / Off Slår funksjonen som angir minneområdet 
for hvitbalanse for hvert ND-filter av/på.
On: Angir minnet for hvitbalanse for 

hvert ND-filter.

	 [Tips]
I forhåndsinnstilt modus er det fire 
innstillinger (CLEAR/1/2/3). I variabel 
modus er det to innstillinger (CLEAR/On).

Off: Angir hvitbalanseminnet som er 
felles for alle ND-filtre.

Shooting >Offset White
Setter innstillinger for hvitbalanseforskyvning.

Element Innstilling for underelement Beskrivelse

Offset White 
<A>

On / Off Velger om du vil legge til (On) eller ikke 
legge til (Off) en forskyvningsverdi til 
hvitbalansen i minne A.

[Merk]
Denne er satt til Off (fast) i Log-
opptaksmoduser.

Offset Color 
Temp<A>

–99 til +99 (±0) Angir forskyvning av fargetemperatur 
som skal legges til hvitbalansen i minne 
A når Offset White <A> er satt til On.

Offset 
Tint<A>

–99 til +99 (±0) Angir forskyvning av Tint-verdi som skal 
legges til hvitbalansen i minne A når 
Offset White <A> er satt til On.

Offset White 
<B>

On / Off Velger om du vil legge til (On) eller ikke 
legge til (Off) en forskyvningsverdi til 
hvitbalansen i minne B.

[Merk]
Denne er satt til Off (fast) i Log-
opptaksmoduser.

Offset Color 
Temp<B>

–99 til +99 (±0) Angir forskyvning av fargetemperatur 
som skal legges til hvitbalansen i minne 
B når Offset White <B> er satt til On.

Offset 
Tint<B>

–99 til +99 (±0) Angir forskyvning av Tint-verdi som skal 
legges til hvitbalansen i minne B når 
Offset White <B> er satt til On.

Offset White 
<ATW>

On / Off Velger om du vil legge til (On) eller ikke 
legge til (Off) en forskyvningsverdi i ATW 
hvitbalanse.

Offset Color 
Temp<ATW>

–99 til +99 (±0) Angir forskyvning av fargetemperatur 
som skal legges til ATW hvitbalansen når 
Offset White <ATW> er satt til On.

Offset 
Tint<ATW>

–99 til +99 (±0) Angir forskyvning av Tint-verdi som skal 
legges til ATW hvitbalansen når Offset 
White <ATW> er satt til On.

Shooting >Focus
Angir fokusinnstillinger.

Element Innstilling for underelement Beskrivelse

AF Transition 
Speed

1(Slow) / 2 / 3 / 4 / 5 / 6 / 7(Fast) Angir hastigheten på fokusmotoren for 
når motivet endres under autofokusering.
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Shooting >Focus
Angir fokusinnstillinger.

Element Innstilling for underelement Beskrivelse

AF Subj. Shift 
Sens.

1(Locked On) / 2 / 3 / 4 / 5(Responsive) Angir følsomheten for endring av fokus 
på motiv under autofokus.

Focus Area Wide / Zone / Flexible Spot Angir målområdet for autofokus og push 
autofokus (AF) (side 38).
Wide: 

Søker etter et motiv over en vid vinkel 
i bildet når du fokuserer.

Zone: 
Søker automatisk etter et fokuspunkt 
innenfor den angitte sonen.

Flexible Spot: 
Fokuserer på en angitt posisjon i 
bildet.

Focus Area 
(AF-S)

Flexible Spot Angir målområdet for autofokus med 
push autofokus (AF-S).

Face/Eye 
Detection AF

Face/Eye Only AF / Face/Eye Priority AF / 
Off

Aktiverer/deaktiverer ansiktsdeteksjon 
AF.

Push AF 
Mode

AF / Single-shot AF(AF-S) Angir modus for push autofokus under 
manuell fokus.

Touch 
Function in 
MF

Tracking AF / Spot Focus Stiller inn handlingen som utføres når 
berøringspanelet trykkes under manuell 
fokus.

Multi Selector 
Function

Face/Eye Sel. Cursor / Pointer Stiller inn metoden for angivelse av 
sanntidssporing av AF-mål i forhold til 
betjening av flervalgsknappen.

Pointer Color Orange / White / Yellow / Cyan / Green / 
Magenta / Red / Blue

Stiller inn fargen på pekeren som brukes 
til angivelse av sanntidssporing av 
AF-mål.

Pointer 
Border

On / Off Stiller inn grensen for pekeren som 
brukes til angivelse av sanntidssporing av 
AF-mål på/av.

AF Assist On / Off Når den er satt til On, kan du midlertidig 
overstyre autofokus og sette fokus 
manuelt.

Shooting >S&Q Motion
Angir innstillinger for sakte og hurtig bevegelse (side 50).

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår sakte og hurtig modus av/på.
Når den er satt til på, deaktiveres 
følgende funksjoner.

ˎˎ Autoiris
ˎˎ Autofokus

Frame Rate 1fps til 60fps / 100fps / 120fps / 150fps / 
180fps / 200fps / 240fps

Angir bildehastigheten for opptak av 
sakte og rask bevegelse.

[Merk]
De tilgjengelige innstillingene varierer 
avhengig av den valgte bildefrekvensen, 
kodeken og videoformatet.

Shooting >LUT On/Off
Angir LUT-innstillinger.

Element Innstilling for underelement Beskrivelse

SDI/HDMI MLUT On / MLUT Off Velger om skjerm-LUT skal brukes på SDI- 
og HDMI-utgangsvideoen.

VF/Proxy/
Stream

MLUT On / MLUT Off Velger om skjerm-LUT skal brukes i 
søkeren, proxy og direkteavspilt video.

Internal Rec MLUT On / MLUT Off Velger om skjerm-LUT skal brukes på den 
interne opptaksvideoen.

Shooting >Noise Suppression
Angir innstillinger for støydemping.

[Tips]
Innstillingene for Setting(Custom) og Level(Custom) vises i Target Display-innstillingen (side 116).

Element Innstilling for underelement Beskrivelse

Setting 
(Custom)

On / Off Slår støydempingsfunksjonen av/på i 
Custom-opptaksmodus.

[Merk]
Denne funksjonen kan ikke konfigureres i Log-
opptaksmodus.

Level 
(Custom)

Low / Mid / High Stiller inn støydempingsnivået i Custom-
opptaksmodus.

[Merk]
Denne funksjonen kan ikke konfigureres i Log-
opptaksmodus.
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Shooting >Noise Suppression
Angir innstillinger for støydemping.

[Tips]
Innstillingene for Setting(Custom) og Level(Custom) vises i Target Display-innstillingen (side 116).

Element Innstilling for underelement Beskrivelse

Setting 
(Cine EI/Flex. 
ISO)

On / Off Slår støydempingsfunksjonen av/på i 
Log-opptaksmodus.

[Merk]
Denne funksjonen kan ikke konfigureres i 
Custom-opptaksmodus.

Level 
(Cine EI/Flex. 
ISO)

Low / Mid / High Stiller inn støydempingsnivået i Log-
opptaksmodus.

[Merk]
Denne funksjonen kan ikke konfigureres i 
Custom-opptaksmodus.

Shooting >Flicker Reduce
Angir innstillinger for flimmerkorrigering.

Element Innstilling for underelement Beskrivelse

Mode Auto / On / Off Angir modusen for flimmerkorrigering.

Frequency 50Hz / 60Hz Angir frekvensen til strømkilden som 
leverer belysningen som forårsaker 
flimringen.

Shooting >SteadyShot
Angir innstillinger for bildestabilisering.

Element Innstilling for underelement Beskrivelse

Setting Active / Standard / Off Angir funksjonen for bildestabilisering.

[Merk]
Aktivert når et kompatibelt objektiv er koblet til.
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Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Project >Base Setting
Angir grunninnstillinger.

Element Innstilling for underelement Beskrivelse

Shooting 
Mode

Custom / Flexible ISO / Cine EI Quick / 
Cine EI

Angir fotograferingsmodus (side 24).

Target 
Display

SDR(BT.709) / HDR(HLG) Angir videostandard for opptak/utdata i 
Custom-opptaksmodus.

Project >Rec Format
Angir innstillinger for opptaksformat.

Element Innstilling for underelement Beskrivelse

Frequency 59.94 / 50 / 29.97 / 25 / 24 / 23.98 Velger systemfrekvens.

Imager Scan 
Mode

FF / S35 Velger Imager-størrelse.

Codec RAW / RAW & XAVC-I / RAW(HDMI) /  
RAW(HDMI) & XAVC-I / XAVC-I / XAVC-L

Angir codec for opptak/avspilling av 
klippet.

RAW Output 
Format

De tilgjengelige innstillingene varierer 
avhengig av Frequency- og Codec-
innstillingene.

Stiller inn bildestørrelsen for RAW-
utgang.

[Merk]
Når Codec er satt til RAW & XAVC-I, skifter 
innstillingen av Video Format i samsvar med 
innstillingen av RAW Output Format.

Frequency Codec Valgalternativer

59.94/
50/
29.97/
25/
23.98

RAW 4096×2160

3840×2160

RAW & 
XAVC-I

4096×2160

3840×2160

RAW(HDMI) 4240×2392

RAW(HDMI) 
& XAVC-I

4240×2392

24 RAW 4096×2160

RAW & 
XAVC-I

4096×2160

Project >Rec Format
Angir innstillinger for opptaksformat.

Element Innstilling for underelement Beskrivelse

Video Format De tilgjengelige innstillingene varierer 
avhengig av Frequency- og Codec-
innstillingene.

Stiller inn bildestørrelsen og bithastighet.

Frequency Codec Valgalternativer

59.94 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

50 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Project-menyen
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Project >Rec Format
Angir innstillinger for opptaksformat.

Element Innstilling for underelement Beskrivelse

Video Format 29.97 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

25 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

Project >Rec Format
Angir innstillinger for opptaksformat.

Element Innstilling for underelement Beskrivelse

Video Format 23.98 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

3840×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

3840×2160P

1920×1080P

XAVC-L 3840×2160P

1920×1080P 50

1920×1080P 35

24 RAW/
RAW(HDMI)

–

RAW & 
XAVC-I

4096×2160P

RAW(HDMI) 
& XAVC-I

3840×2160P

XAVC-I 4096×2160P

Project >Cine EI/Flex.ISO Set
Angir innstillinger av Log-opptaksmodus (Cine EI, Cine EI Quick, Flexible ISO).

Element Innstilling for underelement Beskrivelse

Color Gamut S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Angir fargeskalaer for Log-
opptaksmoduser.

Embed LUT 
File

On / Off Slår 3D LUT-filens (CUBE-fil) 
metadataopptak av/på.
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Project >HDR Setting
Stiller inn HDR-modusens innstillinger.

Element Innstilling for underelement Beskrivelse

VF SDR 
Preview

On / Off I HDR-modus vil denne funksjonen slå 
funksjonen som konverterer søkerens 
bilde fra HDR til SDR av/på når Gamma 
Display-skjermhjelp er aktivert.

[Tips]
Når den er satt til On, brukes SDR Gain på 
søkerens bilde.

SDR Gain 0dB til –15dB (–6dB) I HDR-modus vil dette stille inn SDR 
Gain-innstillingen som brukes for 
søkeren når VF SDR Preview er satt til On.

Project >Simul Rec
Angir innstillinger for samtidig opptaksmodus (side 52).

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår den samtidige opptaksfunksjonen 
av/på og angir målmediet for opptak.

Rec Button 
Set

Rec Button:[SlotA SlotB] Handle Rec 
Button:[SlotA SlotB] / Rec Button:[SlotA] 
Handle Rec Button:[SlotB] / Rec 
Button:[SlotB] Handle Rec Button:[SlotA]

Tilordner opptaksknappene som brukes 
til å styre hvert enkelt av 
opptaksmediene.

Project >Proxy Rec
Angir innstillinger for proxy-oppptak-modus.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår proxy-opptaksmodus av/på.

Audio 
Channel

CH1/CH2 / CH3/CH4 Velger lydkanalen som skal tas opp til 
proxy-data.

Chunk 30s / 1min / 2min Velger underinndeling-opptaksintervall 
for proxy-filer.

Project >Interval Rec
Angir innstillinger for intervallopptaksmodus (side 50).

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår intervallopptaksmodus av/på. (Hvis 
du setter denne modusen til On, settes 
alle andre spesialmoduser til Off.)

Interval Time 1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 
20 / 30 / 40 / 50 (s)
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 15 / 20 / 
30 / 40 / 50 (min)
1 / 2 / 3 / 4 / 6 / 12 / 24 (h)

Angir intervallet mellom opptak i 
modusen for intervallopptak (når Interval 
Rec er satt til On).

Project >Interval Rec
Angir innstillinger for intervallopptaksmodus (side 50).

Element Innstilling for underelement Beskrivelse

Number of 
Frames

1frame / 2frames / 3frames / 6frames / 
9frames / 12frames
De tilgjengelige innstillingene varierer 
avhengig av bildefrekvensen til det valgte 
videoformatet.
59.94P/50P: 

2frames / 6frames / 12frames
29.97P/25P/24P/23.98P: 

1frame / 3frames / 6frames / 9frames

Angir antall bilder som skal tas per 
opptak i modusen for intervallopptak 
(når Interval Rec er satt til On).

Pre-Lighting Off / 2 s / 5 s / 10 s Angir hvor mange sekunder videolyset 
skal slås på før opptaket starter i 
modusen for intervallopptak.

[Tips]
Bare tilgjengelig ved bruk av HVL-LBPC 
(tilleggsutstyr).

Project >Picture Cache Rec
Stiller inn bildets cache-opptaksmodus (side 51).

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår bildets cache-opptaksmodus av/på.

Cache Size Short / Medium / Long / Max Stiller inn tiden for akkumulering av 
bilder i cache-minnet (opptakstid for 
bilde-cache).

Cache Rec 
Time

Viser tiden for akkumulering av bilder i 
cache-minnet (opptakstid for bilde-
cache).
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Project >SDI/HDMI Rec Control
Angir innstillinger for SDI/HDMI-opptakskontroll.

Element Innstilling for underelement Beskrivelse

Setting Off / SDI/HDMI Remote I/F / Parallel Rec Angir start-/stoppkontroll av opptak i en 
ekstern enhet via SDI/HDMI-
utgangssignalet.
Off: 

Ikke bruk fjernkontroll.
SDI/HDMI Remote I/F: 

Stopp/start-kontroll av opptak i en 
ekstern tilkoblet enhet, når det ikke er 
satt inn noe medium i 
videokameraet. Ikke synkronisert 
med bildenøyaktighet til 
videokameramediet.

Parallel Rec: 
Stopp/start-kontroll av opptak i en 
ekstern tilkoblet enhet, når det er satt 
inn medium i videokameraet. 
Synkronisert med bildenøyaktighet i 
forhold til videokameramedier.

[Merk]
For kontroll ved bruk av HDMI-utgangssignalet, 
sett HDMI TC Out >Setting (side 94) i 
hovedmenyens TC/Media-meny til On.

Project >Assignable Button
Setter funksjonstilordninger til knapper som kan tilordnes.

Element Innstilling for underelement Beskrivelse

<1> til <9>, 
Focus Hold 
Button

Off / Base ISO/Sensitivity / AGC / Push 
AGC / ND Filter Position / Auto ND Filter / 
Push Auto ND / Auto Iris / Push Auto Iris / 
Bokeh Control / Auto Shutter / Auto 
Exposure Level / Backlight / Spotlight / 
Preset White Select / ATW / ATW Hold / AF 
Speed/Sens. / Focus Setting / Focus Area / 
Focus Area(AF-S) / Face/Eye Detection AF / 
Push AF Mode / Push AF/Push MF / Focus 
Hold / Focus Magnifier x3/x6 / Focus 
Magnifier x3 / Focus Magnifier x6 / S&Q 
Motion / SteadyShot / Rec / Picture Cache 
Rec / Rec Review / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / Color Bars / Tally 
[Front] / DURATION/TC/U-BIT / Display / 
Lens Info / Video Signal Monitor / Marker / 
VF Adjust / VF Mode / Gamma Display 
Assist / Peaking / Zebra / Volume / 
Thumbnail / Touch Operation / Handle 
Zoom / NFC / Auto Upload (Proxy) / Direct 
Menu / User Menu / Menu

Tilordner funksjoner til knapper som kan 
tilordnes.
Base ISO/Sensitivity: 

Endrer bildesensorens 
basisfølsomhet.

AGC: 
Slår AGC-funksjonen av/på.

Push AGC: 
Aktiverer AGC-funksjonen mens 
knappen trykkes inn.

ND Filter Position: 
Skifter ND-filtre.

Auto ND-filter: 
Slår auto ND-filterfunksjonen av/på.

Push Auto ND: 
Aktiverer funksjonen automatisk 
ND-filter mens knappen trykkes inn.

Auto Iris: 
Slår irisfunksjonen av/på.

Push Auto Iris: 
Aktiverer autoiris-funksjonen mens 
knappen trykkes inn.

Bokeh Control: 
Slår Bokeh-kontrollmodus av/på.

Auto Shutter: 
Slår funksjonen automatisk 
lukkerkontroll av/på.

Auto Exposure Level: 
Viser/avslutter hurtigmenyen for 
Auto Exposure Level.

Backlight: 
Veksler mellom Backlight og 
Standard.

Spotlight: 
Veksler mellom Spotlight og 
Standard.

Preset White Select: 
Endrer verdien for forhåndsinnstilt 
hvitbalansemodus.

ATW: 
Slår ATW-funksjonen av/på.

ATW-hold: 
Stanser ATW-funksjonen midlertidig.
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Project >Assignable Button
Setter funksjonstilordninger til knapper som kan tilordnes.

Element Innstilling for underelement Beskrivelse

<1> til <9>, 
Focus Hold 
Button

AF Speed/Sens.: 
Endrer innstillingen for AF-
overgangshastighet og innstillingen 
for AF-motivets følsomhet.

Focus Setting: 
Angir fokusområdet. 

Focus Area: 
Angir fokusområdet for AF og Push 
AF.

Focus Area(AF-S): 
Angir fokusområdet for Push AF 
(AF-S).

Face/Eye Detection AF: 
Endrer AF-innstillingene for ansikts-/
øyedeteksjon.

Push AF Mode: 
Endrer innstillingen for Push AF-
modus.

Push AF/Push MF: 
I MF-fokuseringsmodus aktiveres AF 
mens knappen trykkes inn. 
I AF-fokuseringsmodus aktiveres MF 
mens knappen trykkes inn.

Focus Hold: 
I AF-fokuseringsmodus er fokus låst 
mens knappen trykkes inn.

Focus Magnifier x3/x6:
Focus Magnifier x3:
Focus Magnifier x6: 

Slår forstørrelsesfunksjonen for fokus 
av/på.

S&Q Motion: 
Slår Slow & Quick Motion av/på. 
Angir bildehastigheten når du trykker 
og holder inne.

SteadyShot: 
Veksler mellom Active, Standard og 
Off.

Rec: 
Starter/stopper opptaket.

Picture Cache Rec: 
Slår bildets cache-opptaksmodus av/
på.

Project >Assignable Button
Setter funksjonstilordninger til knapper som kan tilordnes.

Element Innstilling for underelement Beskrivelse

<1> til <9>, 
Focus Hold 
Button

Rec Review: 
Slår funksjonen 
opptaksgjennomgang av/på.

Clip Flag OK: 
Utfører funksjonen Add OK. 
Trykk to ganger for å Delete Clip Flag.

Clip Flag NG: 
Utfører funksjonen Add NG. 
Trykk to ganger for å Delete Clip Flag.

Clip Flag Keep: 
Utfører funksjonen Add Keep. 
Trykk to ganger for å Delete Clip Flag.

Color Bars: 
Slår fargestolpene av/på.

Tally [Front]: 
Slår lyset/blinkingen for opptaks-/
tellefunksjonen av/på.

DURATION/TC/U-BIT: 
Veksler mellom Time Code, Users Bit 
og Duration.

Display: 
Slår skjermindikatorene av/på.

Lens Info: 
Skifter dybdeskarphetsindikatoren.

Video Signal Monitor: 
Skifter videosignalskjermen (for 
eksempel en kurveskjerm).

Marker: 
Slår markørfunksjonen av/på.

VF Adjust: 
Viser nivålinjene for justering av 
lysstyrken på søkerskjermen.

VF Mode: 
Bytter søkervisning mellom farge og 
svart/hvitt.

Gamma Display Assist: 
Aktiverer eller deaktiverer funksjonen 
gammaskjermhjelp.

Peaking: 
Slår Peaking-funksjonen av/på.
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Project >Assignable Button
Setter funksjonstilordninger til knapper som kan tilordnes.

Element Innstilling for underelement Beskrivelse

<1> til <9>, 
Focus Hold 
Button

Zebra: 
Slår Zebra-funksjonen av/på.

Volume: 
Justerer lydutgangen fra skjermen til 
hodetelefonkontakten og den 
innebygde høyttaleren.

Thumbnail: 
Viser/avslutter 
miniatyrbildeskjermen.

Touch Operation: 
Slår berøringsfunksjonen av/på.

Handle zoom: 
Skifter zoom-operasjon for 
håndtaket.

NFC: 
Utfører NFC-funksjonen.

Auto Upload (Proxy): 
Slår av/på automatisk opplasting, 
eller angir Chunk-modus.

Direct Menu: 
Viser/lukker hurtigmenyen.

User Menu: 
Viser/lukker menyen User.

Menu: 
Viser/lukker hovedmenyen.

Project >Assignable Dial
Angir funksjonstilordninger for hjul som kan tilordnes og angir rotasjonsretning.

Element Innstilling for underelement Beskrivelse

Grip/Remote 
Dial

Off / ISO/Gain/EI / ND Filter / IRIS /  
Auto Exposure Level / Audio Input Level / 
Multi Function Dial

Tilordner funksjoner til det 
programmerbare hjulet på grepet.
ISO/Gain/EI: 

Justerer forsterkningen eller EI.
ND Filter: 

Justerer ND-filteret.
IRIS: 

Justerer iris.
Auto Exposure Level: 

Justerer nivået for automatisk 
eksponeringsnivå.

Audio Input Level: 
Justerer nivået for lydopptak.

Multi Function Dial: 
Fungerer som et flerfunksjonshjul.

Grip Dial 
Direction

Normal / Opposite Angir dreieretningen for grephjulet som 
kan tilordnes.
Normal: Drei i normal retning.
Opposite: Drei i motsatt retning.

Handle Dial Off / ISO/Gain/EI / ND Filter / IRIS / Auto 
Exposure Level / Audio Input Level / Multi 
Function Dial

Tilordner funksjoner til det 
programmerbare hjulet på håndtaket.
ISO/Gain/EI: 

Justerer forsterkningen eller EI.
ND Filter: 

Justerer ND-filteret.
IRIS: 

Justerer iris.
Auto Exposure Level: 

Justerer nivået for automatisk 
eksponeringsnivå.

Audio Input Level: 
Justerer nivået for lydopptak.

Multi Function Dial: 
Fungerer som et flerfunksjonshjul.

Handle Dial 
Direction

Normal / Opposite Angir dreieretningen for hjulet på 
håndtaket som kan tilordnes.
Normal: Drei i normal retning.
Opposite: Drei i motsatt retning.
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Project >Multi Function Dial
Tilordner funksjoner til flerfunksjonshjulet.

Element Innstilling for underelement Beskrivelse

Default 
Function

Off / IRIS / ISO/Gain/EI / Auto Exposure 
Level / Audio Input Level

Tilordner standardfunksjonen til 
flerfunksjonshjulet.
IRIS: 

Justerer iris.
ISO/Gain/EI: 

Justerer forsterkningen eller EI.
Auto Exposure Level: 

Justerer nivået for automatisk 
eksponeringsnivå.

Audio Input Level: 
Justerer nivået for lydopptak.

Project >User File
Angir innstillinger som gjelder brukerfiloperasjoner.

Element Innstilling for underelement Beskrivelse

Load from 
Media(B)

Execute / Cancel Laster inn brukerfilinnstillinger fra et 
minnekort som er satt inn i CFexpress 
Type A/SD-kortspor (B).
Execute: Utfør funksjon.

Save to 
Media(B)

Execute / Cancel Lagrer brukerinnstillinger på et minnekort 
som er satt inn i CFexpress Type A/
SD-kortspor (B).
Execute: Utfør funksjon.

File ID Viser et skjermbilde for visning/
redigering av fil-ID-en til brukerfiler.

Load 
Customize 
Data

On / Off Angir om User-menyens tilpassede 
informasjon skal lastes når Load from 
Media(B) utføres.

Load White 
Data

On / Off Angir om det skal lastes inn informasjon 
om hvitbalanse når Load from Media(B) 
utføres.

Project >All File
Angir innstillinger som gjelder ALL-filer.

Element Innstilling for underelement Beskrivelse

Load from 
Media(B)

Execute / Cancel Laster inn ALL-filinnstillinger fra et 
minnekort som er satt inn i CFexpress 
Type A/SD-kortspor (B).
Execute: Utfør funksjon.

Load from 
Cloud(Private)

Execute / Cancel Laster en opplastet ALL-fil fra C3 Portal-
skytjenesten (private)
Execute: Utfør funksjon.

Load from 
Cloud(Share)

Execute / Cancel Laster en opplastet ALL-fil fra C3 Portal-
skytjenesten (share)
Execute: Utfør funksjon.

Save to 
Media(B)

Execute / Cancel Lagrer ALL-filinnstillinger på et minnekort 
som er satt inn i CFexpress Type A/
SD-kortspor (B).
Execute: Utfør funksjon.

Save to 
Cloud(Private)

Execute / Cancel Laster ALL-filinnstillinger til C3 Portal-
skytjenesten (private).
Execute: Utfør funksjon.

Save to 
Cloud(Share)

Execute / Cancel Laster ALL-filinnstillinger til C3 Portal-
skytjenesten (share).
Execute: Utfør funksjon.

File ID Tilordner et navn til filen.

Load Network 
Data

On / Off Angir om innstillingsinformasjon for 
menyen Network skal lastes når Load 
from Media(B), Load from Cloud(Private), 
eller Load from Cloud(Share) utføres.
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Paint/Look-meny
Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Paint/Look >Scene File
Angir innstillinger som gjelder scenefiler.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Recall Laster inn en scenefil som er lagret i det 
interne minnet, og bruker innstillingene 
som de gjeldende innstillingene for 
bildekvalitet.

Store Lagrer gjeldende bildekvalitetsstatus 
som en scenefil i det interne minnet.

Delete Sletter en scenefil som er lagret i 
internminnet.

Preset Recall Når Shooting Mode er satt som Custom og 
Target Display er satt til SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 / 
709tone / Cancel

Når Shooting Mode er satt som Custom og 
Target Display er satt til HDR (HLG):

HLG Live / HLG Natural / Cancel

Bruker forhåndsinnstilte 
bildekvalitetsinnstillinger (ikke-
overskrivbare) som gjeldende 
innstillinger for bildekvalitet.

Paint/Look >Base Look
Angir innstillinger som gjelder basisutseende.

Element Innstilling for underelement Beskrivelse

Select Når Shooting Mode er satt som Custom og 
Target Display er satt til SDR(BT.709):

S-Cinetone / Standard / Still / ITU709 / 
709tone / User1 til User16

Når Shooting Mode er satt som Custom og 
Target Display er satt til HDR (HLG):

HLG Live / HLG Natural / User1 til 
User16

Når du står i Log-opptaksmodus:
s709 / 709(800) / S-Log3 / User1 til 
User16

Velger et basisutseende.

Delete Sletter det valgte basisutseendet.

Delete All Sletter alle basisutseender.
Import from 
Media(B)

Execute / Cancel Importerer en basisutseende-fil fra et 
minnekort som er satt inn i CFexpress 
Type A/SD-kortspor (B).
Execute: Utfør funksjon.

Paint/Look >Base Look
Angir innstillinger som gjelder basisutseende.

Element Innstilling for underelement Beskrivelse
Import from 
Cloud(Private)

Execute / Cancel Importerer en opplastet basisutseende-fil 
fra C3 Portal-skytjenesten (private).
Execute: Utfør funksjon.

Import from 
Cloud(Share)

Execute / Cancel Importerer en opplastet basisutseende-fil 
fra C3 Portal-skytjenesten (share).
Execute: Utfør funksjon.

Input S-Gamut3/SLog3 / S-Gamut3.Cine/SLog3 Angir innfargeregister for det valgte 
basisutseendet.

Output BT.709 / HLG Angir utfargespekteret for det valgte 
basisutseendet.

AE Level 
Offset

0EV / 1/3EV / 2/3EV / 1EV / 4/3EV /  
5/3EV / 2EV

Angir eksponeringsreferanseverdien for 
det valgte basisutseendet.

Paint/Look >Reset Paint Settings
Tilbakestiller innstillingene for Paint-/Look-menyen, unntatt basisutseende.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Reset without 
Base Look

Execute / Cancel Tilbakestiller innstillingene for Paint-/
Look-menyen, unntatt basisutseende.
Execute: Utfør funksjon.

Paint/Look >Black
Angir sorte innstillinger.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Master Black –99.0 til +99.0 (±0.0) Angir nivået for hoved-sort.

R Black –99.0 til +99.0 (±0.0) Angir nivået for R-sort.

B Black –99.0 til +99.0 (±0.0) Angir nivået for B-sort.

Paint/Look >Knee
Angir innstillinger for knekorrigering.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Setting Når Target Display er satt til SDR(BT.709):
On / Off / ---

Når Target Display er satt til HDR(HLG):
On / Off / ---

Slår funksjonen for knekorreksjon av/på.

[Tips]
Aktivert kun når Base Look >Select er satt til 
Standard, ITU709, 709tone, HLG Live, eller HLG 
Natural.
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Paint/Look >Knee
Angir innstillinger for knekorrigering.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Auto Knee Når Target Display er satt til SDR(BT.709):
On / Off / ---

Når Target Display er satt til HDR(HLG):
On / Off / ---

Slår den automatiske knefunksjonen av/
på.

[Tips]
Aktivert kun når Setting for kne-korreksjon 
er satt til On og Base Look >Select er satt til 
Standard, ITU709, eller 709tone.

Point 75% til 109% (90%) Angir knepunktet.

Slope –99 til +99 (±0) Angir hellingen for kneet.

Paint/Look >Detail
Angir innstillinger for detaljjustering.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår den detaljfunksjonen av/på.

Level –7 til +7 (±0) Angir detaljnivået.

Manual 
Setting

On / Off / --- Slår funksjonen for manuell justering av 
detaljer av/på.

V/H Balance –2 til +2 (±0) Stiller inn balansen mellom vertikale (V) 
og horisontale (H) detaljer for manuell 
justering av detaljer.

B/W Balance Type1 / Type2 / Type3 / Type4 / Type5 Angir balansen mellom de svarte (B) 
detaljene for områder med lav lystetthet 
og de hvite (W) detaljene for områder 
med høy lystetthet for manuell justering 
av detaljer.

Limit 0 til 7 Angir detaljnivå for manuell justering av 
detaljer.

Crispening 0 til 7 Angir konturforsterkningen for manuell 
justering av detaljer.

High Light 
Detail

0 til 4 Angir detaljnivået for områder med høy 
lysstyrke for manuell justering av detaljer.

Paint/Look >Matrix
Angir innstillinger for matrisekorrigering.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

User Matrix On / Off Slår funksjonen for korreksjon av 
brukermatrisen av/på.

User Matrix 
Level

–99 til +99 (±0) Justerer fargemetningen for hele bildet.

User Matrix 
Phase

–99 til +99 (±0) Justerer fargetonen (fasen) i hele bildet.

User Matrix 
R-G

–99 til +99 (±0) Angir en brukerdefinert R-G-
brukermatrise.

User Matrix 
R-B

–99 til +99 (±0) Angir en brukerdefinert R-B-
brukermatrise.

User Matrix 
G-R

–99 til +99 (±0) Angir en brukerdefinert G-R-
brukermatrise.

User Matrix 
G-B

–99 til +99 (±0) Angir en brukerdefinert G-B-
brukermatrise.

User Matrix 
B-R

–99 til +99 (±0) Angir en brukerdefinert B-R-
brukermatrise.

User Matrix 
B-G

–99 til +99 (±0) Angir en brukerdefinert B-G-
brukermatrise.

Paint/Look >Multi Matrix
Angir innstillinger for multimatrisekorrigering.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår funksjonen for 
multimatrisekorrigering av/på.
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Paint/Look >Multi Matrix
Angir innstillinger for multimatrisekorrigering.

[Merk]
Aktivert kun i Custom-opptaksmodus.

Element Innstilling for underelement Beskrivelse

Area 
Indication

On / Off Slår på/av displayfunksjonen som 
identifiserer målområdet som tilsvarer 
målaksefargen for korreksjon under Multi 
Matrix-funksjon.
On:  

Viser områder, unntatt det 
fargeområdet som er angitt av Axis i 
svart og hvitt.

Off:  
Normal visning.

[Tips]
ˎˎ Innstillingen veksler mellom On/Off 

når du trykker på DISPLAY-knappen 
(side 6) mens innstillingsskjermen for 
multimatrisekorreksjon vises.
ˎˎ Denne innstillingen er satt til Off (fast) 

under opptak og når Bilde-cache-
opptaksfunksjonen er slått på.
ˎˎ Denne innstillingen settes automatisk 

til Off når du går fra Multi Matrix-
innstillingsmenyen til en annen skjerm.

[Merknader]
ˎˎ Når funksjonen for indikasjonsvisning av 

målområde er slått på, vil den viste videoen 
og så sendes ut som opptaksvideo og 
avspilt video.
ˎˎ Når Bilde-cache-opptaksfunksjonen er slått 

på, er det ikke mulig å endre innstillingen for 
Area Indication.

Reset Execute / Cancel Tilbakestiller innstillingene for nyanse og 
metning for hver fargeakse til 
standardverdiene.

Axis B / B+ / MG– / MG / MG+ / R / R+ / YL– / 
YL / YL+ / G– / G / G+ / CY / CY+ / B–

Velg det målet for fargeakse som skal 
justeres.

Hue –99 til +99 (±0) Stiller inn nyanse for fargeakse for 
justering som er valgt i Axis.

Saturation –99 til +99 (±0) Stiller inn metning for fargeakse for 
justering som er valgt i Axis.
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TC/Media-meny
Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

TC/Media >Timecode
Angir tidskodeinnstillinger.

Element Innstilling for underelement Beskrivelse

Mode Preset / Regen / Clock Angir kjøremodusen for tidskoder.
Preset: 

Begynner å kjøre fra en 
forhåndsinnstilt verdi.

Regen: 
Begynner å kjøre fra tidskoden på 
slutten av forrige klipp.

Clock: 
Bruker den interne klokken som 
tidskode.

Run Rec Run / Free Run Rec Run: Kjører bare under opptak.
Free Run: Kjører alltid, uavhengig av 

videokamerabruk.

Setting Setter tidskoden til en vilkårlig verdi.
SET: Angi verdien.

Reset Execute / Cancel Tilbakestiller tidskoden til 00:00:00:00.
Execute: Utfør funksjon.

TC Format DF / NDF Angir tidskodeformatet.
DF: Drop Frame
NDF: Non-Drop Frame

TC/Media >TC Display
Angir innstillinger for visning av tidsdata.

Element Innstilling for underelement Beskrivelse

Display Select Timecode / Users Bit / Duration Skifter visning av tidsdata.

TC/Media >Users Bit
Angir innstillinger som gjelder brukerbits.

Element Innstilling for underelement Beskrivelse

Mode Fix / Time Angir brukerbitsmodus.
Fix: Bruker en vilkårlig fast verdi i 

brukerbits.
Time: Bruker gjeldende time, minutt og 

sekund brukerbits.

Setting Setter brukerbits til en vilkårlig verdi.

TC/Media >HDMI TC Out
Angir innstillinger som gjelder tidskodeutgangen ved bruk av HDMI.

Element Innstilling for underelement Beskrivelse

Setting On / Off Angir om tidskode skal sendes til enheter 
for andre formål ved hjelp av HDMI.

TC/Media >Clip Name Format
Angir innstillinger som gjelder navn og sletting av klipp.

Element Innstilling for underelement Beskrivelse

Auto Naming Cam ID + Reel# / Title Velger format for navnsetting av klipp.
Cam ID + Reel#: 

Camera ID + Reel Number + Shot 
Number + dato + tilfeldig streng

Tittel:  
Tilfeldig streng spesifisert med Title 
Prefix + klippnummer

Camera ID A til Z Angi kamera-ID som brukes ved 
generering av klippnavn.

[Merk]
Konfigurerbar kun når Auto Naming er angitt til 
Cam ID + Reel#.

Reel Number 001 til 999 Angir den numeriske delen av Reel 
Number som brukes ved generering av 
klippnavn.

[Merk]
Konfigurerbar kun når Auto Naming er angitt til 
Cam ID + Reel#.

Camera 
Position

C / L / R Angir den første tegn-delen av Shot 
Number som brukes ved generering av 
klippnavn.

[Merk]
Konfigurerbar kun når Auto Naming er angitt til 
Cam ID + Reel#.
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TC/Media >Clip Name Format
Angir innstillinger som gjelder navn og sletting av klipp.

Element Innstilling for underelement Beskrivelse

Title Prefix nnn_ (nnn er de siste tre sifrene i 
serienummeret)

Angir titteldelen (4 til 46 tegn) for 
klippnavnet.
Åpner et skjermbilde der du kan angi 
tegnstrenger.

Skjermstruktur for innlegging av 
tegnstrenger
Område for valg av tegn (3 linjer): 

Velger tegnene som skal settes inn 
ved markørposisjonen i området Title 
Prefix.  
!#$%()+.-.;=@[ ]^_~0123456789 
abcdefghijklmnopqrstuvwxyz 
ABCDEFGHIJKLMNOPQRSTUVWXYZ

Markørens driftsområde (1 linje): 
Space: Setter inn et mellomrom i 
markørposisjonen.  
: Flytter markøren til venstre.  
: Flytter markøren til høyre.  
BS: Sletter tegnet til venstre for 
markøren.

Tittel prefiks (1 linje): 
Område for angivelse av tittel.

Slik angir du tittelen
1.	 Velg tegnet som skal settes inn ved 

markørposisjonen i Title Prefix-
området fra tegnvalgområdet ved 
hjelp av flervalg-knappen 
(side 7), og trykk på flervalg-
knappen bruksknapp. (Det valgte 
tegnet settes inn, og markøren flyttes 
mot høyre.)

2.	 Gjenta trinn 1 for å angi tittelen. (Bruk 
BS etter behov.)

3.	 Når du har angitt tittelen, velger du 
Done for å lukke tekstskjermbildet.

TC/Media >Clip Name Format
Angir innstillinger som gjelder navn og sletting av klipp.

Element Innstilling for underelement Beskrivelse

Number Set 0001 til 9999 Angir 4-sifret tallsuffiks for klippnavnet.

TC/Media >Update Media
Oppdaterer administrasjonsfilen på minnekort.

Element Innstilling for underelement Beskrivelse

Media(A) Execute / Cancel Oppdaterer administrasjonsfilen på 
minnekortet i spor A.
Execute: Utfør funksjon.

Media(B) Execute / Cancel Oppdaterer administrasjonsfilen på 
minnekortet i spor B.
Execute: Utfør funksjon.

TC/Media >Format Media
Initaliserer minnekort.

Element Innstilling for underelement Beskrivelse

Media(A) Full Format / Quick Format / Cancel Formaterer minnekortet i spor A.

Media(B) Full Format / Quick Format / Cancel Formaterer minnekortet i spor B.
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Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Monitoring >Output On/Off
Stiller inn videoens utgangsinnstillinger.

Element Innstilling for underelement Beskrivelse

SDI On / Off Slår SDI-utgangen av/på.

HDMI On / Off Slår HDMI-utgangen av/på.

Monitoring >Output Format
Angir innstillinger for utdataformat.

Element Innstilling for underelement Beskrivelse

SDI For mer informasjon om innstillinger, se 
"Utdataformater og -begrensninger" 
(side 123).

Angir oppløsningen for SDI- og HDMI-
utgangene.HDMI

Monitoring >De-Squeeze
Angir De-Squeeze-innstillingene.

Element Innstilling for underelement Beskrivelse

Ratio (HDMI/
VF)

Off(1.0×) / 1.3× / 1.5× / 2.0× Velger De-Squeeze-sideforhold for 
HDMI-utgangsbildet og bildet som vises i 
søkeren når opptak gjøres med et 
anamorft objektiv.

Monitoring >Output Display
Stiller inn skjermvisningens utgangsinnstillinger.

Element Innstilling for underelement Beskrivelse

SDI On / Off Stiller inn om menyen og status og 
skjermvisning er innebygd i SDI-
utgangssignalet.

HDMI On / Off Stiller inn om menyen og status og 
skjermvisning er innebygd i HDMI-
utgangssignalet.

Monitoring >Display On/Off
Angir innstillinger for skjermelementer.

Element Innstilling for underelement Beskrivelse

Network 
Status

On / Off Velger elementene som skal vises i 
søkeren.

File Transfer 
Status

On / Off

Rec/Play 
Status

On / Off

RAW Output 
Control 
Status

On / Off

Tally On / Off

Battery 
Remain

On / Off

Focus Mode On / Off

Focus 
Position

On / Off

Focus Area 
Indicator

On / Off

Focus Area 
Ind.(AF-S)

On / Off

Face/Eye 
Detection 
Frame

On / Off

Tracking AF 
Pointer

On / Off

Lens Info On / Off

Imager Scan 
Mode

On / Off

Rec Format On / Off

Frame Rate On / Off

Zoom 
Position

On / Off

UWP RF Level On / Off

SteadyShot On / Off

Monitoring-meny
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Monitoring >Display On/Off
Angir innstillinger for skjermelementer.

Element Innstilling for underelement Beskrivelse

Base Look/
Rec Look

On / Off

SDI/HDMI 
Rec Control

On / Off

Monitoring 
Look

On / Off

Proxy Status On / Off

Base ISO/
Sensitivity

On / Off

Media Status On / Off

Video Signal 
Monitor

Off / Waveform / Vector / Histogram

Clip Name On / Off

White 
Balance

On / Off

Scene File On / Off

Focus 
Indicator

On / Off

Auto 
Exposure 
Mode

On / Off

Auto 
Exposure 
Level

On / Off

Timecode On / Off

ND Filter On / Off

Iris On / Off

ISO/Gain/EI On / Off

Shutter On / Off

Level Gauge On / Off

Audio Level 
Meter

On / Off

Video Level 
Warning

On / Off

Clip Number On / Off

Notice 
Message

On / Off

Monitoring >Marker
Angir innstillinger for markørvisning.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår visningen av alle markører av/på.

Color White / Yellow / Cyan / Green / Magenta / 
Red / Blue

Velger fargen på markørsignalet.

Center 
Marker

1 / 2 / 3 / 4 / Off Velger sentermarkøren.

Safety Zone On / Off Slår sikkerhetssonemarkøren av/på.

Safety Area 80% / 90% / 92.5% / 95% Velger størrelsen på 
sikkerhetssonemarkøren (i prosent av 
total skjermstørrelse).

Aspect 
Marker

Line / Mask / Off Velger typen aspektmarkør.

Aspect Mask 0 til 15 (12) Angir nivået for videosignalet utenfor 
markøren.

Aspect Safety 
Zone

On / Off Slår indikatoren for 
aspektsikkerhetssonen av/på.

Aspect Safety 
Area

80% / 90% / 92.5% / 95% Velger størrelsen på markøren for 
aspektsikkerhetssonen (som prosent av 
total skjermstørrelse).

Aspect Select 1:1 / 4:3 / 13:9 / 14:9 / 15:9 / 16:9 / 17:9 / 
1.66:1 / 1.85:1 / 2.35:1 / 2.39:1 / Custom

Angir modus for visning av 
aspektmarkøren.

Custom 
Aspect Ratio

Angi vilkårlig verdi (01.00:01.00) Setter aspektforholdet til en vilkårlig 
verdi.

[Merk]
Denne innstillingen er bare tilgjengelig når 
Aspect Select er satt til Custom.

Guide Frame On / Off Slår visningen av føringsrammen av/på.

100% Marker On / Off Slår markøren for 100% av/på.

User Box On / Off Slår visningen av brukerboksen av/på.

User Box 
Width

3 til 479 (240) Angir bredden på brukerboksmarkøren 
(avstanden fra midten til venstre og 
høyre kant).

User Box 
Height

3 til 269 (135) Angir høyden på brukerboksmarkøren 
(avstand fra midten til øvre og nedre 
kant).

User Box H 
Position

–476 til +476 (0) Angir den horisontale posisjonen til 
midten av brukerboksmarkøren.

User Box V 
Position

–266 til +266 (0) Angir den vertikale posisjonen til midten 
av brukerboksmarkøren.
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Monitoring >VF Setting
Angir søkerinnstillinger.

Element Innstilling for underelement Beskrivelse

Brightness 1 til 15 (8) Justerer lysstyrken i søkerbildet.

Color Mode Color / B&W Velger visningsmodus for søkeren i E-E/
opptaksmodus.

Monitoring >Gamma Display Assist
Angir innstillingene for gammaskjermhjelp.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår funksjonen gammaskjermhjelp av/
på i Custom-opptaksmodus når Target 
Display er angitt til HDR(HLG).

[Merk]
Denne er satt til Off (fast) i Log-
opptaksmoduser.

Monitoring >Peaking
Angir Peaking-innstillinger.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår peaking-funksjonen av/på.

Peaking Level High / Mid / Low Angir nivået for peaking av farge.

Color B&W / Red / Yellow / Blue Velger farge for fargepeaking-signalet.

Monitoring >Zebra
Angir innstillinger for sebramønster.

Element Innstilling for underelement Beskrivelse

Setting Off / Zebra1 / Zebra2 Velger type sebramønster (Off, Zebra 1, 
Zebra 2).

Zebra1 Level 0% til 109% (70%) Stiller inn visningsnivået Zebra 1.

Zebra1 
Aperture 
Level

2% til 20% (10%) Angir nivået for blenderåpning i Zebra 1.

Zebra2 Level 0% til 109% (100%) Stiller inn visningsnivået Zebra 2.
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Audio-menyen
Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).
Se "Blokkdiagram" (side 138).

Audio > Audio Input
Innstillinger for lydinnganger.

Element Innstilling for underelement Beskrivelse

CH1 Input 
Select

INPUT1 / Internal MIC / Shoe CH1 Bytter inngangskilde for opptak på kanal 
1.

CH2 Input 
Select

INPUT1 / INPUT2 / Internal MIC / Shoe CH2 Bytter inngangskilde for opptak på kanal 
2.

CH3 Input 
Select

Off / INPUT1 / Internal MIC / Shoe CH1 Bytter inngangskilde for opptak på kanal 
3.

CH4 Input 
Select

Off / INPUT1 / INPUT2 / Internal MIC / 
Shoe CH2

Bytter inngangskilde for opptak på kanal 
4.

INPUT1 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Angir referanseopptaksnivået for XLR-
mikrofoninngangen fra INPUT1.

INPUT2 MIC 
Reference

–80dB / –70dB / –60dB / –50dB / –40dB / 
–30dB

Angir referanseopptaksnivået for XLR-
mikrofoninngangen fra INPUT2.

Line Input 
Reference

+4dB / 0dB / –3dB / EBUL Velger referanseinngangsnivået når 
INPUT1/INPUT2-bryteren er satt til LINE.

Reference 
Level

–20dB / –18dB / –16dB / –12dB / EBUL Velger opptaksnivået for 1 kHz-
referansetonesignalet.

CH1 Wind 
Filter

On / Off Aktiverer/deaktiverer 
vindreduksjonsfilteret for kanal 1-opptak.

CH2 Wind 
Filter

On / Off Aktiverer/deaktiverer 
vindreduksjonsfilteret for kanal 2-opptak.

CH3 Wind 
Filter

On / Off Aktiverer/deaktiverer 
vindreduksjonsfilteret for kanal 3-opptak.

CH4 Wind 
Filter

On / Off Aktiverer/deaktiverer 
vindreduksjonsfilteret for kanal 4-opptak.

CH3 Level 
Control

Auto / Manual Velger automatisk justering av innlydnivå 
eller manuell justering av opptakskanal 3.

[Merk]
Hvis både CH3 Input Select og CH4 Input 
Select er satt til Internal MIC (Intern mikrofon), 
byttes CH4 til Automatic/Manual (automatisk/
manuell inngangsvalg) sammen med denne 
innstillingen.

Audio > Audio Input
Innstillinger for lydinnganger.

Element Innstilling for underelement Beskrivelse

CH4 Level 
Control

Auto / Manual Velger automatisk justering av innlydnivå 
eller manuell justering av opptakskanal 4.

[Merk]
Hvis både CH3 Input Select og CH4 Input Select 
er satt til Internal MIC (Intern mikrofon), byttes 
CH4 til Automatic/Manual (automatisk/manuell 
inngangsvalg) sammen med CH3 Level Control-
innstillingen.

CH3 Input 
Level

0 til 99 (49) Stiller inn inngangsnivå for opptakskanal 
3.

CH4 Input 
Level

0 til 99 (49) Stiller inn inngangsnivå for opptakskanal 
4.

Audio Input 
Level

0 til 99 Angir lydinngangsnivået.
Kan brukes som hovedvolum i henhold til 
innstillingene av CH1 level til CH4 level.

Limiter Mode Off / –6dB / –9dB / –12dB / –15dB / –17dB Velger begrensningskarakteristikken for 
store inngangssignaler ved manuell 
justering av lydinngangsnivået.

CH1&2 AGC 
Mode

Mono / Stereo Angir modusen for automatisk 
nivåjustering av opptakskanal 1 og kanal 
2. Når AGC er satt til Stereo, er den koblet 
sammen mellom kanalene.

CH3&4 AGC 
Mode

Mono / Stereo Angir modusen for automatisk 
nivåjustering av opptakskanal 3 og kanal 
4. Når AGC er satt til Stereo, er den koblet 
sammen mellom kanalene.

AGC Spec –6dB / –9dB / –12dB / –15dB / –17dB Velger AGC-karakteristikken.

1kHz Tone on 
Color Bars

On / Off Slår av/på 1 kHz-referansetonesignalet 
ved visning av fargefelt.

[Merk]
Når det er satt til On, settes 1 kHz-
referansetonesignalet for opptak på kanal 3 og 
kanal 4, selv om CH3 Input Select og CH4 Input 
Select er satt til Off.
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Audio > Audio Input
Innstillinger for lydinnganger.

Element Innstilling for underelement Beskrivelse

CH1 Level Inngang uten XLR-adapter
Audio Input Level / Side / Level+Side

Inngang med XLR-adapter (side 48)
Audio Input Level / Through

Angir kombinasjonen av justering av 
lydinngangsnivå som er aktivert for 
opptakskanal 1.

[Merk]
"Side" refererer til AUDIO LEVEL (CH1)-hjulet 
på siden av videokameraet. Når Level+Side 
er valgt, bestemmes lydopptaksnivået av 
kombinasjonen av Audio Input Level og 
hjulinnstillinger (side 138).

CH2 Level Inngang uten XLR-adapter
Audio Input Level / Side / Level+Side

Inngang med XLR-adapter (side 48)
Audio Input Level / Through

Angir kombinasjonen av justering av 
lydinngangsnivå som er aktivert for 
opptakskanal 2.

[Merk]
"Side" refererer til AUDIO LEVEL (CH2)-hjulet 
på siden av videokameraet. Når Level+Side 
er valgt, bestemmes lydopptaksnivået av 
kombinasjonen av Audio Input Level og 
hjulinnstillinger (side 138).

CH3 Level Inngang uten XLR-adapter
Audio Input Level / CH3 Input Level / 
Level+CH3 Input Level

Inngang med XLR-adapter (side 48)
Audio Input Level / Through

Angir kombinasjonen av justering av 
lydinngangsnivå som er aktivert for 
opptakskanal 3.

CH4 Level Inngang uten XLR-adapter
Audio Input Level / CH4 Input Level / 
Level+CH4 Input Level

Inngang med XLR-adapter (side 48)
Audio Input Level / Through

Angir kombinasjonen av justering av 
lydinngangsnivå som er aktivert for 
opptakskanal 4.

Audio >Audio Output
Innstillinger for lydutganger.

Element Innstilling for underelement Beskrivelse

Monitor CH CH1/CH2 / CH3/CH4 / MIX ALL / CH1 / 
CH2 / CH3 / CH4

Velger lydkanalutgangen til 
hodetelefonkontakten og den innebygde 
høyttaleren.

[Merk]
Hvis lyd for flere kanaler er angitt for samtidig 
avspilling, reduseres utgangsnivået for hver 
kanal på utgangen for å forhindre klipping.

Volume 0 til 50 Justerer monitor-lydutgangen til 
hodetelefonkontakten og den innebygde 
høyttaleren.

Headphone 
Out

Mono / Stereo Velger om hodetelefonutgangen er i 
mono (Mono) eller stereo (Stereo).

Alarm Level 0 til 7 (4) Justerer lydstyrken for alarmen.

HDMI Output 
CH

CH1/CH2 / CH3/CH4 Angir kombinasjonen av lydkanaler på 
HDMI-utgangen.
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Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Thumbnail

Element Innstilling for underelement Beskrivelse

Display Clip 
Properties

Viser skjermbildet for klippegenskaper.

Thumbnail >Set Clip Flag
Angir klippflagginnstillinger.

Element Innstilling for underelement Beskrivelse

Add OK Legger til et OK-flagg.

Add NG Legger til et NG-flagg.

Add KEEP Legger til et Keep-flagg.

Delete Clip 
Flag

Sletter alle flagg.

Thumbnail >Lock/Unlock Clip
Angir innstillinger for klippflaggbeskyttelse.

Element Innstilling for underelement Beskrivelse

Select Clip Velger og låser / låser opp et klipp.

Lock All Clips Låser alle klipp.

Unlock All 
Clips

Låser opp alle klipp.

Thumbnail >Delete Clip
Sletter klipp.

Element Innstilling for underelement Beskrivelse

Select Clip Sletter det valgte klippet.

All Clips Sletter alle klipp.

Thumbnail >Transfer Clip
Overfører klipp.

[Merk]
Transfer Clip kan ikke konfigureres når et passord ikke er konfigurert med Access Authentication i Network-
menyen.

Element Innstilling for underelement Beskrivelse

Select Clip Overfører valgte klipp.

All Clips Overfører alle klipp.

[Merk]
Opptil 200 klipp kan overføres.

Thumbnail >Transfer Clip (Proxy)
Overfører proxy-klipp.

[Merk]
Transfer Clip (Proxy) kan ikke konfigureres når et passord ikke er konfigurert med Access Authentication i 
Network-menyen.

Element Innstilling for underelement Beskrivelse

Select Clip Overfører proxy-klipp som svarer til de 
valgte klippene.

All Clips Overfører proxy-klipp som svarer til alle 
klippene.

[Merk]
Opptil 200 klipp kan overføres.

Thumbnail >Filter Clips
Angir innstillingene for klippene som skal vises.

Element Innstilling for underelement Beskrivelse

OK Vis bare klipp som har et OK-flagg.

NG Vis bare klipp som har et NG-flagg.

KEEP Vis bare klipp som har et Keep-flagg.

None Vis bare klipp som ikke har et flagg.

All Viser alle klippene, uansett om det er 
noen flagg.

Thumbnail >Customize View
Bytter miniatyrbildevisning.

Element Innstilling for underelement Beskrivelse

Thumbnail 
Caption

Date Time / Time Code / Duration / 
Sequential Number

Skifter informasjon som vises under 
miniatyrbilder.

Thumbnail-menyen
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Technical-menyen
Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Technical >Color Bars
Angir innstillinger for fargestolper.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår fargestolpene av/på.

Type ARIB / 100% / 75% / SMPTE Velger fargestolpetype.

Technical >ND Dial
Angir innstillinger som gjelder bruk av hjulet ND VARIABLE.

Element Innstilling for underelement Beskrivelse

CLEAR with 
Dial

On / Off Angir om ND-statusendring skal aktiveres 
(CLEAR  On) ved bruk av hjulet ND 
VARIABLE.

Technical >Tally
Angir innstillinger for opptaks-/tellelampe.

Element Innstilling for underelement Beskrivelse

Front On / Off Slår opptaks-/tellelampen (Foran) av/på.

Rear On / Off Slår opptaks-/tellelampen (Bak) av/på.

Technical >HOLD Switch Setting
Angir innstillinger for holdebryter.

Element Innstilling for underelement Beskrivelse

with Rec 
Button

On / Off Angir om START/STOP-knappen for 
opptak skal låses.

with Hand 
Grip Remote

On / Off Angir om gripefjernkontrollen skal låses.

Handle HOLD 
Switch

Normal / Rec Button Only Stiller inn om Hold målet i håndtakets 
HOLD-bryter kun fungerer som 
håndtakets START/STOP-knapp for 
opptak.
Normal: 

Alle betjeningsenheter på håndtaket 
er mål for Hold-funksjonen.  
Imidlertid følger START/STOP-
knappen for opptak på håndtaket 
innstillingene for "with Rec Button"-
innstillingen.

Rec Button Only: 
Kun håndtakets START/STOP-knapp 
for opptak er målet for Hold-
funksjonen.

Technical >Touch Operation
Angir innstillinger som gjelder bruk av berøring.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår berøringsfunksjonen av/på.

Technical >Rec Review
Angir innstillinger for opptaksgjennomgang.

Element Innstilling for underelement Beskrivelse

Setting 3 s / 10 s / Clip Velger tid for avspilling av klipp som 
nettopp er tatt opp for gjennomgang av 
opptak.

Technical >Zoom
Angir zoominnstillingene.

Element Innstilling for underelement Beskrivelse

Zoom Type Optical Zoom Only / On(Clear Image 
Zoom)

Angir typen zoom.
Optical Zoom Only: 

Optisk zoom justeres ved hjelp av 
objektivet.

On(Clear Image Zoom): 
Elektronisk zoom med liten eller 
ingen forringelse av bildekvaliteten.

Technical >Handle Zoom
Angir innstillingene for håndtakets zoom.

Element Innstilling for underelement Beskrivelse

Setting Off / Low / High / Variable Angir hastigheten for håndtakets zoom.

High 1 til 8 (8) Angir zoomhastigheten for håndtakets 
zoomspak når du velger High 
zoomhastighet for håndtaket.

Low 1 til 8 (3) Angir zoomhastigheten for håndtakets 
zoomspak når du velger Low 
zoomhastighet for håndtaket.

[Merk]
Ujevn zooming kan forekomme når 
zoomhastigheten er satt til en lav verdi.
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Technical >Menu Settings
Angir innstillinger som gjelder menyen.

Element Innstilling for underelement Beskrivelse

User Menu 
Only

On / Off Angir om bare User-menyen skal vises 
(On) eller om menylisten (Off) skal vises 
når videokameraet viser menyen.

User Menu 
with Lock

On / Off Angir om menyvisningen skal låses, og 
vise bare User-menyen.

[Merk]
Ved normal bruk av menyvisningen vises ikke 
dette elementet. For mer informasjon om bruk 
av menyvisningen, se side 73.

Technical >Menu Page On/Off
Angir innstillinger som gjelder visning av statusskjermen.

Element Innstilling for underelement Beskrivelse

Main On / Off Slår visningen av Main-statusskjermen 
av/på.

Camera On / Off Slår visningen av Camera-statusskjermen 
av/på.

Audio On / Off Slår visningen av Audio-statusskjermen 
av/på.

Project On / Off Slår visningen av Project-statusskjermen 
av/på.

Monitoring On / Off Slår visningen av Monitoring-
statusskjermen av/på.

Assignable 
Button

On / Off Slår visningen av Assignable Button-
statusskjermen av/på.

Battery On / Off Slår visningen av Battery-statusskjermen 
av/på.

Media On / Off Slår visningen av Media-statusskjermen 
av/på.

Network On / Off Slår visningen av Network-
statusskjermen av/på.

File Transfer On / Off Slår visningen av File Transfer-
statusskjermen av/på.

Technical >Fan Control
Angir innstillinger for viftekontroll-modus.

Element Innstilling for underelement Beskrivelse

Setting Auto / Minimum / Off in Rec Angir modus for styring av viften i 
videokameraet.

[Merk]
Selv om av Off in Rec er valgt, vil viften starte 
hvis den interne temperaturen i videokameraet 
stiger over en bestemt verdi.

Technical >Lens
Angir innstillinger som gjelder objektiver.

Element Innstilling for underelement Beskrivelse

Zoom Ring 
Direction

Left(W)/Right(T) / Right(W)/Left(T) Angir retningen for bruk av zoomringen.

[Merk]
Denne funksjonen er bare aktivert når du 
bruker et objektiv med E-feste som støtter 
veksling av zoomringens retning.

Shading 
Compensation

Auto / Off Angir automatisk skyggekompensering.

Chroma 
Aberration 
Comp.

Auto / Off Angir automatisk kromatisk aberrasjon-
kompensering.

Distortion 
Comp.

Auto / Off Angir automatisk 
forvrengningskompensering.

Breathing 
Compensation

Auto / Off Angi objektivets pust-kompensering.

Distance 
Display

Meter / Feet Angir visningsenhetene for 
objektinformasjon og fokusposisjon.

Zoom 
Position 
Display

Focal Length / Number / Bar Angir visningsformatet for 
zoomposisjonen.
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Technical >Video Light Set
Angir belysningsmetode for videolyset. Bare tilgjengelig ved bruk av HVL-LBPC (tilleggsutstyr).

Element Innstilling for underelement Beskrivelse

Video Light 
Set

Power Link / Rec Link / Rec Link + Stby Angir metoden for belysningsstyring med 
videolyset som er festet til 
flergrensesnittskoen.
Power Link: 

Slår videolyset av/på når 
videokameraet slås av/på.

Rec Link: 
Slår videolyset av/på når 
videokameraet starter/stopper 
opptaket.

Rec Link + Stby: 
Slår videolyset på/standby når 
videokameraet starter/stopper 
opptaket.

Technical >APR
Utfører APR.

Element Innstilling for underelement Beskrivelse

APR Execute / Cancel Kjører APR (Automatic Pixel Restoration) 
for automatisk justering av bildesensor.
Execute: Utfør funksjon.

[Merk]
Sett alltid på linsedekselet før du kjører APR.

Technical >Camera Battery Alarm
Angir innstillinger for alarm for lav batterispenning.

Element Innstilling for underelement Beskrivelse

Low Battery 5% / 10% / 15% / … / 45% / 50% Stiller inn gjenværende batterinivå for å 
vise en alarm for lav batterispenning (i 
trinn på 5%).

Battery 
Empty

3% til 7% Stiller inn gjenværende batterinivå for å 
vise en alarm for tomt batteri.

Technical >Camera DC IN Alarm
Angir innstillinger for alarm for lav innspenning.

Element Innstilling for underelement Beskrivelse

DC Low 
Voltage1

16.0 V til 19.0 V (16.5 V) Angir spenningen for å vise en DC IN 
alarm for lav inngangsspenning.

DC Low 
Voltage2

15.5 V til 18.5 V Angir spenningen for å vise en DC IN 
alarm for utilstrekkelig 
inngangsspenning.
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Network-meny
Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Network >Setup for Mobile App
Utfører hjelpeverktøyet for nettverksoppsett.

Element Innstilling for underelement Beskrivelse

Setup Starter hjelpeverktøyet for 
nettverksoppsett.

Network >Access Authentication
Angir innstillinger som gjelder tilgangsautentisering.

Element Innstilling for underelement Beskrivelse

User Name Angir brukernavnet for 
tilgangsgodkjenning.

Input 
Password

Angir passordet for tilgangsgodkjenning.

[Merk]
Fra et sikkerhetssynspunkt anbefales det at du 
oppretter et passord med tilstrekkelig mange 
tegn, som er vanskelig å gjette for andre, og 
som du oppbevarer sikkert.

Generate 
Password

Execute / Cancel Genererer automatisk et passord for 
tilgangsautentisering.
Execute: Utfør funksjon.

Show 
Settings

Viser informasjon for 
tilgangsautentisering.
Viser brukernavnet, passord, 
fingeravtrykk, serienummer, og 
modellnavn som tekst og QR-kode.

[Merk]
Sørg for at passordet ikke vises for andre og at 
QR-kodebildet ikke kan kopieres av andre.

Network >Wireless LAN
Angir innstillinger som gjelder trådløse LAN-tilkoblinger.

Element Innstilling for underelement Beskrivelse

Setting Access Point Mode / Station Mode / Off Velger bruksmodus for den trådløse 
LAN-tilkoblingen.

WPS Execute / Cancel Oppretter en tilkobling ved hjelp av WPS 
(Wi-Fi Protected Setup).
Execute: Utfør funksjon.

NFC Execute / Cancel Oppretter en tilkobling ved hjelp av NFC 
(Near Field Communication).
Execute: Utfør funksjon.

Network >Wireless LAN
Angir innstillinger som gjelder trådløse LAN-tilkoblinger.

Element Innstilling for underelement Beskrivelse

MAC Address Viser MAC-adressen til videokameraets 
trådløse LAN-grensesnitt.

Network >AP Mode Settings
Angir innstillinger som gjelder tilkoblinger i aksesspunktmodus.

Element Innstilling for underelement Beskrivelse

Channel Auto(5GHz) / Auto / CH1 / CH2 /  
CH3 / CH4 / CH5 / CH6 / CH7 / CH8 / CH9 / 
CH10 / CH11

Angir kanal for trådløst LAN.
Auto(5GHz) er kun tilgjengelig på 
ILME‑FX6V/VK.

Camera SSID 
& Password

Viser videokameraets SSID og passord.

Regenerate 
Password

Execute / Cancel Oppretter et nytt passord.
Execute: Utfør funksjon.

IP Address Viser IP-adressen til videokameraet i 
aksesspunktmodus.

Subnet Mask Viser subnettmasken til videokameraet i 
aksesspunktmodus.
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Network >ST Mode Settings
Angir innstillinger som gjelder tilkoblinger i stasjonsmodus.

Element Innstilling for underelement Beskrivelse

Camera 
Remote 
Control

Enable / Disable Angir om det skal aktiveres fjernkontroll 
fra en enhet som er koblet til 
videokameraet via trådløst LAN i 
stasjonsmodus.

Connected 
Network

Viser tilkoblet trådløst LAN (aksesspunkt).

SSID Viser SSID for aksesspunktet som kobles 
til.

Security Viser sikkerhetstypen for aksesspunktet 
som kobles til.

Password Viser passordet for aksesspunktet som 
kobles til.
Når Security settes til WEP eller WPA: 

*******
Når Security er satt til None: (tom)

DHCP Viser om DHCP er av/på.

IP Address Viser videokameraets IP-adresse når 
DHCP er satt til Off.

Subnet Mask Viser videokameraets nettverksmaske 
når DHCP er satt til Off.

Gateway Viser videokameraets standard gateway 
når DHCP er satt til Off.

DNS Auto Viser om DNS-henting er av/på.

Primary DNS Server Viser den primære DNS-serveren for 
videokameraet når DNS Auto er satt til 
Off.

Secondary DNS Server Viser den sekundære DNS-serveren for 
videokameraet når DNS Auto er satt til 
Off.

Network >ST Mode Settings
Angir innstillinger som gjelder tilkoblinger i stasjonsmodus.

Element Innstilling for underelement Beskrivelse

Scan 
Networks

Finner trådløse LAN (aksesspunkt) og 
viser en liste.
Velg en tilkobling fra listen for å koble til.

SSID Viser SSID for aksesspunktet som kobles 
til.

Security Viser sikkerhetstypen for aksesspunktet 
som kobles til.

Password Skriv inn passordet for aksesspunktet for 
å koble til.

DHCP 
On / Off

Slå DHCP av/på.

IP Address Skriv inn videokameraets IP-adresse når 
DHCP er satt til Off.

Subnet Mask Skriv inn videokameraets nettverksmaske 
når DHCP er satt til Off.

Gateway Skriv inn videokameraets standard 
gateway når DHCP er satt til Off.

DNS Auto 
On / Off

Viser om automatisk DNS-henting er av/
på.

Primary DNS Server Skriv inn den primære DNS-serveren for 
videokameraet når DNS Auto er satt til 
Off.

Secondary DNS Server Skriv inn den sekundære DNS-serveren 
for videokameraet når DNS Auto er satt til 
Off.
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Network >ST Mode Settings
Angir innstillinger som gjelder tilkoblinger i stasjonsmodus.

Element Innstilling for underelement Beskrivelse

Manual 
Register

Registrerer innstillinger for manuell 
tilkobling til et aksesspunkt.

SSID Skriv inn SSID for aksesspunktet som 
kobles til.

Security 
None / WEP / WPA

Angi sikkerhetstypen for aksesspunktet 
som kobles til. Velg WPA hvis 
sikkerhetstypen for målaksesspunktet er 
WPA eller WPA2.

Password Skriv inn passordet for aksesspunktet for 
å koble til.

DHCP 
On / Off

Slå DHCP av/på.

IP Address Skriv inn videokameraets IP-adresse når 
DHCP er satt til Off.

Subnet Mask Skriv inn videokameraets nettverksmaske 
når DHCP er satt til Off.

Gateway Skriv inn videokameraets standard 
gateway når DHCP er satt til Off.

DNS Auto 
On / Off

Viser om automatisk DNS-henting er av/
på.

Primary DNS Server Skriv inn den primære DNS-serveren når 
DNS Auto er satt til Off.

Secondary DNS Server Skriv inn den sekundære DNS-serveren 
når DNS Auto er satt til Off.

Network >Wired LAN
Angir innstillinger som gjelder kablede LAN-tilkoblinger.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår den kablede LAN-funksjonen av/på.

Camera 
Remote 
Control

Enable / Disable Angir om det skal aktiveres fjernkontroll 
fra en enhet som er koblet til 
videokameraet via et kablet LAN.

Detail 
Settings

Konfigurerer egenskapene til den 
kablede LAN-tilkoblingen.

DHCP 
On / Off

Slå DHCP av/på.

IP Address Skriv inn videokameraets IP-adresse når 
DHCP er satt til Off.

Subnet Mask Skriv inn videokameraets nettverksmaske 
når DHCP er satt til Off.

Gateway Skriv inn videokameraets standard 
gateway når DHCP er satt til Off.

DNS Auto 
On / Off

Viser om automatisk DNS-henting er av/
på.

Primary DNS Server Skriv inn den primære DNS-serveren når 
DNS Auto er satt til Off.

Secondary DNS Server Skriv inn den sekundære DNS-serveren 
når DNS Auto er satt til Off.

Network >Modem
Angir innstillinger som gjelder internettdeling via USB.

Element Innstilling for underelement Beskrivelse

Setting On / Off Slår mobiltelefontilkoblingen av/på.

Camera 
Remote 
Control

Enable / Disable Angi tillatelser for fjernkontroll ved 
internettdeling via USB med bruk av 
apper på smarttelefon, som f.eks. 
Monitor & Control eller Creators' App for 
enterprise.

Device Name Viser enhetsnavnet for mobiltelefonen.

IP Address Viser mobiltelefonens IP-adresse.

Subnet Mask Viser mobiltelefonens nettverksmaske.
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Network >File Transfer
Angir innstillinger som gjelder filoverføringer.

Element Innstilling for underelement Beskrivelse

Auto Upload On / Off Slår av/på automatisk opplasting av 
originalfiler.

[Merk]
Når Simul Rec >Setting (side 86) i menyen 
Project er satt til On, vil klippene som er 
tatt opp på media i spor B ikke lastes opp 
automatisk.

Auto Upload 
(Proxy)

On / Off / Chunk On:
Aktiverer automatisk opplading av 
proxy-fil.

Off:
Deaktiverer automatisk opplading av 
proxy-fil.

Chunk:
Laster opp en proxy-fil som er tatt 
opp i underinndelinger automatisk.

[Merk]
Når Simul Rec >Setting (side 86) i menyen 
Project er satt til On, vil klippene som er 
tatt opp på media i spor B ikke lastes opp 
automatisk. I tillegg vil Chunk være nedtonet 
og kan ikke velges.

Default 
Upload 
Server

Velger opplastingsserveren for filer. 
Serveren som velges her, blir målet for 
automatisk opplasting av originalfiler og 
proxy-filer, og målet for opplasting av 
filer fra miniatyrbildeskjermen.
Viser visningsnavnet som er konfigurert i 
Server Settings 1 til 3.

Clear 
Completed 
Jobs

Execute / Cancel Fjerner fullførte overføringsjobber fra 
listen.
Execute: Utfør funksjon.

Clear All Jobs Execute / Cancel Fjerner alle overføringsjobber fra listen.
Execute: Utfør funksjon.

View Job List Viser listen over overføringsjobber.

Network >File Transfer
Angir innstillinger som gjelder filoverføringer.

Element Innstilling for underelement Beskrivelse

Server 
Settings1

Display Name Angir visningsnavnet som vises i 
overføringsmålenes oppsettmeny.

Service 
FTP

Viser typen server.

Host Name Angir vertsnavnet for 
overføringsmålserveren.

Port (1 til 65535 (21)) Angir portnummeret til serveren for 
overføringsmålet.

User Name Angir brukernavnet for godkjenning av 
forbindelsen med serveren for 
overføringsmålet.

Password Angir godkjenningspassordet for 
tilkoblingen overføringsmålserveren.

Passive Mode 
On / Off

Slår PASV-modus av/på.

Destination Directory Skriv inn navnet på overføringens 
målmappe.

Using Secure Protocol 
On / Off

Angir om sikker FTP-overføring skal 
brukes (On) eller ikke (Off) (FTPS Explicit 
Mode: FTPES).

Root Certificate 
Load / Clear / None

Laster inn et rotsertifikat for sikker 
FTP-overføring og sletter innstillinger.

Root Certificate Status 
Loaded / No Certificate

Viser status for innlasting av rotsertifikat 
for sikker FTP-overføring.

Reset 
Execute / Cancel

Tilbakestiller innstillingene i Server 
Settings til standardinnstillingene.
Execute: Utfør funksjon.

Server 
Settings2

Samme som Server Settings1.

Server 
Settings3

Samme som Server Settings1.

Network >Network Reset
Tilbakestiller nettverksinnstillingene.

Element Innstilling for underelement Beskrivelse

Reset Execute / Cancel Tilbakestiller nettverksinnstillingene.
Execute: Utfør funksjon.
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Dette avsnittet beskriver funksjonen og innstillingene for hvert menyelement.
Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 18dB).

Maintenance >Language
Angir skjermspråket.

Element Innstilling for underelement Beskrivelse

Select Angir skjermspråket.
SET: Angi språk.

Maintenance >Clock Set
Angir interne klokkeinnstillinger.

Element Innstilling for underelement Beskrivelse

Time Zone UTC – 12:00 til UTC + 14:00 Angir tidsforskjellen fra UTC i 
30-minutters enheter.

Date Mode YYMMDD / MMDDYY / DDMMYY Velger visningsformat for datoer.
YYMMDD: År, måned, dag
MMDDYY: Måned, dag, år
DDMMYY: Dag, måned, år

12h/24h 12h / 24h Velger visningsformat for klokken.
12h: 12-timers modus
24h: 24-timers modus

Date Angir gjeldende dato.
SET: Angi verdien.

Time Angir gjeldende klokkeslett.
SET: Angi verdien.

Maintenance >All Reset
Tilbakestiller innstillingene til standardinnstillingene.

Element Innstilling for underelement Beskrivelse

Reset Execute / Cancel Tilbakestiller alle innstillinger til 
fabrikkinnstillingene.
Execute: Utfør funksjon.

[Merk]
En 3D LUT-fil som er importert med bruk av 
Base Look >Import from Media(B), Import from 
Cloud(Private) eller Import from Cloud(Share) 
(side 91) i menyen Paint/Look, kan ikke 
slettes. For å slette alle de importerte 3D LUT-
filene, velg Base Look >Delete All (side 91) i 
menyen Paint/Look.

Reset without 
Network

Execute / Cancel Tilbakestiller menyinnstillingene, unntatt 
Network-menyinnstillingene, til 
fabrikkinnstillinger.

Maintenance >All Reset
Tilbakestiller innstillingene til standardinnstillingene.

Element Innstilling for underelement Beskrivelse

Reset to 
Factory 
Defaults

Execute / Cancel Sletter alle innstillinger og filer, og 
tilbakestiller dem til fabrikkinnstillinger.

Maintenance >Hours Meter
Viser akkumulert driftstid.

Element Innstilling for underelement Beskrivelse

Hours 
(System)

Viser de akkumulerte brukstimene (kan 
ikke tilbakestilles).

Hours(Reset) Viser de akkumulerte brukstimene (kan 
tilbakestilles).

Reset Execute / Cancel Tilbakestiller visningen av Hours(Reset) til 
0.
Execute: Utfør funksjon.

Maintenance >Version
Viser versjonsinformasjon.

Element Innstilling for underelement Beskrivelse

Version 
Number

Vx.xx Viser videokameraets 
programvareversjon.

Version Up Execute / Cancel Oppdaterer videokameraet.*

Execute: Utfør funksjon.
*	 Denne funksjonen oppdaterer programvaren 

i videokameraet.

Lens Version 
Number

Vxx Viser programvareversjonen for et 
objektiv med E-feste.

Maintenance-menyen
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Shooting-meny, innstillinger og standardverdier

ISO/Gain-innstillinger og standardverdier

Området for ISO/Gain-innstillinger (side 77) og standardverdier varierer avhengig av innstillingene Mode, Target Display, Base Look >Select, Base Sensitivity og Base ISO. De tilgjengelige 
alternativene er uthevet i grått.

Når Mode er satt til ISO

Custom
Target Display SDR(BT.709) HDR(HLG) SDR(BT.709) og HDR(HLG) felles

Base Look >Select S-Cinetone / Standard / Still / ITU709 / 709tone HLG Live / HLG Natural User1 til User16

Base Sensitivity Low High Low High Low High

ISO 320 ISO/Gain<L> standard

ISO 400

ISO 500

ISO 640 ISO/Gain<M> standard

ISO 800 ISO/Gain<L> standard ISO/Gain<L> standard

ISO 1000

ISO 1250 ISO/Gain<H> standard

ISO 1600 ISO/Gain<M> standard ISO/Gain<M> standard

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H> standard ISO/Gain<H> standard

ISO 4000

ISO 5000 ISO/Gain<L> standard

ISO 6400

ISO 8000

ISO 10000 ISO/Gain<M> standard

ISO 12800 ISO/Gain<L> standard ISO/Gain<L> standard

ISO 16000

ISO 20000 ISO/Gain<H> standard

ISO 25600 ISO/Gain<M> standard ISO/Gain<M> standard

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H> standard ISO/Gain<H> standard

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Flexible ISO
Base ISO ISO 12800 ISO 800

ISO 320

ISO 400

ISO 500

ISO 640

ISO 800 ISO/Gain<L> standard

ISO 1000

ISO 1250

ISO 1600 ISO/Gain<M> standard

ISO 2000

ISO 2500

ISO 3200 ISO/Gain<H> standard

ISO 4000

ISO 5000

ISO 6400

ISO 8000

ISO 10000

ISO 12800 ISO/Gain<L> standard

ISO 16000

ISO 20000

ISO 25600 ISO/Gain<M> standard

ISO 32000

ISO 40000

ISO 51200 ISO/Gain<H> standard

ISO 64000

ISO 80000

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Når Mode er satt til dB

Innstillingsområde

–3dB

–2dB

–1dB

0dB ISO/Gain<L> standard

1dB

2dB

3dB

4dB

5dB

6dB ISO/Gain<M> standard

7dB

8dB

9dB

10dB

11dB

12dB ISO/Gain<H> standard

13dB

14dB

15dB

16dB

17dB

18dB

19dB

20dB

21dB

22dB

23dB

24dB

25dB

26dB

27dB

28dB

29dB

30dB
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AGC Limit-innstillinger og standardverdier

Området for AGC Limit-innstillinger (side 80) og standardverdier varierer avhengig av innstillingene Mode, Target Display, Base Look >Select, Base Sensitivity og Base ISO. De tilgjengelige 
alternativene er uthevet i grått.

Når Mode er satt til ISO

Custom
Target Display SDR(BT.709) HDR(HLG) HDR(HLG) SDR(BT.709) og HDR(HLG) felles

Base Look >Select S-Cinetone / Standard / Still / ITU709 / 709tone HLG Live HLG Natural User1 til User16

Base Sensitivity Low High Low High Low High Low High

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000 Standard

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Standard Standard Standard

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000 Standard

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Standard Standard Standard

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Flexible ISO
Base ISO ISO 12800 ISO 800

ISO 400

ISO 500

ISO 640

ISO 800

ISO 1000

ISO 1250

ISO 1600

ISO 2000

ISO 2500

ISO 3200

ISO 4000

ISO 5000 Standard

ISO 6400

ISO 8000

ISO 10000

ISO 12800

ISO 16000

ISO 20000

ISO 25600

ISO 32000

ISO 40000

ISO 51200

ISO 64000

ISO 80000 Standard

ISO 102400

ISO 128000

ISO 160000

ISO 204800

ISO 256000

ISO 320000

ISO 409600
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Når Mode er satt til dB

Innstillingsområde

3dB

6dB

9dB

12dB

15dB Standard

18dB

21dB

24dB

27dB

30dB
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Bildekvalitetsinnstillinger lagres for hver opptaksmodus
Gjeldende status på konfigurasjonselementer som er knyttet til bildekvalitet, lagres for hver av de følgende opptaksmodiene (side 24). Når du endrer opptaksmodus, brukes innstillingene som er 
lagret for målopptaksmodusen.
ˎˎ Custom-opptaksmodus SDR(BT.709)
ˎˎ Custom-opptaksmodus HDR(HLG)
ˎˎ Log-opptaksmoduser (Cine EI, Cine EI Quick, Flexible ISO)

Konfigurasjonselementer som er knyttet til bildekvalitet og som lagres for hver opptaksmodus, er vist nedenfor.
Ja: Elementet lagres.
Nei: Element lagres ikke.

Konfigurasjonselement Opptaksmodus

Custom Flexible ISO Cine EI Quick Cine EI

SDR(BT.709) HDR(HLG)

Shooting-meny ISO/Gain/EI ISO/Gain Ja1) Ja Nei

Exposure Index Nei Nei Ja Ja

Base Sensitivity Ja Nei

Base ISO Nei Ja4) Nei3) Ja4)

White Preset White Ja Ja

Annet enn ovenstående Ja

White Setting Ja

Offset White Ja Nei

LUT On/Off Nei Ja

Noise Suppression Setting(Custom) Ja Ja Nei

Level(Custom) Ja Ja Nei

Setting (Cine EI/Flex. ISO) Nei Ja

Level (Cine EI/Flex. ISO) Nei Ja

Paint/Look-meny Base Look Select Ja Ja Ja

Input2) Ja

Output2) Ja

AE Level Offset2) Ja

Black Ja Ja Nei

Knee Auto Knee Ja Nei Nei

Annet enn ovenstående Ja Ja Nei

Detail Ja Ja Nei

Matrix Ja Ja Nei

Multi Matrix Ja Ja Nei

1)	 Egne innstillinger for ISO-følsomhet lagres for både Custom-opptaksmodus SDR(BT.709) og HDR(HLG).
2)	 Innstillinger lagres for hvert basisutseende, og avhenger ikke av opptaksmodusen.
3)	Base ISO-følsomheten endres i samsvar med Exposure Index.
4)	Felles innstillingsverdier i Flexible ISO- og Cine EI-opptaksmodus.
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Konfigurasjonsdata

Du kan lagre innstillingene fra hovedmenyen 
på et minnekort som er satt inn i CFexpress 
Type A/SD-kortspor (B). Du kan også lagre 
en ALL-fil til en skytjeneste. Dette gjør at du 
raskt kan hente frem et passende sett med 
menyinnstillinger for den aktuelle situasjonen.
Konfigurasjonsdata lagres i følgende 
kategorier.

Brukerfiler
Brukerfiler lagrer innstillingspunktene og 
dataene i User-menyen som kan tilpasses.
Du kan lagre opptil 64 filer på et minnekort.
Ved å laste denne filen inn i videokameraets 
minne kan du tilpasse oppsettet av User-
menyen.

ALL-filer (alle innstillinger)
ALL-filer lagrer konfigurasjonsdataene for 
alle menyer. Du kan lagre opptil 64 filer på et 
minnekort. Opp til 120 filer kan lagres til C3 
Portal (skytjeneste), som består av 60 private-
filer og 60 share-filer.

[Merk]
For detaljer om innholdet som er lagret i en ALL-file, se 
"Elementer som er lagret i filer" (side 130).

Lagre en brukerfil / ALL-fil

Lagre til et minnekort

1	 Sett et minnekort inn i et CFexpress Type 
A/SD-kortspor (B) (side 6).
ˎˎ For CFexpress-kort vender etiketten mot 
venstre.
ˎˎ På SD-kort vender etiketten mot høyre 
med det skrå hjørnet nederst.

2	 For en brukerfil velger du User File >Save 
to Media(B) (side 90) >Execute i Project-
menyen i hovedmenyen.
For en ALL-fil velger du All File >Save to 
Media(B) (side 90) >Execute i Project-
menyen i hovedmenyen.
Skjermbildet for lagring av filer vises.

3	 Velg en rad uten fil (No File) i skjermbildet 
for lagring.
Hvis du velger en rad med en File ID-
oppføring, overskrives den valgte filen.
Den File ID som tilordnes ved lagring kan 
endres via menyen. For mer informasjon 
om konfigurasjon, se "Endre File ID-en" 
(side 118).

4	 Velg Execute på bekreftelsesskjermbildet.

Lagre en ALL-fil til en skytjeneste

1	 Koble til enheten fra smarttelefonappen 
"Creators' App for enterprise" (side 67).

2	 Velg All File >Save to Cloud(Private) eller 
Save to Cloud(Share) (side 90) >Execute 
i menyen Project i hovedmenyen.
Skjermbildet for lagring av filer vises.

3	 Velg en rad uten fil (No File) i skjermbildet 
for lagring.
Hvis du velger en rad med en File ID-
oppføring, overskrives den valgte filen.
Den File ID som tilordnes ved lagring kan 
endres via menyen. For mer informasjon 
om konfigurasjon, se "Endre File ID-en" 
(side 118).

4	 Velg Execute på bekreftelsesskjermbildet.

Laste inn en brukerfil / ALL-fil

Laste inn fra et minnekort

1	 Sett et minnekort som har en lagret fil på 
seg inn i et CFexpress Type A/SD-kortspor 
(B) (side 6).
ˎˎ For CFexpress-kort vender etiketten mot 
venstre.
ˎˎ På SD-kort vender etiketten mot høyre 
med det skrå hjørnet nederst.

2	 For en brukerfil velger du User File >Load 
from Media(B) (side 90) >Execute i 
Project-menyen på hovedmenyen.
For en ALL-fil velger du All File >Load from 
Media(B) (side 90) >Execute i Project-
menyen på hovedmenyen.
Et skjermbildet med en filliste vises.

3	 Velg en fil for opplasting.
Det vises et bekreftelsesskjermbilde.

4	 Velg Execute.

[Merknader]
ˎˎ Enheten startes automatisk på nytt etter innlasting av 

konfigurasjonsdata.
ˎˎ Når All File >Load Network Data i Project-menyen på 

hovedmenyen er satt til Off, lastes alle innstillingene i 
ALL-filen inn, unntatt menyinnstillingene fra Network-
menyen.

Lagre og laste inn konfigurasjonsdata
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Laste inn en ALL-fil fra en skytjeneste

1	 Koble til enheten fra smarttelefonappen 
"Creators' App for enterprise" (side 67).

2	 Velg All File >Load fra Cloud(Private) eller 
Load from Cloud(Share) (side 90) 
>Execute i menyen Project i 
hovedmenyen.
Et skjermbildet med en filliste vises.

3	 Velg en fil for opplasting.
Det vises et bekreftelsesskjermbilde.

4	 Velg Execute.

[Merknader]
ˎˎ Enheten startes automatisk på nytt etter innlasting av 

konfigurasjonsdata.
ˎˎ Når All File >Load Network Data i Project-menyen på 

hovedmenyen er satt til Off, lastes alle innstillingene i 
ALL-filen inn, unntatt menyinnstillingene fra Network-
menyen.

Endre File ID-en

1	 For en brukerfil velger du User File >File ID 
(side 90) i Project-menyen på 
hovedmenyen.
For en ALL-fil velger du All File >File ID 
(side 90) i Project-menyen på 
hovedmenyen.
Det vises et skjermbilde for redigering av 
File ID-en.

2	 Velg tegn med flervalg-knappen 
(side 7) eller flerfunksjonshjulet 
(side 5), og trykk deretter på flervalg-
knappen bruksknapp eller 
flerfunksjonshjulet.

3	 Gjenta trinn 2 etter behov.

4	 Når du er ferdig med å skrive inn tegn, 
velger du Done.
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Koble til eksterne skjermer og opptaksenheter
For å vise/spille av bilder på en ekstern skjerm, 
velger du utgangssignalet til videokameraet 
og bruker en passende kabel for skjermen 
som skal kobles til.
Du kan også koble til opptaksenheter, for 
eksempel en VTR, og ta opp utgangssignalet 
fra videokameraet.
Du kan vise den samme informasjonen 
som vises i søkeren, for eksempel 
statusinformasjon og menyer, på en ekstern 
skjerm. Sett Info. Disp. (side 15) på 
skjermbildet Monitoring-statusskjermen eller 
Output Display (side 96) i Monitoring-
menyen i hovedmenyen til On i henhold til 
signalet som skal sendes til skjermen.

[Merk]
Overhold det følgende ved tilkobling av en ekstern 
monitor eller opptaksenhet til enheten. Hvis dette ikke 
overholdes kan det føre til at høye strømverdier ledes 
gjennom de innvendige kretsene i enheten, og det kan 
skade de elektroniske komponentene.
1.	 Om likestrømskabler 

Bruk likestrømskabler med lav GND-linjeimpedans for 
tilkobling av en ekstern monitor, opptaksenhet eller 
annen enhet.

2.	 Kontrollere for potensialforskjell 
Før bruk, kontroller at det ikke er noen 
potensialforskjell mellom noen av de tilkoblede 
enhetene og denne enheten.
(1)	 Koble fra alle tilkoblede enheter, som f.eks. en 

ekstern skjerm eller opptaksenheter, fra denne 
enheten. 
Kontroller at den 75 Ω koaksialkabelen, HDMI-
kabel eller andre kabler ikke er tilkoblet.

(2)	 Koble til likestrømskablene for alle tilkoblede 
enheter og denne enheten, og slå deretter på 
strømmen for hver tilkoblet enhet og denne 
enheten.

(3)	 Bruk et testinstrument eller en annen enhet for 
å bekrefte at det ikke finnes potensialforskjeller 
mellom denne enheten og hver enkelt tilkoblet 
enhet.

	 Hvis det foreligger en potensialforskjell, er det mulig 
at GND-linjeimpedansen for en av likestrømskablene 
er høy. Skift ut aktuelle kabler med kabler som har 
lav GND-linjeimpedans ved behov for å eliminere 
eventuell potensialforskjell,.

3.	 Sekvens for å koble til og slå på strømmen 
Koble til hver enkelt kabel og slå på strømmen i 
følgende rekkefølge.
(1)	 Slå av strømmen til denne enheten, ekstern 

skjerm, opptaksenheter og alle andre enheter.
(2)	 Koble til DC-kablene for alle enheter.
(3)	 Koble til den 75 Ω koaksialkabelen, HDMI-kabel og 

andre kabler.
(4)	 Slå på strømmen til alle tilkoblede enheter, og 

deretter til denne enheten.
For mer informasjon, kontakt en servicerepresentant for 
Sony.

SDI OUT-kontakt (BNC-type)

Angi av/på-innstillingen for utgangen 
og utdataformatet i Monitoring-menyen 
(side 96).
Bruk en kommersielt tilgjengelig 75 Ω 
koaksialkabel for tilkoblingen.

For å starte opptak på videokameraet og 
den eksterne enheten samtidig

Med SDI-signalutgangen aktivert, angir du 
SDI/HDMI Rec Control (side 87) >Setting på 
menyen Project i hovedmenyen til SDI/HDMI 
Remote I/F eller Parallel Rec for å aktivere at 
et REC-utløsersignal sendes til den eksterne 
enheten som er koblet til SDI OUT-kontakten. 
Dette kobler opptaket på den eksterne 
enheten til videokameraet.

[Merknader]
ˎˎ Hvis en tilkoblet ekstern enhet ikke støtter et REC-

utløsersignal, kan ikke enheten brukes.
ˎˎ Når den er satt til SDI/HDMI Remote I/F, vil kun REC-

utløsersignalet sendes ut når det ikke er satt inn noe 
opptaksmedium.

HDMI OUT-kontakt (Type 
A-kontakt)

Angi av/på-innstillingen for utgangen 
og utdataformatet i Monitoring-menyen 
(side 96) i hovedmenyen.

For å starte opptak på videokameraet og 
den eksterne enheten samtidig

Med HDMI-signalutgangen er aktivert, 
still HDMI TC Out >Setting (side 94) på 
hovedmenyens TC/Media-meny til On, og still 
SDI/HDMI Rec Control >Setting (side 87) 
i Project-menyen til SDI/HDMI Remote I/F 
eller Parallel Rec for å aktivere at et REC-
utløsersignal sendes til den eksterne enheten 
som er koblet til HDMI OUT-kontakten. Dette 
synkroniserer opptaket på den eksterne 
enheten med videokameraet.

[Merknader]
ˎˎ Hvis en tilkoblet ekstern enhet ikke støtter et REC-

utløsersignal, kan ikke enheten brukes.
ˎˎ Når den er satt til SDI/HDMI Remote I/F, vil kun REC-

utløsersignalet sendes ut når det ikke er satt inn noe 
opptaksmedium.
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Synkronisering av tidskoder
Du kan synkronisere tidskoden på enheten 
med andre enheter.

Låse tidskoden til andre enheter

Still enheten som forsyner tidskoden til en 
modus der tidskodeutgangen fortsetter å gå, 
(for eksempel Free Run eller Clock).

1	 Angi Timecode (side 94) i TC/Media-
menyen/ i hovedmenyen som følger.
Mode: Preset
Run: Free Run

2	 Trykk på knappen som kan tilordnes 
(side 49) som er tilordnet DURATION/
TC/U-BIT-funksjonen for å vise tidskoden 
på skjermen.

3	 Kontroller at velgerbrytere TC IN/OUT 
(tidskodeinngang/-utgang) (side 4) er 
satt til IN og tilfør så en referansetidskode 
for synkronisering av systemfrekvensen 
på videokameraet til TC IN/TC OUT-
kontakten.

Tidskodegeneratoren på videokameraet låser 
seg til den aktuelle referansekoden, og "EXT-
LK" vises på skjermen.
Når det har gått ca. ti sekunder etter 
tidskodelåsingen, opprettholdes den 
eksterne låsestatusen selv om den eksterne 
referansekodekilden kobles fra.

[Merknader]
ˎˎ Når du bruker ekstern lås, låses tidskoden 

umiddelbart mot den eksterne tidskoden, og den 
eksterne tidskodeverdien vises i datavisningsområdet. 
Du må imidlertid ikke starte opptaket umiddelbart. 
Vent noen sekunder til tidskodegeneratoren 
stabiliseres før du tar opp.
ˎˎ Hvis frekvensen til referansetidskode og 

bildefrekvensen på videokameraet ikke er den 
samme, kan ikke låsing oppnås, og videokameraet 
fungerer ikke som det skal. Hvis dette skjer, vil 
tidskoden ikke oppnå låsing med den eksterne 
tidskode.
ˎˎ Tidskoden kan endres med én ramme per time i 

forhold til referansetidskoden.

For å frigi den eksterne låsen

Endre Timecode-innstillingen i TC/Media-
menyen i hovedmenyen.
Ekstern synkronisering frigis også hvis 
systemfrekvensen endres, og når du starter 
opptaket i en spesiell opptaksmodus (Slow & 
Quick Motion eller Interval Rec).

Synkronisere tidskoden på en 
annen enhet med tidskoden på 
videokameraet

Still enheten som forsyner tidskoden til en 
modus der tidskodeutgangen fortsetter å gå, 
(for eksempel Free Run eller Clock).

1	 Still inn tidskoden på videokameraet med 
Timecode (side 94) på TC/Media-
menyen i hovedmenyen.

2	 Kontroller at velgerbrytere TC IN/OUT 
(tidskodeinngang/-utgang) (side 4) er 
satt til OUT (ut) og koble kontakten TC IN/
TC OUT til inngangen for tidskode på 
enheten som du vil synkronisere med.
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Administrere/redigere klipp ved hjelp av en datamaskin

Koble til med en USB-kabel

Bruke en kortleser (ekstrautstyr)

Koble en CFexpress Type A-kortleser eller 
SD-kortleser til en datamaskin ved hjelp 
av en USB-kabel, og sett inn et minnekort i 
kortlesersporet. Minnekortet gjenkjennes som 
en lagerstasjon for datamaskinen. På støttede 
datamaskiner kan du importere klipp med 
høy hastighet ved hjelp av videokameraets 
masselagringsmodus.

Bruke masselagringsmodus

[Merk]
Masselagringsmodus kan ikke brukes når Modem 
>Setting i Network-menyen på den fullstendige menyen 
er satt til On eller hvis Wired LAN >Setting i Network-
menyen er satt til On. Sett begge disse til Off.

Koble til videokameraet med en USB-
kabel og sett et minnekort inn i kortspor A 
eller B. Minnekortet gjenkjennes som en 
lagringsstasjon for datamaskin.

1	 Koble USB-C-kontakten (side 7) eller 
USB/multikontakten (side 7) til 
datamaskinen ved hjelp av en USB-kabel.

2	 Vri videokameraets POWER-bryter til 
stilling ON.
Det vises en melding i søkerskjermen som 
spør om du vil aktivere USB-tilkobling.

	 [Merk]
Bekreftelsesmeldingen for USB-tilkobling vises 
ikke mens en annen bekreftelsesmelding eller 
fremdriftsmelding vises, for eksempel når et 
minnekort formateres eller gjenopprettes.
Bekreftelsesmeldingen vises når formateringen 
eller gjenopprettingen er ferdig. USB-
bekreftelsesmeldingen vises heller ikke når 
skjermbildet for klippegenskaper vises. Meldingen 
vises når behandlingen avsluttes, eller når du går 
tilbake til miniatyrbildeskjermen.

3	 Drei på flerfunksjonshjulet for å velge 
Execute.

4	 I Windows må du kontrollere at kortet er 
lagt til som en flyttbar disk i vinduet Min 
datamaskin.
På Mac må du kontrollere at det er 
opprettet en mappe med navnet "NO 
NAME" eller "Untitled" (kan redigeres) på 
skrivebordet.

[Merknader]
ˎˎ Ikke utfør følgende operasjoner hvis 

tilgangsindikatoren lyser rødt.
–– Slå av monitoren eller ta ut strømledningen
–– Ta ut minnekortet
–– Koble fra USB-kabelen

ˎˎ Det kan ikke garanteres at dett fungerer på alle 
datamaskiner.

Bruke et ikke-lineært 
redigeringssystem

I et ikke-lineært redigeringssystem kreves 
en redigeringsprogramvare (tilleggsutstyr) 
som støtter formatene som er tatt opp med 
videokameraet.
Bruk dedikert programvare til å lagre 
klippene du vil redigere på harddisken på 
datamaskinen på forhånd.
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Forsiktighetsregler ved bruk
Ved kondens

Hvis enheten flyttes plutselig fra et kaldt 
til et varmt sted, eller hvis temperaturen i 
omgivelsene plutselig stiger, kan fuktighet 
kondensere på overflaten og/eller inne i 
enheten. Dette kalles fuktighetskondens. Hvis 
kondens forekommer, slår du av enheten og 
bruker den ikke før kondensen har fordampet. 
Bruk av enheten mens det er kondens kan 
skade enheten.

På LCD-paneler

LCD-panelet montert på denne enheten 
er produsert med høypresisjonsteknologi, 
noe som gir et funksjonelt pikselforhold på 
minst 99,99%. Dermed er det bare et svært 
lite antall piksler som "sitter fast", enten 
alltid av (svart), alltid på (rød, grønn eller blå) 
eller blinker. I tillegg kan slike piksler oppstå 
spontant ved lengre bruksperioder pga. de 
fysiske kjennetegnene til den flytende krystall-
skjermen. Disse problemene er ikke en feil. 
Merk at ingen slike problemer har noen effekt 
på opptaksdata.

CMOS bildesensorfenomen i kameraet

[Merk]
De følgende fenomenene kan oppstå i bilder, og 
er spesifikke for bildesensorer. De indikerer ikke en 
feiltilstand.

Hvite flekker
Selv om bildesensorene produseres med 
svært presise teknologier, kan det en sjelden 
gang dannes små hvite flekker på skjermen, 
dette skjer på grunn av kosmisk stråling osv.
Dette skyldes bildesensorens virkemåte og er 
ikke en feil.
De hvite flekkene har spesielt en tendens til å 
vises under følgende omstendigheter:

ˎˎ Når det jobbes med høye 
omgivelsestemperaturer
ˎˎ Når du har økt forsterkningen (følsomheten)

Flimring
Når du tar bilder i lyst fra lysrør, 
natriumlamper, kvikksølvlampdamper eller 
LED-lys, kan skjermen flimre eller fargene kan 
variere.

På slitedeler

ˎˎ Viften og batteriet er forbruksmaterialer 
som må skiftes ut periodisk.  
Ved bruk i romtemperatur, må de vanligvis 
skiftes ut etter omtrent fem år. Dette er 
derimot kun en generell veiledning og 
antyder ikke at disse delenes forventet 
levetid er garantert. For detaljer om 
utskifting av delen, kontakter du Sony 
service eller forhandleren.
ˎˎ Den forventede levetiden til AC-adapteren 
og elektrolyttkondensatoren er ca. 5 år 
under normale driftstemperaturer og normal 
drift (8 timer per dag, 25 dager per måned). 
Hvis bruken overskrider den ovennevnte 
bruksfrekvensen, kan den forventede 
levetiden reduseres tilsvarende.
ˎˎ Batteripolen på denne enheten (kontakten 
for batteripakker og strømadaptere) er en 
forbruksdel.  
Enheten får kanskje ikke strøm hvis pinnene 
på batteripolen er bøyd eller deformert 
av støt eller vibrasjoner, eller hvis de blir 
korrodert på grunn av langvarig utendørs 
bruk.  
Periodiske kontroller anbefales for å 
holde enheten i orden og forlenge 
levetiden. Kontakt en Sony service- eller 
salgsrepresentant for å få mer informasjon 
om inspeksjoner.

Om det innebygde oppladbare batteriet

Videokameraet har et innebygd oppladbart 
batteri for lagring av dato, klokkeslett og andre 
innstillinger, selv når videokameraet er slått av. 
Det innebygde oppladbare batteriet blir ladet 
i løpet av 24 timer hvis enheten er koblet til 
en stikkontakt ved bruk av strømadapteren, 
eller hvis en fulladet batteripakke kobles 
til, uavhengig av om videokameraet er slått 
av eller på. Det oppladbare batteriet blir 
helt utladet i løpet av cirka to måneder hvis 
strømadapteren ikke er koblet til, eller hvis 
videokameraet brukes uten at batteripakken 
er koblet til. Bruk videokameraet etter at 
batteriet er ladet. Selv om det oppladbare 
batteriet ikke er ladet, påvirkes ikke driften 
av videokameraet så lenge du ikke trenger å 
registrere datoen.

Bruks- og oppbevaringssteder

Oppbevares på et flatt, ventilert sted.
Unngå å bruke eller oppbevare enheten på 
følgende steder.
ˎˎ Ved for høy varme eller kulde 
(driftstemperatur fra 0 til 40 °C) 
I varme klima skal du huske på at 
temperaturen inne i en bil med vinduene 
lukket lett overstige 50 °C om sommeren.
ˎˎ På fuktige eller støvete steder. Steder der 
enheten kan bli utsatt for regn
ˎˎ Steder der den utsettes for voldsomme 
vibrasjoner
ˎˎ Nær sterke magnetfelt
ˎˎ I nærheten av radio- eller TV-sendere som 
produserer sterke elektromagnetiske felt
ˎˎ Lange perioder i direkte sollys eller i 
nærheten av varmeovner

Merknad om laserstråler

Laserstråler kan skade CMOS-bildesensoren. 
Hvis du filmer et motiv som inneholder 
en laserstråle, må du være forsiktig slik at 

laserstrålen ikke rettes inn i objektivet på 
enheten. Spesielt kan kraftige laserstråler fra 
medisinsk utstyr eller annet utstyr forårsake 
skade på grunn av reflektert lys og spredt lys.

For å hindre elektromagnetisk 
forstyrrelse fra bærbart 
kommunikasjonsutstyr

Bruk av bærbare telefoner og andre 
kommunikasjonsenheter i nærheten av dette 
kameraet kan føre til feil og forstyrrelser i lyd- 
og bildesignaler. Det anbefales at de bærbare 
kommunikasjonsenhetene i nærheten av dette 
kameraet slås av.

Sikkerhetstiltak

ˎˎ SONY SKAL IKKE VÆRE ANSVARLIG FOR 
SKADER AV NOE SLAG SOM FØLGER 
AV UNNLATELSE AV Å IMPLEMENTERE 
RIKTIGE SIKKERHETSTILTAK PÅ 
OVERFØRINGSENHETER, UUNNGÅELIGE 
DATALEKKASJER PÅ GRUNN AV 
OVERFØRINGSSPESIFIKASJONER ELLER 
SIKKERHETSPROBLEMER AV NOE SLAG.
ˎˎ Avhengig av driftsmiljøet, kan uautoriserte 
tredjeparter på nettverket være i stand 
til å få tilgang til enheten. Ved tilkobling 
av enheten til nettverk må du sørge for 
å kontrollere at nettverket har sikker 
beskyttelse.
ˎˎ Kommunikasjonsinnhold kan bli fanget opp 
av uautoriserte tredjeparter i nærheten av 
signalene, uten at vi kjenner til det. Når man 
benytter trådløs LAN-kommunikasjon skal 
det iverksettes sikkerhetstiltak for å beskytte 
kommunikasjonsinnholdet.
ˎˎ Ved tilkobling av dette produktet til et 
nettverk, koble til via et system som har en 
beskyttelsesfunksjon, som for eksempel 
en ruter eller en brannvegg. Hvis produktet 
kobles til uten slik beskyttelse kan det 
medføre sikkerhetsproblemer.
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Standard fabrikkinnstillinger vises i halvfet skrift (for eksempel 1920×1080P (Level A)).

[Merknader]
ˎˎ Oppløsningen på utdataformatet begrenses av innstillingene for Rec Format >Frequency, Codec og Video Format i 

Project-menyen i hovedmenyen (side 84).
ˎˎ Oppløsningen på utdataformatet begrenses også av kombinasjonen med S&Q-bildefrekvensen. I tillegg til tabellen 

for SDI OUT/HDMI OUT-kontaktutgangsformater nedenfor, endres HDMI-utgangen til Full HD eller lavere når alle 
følgende betingelser er oppfylt.
–– S&Q Motion >Setting i Shooting-menyen er satt til On
–– S&Q Motion >Frame Rate i Shooting-menyen er høyere enn 60fps
–– Rec Format >Codec i Project-menyen er satt til RAW eller RAW & XAVC-I, eller Output On/Off >SDI i Monitoring-

menyen er satt til On
ˎˎ Når betingelsene ovenfor blir oppfylt, blir valgalternativene HDMI-utgang 4096×2160P og 3840×2160P for Output 

Format >SDI/HDMI (side 96) i Monitoring-menyen nedtonet og kan ikke velges.
ˎˎ Bildet blir ikke sendt hvis en høyere oppløsning enn avspillingens bildeoppløsning konfigureres.

Utdataformater for kontakten SDI OUT/HDMI OUT

Systemfrekven-
sinnstilling
(Rec Format 
>Frequency i 
menyen Project)

Codec-innstilling
(Rec Format 
>Codec i menyen 
Project)

RAW/Opptak-
formatinnstilling
(Rec Format >RAW 
Output Format/Video 
Format i menyen 
Project)

Utgangsformat (Output Format i 
Monitoring-menyen)

SDI HDMI

50/59.94Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P 
(Level A)

(4240×2392 HDMI 
RAW)

1920×1080P 
(Level B)

1920×1080i

Systemfrekven-
sinnstilling
(Rec Format 
>Frequency i 
menyen Project)

Codec-innstilling
(Rec Format 
>Codec i menyen 
Project)

RAW/Opptak-
formatinnstilling
(Rec Format >RAW 
Output Format/Video 
Format i menyen 
Project)

Utgangsformat (Output Format i 
Monitoring-menyen)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

4096×2160P 1920×1080i

3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

3840×2160P 1920×1080i

1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

Utdataformater og -begrensninger
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Systemfrekven-
sinnstilling
(Rec Format 
>Frequency i 
menyen Project)

Codec-innstilling
(Rec Format 
>Codec i menyen 
Project)

RAW/Opptak-
formatinnstilling
(Rec Format >RAW 
Output Format/Video 
Format i menyen 
Project)

Utgangsformat (Output Format i 
Monitoring-menyen)

SDI HDMI

50/59.94Hz XAVC-I
XAVC-L

1920×1080(Video) 1920×1080P 
(Level A)

1920×1080P

1920×1080P 
(Level A)

1920×1080i

1920×1080P 
(Level B)

1920×1080P

1920×1080P 
(Level B)

1920×1080i

1920×1080i 1920×1080i

(Utgang stoppet) 720×480P1) 2)

720×576P1) 3)

25/29.97Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

1920×1080i

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

1920×1080i

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

1920×1080(Video) 1920×1080P 1920×1080P

1920×1080PsF 1920×1080i

Systemfrekven-
sinnstilling
(Rec Format 
>Frequency i 
menyen Project)

Codec-innstilling
(Rec Format 
>Codec i menyen 
Project)

RAW/Opptak-
formatinnstilling
(Rec Format >RAW 
Output Format/Video 
Format i menyen 
Project)

Utgangsformat (Output Format i 
Monitoring-menyen)

SDI HDMI

23.98Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

3840×2160P

1920×1080P

3840×2160(RAW) (3840×2160 RAW) 3840×2160P

1920×1080P

RAW(HDMI)
RAW(HDMI) & 
XAVC-I

4240×2392(RAW) 1920×1080P (4240×2392 HDMI 
RAW)1920×1080PsF

XAVC-I
XAVC-L

4096×2160(Video) 4096×2160P1) 4096×2160P

4096×2160P 1920×1080P

3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080P

3840×2160(Video) 3840×2160P 3840×2160P

3840×2160P 1920×1080P

1920×1080P 1920×1080P

1920×1080PsF 1920×1080P

1920×1080(Video) 1920×1080P 1920×1080P

1920×1080PsF 1920×1080P

24Hz RAW
RAW & XAVC-I

4096×2160(RAW) (4096×2160 RAW) 4096×2160P

1920×1080P

XAVC-I 4096×2160(Video) 4096×2160P1) 4096×2160P

1920×1080P 1920×1080P

1)	 Skjermvisningen kan ikke være innebygd.
2)	Når systemfrekvensen er 59.94
3)	Når systemfrekvensen er 50
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Strømforsyning

Symptom Årsak Løsning

Videokameraet slår seg ikke 
på.

Det er ikke satt inn en 
batteripakke, og det får ikke 
strøm fra DC IN-kontakten.

Monter en batteripakke (side 17) 
eller koble det til en stikkontakt med en 
strømadapter (side 18).

Batteripakken er helt utladet. Bytt ut batteripakken med en fulladet 
batteripakke (side 17).

Strømavbrudd under drift. Batteripakken er utladet. Bytt ut batteripakken med en fulladet 
batteripakke (side 17).

Batteripakken tømmes svært 
raskt.

Omgivelsestemperaturen er 
svært lav.

Dette skyldes batteriets egenskaper og 
er ikke en feil.

Batteripakken er 
utilstrekkelig ladet.

Lad batteripakken på nytt (side 17).
Hvis batteripakken tømmes raskt selv 
etter at du har ladet det helt opp, kan 
det hende at levetiden er over. Skift ut 
med et nytt.

Opptak/avspilling

Symptom Årsak Løsning

Opptaket starter ikke når du 
trykker på START/STOP-
knappen for opptak.

Minnekortet er fullt. Bytt ut minnekortet med et som har 
nok plass.

Minnekortet må 
gjenopprettes.

Gjenopprett minnekortet (side 33).

Lydopptak er ikke mulig. Hjulene for AUDIO LEVEL 
(CH1/CH2) er satt til 
minimumsnivået.

Juster lydopptaknivået med hjulene for 
AUDIO LEVEL (CH1/CH2) (side 47).

Den innspilte lyden er 
forvrengt.

Lydnivået er for høyt. Juster lydopptaknivået med hjulene for 
AUDIO LEVEL (CH1/CH2) (side 47).

Den innspilte lyden har et 
høyt støynivå.

Lydnivået er for lavt. Juster lydopptaknivået med hjulene for 
AUDIO LEVEL (CH1/CH2) (side 47).
Når du har valgt en ekstern mikrofon, 
må du også justere innstillingen INPUT 
MIC Reference under Audio Input på 
Audio-menyen (side 99).

Symptom Årsak Løsning

Klipp kan ikke spilles av. Klippet redigeres. Klipp kan ikke spilles av hvis du har 
endret filnavn eller mapper, eller hvis 
klippet er i bruk på en datamaskin. 
Dette er ikke en feil.

Klippet tas opp på en annen 
enhet.

Klipp som er tatt opp på andre enheter, 
kan kanskje ikke spilles av eller vises 
med feil størrelse. Dette er ikke en feil.

Eksterne enheter

Symptom Løsning

Datamaskinen gjenkjenner ikke 
videokameraet.

Deaktivere Internett-deling via USB.

Koble USB-kabelen fra datamaskinen, og koble den deretter 
ordentlig til igjen.

Koble USB-kabelen fra datamaskinen, start datamaskinen på nytt, 
og følg trinnene på nytt i riktig rekkefølge.

Koble datamaskinen til videokameraet ved å sette en USB-kabel 
inn i enten USB-C-kontakten eller USB-/multikontakten.

Det er ikke mulig å laste inn klipp 
på datamaskinen.

Koble USB-kabelen fra datamaskinen, start videokameraet på nytt, 
og koble det til igjen.

Det må være installert programvare for å kunne laste inn klipp på 
datamaskinen (side 121).

Feilsøking
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Trådløs LAN-forbindelse

[Merk]
Hindringer og elektromagnetisk interferens mellom videokameraet og det trådløse LAN-aksesspunktet eller 
terminalenheten, eller omgivelsene (for eksempel veggmaterialer) kan gi kortere kommunikasjonsrekkevidde eller 
forhindre alle tilkoblinger. Hvis du opplever disse problemene, kontroller tilkoblingen/kommunikasjonsstatusen etter 
at du har flyttet videokameraet til et nytt sted, eller bring videokameraet og aksesspunktet/terminalenheten nærmere 
hverandre.

Symptom Løsning

En terminalenhet får ikke tilgang 
til videokameraet.

ˎˎ Kontroller den trådløse LAN-tilkoblingen (IP-adresse osv.).
ˎˎ Kommunikasjonsinnstillingen mellom aksesspunktet og klienten 
kan være ugyldig. Du finner mer informasjon om tilkobling i 
bruksanvisningen for aksesspunktet.

Du kan ikke logge på 
videokameraet.

Kontroller brukernavnet og passordet du har angitt.

Internettforbindelse

Symptom Løsning

Filopplastinger mislykkes. Brukernavnet og passordet til serveren er kanskje ikke riktig.
Skriv inn riktig brukernavn og passord.

Opplasting av fil er ikke 
tilgjengelig.

Signalforholdene kan være dårlig.
Flytt til et annet sted, og prøv på nytt.

Når ND-filteret brukes

Symptom Løsning

ND-filteret beveger seg ikke. Du kan flytte filteret til posisjonen Clear manuelt ved hjelp av 
følgende fremgangsmåte.

1	 Vri videokameraets POWER-bryter til stilling Off.

2	 Ta av det runde lokket på undersiden.

3	 Sett en skrutrekker inn i hullet og vri den mot urviseren.
ˎˎ ND-filteret flyttes til Clear-stilling ved å vri det mot urviseren. Fortsett å vri til det når Clear-
stillingen.
ˎˎ Bruk en skrutrekker med ø2,4 mm diameter eller mindre. Innsettingsdybden på 
skrutrekkeren er ca. 3,0 cm.

Skrutrekkerhull
(med hetten fjernet)

4	 Sett bryteren ND PRESET/VARIABLE (side 5) i PRESET posisjon, og sett opp-/
nedknappene for ND FILTER POSITION (side 5) til CLEAR-posisjonen.

[Merknader]
ˎˎ Ikke bruk prosedyren over ved normal bruk. Bruk denne prosedyren bare hvis ND-filteret ikke beveger seg. ND-

filteret kan bli skadet hvis denne prosedyren brukes under normal bruk.
ˎˎ Etter at prosedyren ovenfor er brukt, må du kontakte et Sony-servicesenter for å få videokameraet reparert.
ˎˎ Hvis det fortsatt vises en feilmelding etter at du har utført prosedyren ovenfor, er det fremdeles mulig å ta bilder.
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Hvis det vises en advarsel, en forsiktighetsvarsel eller en driftstilstand som krever bekreftelse på 
videokameraet, vises det en melding i søkeren, lampen for opptak/telling begynner å blinke og 
det høres en varsellyd.
Varselsignalet kommer fra hodetelefonene som er koblet til hodetelefonkontakten.

Feilmeldinger

Videokameraet slutter å fungere når følgende typer visning forekommer.

Søker-melding Varsellyd Opptaks-/
tellelampe

Årsak og løsning

E + feilkode Kontinuerlig Hurtig 
blinkende

Indikerer en unormal tilstand i videokameraet. 
Opptaket stopper, selv om REC vises i søkeren.
Slå av videokameraet, og se etter eventuelle 
problemer med tilkoblede enheter, kabler eller 
medier. Hvis feilen vedvarer når videokameraet 
slås på igjen, kontakt en servicerepresentant for 
Sony.
(Hvis videokameraet ikke slår seg av når POWER-
bryteren er satt til OFF, tar du ut batteriet eller 
kobler fra DC IN-tilførselen.)
Avhengig av statusen til videokameraet kan det 
hende at det ikke vises en feilvisning eller et 
varselsignal.

Varselmelding

Følg instruksjonene hvis følgende skjermvisning oppstår.

Søker-melding Varsellyd Opptaks-/
tellelampe

Årsak og løsning

Battery Near End Periodisk Blinkende Gjenværende kapasitet i batteripakken er i ferd 
med å bli lav.
Lad opp ved første anledning.

Battery End Kontinuerlig Hurtig 
blinkende

Batteripakken er tom. Opptak er deaktivert.
Stopp bruken og bytt batteripakken.

Temperature High Periodisk Blinkende Den interne temperaturen er høy.
Slå av videokameraet, og la det avkjøles før du 
bruker det igjen.

Søker-melding Varsellyd Opptaks-/
tellelampe

Årsak og løsning

Media Temperature 
High

Periodisk Blinkende Temperaturen på CFexpress-kortet er høy.
Bytt ut kortet eller la det avkjøles før du bruker det 
igjen.

Voltage Low Periodisk Blinkende DC IN-spenningen er lav (nivå 1). Sjekk 
strømkilden.

Insufficient Voltage Kontinuerlig Hurtig 
blinkende

DC IN-spenningen er for lav (nivå 2). Opptak er 
deaktivert.
Koble til en annen strømkilde.

Media Near Full Periodisk Blinkende Gjenværende kapasitet i minnekortet er i ferd med 
å bli lav.
Skift ved første anledning.

Media Full Kontinuerlig Hurtig 
blinkende

Klipp kunne ikke tas opp eller kopieres fordi det 
ikke er mer kapasitet igjen på minnekortet.
Bytt med en gang.

Clips Near Full Periodisk Blinkende Antall ekstra klipp som kan tas opp på et 
minnekort, begynner å bli lavt.
Skift ved første anledning.

Clips Full Kontinuerlig Hurtig 
blinkende

Det maksimale antallet klipp som kan tas opp på 
minnekortet, er nådd.
Det er ikke mulig å ta opp eller kopiere flere klipp. 
Bytt med en gang.

Last Clip Recording Periodisk Blinkende Klippet som tas opp i øyeblikket, er det siste 
klippet som kan tas opp, siden det maksimale 
antallet klipp er nådd.
Klargjør et nytt minnekort.

Media(A)1) Life Near 
End

Periodisk Blinkende Minnekortet nærmer seg slutten på levetiden. 
Skift ved første anledning.

Media(A)1) Life End Kontinuerlig Hurtig 
blinkende

Minnekortet har nådd slutten av levetiden. Bytt 
med en gang.

Media(A)1) Near Full Periodisk Blinkende Når du bruker funksjonen Simul Rec

Media(A)1) Full Kontinuerlig Hurtig 
blinkende

Når du bruker funksjonen Simul Rec

Media(A)1) Clips Near 
Full

Periodisk Blinkende Når du bruker funksjonen Simul Rec

Media(A)1) Clips Full Kontinuerlig Hurtig 
blinkende

Når du bruker funksjonen Simul Rec

Media(A)1) Last Clip 
Rec

Periodisk Blinkende Når du bruker funksjonen Simul Rec

Transfer Jobs Near 
Full

– – Antall FTP-filoverføringsjobber som kan 
registreres begynner å bli lavt.

Feil-/varselmeldinger
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Søker-melding Varsellyd Opptaks-/
tellelampe

Årsak og løsning

Transfer Jobs Full – – Antall FTP-filoverføringsjobber som kan 
registreres har nådd øvre grense. For å legge til 
enda en jobb må du først slette en jobb du ikke 
trenger.2)

1)	 "(B)" vises for kortet i spor B.
2)	Du kan velge og slette jobber via File Transfer >View Job List (side 108) i menyen Network i hovedmenyen. Du 

kan også slette jobber fra CBM-jobblisten.

Forsiktig- og driftsmeldinger

Følgende forsiktig- og driftsmeldinger kan vises midt på skjermen. Følg instruksjonene for å 
løse problemet.

Vist melding Årsak og løsning

Battery Error
Please Change Battery

Det ble oppdaget en feil i batteripakken.
Erstatt med en vanlig batteripakke.

Backup Battery End
Please Change

Gjenværende kapasitet i reservebatteriet er utilstrekkelig.
Lad reservebatteriet.

Unknown Media (A) 1)

Please Change
Et minnekort ble satt inn som er partisjonert eller et minnekort 
som inneholder flere klipp enn det som kan håndteres av 
videokameraet.
Kortet kan ikke brukes i videokameraet og må byttes ut.

Cannot Use Media (A) 1)

Unsupported File System
Et kort ble satt inn som bruker et annet filsystem eller et 
uformatert kort.
Kortet kan ikke brukes i videokameraet, og det må byttes ut 
eller formateres ved hjelp av videokameraet.

Media Error
Media (A) 1) Needs to be Restored

Det oppstod en feil på minnekortet, og kortet må 
gjenopprettes.
Gjenopprett minnekortet.

Media Error
Cannot Record to Media (A) 1)

Minnekortet kan være skadet og kan ikke lenger brukes til 
opptak.
Avspilling er mulig, så det anbefales at du tar en kopi og 
bytter ut minnekortet.

Media Error
Cannot Use Media (A) 1)

Minnekortet kan være skadet og kan ikke lenger brukes til 
opptak eller avspilling.
Kortet kan ikke brukes i videokameraet og må byttes ut.

Media (A) 1) Error
Recording Halted
Playback Halted

Opptak og avspilling ble stoppet fordi det oppstod en feil 
under bruk av minnekortet.
Hvis problemet vedvarer, bytt ut minnekortet.

Media Reached Rewriting Limit
Change Media (A) 1)

Minnekortet har nådd slutten av levetiden.
Ta en sikkerhetskopi og skift kortet umiddelbart. Hvis du 
fortsetter å bruke kortet, kan det hende at kortet ikke kan ta 
opp eller spille av.
For mer informasjon, se bruksanvisningen for minnekortet.

The specified address is invalid. Den angitte adressen er ugyldig.
Kontroller at innstillingen er riktig.

Cannot Use Specified Port Number Det angitte portnummeret er ugyldig.
Kontroller at innstillingen er riktig.
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Vist melding Årsak og løsning

Fan Stopped Den innebygde viften stoppet.
Unngå bruk ved høye temperaturer, koble fra strømmen og 
kontakt servicerepresentanten for Sony.

LENS Error Det ble oppdaget en objektivfeil i objektivets 
I/F-kommunikasjonen da et objektiv med E-fatning ble koblet 
til.
Kontroller statusen for tilkoblingen til objektivet med 
E-fatning.

This Multi Term. acc is not supported 
by the device and cannot be used.
Please verify the compatibility.

Det ble oppdaget et inkompatibelt tilbehør.
Det eneste flerterminaltilbehøret som støttes av enheten, er 
den medfølgende grepfjernkontrollen.

Failed Denne feilen kan vises hvis det ikke er mulig å få tak i en 
adresse med DHCP satt til On.
Kontroller DHCP-serverinnstillingene.

Addition of auto upload job failed. Det maksimale antallet overføringsjobber er nådd.
Fjern alle uønskede jobber. Innstillingen av mål for automatisk 
opplasting av originalfiler eller proxy-filer kan også være feil. 
Kontroller at innstillingen er riktig.

<SSID>Not found. Finner ikke nettverket (aksesspunktet) med angitt <SSID>.
Kontroller at innstillingen er riktig.

<SSID>Authentication Failed Tilkoblingsgodkjenning på nettverket (aksesspunktet) med 
den angitte <SSID> mislyktes.
Kontroller at passordet og andre innstillinger er riktige.

An IP address conflict has occurred. 
Please check the network settings.

Det er en konflikt i nettverksadressene for trådløst LAN, kablet 
LAN eller Internettdeling via USB.
Endre adressen manuelt eller endre innstillingene for 
nettverksruteren.

The IP address of the Wireless LAN 
Access Point Mode has been 
changed due to an IP address 
conflict.

IP-adressen til aksesspunktet for trådløst LAN ble endret på 
grunn av en konflikt i nettverksadressene til trådløst LAN-
aksesspunkt, kablet LAN eller Internettdeling via USB.
Kontroller IP-adresseinnstillingen.

1)	 "(B)" vises for kortet i spor B.
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Elementer som er konfigurert i hovedmenyen

Ja: Elementet lagres.
Nei: Element lagres ikke.
–: Ikke lagret (midlertidig innstilling)

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting ISO/Gain/EI Mode Ja Nei

ISO/Gain<H> Ja Nei

ISO/Gain<M> Ja Nei

ISO/Gain<L> Ja Nei

Exposure Index<H> Ja Nei

Exposure Index<M> Ja Nei

Exposure Index<L> Ja Nei

Shockless Gain Ja Nei

Base Sensitivity Ja Nei

Base ISO Ja Nei

ND Filter Preset1 Ja Nei

Preset2 Ja Nei

Preset3 Ja Nei

Shutter Mode Ja Nei

Shutter Speed On/Off Ja Nei

Shutter Speed Ja Nei

Shutter Angle Ja Nei

ECS On/Off Ja Nei

ECS Frequency Ja Nei

Iris Bokeh Control Nei Nei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Auto Exposure Level Ja Nei

Mode Ja Nei

Speed Ja Nei

AGC Ja Nei

AGC Limit Ja Nei

AGC Point Ja Nei

Auto Shutter Ja Nei

A.SHT Limit Ja Nei

A.SHT Point Ja Nei

Clip High light Ja Nei

Detect Window Ja Nei

Detect Window Indication Ja Nei

Custom Width Ja Nei

Custom Height Ja Nei

Custom H Position Ja Nei

Custom V Position Ja Nei

White Preset White Ja Nei

Color Temp <A> Ja Nei

Tint<A> Ja Nei

R Gain <A> Ja Nei

B Gain <A> Ja Nei

Color Temp <B> Ja Nei

Tint<B> Ja Nei

R Gain <B> Ja Nei

B Gain <B> Ja Nei

White Setting Shockless White Ja Nei

ATW Speed Ja Nei

White Switch<B> Ja Nei

Filter White Memory Ja Nei

Elementer som er lagret i filer
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Shooting Offset White Offset White <A> Ja Nei

Offset Color Temp<A> Ja Nei

Offset Tint<A> Ja Nei

Offset White <B> Ja Nei

Offset Color Temp<B> Ja Nei

Offset Tint<B> Ja Nei

Offset White<ATW> Ja Nei

Offset Color Temp<ATW> Ja Nei

Offset Tint<ATW> Ja Nei

Focus AF Transition Speed Ja Nei

AF Subj. Shift Sens. Ja Nei

Focus Area Ja Nei

Focus Area (AF-S) Ja Nei

Face/Eye Detection AF Ja Nei

Push AF Mode Ja Nei

Touch Function in MF Ja Nei

Multi Selector Function Ja Nei

Pointer Color Ja Nei

Pointer Border Ja Nei

AF Assist Ja Nei

S&Q Motion Setting Ja Nei

Frame Rate Ja Nei

LUT On/Off SDI/HDMI Ja Nei

VF/Proxy/Stream Ja Nei

Internal Rec Ja Nei

Noise Suppression Setting(Custom) Ja Nei

Level(Custom) Ja Nei

Setting (Cine EI/Flex. ISO) Ja –

Level (Cine EI/Flex. ISO) Ja –

Flicker Reduce Mode Ja Nei

Frequency Ja Nei

SteadyShot Setting Ja Nei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Base Setting Shooting Mode Ja –

Target Display Ja –

Rec Format Frequency Ja Nei

Imager Scan Mode Ja Nei

Codec Ja Nei

RAW Output Format Ja Nei

Video Format Ja Nei

Cine EI/Flex.ISO Set Color Gamut Ja –

Embed LUT File Ja Nei

HDR Setting VF SDR Preview Ja Nei

SDR Gain Ja Nei

Simul Rec Setting Ja Nei

Rec Button Set Ja Nei

Proxy Rec Setting Ja Nei

Audio Channel Ja Nei

Chunk Ja Nei

Interval Rec Setting Nei Nei

Interval Time Ja Nei

Number of Frames Ja Nei

Pre-Lighting Ja Nei

Picture Cache Rec Setting Ja Nei

Cache Size Ja Nei

Cache Rec Time – –

SDI/HDMI Rec Control Setting Ja Nei

Assignable Button <1> Ja Nei

<2> Ja Nei

<3> Ja Nei

<4> Ja Nei

<5> Ja Nei

<6> Ja Nei

<7> Ja Nei

<8> Ja Nei

<9> Ja Nei

Focus Hold Button Ja Nei

Assignable Dial Grip/Remote Dial Ja Nei

Grip Dial Direction Ja Nei

Handle Dial Ja Nei

Handle Dial Direction Ja Nei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Project Multi Function Dial Default Function Ja Nei

User File Load from Media(B) – –

Save to Media(B) – –

File ID Nei Nei

Load Customize Data Ja Nei

Load White Data Ja Nei

All File Load from Media(B) – –

Load from Cloud(Private) – –

Load from Cloud(Share) – –

Save to Media(B) – –

Save to Cloud(Private) – –

Save to Cloud(Share) – –

File ID Ja Nei

Load Network Data Nei Nei

Paint/Look Scene File Recall – –

Store – –

Delete – –

Preset Recall – –

Base Look Select Ja Ja

Delete – –

Delete All – –

Import from Media(B) – –

Import from Cloud(Private) – –

Import from Cloud(Share) – –

Input Ja Ja

Output Ja Ja

AE Level Offset Ja Ja

Reset Paint Settings Reset without Base Look – –

Black Master Black Ja Ja

R Black Ja Ja

B Black Ja Ja

Knee Setting Ja Ja

Auto Knee Ja Ja

Point Ja Ja

Slope Ja Ja

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Paint/Look Detail Setting Ja Ja

Level Ja Ja

Manual Setting Ja Ja

V/H Balance Ja Ja

B/W Balance Ja Ja

Limit Ja Ja

Crispening Ja Ja

High Light Detail Ja Ja

Matrix User Matrix Ja Ja

User Matrix Level Ja Ja

User Matrix Phase Ja Ja

User Matrix R-G Ja Ja

User Matrix R-B Ja Ja

User Matrix G-R Ja Ja

User Matrix G-B Ja Ja

User Matrix B-R Ja Ja

User Matrix B-G Ja Ja

Multi Matrix Setting Ja Ja

Area Indication Nei Nei

Reset – –

Axis Nei Ja

Hue Ja Ja

Saturation Ja Ja

TC/Media Timecode Mode Ja Nei

Run Ja Nei

Setting Nei Nei

Reset – –

TC Format Ja Nei

TC Display Display Select Ja Nei

Users Bit Mode Ja Nei

Setting Nei Nei

HDMI TC Out Setting Ja Nei

Clip Name Format Auto Naming Ja Nei

Camera ID Nei Nei

Reel Number Nei Nei

Camera Position Nei Nei

Title Prefix Ja Nei

Number Set Nei Nei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

TC/Media Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

Monitoring Output On/Off SDI Ja Nei

HDMI Ja Nei

Output Format SDI Ja Nei

HDMI Ja Nei

De-Squeeze Ratio (HDMI/VF) Ja Nei

Output Display SDI Ja Nei

HDMI Ja Nei

Display On/Off Network Status Ja Nei

File Transfer Status Ja Nei

Rec/Play Status Ja Nei

RAW Output Control Status Ja Nei

Tally Ja Nei

Battery Remain Ja Nei

Focus Mode Ja Nei

Focus Position Ja Nei

Focus Area Indicator Ja Nei

Focus Area Ind.(AF-S) Ja Nei

Face/Eye Detection Frame Ja Nei

Tracking AF Pointer Ja Nei

Lens Info Ja Nei

Imager Scan Mode Ja Nei

Rec Format Ja Nei

Frame Rate Ja Nei

Zoom Position Ja Nei

UWP RF Level Ja Nei

SteadyShot Ja Nei

Base Look/Rec Look Ja Nei

SDI/HDMI Rec Control Ja Nei

Monitoring Look Ja Nei

Proxy Status Ja Nei

Base ISO/Sensitivity Ja Nei

Media Status Ja Nei

Video Signal Monitor Ja Nei

Clip Name Ja Nei

White Balance Ja Nei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Display On/Off Scene File Ja Nei

Focus Indicator Ja Nei

Auto Exposure Mode Ja Nei

Auto Exposure Level Ja Nei

Timecode Ja Nei

ND Filter Ja Nei

Iris Ja Nei

ISO/Gain/EI Ja Nei

Shutter Ja Nei

Level Gauge Ja Nei

Audio Level Meter Ja Nei

Video Level Warning Ja Nei

Clip Number Ja Nei

Notice Message Ja Nei

Marker Setting Ja Nei

Color Ja Nei

Center Marker Ja Nei

Safety Zone Ja Nei

Safety Area Ja Nei

Aspect Marker Ja Nei

Aspect Mask Ja Nei

Aspect Safety Zone Ja Nei

Aspect Safety Area Ja Nei

Aspect Select Ja Nei

Custom Aspect Ratio Ja Nei

Guide Frame Ja Nei

100% Marker Ja Nei

User Box Ja Nei

User Box Width Ja Nei

User Box Height Ja Nei

User Box H Position Ja Nei

User Box V Position Ja Nei

VF Setting Brightness Ja Nei

Color Mode Ja Nei

Gamma Display Assist Setting Ja Nei

Peaking Setting Ja Nei

Peaking Level Ja Nei

Color Ja Nei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Monitoring Zebra Setting Ja Nei

Zebra1 Level Ja Nei

Zebra1 Aperture Level Ja Nei

Zebra2 Level Ja Nei

Audio Audio Input CH1 Input Select Ja Nei

CH2 Input Select Ja Nei

CH3 Input Select Ja Nei

CH4 Input Select Ja Nei

INPUT1 MIC Reference Ja Nei

INPUT2 MIC Reference Ja Nei

Line Input Reference Ja Nei

Reference Level Ja Nei

CH1 Wind Filter Ja Nei

CH2 Wind Filter Ja Nei

CH3 Wind Filter Ja Nei

CH4 Wind Filter Ja Nei

CH3 Level Control Ja Nei

CH4 Level Control Ja Nei

CH3 Input Level Ja Nei

CH4 Input Level Ja Nei

Audio Input Level Ja Nei

Limiter Mode Ja Nei

CH1&2 AGC Mode Ja Nei

CH3&4 AGC Mode Ja Nei

AGC Spec Ja Nei

1kHz Tone on Color Bars Ja Nei

CH1 Level Ja Nei

CH2 Level Ja Nei

CH3 Level Ja Nei

CH4 Level Ja Nei

Audio Output Monitor CH Ja Nei

Volume Nei Nei

Headphone Out Ja Nei

Alarm Level Ja Nei

HDMI Output CH Ja Nei

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Thumbnail Display Clip Properties – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Transfer Clip Select Clip – –

All Clips – –

Transfer Clip (Proxy) Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

All – –

Customize View Thumbnail Caption Ja –

Technical Color Bars Setting Nei Nei

Type Ja Nei

ND Dial CLEAR with Dial Ja Nei

Tally Front Ja Nei

Rear Ja Nei

HOLD Switch Setting with Rec Button Ja Nei

with Hand Grip Remote Ja Nei

Handle HOLD Switch Ja Nei

Touch Operation Setting Ja Nei

Rec Review Setting Ja Nei

Zoom Zoom Type Ja Nei

Handle Zoom Setting Ja Nei

High Ja Nei

Low Ja Nei

Menu Settings User Menu Only Ja Nei

User Menu with Lock Nei Nei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Technical Menu Page On/Off Main Ja Nei

Camera Ja Nei

Audio Ja Nei

Project Ja Nei

Monitoring Ja Nei

Assignable Button Ja Nei

Battery Ja Nei

Media Ja Nei

Network Ja Nei

File Transfer Ja Nei

Fan Control Setting Ja Nei

Lens Zoom Ring Direction Ja Nei

Shading Compensation Ja Nei

Chroma Aberration Comp. Ja Nei

Distortion Comp. Ja Nei

Breathing Compensation Ja Nei

Distance Display Ja Nei

Zoom Position Display Ja Nei

Video Light Set Video Light Set Ja Nei

APR APR – –

Camera Battery Alarm Low Battery Ja Nei

Battery Empty Ja Nei

Camera DC IN Alarm DC Low Voltage1 Ja Nei

DC Low Voltage2 Ja Nei

Network Setup for Mobile App Setup – –

Access Authentication User Name Nei Nei

Input Password Nei Nei

Generate Password – –

Show Settings – –

Wireless LAN Setting Ja Nei

WPS – –

NFC – –

MAC Address – –

AP Mode Settings Channel Ja Nei

Camera SSID & Password – –

Regenerate Password – –

IP Address – –

Subnet Mask – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network ST Mode Settings Camera Remote Control Ja Nei

Connected Network

SSID – –

Security – –

Password – –

DHCP – –

IP Address – –

Subnet Mask – –

Gateway – –

DNS Auto – –

Primary DNS Server – –

Secondary DNS Server – –

Scan Networks

SSID – –

Security – –

Password Nei Nei

DHCP Ja Nei

IP Address Ja Nei

Subnet Mask Ja Nei

Gateway Ja Nei

DNS Auto Ja Nei

Primary DNS Server Ja Nei

Secondary DNS Server Ja Nei

Manual Register

SSID Ja Nei

Security Ja Nei

Password Nei Nei

DHCP Ja Nei

IP Address Ja Nei

Subnet Mask Ja Nei

Gateway Ja Nei

DNS Auto Ja Nei

Primary DNS Server Ja Nei

Secondary DNS Server Ja Nei
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LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Network Wired LAN Setting Ja Nei

Camera Remote Control Ja Nei

Detail Settings

DHCP Ja Nei

IP Address Ja Nei

Subnet Mask Ja Nei

Gateway Ja Nei

DNS Auto Ja Nei

Primary DNS Server Ja Nei

Secondary DNS Server Ja Nei

Modem Setting Ja Nei

Camera Remote Control Ja Nei

Device Name – –

IP Address – –

Subnet Mask – –

File Transfer Auto Upload Ja Nei

Auto Upload (Proxy) Ja Nei

Default Upload Server Ja Nei

Clear Completed Jobs – –

Clear All Jobs – –

View Job List – –

Server Settings1/Server Settings2/Server Settings3

Display Name Ja Nei

Service Ja Nei

Host Name Ja Nei

Port Ja Nei

User Name Nei Nei

Password Nei Nei

Passive Mode Ja Nei

Destination Directory Ja Nei

Using Secure Protocol Ja Nei

Root Certificate – –

Root Certificate Status – –

Reset – –

Network Reset Reset – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File

Maintenance Language Select Ja Nei

Clock Set Time Zone Ja Nei

Date Mode Ja Nei

12h/24h Ja Nei

Date Nei Nei

Time Nei Nei

All Reset Reset – –

Reset without Network – –

Reset to Factory Defaults – –

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Version Version Number – –

Version Up – –

Lens Version Number – –
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Elementer som konfigureres med knapper som kan tilordnes

Ja: Elementet lagres.
Nei: Element lagres ikke.
–: Ikke lagret (midlertidig innstilling)

Knappevalg som kan tilordnes All File Scene File

ND Filter Position Ja Nei

Auto Iris Ja Nei

ATW Ja Nei

Focus Setting Ja Nei

Display Ja –

VF Adjust Ja –

Elementer som konfigureres med hjulet som kan tilordnes

Ja: Elementet lagres.
Nei: Element lagres ikke.
–: Ikke lagret (midlertidig innstilling)

Valg som tilordnes hjulet All File Scene File

IRIS Ja Nei

ND Filter Ja Nei

Audio Input Level Ja Nei



8. Tillegg138

Se beslektede elementer i "Angi at lyden skal tas opp" (side 47) og "User-meny" (side 75).

Audio Input (CH1&CH2)

Nedenfor vises blokkdiagrammet med håndtaket tilkoblet.

INPUT1

L

R

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

CH1

[CH1 Input Select]
INPUT1
Internal MIC
Shoe CH1

[CH2 Input Select]
INPUT1
INPUT2
Internal MIC
Shoe CH2

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

<CH1 LEVEL
   CONTROL>*
AUTO
MAN

<CH1 INPUT LEVEL>
0 ~ 10

[CH1 Wind Filter]
On
O�

[CH2 Wind Filter]
On
O�

CH2

<CH2 LEVEL
   CONTROL>*
AUTO
MAN

<CH2 INPUT LEVEL>
0 ~ 10

[CH1&2 AGC Mode]
Mono
Stereo [Color Bars]

[1kHz Tone on Color
Bars]
On
O�

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,

-9dB, -12dB,
-15dB, -17dB SG

[CH1 Level]
Audio Input Level
Side
Level + Side
Through

[CH2 Level]
Audio Input Level
Side
Level + Side
Through

*	 Sett til Manual når lyd mates inn fra XLR-adapter.

Blokkdiagram
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Audio Input (CH3&CH4)

Nedenfor vises blokkdiagrammet med håndtaket tilkoblet.

L

R

CH3

[CH3 Level
 Control]*
Auto
Manual

[CH4 Level
 Control]*
Auto
Manual

[CH3 Input Level]
0 ~ 99

CH4

[CH4 Input Level]
0 ~ 99

[CH3&4 AGC Mode]
Mono
Stereo

[Audio Input Level]
0 ~ 99

[Limiter Mode]
O�, -6dB,
-9dB, -12dB,
-15dB, -17dB SG

OFF

[CH3 Input Select]
O�
INPUT1
Internal MIC
Shoe CH1

Fo
r 

X
LR

 a
d

ap
to

r
Fo

r 
X

LR
 a

d
ap

to
r

[CH3 Wind Filter]
On
O�

[CH4 Wind Filter]
On
O�

[CH4 Input Select]
O�
INPUT1
INPUT2
Internal MIC
Shoe CH2

INPUT1

INPUT2

Shoe CH1

Shoe CH2

Internal MIC

[CH3 Level]
Audio Input Level
CH3 Input Level
Level+CH3 Input Level
Through

[CH4 Level]
Audio Input Level
CH4 Input Level
Level+CH4 Input Level
Through

[Color Bars]
[1kHz Tone on Color
Bars]
On
O�

 
*	 Sett til Manual når lyd mates inn fra XLR-adapter.
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Audio Output

L

R

Alarm
Beep

[HDMI Output CH]
CH1/CH2, CH3/CH4

[Monitor CH]
CH1, CH2, CH3, CH4,
CH1/CH2, CH3/CH4,
MIX ALL

[Headphone Out]
Mono, Stereo

[VOLUME]
0 ～ 50

[Alarm Level]
0 ～ 7

Ch
MIX

CH1

SDI OUT

Headphone

Internal Speaker

HDMI OUT

CH2

CH3

CH4
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Du kan oppdatere programvaren til et objektiv 
med E-fatning ved hjelp av videokameraet.
Se nettstedet for objektivet for objektiver som 
kan oppdateres og tilsvarende programvare.

Kontrollere versjonen

1	 Fest et objektiv med E-fatning til 
videokameraet (side 22).

2	 Velg Version i menyen Maintenance i 
hovedmenyen for å vise Lens Version 
Number for objektivet (side 109).
Programvareversjonen for et objektiv med 
E-fatning vises på siden.

Oppdatere programvare

Sett videokameraet i masselagringsmodus 
(side 121).
Oppdater programvaren ved å følge 
prosedyren som følger med programvaren for 
objektivet.

Oppdatere programvare for objektiv med E-fatning
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MPEG-4 AVC lisens for 
patentportefølje

DETTE PRODUKTET LISENSIERES UNDER AVC 
PATENTPORTEFØLJLISENSEN FOR PERSONLIG 
BRUK AV EN FORBRUKER ELLER ANNEN BRUK 
SOM DET IKKE MOTTAS GODTGJØRELSE FOR
(i)	 KODING AV VIDEO I SAMSVAR MED AVC-

STANDARDEN ("AVC-VIDEO") OG/ELLER
(ii)	DEKODING AV AVC VIDEO SOM BLE KODET 

AV EN FORBRUKER SOM DRIVER EN 
PERSONLIG AKTIVITET, OG/ELLER SOM BLE 
INNHENTET FRA EN VIDEOLEVERANDØR 
SOM ER LISENSIERT FOR Å LEVERE AVC 
VIDEO.

INGEN LISENS GIS ELLER SKAL UNDERFORSTÅS 
FOR NOEN ANNEN BRUK. YTTERLIGERE 
INFORMASJON KAN FÅS FRA MPEG LA, LLC. SE 
HTTP://WWW.MPEGLA.COM

Skaffe programvare under GPL/
LGPL-lisens

Dette produktet bruker programvare som 
GPL/LGPL gjelder for. Dette er informasjon 
om at du har rett til å ha tilgang til, endre 
og videredistribuere kildekode for disse 
programmene i henhold til vilkårene for GPL/
LGPL.
Kildekoden er tilgjengelig på internett. 
Bruk følgende URL-adresse, og følg 
nedlastingsinstruksjonene.
https://oss.sony.net/Products/Linux/

Vi foretrekker at du ikke kontakter oss 
angående innholdet i kildekoden.

Lisenser (på engelsk) registreres i produktets 
interne minne.
Opprett en Mass Storage-forbindelse mellom 
produktet og en datamaskin for å lese lisenser 
i mappen "PMHOME" - "LICENSE".

LISENSAVTALE FOR SLUTTBRUKER

IMPORTANT: 
BEFORE USING THE SOFTWARE CONTAINED IN THE 
SOLID STATE MEMORY CAMCORDER, PLEASE READ THIS 
END USER LICENSE AGREEMENT (“EULA”) CAREFULLY. BY 
USING THE SOFTWARE YOU ARE ACCEPTING THE TERMS 
OF THIS EULA. IF YOU DO NOT ACCEPT THE TERMS OF 
THIS EULA, YOU MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and Sony 
Corporation (“SONY”). This EULA governs your rights 
and obligations regarding the software of SONY and/or 
its third party licensors (including SONY’s affiliates) and 
their respective affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, together 
with any updates/ upgrades provided by SONY, any 
printed, on-line or other electronic documentation for 
such software, and any data files created by operation of 
such software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user license 
agreement (including, but not limited to, GNU General 
Public license and Lesser/Library General Public License) 
shall be covered by such applicable separate end user 
license agreement in lieu of the terms of this EULA to 
the extent required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The SOFTWARE is 
protected by copyright and other intellectual property 
laws and international treaties.

COPYRIGHT
All right and title in and to the SOFTWARE (including, 
but not limited to, any images, photographs, animation, 
video, audio, music, text and “applets” incorporated into 
the SOFTWARE) is owned by SONY or one or more of the 
THIRD-PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the SOFTWARE 
solely in connection with the wireless adapter and only 
for your individual use. SONY and the THIRD-PARTY 
SUPPLIERS expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual property 
rights) in and to the SOFTWARE that this EULA does not 
specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, attempt 
to derive source code, modify, reverse engineer, 
decompile, or disassemble any of the SOFTWARE, 
whether in whole or in part, or create any derivative 
works from or of the SOFTWARE unless such derivative 
works are intentionally facilitated by the SOFTWARE. 
You may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. You 
may not bypass, modify, defeat or circumvent any of 
the functions or protections of the SOFTWARE or any 
mechanisms operatively linked to the SOFTWARE. You 
may not separate any individual component of the 
SOFTWARE for use on more than one wireless adapter 
unless expressly authorized to do so by SONY. You 
may not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not share, 

distribute, rent, lease, sublicense, assign, transfer or 
sell the SOFTWARE. The software, network services 
or other products other than SOFTWARE upon which 
the SOFTWARE’S performance depends might be 
interrupted or discontinued at the discretion of the 
suppliers (software suppliers, service suppliers, or 
SONY). SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other products 
will continue to be available, or will operate without 
interruption or modification. 

EXCLUDED SOFTWARE AND OPEN SOURCE 
COMPONENTS
Notwithstanding the foregoing limited license grant, 
you acknowledge that the SOFTWARE may include 
EXCLUDED SOFTWARE. Certain EXCLUDED SOFTWARE 
may be covered by open source software licenses 
(“Open Source Components”), which means any 
software licenses approved as open source licenses by 
the Open Source Initiative or any substantially similar 
licenses, including but not limited to any license that, 
as a condition of distribution of the software licensed 
under such license, requires that the distributor make 
the software available in source code format. If and to 
the extent disclosure is required, please visit www.sony.
com/linux or other SONY-designated web site for a list 
of applicable OPEN SOURCE COMPONENTS included in 
the SOFTWARE from time to time, and the applicable 
terms and conditions governing its use. Such terms 
and conditions may be changed by the applicable 
third party at any time without liability to you. To the 
extent required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will apply in lieu 
of the terms of this EULA. To the extent the terms of the 
licenses applicable to EXCLUDED SOFTWARE prohibit 
any of the restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will not apply 
to such EXCLUDED SOFTWARE. To the extent the terms 
of the licenses applicable to Open Source Components 
require SONY to make an offer to provide source code 
in connection with the SOFTWARE, such offer is hereby 
made. 

Lisenser

HTTP://WWW.MPEGLA.COM
https://oss.sony.net/Products/Linux/
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USE OF SOFTWARE WITH COPYRIGHTED 
MATERIALS
The SOFTWARE may be capable of being used by you 
to view, store, process and/or use content created by 
you and/or third parties. Such content may be protected 
by copyright, other intellectual property laws, and/
or agreements. You agree to use the SOFTWARE only 
in compliance with all such laws and agreements that 
apply to such content. You acknowledge and agree 
that SONY may take appropriate measures to protect 
the copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are not 
limited to, counting the frequency of your backup and 
restoration through certain SOFTWARE features, refusal 
to accept your request to enable restoration of data, and 
termination of this EULA in the event of your illegitimate 
use of the SOFTWARE. 

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE SOFTWARE MAY BE 
DESIGNED TO BE USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT SERVICES 
(“CONTENT SERVICE”). USE OF THE SERVICE AND THAT 
CONTENT IS SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU DECLINE TO ACCEPT 
THOSE TERMS, YOUR USE OF THE SOFTWARE WILL 
BE LIMITED. You acknowledge and agree that certain 
content and services available through the SOFTWARE 
may be provided by third parties over which SONY has 
no control. USE OF THE CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT SERVICE MAY BE 
DISCONTINUED AT ANY TIME.

INTERNET CONNECTIVITY AND THIRD PARTY 
SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet connection 
for which you are solely responsible. Further, you are 
solely responsible for payment of any third party fees 
associated with your Internet connection, including 
but not limited to Internet service provider or airtime 
charges. Operation of the SOFTWARE may be limited 
or restricted depending on the capabilities, bandwidth 
or technical limitations of your Internet connection 
and service. The provision, quality and security of such 
Internet connectivity are the sole responsibility of the 
third party providing such service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export and re-
export restrictions and regulations of the area or country 
in which you reside, and not to transfer, or authorize 
the transfer, of the SOFTWARE to a prohibited country 
or otherwise in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not designed, 
manufactured or intended for use or resale as on-
line control equipment in hazardous environments 
requiring fail-safe performance, such as in the 
operation of nuclear facilities, aircraft navigation or 
communication systems, air traffic control, direct life 
support machines, or weapons systems, in which the 
failure of the SOFTWARE could lead to death, personal 
injury, or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of the THIRD-
PARTY SUPPLIERS, and each of their respective affiliates 
specifically disclaim any express or implied warranty, 
duty or condition of fitness for HIGH RISK ACTIVITIES.

EXCLUSION OF WARRANTY ON SOFTWARE
You acknowledge and agree that use of the SOFTWARE 
is at your sole risk and that you are responsible for use 
of the SOFTWARE. The SOFTWARE is provided “AS IS,” 
without warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) EXPRESSLY DISCLAIM ALL WARRANTIES, DUTIES 
OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY, NONINFRINGEMENT AND 
FITNESS FOR A PARTICULAR PURPOSE. SONY 
DOES NOT WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE FUNCTIONS 
CONTAINED IN ANY OF THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE UPDATED, (B) 
THAT THE OPERATION OF ANY OF THE SOFTWARE WILL 
BE CORRECT OR ERROR-FREE OR THAT ANY DEFECTS 
WILL BE CORRECTED, (C) THAT THE SOFTWARE WILL 
NOT DAMAGE ANY OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, NETWORK SERVICES 
(INCLUDING THE INTERNET) OR PRODUCTS (OTHER 

THAN THE SOFTWARE) UPON WHICH THE SOFTWARE’S 
PERFORMANCE DEPENDS WILL CONTINUE TO BE 
AVAILABLE, UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR OTHERWISE. 

NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY SONY OR AN AUTHORIZED REPRESENTATIVE 
OF SONY SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE THE SCOPE OF 
THIS WARRANTY. SHOULD THE SOFTWARE PROVE 
DEFECTIVE YOU ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR CORRECTION. SOME 
JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THESE EXCLUSIONS MAY NOT 
APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY SUPPLIERS (for 
purposes of this Section, SONY and each of the THIRD-
PARTY SUPPLIERS shall be collectively referred to as 
“SONY”) SHALL NOT BE LIABLE FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR BREACH OF 
ANY EXPRESS OR IMPLIED WARRANTY, BREACH OF 
CONTRACT, NEGLIGENCE, STRICT LIABILITY OR UNDER 
ANY OTHER LEGAL THEORY RELATED TO THE SOFTWARE, 
INCLUDING, BUT NOT LIMITED TO, ANY DAMAGES 
ARISING OUT OF LOSS OF PROFITS, LOSS OF REVENUE, 
LOSS OF DATA, LOSS OF USE OF THE SOFTWARE OR 
ANY ASSOCIATED HARDWARE, DOWN TIME AND USER'S 
TIME, EVEN IF ANY OF THEM HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, 
EACH AND ALL OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE LIMITED TO 
THE AMOUNT ACTUALLY PAID FOR THE PRODUCT. 
SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION OR LIMITATION 
MAY NOT APPLY TO YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 

collected from the SOFTWARE, including but not 
limited to information about (i) the SOFTWARE and 
(ii) the software applications, contents and peripheral 
devices that interact with your wireless adapter and the 
SOFTWARE (“Information”). Information includes, but 
is not limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) performance 
of the wireless adapter, the SOFTWARE and their 
components; (3) configurations of your wireless adapter, 
the SOFTWARE and the software applications, contents 
and peripheral devices that interact with the wireless 
adapter and the SOFTWARE; (4) use and frequency of 
use of the functions of (x) the SOFTWARE, and (y) the 
software applications, contents and peripheral devices 
that interact with the SOFTWARE; and (5) location data, 
as indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information subject 
to applicable laws in order to improve its products and 
services or to provide products or services to you. Such 
uses include, but are not limited to: (a) administering 
the functionalities of the SOFTWARE; (b) to improve, 
service, update or upgrade the SOFTWARE; (c) 
improving, developing and enhancing the current and 
future products and services of SONY and other parties; 
(d) to provide you with information about the products 
and services offered by SONY and other parties; (e) 
complying with applicable laws or regulations; and (f) 
to the extent offered, providing you with location-based 
services of SONY and other parties, as indicated below. 
In addition, SONY retains the right to use Information 
to protect itself and third parties from illegal, criminal or 
harmful conduct.

Certain services available through the SOFTWARE may 
rely upon location information, including, but not limited 
to, the geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing such 
services, SONY, the THIRDPARTY SUPPLIERS or their 
partners may collect, archive, process and use such 
location data, and that such services are governed by 
the privacy policies of SONY or such third party. By 
reviewed the privacy policies applicable to such services 
and consent to such activities. 
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SONY, its affiliates, partners and agents will not 
intentionally use Information to personally identify 
the owner or user of the SOFTWARE without your 
knowledge or consent. Any use of Information will be 
in accordance with the privacy policies of SONY or such 
third party. 

Please contact applicable contact address of each area or 
country for SONY’s current privacy policy. Please contact 
applicable third parties for privacy policies relating 
to personally identifiable and other information you 
provide when you use or access third party software or 
services. 

Information may be processed, stored or transferred 
to SONY, its affiliates or agents which are located in 
countries outside of your country of residence. Data 
protection and information privacy laws in certain 
countries may not offer the same level of protection 
as your country of residence and you may have fewer 
legal rights in relation to Information processed and 
stored in, or transferred to, such countries. SONY will 
use reasonable efforts to take appropriate technical and 
organizational steps to prevent unauthorized access to 
or disclosure of Information, but does not warrant it will 
eliminate all risk of misuse of such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY SUPPLIERS 
may automatically update or otherwise modify the 
SOFTWARE, including, but not limited to, for purposes 
of enhancement of security functions, error correction 
and improvement of functions, at such time as you 
interact with SONY’s or third parties’ servers, or 
otherwise. Such updates or modifications may delete 
or change the nature of features or other aspects of the 
SOFTWARE, including, but not limited to, functions you 
may rely upon. You acknowledge and agree that such 
activities may occur at SONY’s sole discretion and that 
SONY may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of such 
update or modifications. Any updates/modifications 
shall be deemed to be, and shall constitute part of, the 
SOFTWARE for purposes of this EULA. By acceptance of 
this EULA, you consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, SEVERABILITY
This EULA and SONY’s privacy policy, each as amended 
and modified from time to time, together constitute the 
entire agreement between you and SONY with respect 
to the SOFTWARE. The failure of SONY to exercise or 
enforce any right or provision of this EULA shall not 
constitute a waiver of such right or provision. If any part 
of this EULA is held invalid, illegal, or unenforceable, 
that provision shall be enforced to the maximum extent 
permissible so as to maintain the intent of this EULA, 
and the other parts will remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for the 
International Sale of Goods shall not apply to this EULA. 
This EULA shall be governed by the laws of Japan, 
without regards to conflict of laws provisions. Any 
dispute arising out of this EULA shall be subject to the 
exclusive venue of the Tokyo District Court in Japan, and 
the parties hereby consent to the venue and jurisdiction 
of such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this EULA to the 
contrary, you acknowledge and agree that any violation 
of or noncompliance with this EULA by you will cause 
irreparable harm to SONY, for which monetary damages 
would be inadequate, and you consent to SONY 
obtaining any injunctive or equitable relief that SONY 
deems necessary or appropriate in such circumstances. 
SONY may also take any legal and technical remedies 
to prevent violation of and/or to enforce this EULA, 
including, but not limited to, immediate termination of 
your use of the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to violate 
this EULA. These remedies are in addition to any other 
remedies SONY may have at law, in equity or under 
contract.

TERMINATION
Without prejudice to any of its other rights, SONY may 
terminate this EULA if you fail to comply with any of its 
terms. In case of such termination, you must: (i) cease 
all use, and destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section below 
entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND ANY OF THE 
TERMS OF THIS EULA AT ITS SOLE DISCRETION BY 
POSTING NOTICE ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL ADDRESS PROVIDED 
BY YOU, BY PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN UPGRADES/ UPDATES 
OR BY ANY OTHER LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, you 
should promptly contact SONY for instructions. Your 
continued use of the SOFTWARE after the effective date 
of any such notice shall be deemed your agreement to 
be bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express intended 
thirdparty beneficiary of, and shall have the right to 
enforce, each provision of this EULA with respect to the 
SOFTWARE of such party. 

Should you have any questions concerning this EULA, 
you may contact SONY by writing to SONY at applicable 
contact address of each area or country.

Copyright © 2012 Sony Corporation.

Programvarelisenser for åpen 
kildekode

Med basis i lisenskontrakter mellom Sony og 
rettighetshaverne for programvaren bruker 
dette produktet åpen programvare.
For å oppfylle kravene til rettighetshaverne i 
programvaren er Sony forpliktet til å informere 
deg om innholdet i disse lisensene.
Lisenser (på engelsk) registreres i produktets 
interne minne.
Opprett en Mass Storage-forbindelse mellom 
produktet og en datamaskin for å lese lisenser 
i mappen "PMHOME" - "LICENSE".
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Generelt

Masse

	 Ca. 890 g (bare hovedenhet)

	 Ca. 2,59 kg (inkludert SEL24105G objektiv, 

objektivhette, batteri (BP‑U35), 

søker, håndtak, grep)

Dimensjoner

	 Se side 148.

Krav til nettstrøm

	 19,5 V DC (18,0 V til 20,5 V)

Strømforbruk

	 Ca. 18,0 W (kamerahus, objektiv, XAVC-i QFHD 

59.94P-opptak, søker på, ingen 

ekstern enhet tilkoblet)

	 Ca. 36,0 W (kamerahus, objektiv, XAVC-i QFHD 

59.94P-opptak (S&Q 120 fps), 

søker på, HDMI, SDI, ekstern enhet 

tilkoblet)

Driftstemperatur

	 0 °C til 40 °C

Lagringstemperatur

	 –20 °C til +60 °C

Kontinuerlig driftstid

	 Ca. 105 minutter (med BP-U35) 

(kamerahus, objektiv, XAVC-I 

QFHD 59.94P-opptak, søker på, 

ingen ekstern enhet tilkoblet)

Opptaksformat (video)

	 XAVC Intra

		  XAVC-i 4K-/QFHD-modus: 

VBR, 600 Mbps (maks.) 

bithastighet, MPEG-4 AVC/H.264

		  XAVC-i HD-modus: 

CBG, 223 Mbps (maks.) 

bithastighet, MPEG-4 AVC/H.264

	 XAVC Long

		  XAVC-L QFHD-modus: 

VBR, 150 Mbps (maks.) 

bithastighet, MPEG-4 H.264/AVC

		  XAVC-L HD 50-modus: 

VBR, 50 Mbps (maks.) 

bithastighet, MPEG-4 H.264/AVC

		  XAVC-L HD 35-modus: 

VBR, 35 Mbps (maks.) 

bithastighet, MPEG-4 H.264/AVC

Opptaksformat (lyd)

	 LPCM 24-bit, 48 kHz, 4-kanal

Bildefrekvens ved opptak

	 XAVC Intra

		  XAVC-I 4K-modus: 

4096×2160/59.94P, 50P, 29.97P, 

25P, 24P, 23.98P

		  XAVC-I QFHD-modus: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-I HD-modus: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

	 XAVC Long

		  XAVC-L QFHD-modus: 

3840×2160/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-L HD 50-modus: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

		  XAVC-L HD 35-modus: 

1920×1080/59.94P, 50P, 29.97P, 

25P, 23.98P

Opptaks-/avspillingstid

	 XAVC Intra

		  XAVC-I QFHD-modus:

			   59.94P

			   Ca. 30 minutter 

(med CEA-G160T)

		  XAVC-I HD-modus:

			   59.94P

			   Ca. 78 minutter 

(med CEA-G160T)

	 XAVC Long

		  XAVC-L QFHD-modus:

			   59.94P

			   Ca. 115 minutter 

(med CEA-G160T)

		  XAVC-L HD 50-modus:

			   59.94P

			   Ca. 155 minutter 

(med CEA-G80T)

		  XAVC-L HD 35-modus:

			   59.94P

			   Ca. 210 minutter 

(med CEA-G80T)

[Merk]
Opptaks-/avspillingstiden kan variere på grunn av 
bruksforhold og egenskaper ved minnet. Opptaks- og 
avspillingstidene er for et kontinuerlig opptak som 
ett enkelt klipp. De faktiske tidene kan være kortere, 
avhengig av antall klipp som tas opp.

Kameradelen

Bildeenhet (type)

	 35 mm CMOS-bildesensor tilsvarende full 

størrelse på én brikke

Antall piksler

	 12,9M (total)

	 10,2M (effektiv)

Autofokus

	 Deteksjonsmetode: Fasedetektsjon/

kontrastdeteksjon

Interne ND-filter

	 CLEAR: OFF

	 1: 1/4ND

	 2: 1/16ND

	 3: 1/64ND

	 Lineært variabel ND: 1/4ND til 1/128ND

ISO-følsomhet

	 ISO 800/12800 (Cine EI Quick/Cine EI, D55 

lyskilde)

Objektivfatning

	 E-feste

Eksponeringsintervall

	 15+ stopp

Lukkerhastighet

	 64F til 1/8000 sek (23.98P)

Lukkervinkel

	 5,6° til 360°, 2 til 64 bilder

Sakte og rask bevegelse

	 XAVC QFHD: 1 fps til 120 fps

	 XAVC HD: 1 fps til 240 fps

	 XAVC 4K: 1 fps til 60 fps

	 XAVC HD (S35): 1 fps til 120 fps

Hvitbalanse

	 2000 K til 15000 K

Forsterkning

	 –3 dB til +30 dB (i trinn på 1 dB)

Basisutseende

	 S-Cinetone, Standard, Still, ITU709, 709tone, 

s709, 709(800%), S-Log3,  

HLG Live, HLG Natural

Lyddelen

Samplingsfrekvens

	 48 kHz

Kvantifisering

	 24-biters

Frekvensrespons

	 XLR-inngang i MIC-modus: 20 Hz til 20 kHz 

(±3 dB eller mindre)

	 XLR-inngang i LINE-modus: 20 Hz til 20 kHz 

(±3 dB eller mindre)

Spesifikasjoner
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Dynamisk område

	 XLR-inngang i MIC-modus: 80 dB (typisk)

	 XLR-inngang i LINE-modus: 90 dB (typisk)

Forvrengning

	 XLR-inngang i MIC-modus: 0,08% eller 

mindre (–40 dBu inngangsnivå)

	 XLR-inngang i LINE-modus: 0,08% eller 

mindre (+14 dBu inngangsnivå)

Innebygd høyttaler

	 Mono

Intern mikrofon 

	 Mono

Håndtakets interne mikrofon

	 Kondensatormikrofon for enveisstereo, ikke-

retningsstyrt

[Merk]
Bare den interne mikrofonen på håndtaket aktiveres når 
håndtaket er tilkoblet.

Inn-/ut-delen

Innganger
INPUT 1/2:

	 XLR-type, 3-pinners, hunn

	 LINE / MIC / MIC+48V svitsbar

	 MIC: Referanse –30 dBu til –80 dBu

TC IN:

	 BNC-type

Utganger
SDI OUT:

	 BNC-type, 12G-SDI, 6G-SDI, 3G-SDI  

(Level A/B), HD-SDI

Hodetelefoner (stereo minikontakt):

	 –16 dBu (referansenivåutgang, maksimalt 

monitorvolum, 16 Ω belastning)

HDMI:

	 Type A, 19 pinner

TC OUT:

	 BNC-type

Andre
DC IN:

	 EIAJ-kompatibel, 18 V til 20,5 V DC

Flergrensesnittsko:

	 Dedikert (21-pinners)

REMOTE:

	 2,5 mm 3-polet sub-mini-type

Grep, fjernkontroll:kontakt:

	 3,5 mm 4-polet stereo minikontakt 

(medfølgende kontakt for 

fjernkontroll med grep)

USB-C:

	 USB 3.2 Gen 1

USB/multi:

	 USB 2.0-kompatibel som standard, mikro-B-

type for masselagring (1)

VF:

	 Dedikert (40-pinners)

Skjermdelen

Søker (LCD)
Skjermstørrelse

	 8,8 cm (3,5 tommer) diagonalt

Bildesideforhold

	 16:9

Antall piksler

	 1280 (H) × 720 (V)

Mediespordelen

Kortspor for CFexpress Type A/SD-kort (2)

Trådløst LAN

Standarder som støttes

	 IEEE 802.11 a/b/g/n/ac (ILME-FX6V/VK)

	 IEEE 802.11 b/g/n (ILME-FX6T/TK)

Frekvensbånd

	 2,4 GHz

	 5 GHz (kun ILME-FX6V/VK)

Sikkerhetsprotokoller som støttes

	 WEP/WPA-PSK/WPA2-PSK

Tilkoblingsmetode

	 Wi-Fi Protected Setup™ (WPS)/manuell

Tilgangsmetode

	 Infrastrukturmodus

Batterilader (BC-CU1)

Vekt

	 Ca. 60 g

Dimensjoner

	 Ca. 57 × 26 × 101 mm 

(bredde/høyde/dybde)

Inngang

	 19,5 V DC, 26 W

Utgang

	 16,4 V DC, 1,4 A

Driftstemperatur

	 0 °C til 40 °C

Lagringstemperatur

	 –20 °C til +60 °C

Medfølgende tilbehør

Strømadapter (1)

Strømledning (1) 

Batterilader (1) 

Batteripakke (1)

Håndtak (1)

LCD-skjerm (1)

USB-C-ledning (1)

Grep, fjernkontroll (1)

LCD-hette (1)

Sett for kald sko (1) 

(kald sko (1), skofjær (1), skruer (4))

Deksel for objektivfatning (1)

Beskyttelsesdeksel for håndtakskontakt (1)

Før du bruker enheten (1)

Garantihefte (1)

Konstruksjonen og spesifikasjonene kan bli 
endret uten forvarsel.
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Merknader
ˎˎ Foreta alltid en testinnspilling og bekreft 
at innspillingen ble vellykket. SONY VIL 
IKKE VÆRE ANSVARLIG FOR SKADE AV NOE 
SLAG INKLUDERT, MEN IKKE BEGRENSET 
TIL, ERSTATNING ELLER TILBAKEBETALING 
PÅ GRUNN AV SVIKT AV DENNE ENHETEN 
ELLER DENS OPPTAKSMEDIA, ELLER NOEN 
ANDRE MEDIA ELLER LAGRINGSSYSTEMER 
FOR OPPTAK AV ET HVILKET SOM HELST 
INNHOLD.
ˎˎ Kontroller alltid at enheten virker som 
den skal før bruk. SONY VIL IKKE VÆRE 
ANSVARLIG FOR SKADER AV NOE SLAG 
INKLUDERT, MEN IKKE BEGRENSET TIL, 
ERSTATNING ELLER TILBAKEBETALING PÅ 
GRUNN AV TAP AV EKSISTERENDE ELLER 
FREMTIDIG FORTJENESTE SOM SKYLDES 
SVIKT AV DENNE ENHETEN, ENTEN UNDER 
GARANTIPERIODEN ELLER ETTER AT 
GARANTIEN HAR UTLØPT, ELLER FOR 
UANSETT ANNEN ÅRSAK.
ˎˎ SONY VIL IKKE VÆRE ANSVARLIG FOR 
KRAV AV NOE SLAG, FREMSATT AV 
BRUKERE AV ENHETEN ELLER FREMSATT AV 
TREDJEPARTER.
ˎˎ SONY VIL IKKE VÆRE ANSVARLIG FOR TAP, 
REPARASJONER ELLER REPRODUKSJON 
AV NOEN DATA SOM ER TATT OPP PÅ 
DET INTERNE LAGRINGSSYSTEMET, 
OPPTAKSMEDIER, ELLER NOEN ANDRE 
MEDIER ELLER LAGRINGSSYSTEMER.
ˎˎ SONY VIL IKKE VÆRE ANSVARLIG FOR 
AVSLUTNING ELLER AVBRUDD I NOEN 
TJENESTE SOM ER RELATERT TIL DENNE 
ENHETEN SOM MÅTTE OPPSTÅ PÅ GRUNN 
AV NOEN SOM HELST OMSTENDIGHET.
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Eksterne dimensjoner

Enhet: mm

UNC 1/4-20, Dybde: 6

UNC 3/8-16, Dybde: 5,5

2-UNC 1/8-20, Dybde: 6

UNC 1/4-20, Dybde: 6 UNC 1/4-20, Dybde: 6

UNC 1/4-20, Dybde: 5,5

98,6

11,9
8-UNC 1/4-20, Dybde: 6

143
60

98,6 89,8

82,5

114

62,8

60,6

258

90,1 60,6

25
25

25

4,9

25

117
228

74116

15326,1

6,9 28

UNC 1/4-20, Dybde: 6

Dimensjonene er omtrentlige verdier.
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Varemerker

ˎˎ  er et varemerke for Sony Corporation.
ˎˎ XAVC og  er registrerte varemerker for 
Sony Corporation.
ˎˎ Uttrykkene HDMI og HDMI High-Definition 
Multimedia Interface, og HDMI-logoen, er 
varemerker eller registrerte varemerker som 
tilhører HDMI Licensing Administrator, Inc. i 
USA og andre land.
ˎˎ Microsoft og Windows er varemerker 
eller registrerte varemerker for Microsoft 
Corporation i USA og/eller andre land.
ˎˎ Mac og macOS er registrerte varemerker for 
Apple Inc. i USA og andre land.
ˎˎ "Catalyst Browse," "Monitor & Control," 
"Content Browser Mobile," og "Content 
Browser Mobile"-logoen er varemerker eller 
registrerte varemerker for Sony Corporation.
ˎˎ IOS er et varemerke eller registrert 
varemerke for Cisco Systems Inc. i USA og 
visse andre land.
ˎˎ Android, Google Play er varemerker for 
Google Inc.
ˎˎ Wi-Fi, Wi-Fi-logoen og Wi-Fi PROTECTED 
SETUP er varemerker eller registrerte 
varemerker for Wi-Fi Alliance.
ˎˎ N-merket er et varemerke eller registrert 
varemerke for NFC Forum, Inc. i USA og 
andre land.
ˎˎ SDXC-logoen er et varemerke for SD-3C, LLC.
ˎˎ CFexpress og CFexpress Type A-logoen er 
varemerker for CompactFlash Association.
ˎˎ QR Code er et varemerke for Denso Wave 
Inc.
ˎˎ USB Type-C® og USB-C® er et registrerte 
varemerker for USB Implementers Forum.

Alle andre firmanavn og produktnavn er 
registrerte varemerker eller varemerker for 
sine respektive eierne. Merkevareartikler er 
ikke angitt med ™- eller ® -symboler i dette 
dokumentet.


	Innhold
	1. Oversikt
	Systemkonfigurasjon
	Delenes plassering og funksjon
	Hvordan bruke berøringspanelet
	Skjermvisning

	2. Forberedelse
	Strømforsyning
	Koble til enheter
	Konfigurere grunnleggende bruk av videokameraet
	Hvordan bruke minnekort

	3. Opptak
	Prosedyre for grunnleggende bruk
	Justere zoomen
	Justere fokus
	Justering av lysstyrken
	Justere for naturlige farger (hvitbalanse)
	Angi at lyden skal tas opp
	Nyttige funksjoner
	Proxy-opptak
	Ta bilder med ønsket utseende
	Fotografering med utseendejustering i postproduksjon
	Hvordan ta opp RAW-video

	4. Nettverksfunksjoner
	Koble til andre enheter via LAN
	Koble til Internett
	Laste opp filer
	Bruke Creators' App for enterprise

	5. Thumbnail-skjerm
	Thumbnail-skjerm
	Spille av klipp
	Klipp-handlinger

	6. Menyvisning og innstillinger
	Full menykonfigurasjon og -hierarki
	Bruk av hovedmenyen
	User-meny
	Edit User-meny
	Shooting-meny
	Project-menyen
	Paint/Look-meny
	TC/Media-meny
	Monitoring-meny
	Audio-menyen
	Thumbnail-menyen
	Technical-menyen
	Network-meny
	Maintenance-menyen
	Shooting-meny, innstillinger og standardverdier
	Bildekvalitetsinnstillinger lagres for hver opptaksmodus
	Lagre og laste inn konfigurasjonsdata

	7. Tilkobling av ekstern enhet
	Koble til eksterne skjermer og opptaksenheter
	Synkronisering av tidskoder
	Administrere/redigere klipp ved hjelp av en datamaskin

	8. Tillegg
	Forsiktighetsregler ved bruk
	Utdataformater og -begrensninger
	Feilsøking
	Feil-/varselmeldinger
	Elementer som er lagret i filer
	Blokkdiagram
	Oppdatere programvare for objektiv med E-fatning
	Lisenser
	Spesifikasjoner


